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Instructors: Jason Edward Lewis & Skawennati 

Welcome and Overview  
Introduce workshop, spaces, mentors, instructors, and participants 

 

 
Teaching Days, Time, & Length 
Monday July 9th, 9:15AM — 1 HR 30M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1nLkDobCTfhOA1zw8Vpx7-Fy16KQ8CJ9x4a
cCI8vaPRU/edit?usp=sharing 

 
Instructor Prerequisites 
A thorough working knowledge of the workshop and the history of Indigenous media 
representation.  
 
Participant Prerequisites 
N/A 
 
Equipment/Software Materials 
A presentation screen for showing PowerPoint. 
 
Objectives 

● Introductions and orientation. 
● Learn about AbTeC and the Skins workshop series. 

  
Vocabulary 
Skins, workshop, AbTeC, Indigenous representation 
  
References 

- Aboriginal Territories in Cyberspace website: http://abtec.org. 

- Skins website: http://abtec.org/iif/workshops. 

- “Aboriginal Territories in Cyberspace.” Cultural Survival Quarterly, vol. 29, issue 2. July 
2005. https://goo.gl/8c48wj. 

- “Skins 1.0: A Curriculum for Design Games with First Nations Youth.” Journal of Game 
Design and Development Education, vol. 1, no. 1. Winter 2011. https://goo.gl/2bPhhk. 

- Skins 2.0 Documentary. AbTeC. 2012. https://goo.gl/dyDRkh. 
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Overview 

Welcome everybody to the workshop. 

Ask participants, instructors and mentors, and the Kanaeokana team to introduce 
themselves.  

Introduce Aboriginal Territories in Cyberspace (AbTeC), the research network that created the 
Skins Workshops on Aboriginal Storytelling and Video Game Design.  

Review the general goals of the Skins workshops, and the particular goals of Skins 6.0. 
Discuss workshop culture. 

Workshop Overview  

● Storytelling Event 
● Week 1: Story Development and Game Design 
● Week 2: Technical Lessons 
● Week 3: Production 
● Final Playtest  

Discuss assessment and documentation. 

Orient everybody to the workshop space. 
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Storytelling 1 / Instructors: Skawennati & Kauwila Mahi 

Seeing Red: Native Representations 
in Media and Video Games 
A look at some of the stereotypes that made us mad enough  
to make our own video games, plus a few that we like. 

 

 
Teaching Days, Time, & Length 
Monday July 9th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/18o2B0xPHBhfgThLE8zy1cf6KnWMXqryq6I6
kDCPLTzQ/edit#slide=id.g37b3c3dd55_1_35 

Elizabeth LaPensée, “Native Representations in Video Games” video 
- https://vimeo.com/25991603 

 
Instructor Prerequisites 
Watch “Native Representations in Video Games” video (8 min). 
 
Participant Prerequisites 
Participation in Storytelling Event and introductions. 
 
Equipment/Software Materials 
A presentation screen on which to show “Native Representations in Video Games” and 
PowerPoint.  
 
Objectives 

- To show examples of and discuss harmful stereotypes of Indigenous people in the 
media. What are they? Where did they come from? How can we change them? 

- To learn about and show examples of self-representation and transmediation. 
  
Vocabulary 
stereotypes, self-representation, oral tradition, transmediation 
  
References 
Further Reading: 

- Native Americans In Comic Books: A Critical Study by Michael A. Sheyahshe 
 

 

 
Overview 
This lesson relays the Skins origin story, explaining why we created the workshops in the first 
place and encapsulating what sets the Skins workshops apart from other video game 
workshops. Skins encourages honest self-representation in media by supporting participants 
in sharing their community’s stories, and empowering them to transmediate them into new 
mediums by accessing and learning the tools and techniques of media production.  
 
Introduction 

- Skawennati introduces herself (5-10 minutes) 
One of the reasons we created the Skins workshops was because of all the (mostly terrible) 
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stereotypes about Native people we have encountered in our lives, most of which 
have circulated through books and movies. It seemed like these stereotypes were 
going to move into games as well. Elizabeth LaPensée, while a PhD candidate, made 
this movie that looked at some of the stereotypes of Onkwehonwe in games.  

- Play “Native Representations in Video Games” (8 minutes) 
Because this movie is very “mainland-centric”, I have asked Kauwila to present some of his 
research about the representation of Kānaka Maoli in games. 

- Kauwila introduces himself (5-10 minutes) 
- Kānaka Maoli in Games. (20 minutes) 

 
Discussion (15 minutes) 
Were there any stereotypes of Indigenous people that we missed? Where did these 
stereotypes come from? Why do they persist? 
 
Self-representation (5 minutes) 
In the past, Indigenous people usually did not have access to the tools of media production, 
such as the still camera and the movie camera. When non-Indigenous people took pictures of 
us, they used them to tell their version of who we were. Their stories usually supported the 
colonial narrative: why it was okay for them to come and disrupt our way of life!  
 
Today, thanks to our resilience, we continue to exist and, even better, we are able to have 
access to new technologies comparable to the general population. We can now use these 
tools to tell our own stories about ourselves.  
 
Introduce “Transmediation” (5 minutes) 
One of the things that is unique about the Skins workshops is that they are based on 
traditional storytelling. Our people conveyed their histories, values and stories through oral 
tradition. That is a very different way of telling a story than through a video game. In this 
workshop we will learn to think about how to transmediate: how to bring a story from one 
form to another. We will translate oral tradition into a video game! 
 
Conclusion 
We reviewed Native stereotypes in games, discussing where they came from and why they 
persist. We discussed self-representation, and that the Skins workshop will guide them in 
representing themselves in a video game. They can do this by transmediating an old story, by 
telling a contemporary story from their own lived experience, or imagining a story from the 
future. Remind them that we will be working as a team 
 

 

 
Links 
https://vimeo.com/25991603 
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 Storytelling 2 / Instructors: Skawennati & Noe Arista 

Transmediation of Mo’olelo 
How oral tradition can be translated into  
new mediums and why it’s important. 

 

 
Teaching Days, Time, & Length 
Tuesday July 10th, 9:30AM — 1HR 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1xk9BKUVZbkyTflaPryl1z2izM7IMXB0N31oZ
VrCf9VY/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
A strong cultural foundation. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 

- To show examples of transmediation of Indigenous stories into new media 
- To explain why it is important  

  
Vocabulary 
Moʻolelo, Kumulipo, Kaona, Kinolau, Kamapuaʻa, Pele, Hiʻiaka, Kānaka Maoli 
  
References 
Web Resources: 

Designing Game Narrative 
- http://hitboxteam.com/designing-game-narrative 

She Falls for Ages 
- http://www.skawennati.com/SheFallsForAges/index.html 

The Myth of the Earth Grasper 
- http://faculty.humanities.uci.edu/tcthorne/history12/EarthGrasperMohawkversion.pdf 

 
Reading: 

Algorithms of Oppression by Safiya Umoja Noble 
- https://nyupress.org/books/9781479837243/ 

 
 

 
Overview 
This lesson gives a timeline of storytelling, from oral tradition to video games. The concept of 
interactivity as a storytelling element is introduced as part of the structure of storytelling in 
video games. Participants are then asked to identify the important components of our 
traditional stories and histories. Who are the characters, what are the actions and what 
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values do they convey? How can these characters be brought to life through sound, 
dialogue, imagery, action and interactivity? 
 
A Storytelling Timeline 
Oral tradition: stories that are spoken. 

● “It is important that we remember that … for centuries [this story] was experienced 
through the senses of the ear and not the eye….”John Mohawk describes the 
traditional Iroquois listener: “They often sit immobile, their eyes closed, every bit of 
their energy concentrated on the words of the speaker.” 

Slide of graphic depicting: 

● Ideas over time 
● ears 

Literature: the written word 

● “Writers use words to express ideas, arranging them in ways that draw the reader 
into the world of the story. Writers use descriptive language to evoke the senses; they 
construct dialogue to reveal personalities; and they structure words into sentences, 
paragraphs, and chapters, to set the pacing and flow.” 

Slide of graphic depicting: 

● Ideas over time 
● eyes 

Cinema: The audiovisual experience 

● “Whole pages of descriptive language in a book can be represented by a brief scene 
of imagery in a movie. A conversation between characters is now enhanced by their 
body language, their tone of voice, and the cinematography.” Same with action. 
Lighting, sound effects and music all add to the sensory experience. 

● Mention here the filmmaking concept of “Show don’t tell”, which is to depict as much 
as you can through visuals and action. For example, rather than have the character 
say “It’s raining outside”, you would show her looking out the window at the rain. 

Slide of graphic depicting: 

● Ideas over time + sensory experience 
● eyes + ears 

 

Games: listener, reader, viewer becomes actor 

● “In games, you can discover further depth from doing [a] scene. With interactivity, you 
now get to experience the story firsthand. When you play as the protagonist, you 
have the opportunity to take on their motivations and emotions. You hear and see 
things via your own discovery, not from the guiding lens of a cameraman. We could 
say that video games communicate depth of narrative experientially, whereas cinema 
did it visually.” 

● In the still-developing world of game design, should the motto be: “Play don’t show”? 

Slide of graphic depicting: 

● Ideas over time + sensory experience + interactivity 
● eyes + ears + hands/body 

 

The Myth of the Earth Grasper, read a page or two 

● This book in itself is an example of transmediation. An ethnographer, J.N.B. Hewitt 
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worked with Onondaga Chief John Arthur Gibson --called “the last surviving 
individual trained to recite the story”-- to create a written record of the 
Iroquois creation story. So as Gibson dictated, Hewitt typed, and eventually, a 
book was made. By the time I got it, more than a hundred years later, another 
Iroquois scholar, the brilliant John Mohawk, had edited it: the original writing 
style was so outdated that only specialists could understand it. In the foreword he 
states, “Above all, I tried to preserve the thoughts of the ancients.” 

 

Transmediation Example 1: She Falls For Ages, a machinima by Skawennati 
Introduce and play excerpt from She Falls For Ages 

● She Falls For Ages is a sci-fi retelling that very closely follows John Mohawk’s version. 
I, too, tried to preserve ancient thinking and values. However, as John Mohawk wrote, 
“while removing one set of conventions, one necessarily replaces it with another”. 

 

 

ʻO Noe au 
I am Noe [5 mins] 
 
Kānaka maoli, writer, historian, he wahine, makua, and mentor. A kumu working to negotiate 
the shift of ʻike Hawaiʻi (Hawaiian knowledge) from writing and print into various digital 
mediums. Maybe my training, thinking and approach to things makes me well suited to 
considering trans-mediation. But how did i get here? 
 
[bowling alley / video game sequence] 
 
I was raised in a bowling alley in a place where I learned how to listen, how to read and how 
to play video games. A very “traditional” upbringing.  
 
I was also nourished on music playing various instruments and singing so my ear was trained 
from a young age to pay particular attention to sound. I would describe myself as a person 
who privileges sound over visuals. I tried my hand at being a musician, but failed in that 
academic pursuit, then i went on to a degree in Hawaiian religion, which required that I learn 
Hawaiian language by default. I began studying language when I was 27. I was trained by 
both academics and kūpuna experts. I learned with my classmates and these kumu until the 
day when I could read and hear and understand.  

 

The word makes the world  
Transmediation Example 1: Orality into Print 
In Hawaiian words hold paramount importance for several reasons. Words were used to pray 
to the gods to ask for what was needed to fight, to survive, to heal, and so the land and 
people could thrive. Words were the medium that secured all of our knowledge since we had 
no writing system for the purpose of recalling all of our stories, songs, laws, and prayers. 
People tasked with remembering and presenting Hawaiian knowledge were trained in formal 
schools and in families under kapu---their memories carved in particular ways to receive, 
make connections and transmit information making recall formal, professional and 
precise----not random or easily forgotten or misrepresented. Kapu means that their capacity 
to recall was disciplined, their speech restricted and governed by rules that could at times be 
punitive.  
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When missionaries arrived in 1820 they helped set off a transformation with the 
printing press, while chiefly support allowed them to introduce reading and writing to 
the general population in schools. What this means is that much of our literature, 
history, stories have been written down or published. The Hawaiian language textual source 
base is the largest native language source base in native North America and the Polynesian 
Pacific.  
 
Iʻm asking you to consider not perhaps for the work that follows in the next three weeks but 
for the work of generations after----that we in Hawaiʻi are not working with an “oral 
tradition,” but orality that is still being performed (hula, theater, prayer) and also fixed in 
writing and print. You can actually read these written pieces and learn, become inspired and 
create with them, but only if you are reading Hawaiian language or if the work of translators 
or transmedia specialist is supported.  
 
I might say that training my current skillset took the first thirty-three years of my life, certainly 
longer than some of you have been alive, so when Iʻm talking about Hawaiian things I donʻt 
want anyone to feel stressed out by not already knowing what I am telling you, or by the 
place you are in your development in any of the things you aim to pursue. Since a lot of things 
happened between the time when everyone in our community was fluent in our language and 
culture, a lot of things changed from then until now. Some things for the better.  

 

He Ao Hou  
Transmediation example 2: Oral to Print to Digital  
A new world / day 
 

Hereʻs a glimpse into our first try at making a video game.  

Kumulipo opening cinematic (47 seconds)  

The kumulipo is a genealogy chant that ties the birth of the creatures and plants in the world 
to the birth of a chief. Kumulipo means origin in deep darkness, in Hawaiian thinking the pō is 
the place where ancestors reside, a place from which inspiration springs, the source of life.  

Our gaming journey as kānaka maoli began with this chant because it resonates with these 
concepts, a new world springs forth from ancestral connection, our inspiration flows from the 
source through us to future generations, when the breath of life continues (hā) stories are 
allowed to rise. Therefore we created an opening that engages the past and the future with 
He Ao Hou, that what comes forth from this initial engagement will be excellent. 

Also new beginnings, those require growth, they require separation, we gave ourselves 
permission to create new things, to iterate from the base and create new territory in 
cyberspace.  

Why does moʻolelo [story] matter in game development?  

When we toured a game development company, Behavior Interactive in Montreal, they 
assured us that the narrative of a game is one of the most important elements in game 
design. Itʻs is also an important thing in todayʻs world and to Hawaiians as a people. So what 
stories are the ones we want to tell? Why?  

 

 

What are some of the challenges we face as Hawaiian game designers? 
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We are overly determined by the images that sell Hawaiʻi as paradise.  

[Aloha bumper sticker images slide]  

[Big Kahuna] 

[kānaka maoli] 

Hawaiians in media, in books, film, music, advertisement, are often imagined as people who 
are wisdom keepers, hula dancers, surfers or watermen on canoes, maybe you plant taro, or 
play an ʻukulele.  

What do Hawaiians do? What is Hawaiʻi or Hawaiian? Do we go with the pre-inscribed 
boxes set forth by colonialism that defines us narrowly? What will the kids, teens, adults and 
elders feel or think while they are playing the game you develop?  

 

What moʻolelo and what of Hawaiʻi or Hawaiian things do we want to convey?  

What does it mean to Indigenize game play? 
The floor is Lava or is it?  
Look to the sources of our knowledge: moʻolelo  

Pele and Hiʻiaka in moʻolelo and in RT [video of flow, explosions and flyovers] 
Tell Pele and Hiʻiaka story  

 

How we did it last year 

After a lot of consideration and discussion the group managed to take a direction that 
incorporated elements of Hawaiian stories, values, and design in every layer: narrative, 
opening cinematic, programming, art and animation, game play, sound and level design.  

Kaona in art, level design, and sound 
● Kinolau of the gods, a visual vernacular that is rooted in moʻolelo and practical 

cultural knowledge of place. 
● Indigenizing the soundscape - Kamapuaʻaʻs name chant. 

○ Note: we made a conscious choice not to allow players to play as Kamapuaʻa 
or Pele, but to move in an environment where we can engage them and be 
alongside the akua in different levels.  

 
Hawaiian is a programming language 
 
Narrative Design 

● Narrative design - He Ao Hou - Why would Hawaiians go into space? What are the 
typical reasons for going into space? Extraction? Discovery? Settlement and 
colonialism.  

● Moʻokūʻauhau - genealogy and family ties: Holo mai Pele 
● The ship is an ahupuaʻa - take what we need 

 

 
Links 
http://hitboxteam.com/designing-game-narrative 

http://www.skawennati.com/SheFallsForAges/index.html 

http://faculty.humanities.uci.edu/tcthorne/history12/EarthGrasperMohawkversion.pdf 

https://nyupress.org/books/9781479837243/ 
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Storytelling 3 / Instructor: Skawennati 

Sharing Stories 
Tell a favourite tale/legend/myth/history/fiction from your people and 
discuss the actions, values and unique cultural elements. 

 

 
Teaching Days, Time, & Length 
Tuesday July 10th, 10:45AM — 1HR 45M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1VhIck6nOEehaVv1tSoMbQEEMIDcyHcebQY
WV9m5BYAY/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
The instructor should be comfortable facilitating a group discussion. 
 
Participant Prerequisites 
Students must have attended the Storytelling Event, and Storytelling lessons 1 (Seeing Red) 
and 2 (Transmediation through Mo’olelo). 
 
Equipment/Software Materials 
Whiteboard and dry-erase markers. 
 
Objectives 

- To create a bank of stories that we can draw from to design our game. 
- To see if there is one or two that the participants can “get behind”. 

 
Vocabulary 
Action, morals, character tropes, story structure. 
 
References 
None. 

 

 
Overview 
This is a very important moment in the workshop: the participants share stories. We have 
spoken in previous lessons about stereotyping, self-representation and transmediation. 
However, in this “lesson”, each participant can tell any kind of story they like.  It can be a 
traditional Hawaiian story, or it can be an original story created by the participant.  

Right now, we want to create a bank of stories that we can draw upon later. Still, it is 
important to mention several things: 

● We intend to base the game on one of these stories or a combination of them. 
● The game will belong to the collective. 
● We intend to select the story (and mechanic and art style) through consensus. 
● We will match the story to a mechanic and art style. 

The facilitator will write the main ideas of each story on the whiteboard, so that we can refer 
to each later. 

Participants should be encouraged to think of the stories as a game. They should understand 
that they will eventually have to “get behind” one of them. 
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Storytelling 4 / Instructor: Rilla Khaled 

Communications & Rhetoric in Games 
How games convey message and meaning through play and systems. 

 

 
Teaching Days, Time, & Length 
Thursday July 12th, 9:15AM — 1HR 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/16Gz82iVOMA0gZaUbePMdg26A7H2DibeitJv
7TpXljfw/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
The instructor should be comfortable using x Software, etc. 
 
Participant Prerequisites 
Participants must have participated in Storytelling 1-3 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 

- Become familiar with three different conceptual approaches for conveying meaning 
through mechanics: 

○ Mechanics as verbs 
○ Mechanics, Dynamics, Aesthetics 
○ Metaphor 

- Perform analyses on games to “unpack” their meanings. 
  
Vocabulary 
Game design, game systems, mechanics, MDA, metaphor, procedural rhetorics 
  
References 
Games: 

- A House in California 
- Passage 
- You Used to Be Someone (NB you don’t need to pay to download) 
- Hush 

 
 

What’s the difference between games and other media? 
 

Conversation with the participants. 
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Games, experience, agency, and design 
 

● There are many definitions of games. 
● Games are constantly changing as a medium. 
● Stable qualities:  

○ games let us do things: agency 
○ games provide context for particular experiences  

● The designer’s invitation is to shape and constrain how agency and experience 
happen in a game. 

 

Meaning & mechanics 
 

A game mechanic refers to something you can do in a game.  
Shigeru Miyamoto of Nintendo famously used verbs to establish his mechanics. 
Example: Mario Bros. 
Consider: Mario runs. Mario jumps. Mario collects. 
Verbs are a direct way to move from an envisaged scenario to actionable mechanics. 
What you can do in a game tells us a lot about what the designer of that games wants us to 
feel, experience, and think about. 
Example: A House in California. 

 

Mechanics, Dynamics, and Aesthetics 
 

Of course, the meaning of a game isn’t determined by a single mechanic alone. The way a 
game feels is the result of mechanics acting in concert. 

The  Mechanics, Dynamics, and Aesthetics (MDA) model (Hunicke, Robin, LeBlanc, Marc, and 
Zubek, Robert. (2004). MDA: A Formal Approach to Game Design and Game Research) is one 
conceptual tool we can use to think about the relationship between what we design into a 
game, and how it feels for the player. 

Fundamental to this framework is the idea that games are more like artifacts than media. By 
this we mean that the content of a game is its behavior not the media that streams out of it 
towards the player. 

 

Analysis through an MDA lens: SOLA 
 

Show SOLA and discuss what its experience is. Then discuss how this experience is created 
through mechanics in concert. 

 

Systems of mechanics 
 

One concept that comes up whenever scholars talk about games and how they convey 
meaning is procedural rhetoric.  

In a nutshell, what you need to know about procedural rhetoric is that it is the world view that 
emerges from the game as a result of its mechanics working together. It is the world view 
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that the designer is communicating through systems of mechanics. 

Monopoly has procedural rhetorics: 

● Success is about hyper capitalism 
● Property value is tied to location 
● At regular intervals, the universe will give you money 
● Jail is just random, and unrelated to anything you actually did. 

Discussion: What are more examples of what Monopoly tells us? 

 

Metaphors  
 

A metaphor conveys insight about something by using the qualities of something else. 

Metaphor: uses one thing to stand for another. Metaphors are central to how GUI design has 
evolved over the last few decades - the desktop metaphor.  

We find metaphors in game design too. 

Example: Passage. 

Example: Perfect Woman. 

Metaphors are an excellent design tool. If you want your players to engage with a particular 
perspective / feeling  / understanding, what else can trigger that perspective / feeling / 
understanding? 

 

Look & feel… or look → feel? 
 

So far we’ve essentially talked about game behaviour, what the game lets us do and how it 
responds to us. 

But the play experience is of course shaded by how something looks too. This becomes most 
obvious when we look at more “extreme” examples, where the “look” jars with our 
conventional expectations for how a game should look. 

Example: You Used To Be Someone. 

Example: Hit the Bitch. 

What do you want your players to feel? Which game look will get the players to feel that? 

 

Reskinning a game can change its message and play experience 
 

A way we can generate new meaning from an existing game is to reskin it. A reskin means 
we change the graphics, the narrative layer, the thematics, etc.  

Reskins connect to metaphors -- using one thing to stand in for another. The benefit of these 
sorts of reskins is that the underlying mechanics are already familiar to players, and might be 
very well-suited towards conveying different phenomena from the context in which players 
already know them. 

Example: Guitar Hero & Hush. 

Guitar Hero is about experiencing and embodying the fantasy of being a rockstar. It 
mechanically boils down to: click certain buttons at certain times. 
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Hush is set in the Rwandan civil war of 1994, it presents the experience of being a 
mother trying to get your crying child to go to sleep in the midst of gunfire.  

Like Guitar Hero, Hush mechanically boils down to: click certain buttons at certain 
times. 

Guitar Hero and Hush are mechanically similar, but invite drastically different affective 
experiences, and communicate very different messages. 

 

 

Summary 
 

All games communicate something to us through systems of mechanics, narrative, and 
graphics. Because games foreground agency and experience, it’s key that we think about 
what the games we design let players do. 

Approaches we can use to help us think about what our players will do and how this 
supports the intended player experience include: 

● Thinking about the verbs embodied in mechanics 
● Mechanics, Dynamics, Aesthetics 
● Systems of mechanics 
● Metaphors in game design 
● Reskinning existing game mechanics 

 
 

  

Links 
 

https://www.kongregate.com/games/racter/a-house-in-california 

http://hcsoftware.sourceforge.net/passage/ 

https://squinky.itch.io/yutbs/purchase 

http://www.jamieantonisse.com/hush/download.html 
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Storytelling 5 / Instructor: Skawennati  

Proposing a Story / Graphics / Mechanics 
Through respectful discussion and consensus, the team chooses the 
game’s story, mechanics and style.  

 

 
Teaching Days, Time, & Length 
Thursday July 12th, 3:15PM — 1HR 30M 
 
Supporting Materials 
Presentation slides  

- https://docs.google.com/presentation/d/1HT__DSoJ2SQNCFS1pq3I2XvxndSjEvnHMfk
WzJtRMcA/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
Knowledge of previously discussed stories, characters, cultural elements from previous lesson. 
 
Participant Prerequisites 
Students must have participated in Storytelling lessons 3 (Sharing Stories) and 4 
(Communications & Rhetoric in Games). 
 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint. 
- Notepad for each participant. 

 
Objectives 
Propose and discuss options for a final story, mechanics, and style for the video game. 
  
Vocabulary 
ludonarrative dissonance, game mechanic 
  
References 

- She Falls for Ages 
- Call of Duty Free (Skins 6.0 Test Game) 
- He Au Hou 

 

 

We now have a bank of stories and a bank of mechanics. How can they merge to make a 
game? Discuss ludonarrative dissonance.  

 

Exercise 1: The 6 W Questions 
Most of us have heard that a story is simply the answer to “the 5 Ws”. However, I think that 
there is one more W required, especially for game narratives, and that sixth W is “win?”. I put 
“Where” and “When” first because we are building this story collaboratively. If we select 
those settings first, it should help to determine a lot of the story. For example, if it takes place 
in pre-contact Hawai’i, there will be no cars or spaceships.  If it takes place in 100 years on 
another planet, perhaps there won’t be gravity. 

● Where? 
● When? 
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● Who? 
● What? (What do they do? How do they do it? Mechanic!) 
● Why? 
● Win? (How is the story resolved? Does main character succeed? What 

happens if they fail or win?) 

Once you have answered them, put them together to form a short paragraph. This is actually 
the structure of your story. 

Example from She Falls For Ages 
● Where? Skyworld, a distant planet 
● When? Before the creation of the Earth, but also in the future 
● Who? Otsitsakaion, a young woman with telepathic powers  
● What? She jumps through a portal  
● Why? To transform the world  
● Win? Yes, she survives the fall and succeeds in cultivating the new world. 

Paragraph: 

Long ago, before the creation of the Earth, a young woman with telepathic powers, named 
Otsitsakaion, jumps through a portal so that she can transform the world. She survives the 
fall and succeeds in cultivating the new world. 

 

Example from Call of Duty-Free 
● Where? The airport 
● When? 2018 
● Who? An AbTeC Research Assistant travelling to a Skins workshop 
● What? (After shopping a little too long in the duty-free), they have to rush by jumping 

over suitcases and quickly getting through security 
● Why? To catch their plane on time  
● Win? Yes, she catches the plane, makes it to Hawai’i and keeps her job! 

Paragraph: 

After shopping a little too long in the airport duty-free, an AbTeC Research Assistant 
travelling to a Skins workshop has to rush by jumping over suitcases and quickly getting 
through security to catch her plane on time. She makes it to Hawai’i and keeps her job! 

 

Example from He Au Hou 
● Where? Outer space 
● When? In the future 
● Who? You, a young navigator-in-training whose twin sister goes missing 
● What? You travel from planet to planet, exchanging knowledge with the inhabitants, 

as you search for your sister 
● Why? To bring her home so that she can become a navigator 
● Win? Yes, you find your sister, but she has transformed into a celestial being! 

 

You are a young navigator in training whose twin sister has gone missing. You travel from 
planet to planet, exchanging knowledge with the inhabitants, as you search for your sister to 
bring her home so that she can become a navigator. You find your sister, but she has 
transformed into a celestial being! 
 
Drawing on the stories, mechanics and art directions we have generated during the previous 
lessons, propose a game idea! Write your ideas in your notepad and the facilitators can write 
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them on the board.  
 
From here we will begin to select, through concensus, the story, mechanic and art 
direction for our game. The choice will be up to the participants. The facilitators are 
here to offer guidance, but not to make the decisions. 
 

 

 
Links 
http://www.skawennati.com/SheFallsForAges/ 

http://skins.abtec.org/skins6.0/call-of-duty-free-the-skins-6-0-test-game/ 

http://skins.abtec.org/skins5.0/game-download/ 
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Storytelling 6 / Instructor: Skawennati  

Decisions: Story / Mechanics / Graphics  
The team confirms their decisions and further develops both overall 
vision and details. 

 

 
Teaching Day, Time, & Length 
Friday July 13th, 2:45PM — 2HRS 
 
Supporting Materials 
Presentation slides  

- https://docs.google.com/presentation/d/1YuS_XWeTRTPgNhEuHxs2UHswN31pkxEllY
BA1QmFPZ8/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
The instructor should be comfortable facilitating a decision-making process. 
 
Participant Prerequisites 
Students must have participated in Storytelling 5 (Proposing a Story / Graphics / Mechanics). 
Students must be ready to make a decision. 
 
Equipment/Software Materials 
Whiteboard and dry-erase markers. 
 
Objectives 

- To decide on the story, mechanic and art style of the game. 
- To come to one mind on the game, so that all participants share a vision of it. 

 
Vocabulary 
debate, group discussion, story, concept, character, design 
  
References 
None. 
 

 

Foreword/Ohenton Kariwatekwen 
Take a moment to explain to them the Ohenton Kariwatekwen --the Iroquois thanksgiving 
address. It is meant to set the tone. Like Quincy Jones did when he said to the amazing artists 
who performed “We Are The Word”: “Check your egos at the door”. 

 
Overview 
We will review the proposals that were made in Storytelling 5 and select one. It is important 
to note that often participants have strong feelings about this decision. This workshop is 
usually the first opportunity they have had to create a video game. Many recognize the 
blessing of having access to all the resources Skins provides. Sometimes it is helpful to tell 
them that this is just a first. That we are giving them the tools (the technical skills, the 
network, the mentors) to be able to create more games/media in the future.  

We feel that is important that each participant can “get behind” the decision. Sometimes that 
means that one aspect of the story, mechanic or art style could be modified so that everyone 
can feel good. For example, a participant might say “I am okay with any story as long as the 
protagonist is female.” It also helps to remind people what consensus is.  It does not mean 
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that one or two people can stop the group from moving forward.   

However, if there is really difficulty in coming to a decision through consensus, we 
may have to do a vote. (We have not yet had to do this.) 

Once the story, mechanics and art style have been decided, the group can further 
develop the overall vision and details. This is another important moment,  when the group 
comes to one mind to share the vision of the game.   

The facilitator, with the help of a Research Assistant, will write out the final decisions on the 
whiteboard. 

 

Mini-Exercises 
● Choose descriptive and/or action words to describe the way you want the player to 

feel: proud! angry! warm & fuzzy and *draw* them on the board. 
● Find images that correspond to the art style and put them on the board. 
● Write down words for sounds that can help to create the atmosphere of the game. 

“birds tweeting” “beeeeep-beeeep-beeeep” 
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Paper Prototyping A / Instructor: Skawennati 

Script & Storyboards 
How to write a script and storyboard a cinematic. 

 

 
Teaching Days, Time, & Length 
Monday July 16th, 10:00AM — 2HRS 30M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1ERZ6JdZsKONiTJeKCZYNYOVDnln2lVVLYTH
wIB2VS-Y/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
The instructor should be comfortable with teaching participants the basics of scriptwriting 
and creating storyboards. 
 
Participant Prerequisites 
Participants must have completed Storytelling lessons 1-6. 
 
Equipment/Software Materials 

● A presentation screen on which to show PowerPoint and the script document. 
● Whiteboard with dry-erase markers 
● A sketchpad with pens and pencils 

 
Objectives 
To learn how to write a script and storyboard for our game. 
  
Vocabulary 
script, narrative, context, storyboard 
  
References 
None. 

 
 

 
Exercise: Flesh Out the Story 
Now it’s time to flesh out the story. How does the main character achieve the “win”? 

- Take the sentences you wrote and add in the how. Write whatever comes to mind! Do 
not be afraid of the blank page.  

Little tricks to give you the kick in the b---, you need: 

- Try thinking of it as a game of Exquisite Corpse in which you are each providing a 
sentence. 

- Try writing “Maybe” at the beginning of each sentence. “Maybe he flies his spaceship 
to the nearest planet”. 

 
Exercise 3. Who? 
Write out the characters’ background. 
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- How old are they? 
- What do they look like? Tall/short/blond/bald/muscular/scrawny/etc/etc 

- Are they charming? Annoying? Brainy? Goofy? Thrifty? All of the above?? 

- What do they wear? 

- Where are they from? Do they still live there? Where do they live now? 
- How do they spend their time? 

- Who do they spend the most time with?  

- Do they have a job? Doing what? Do they like it?  

- How do they get around?  

These questions are there to help get you started. You can answer all of them or different 
ones. You can also add “Why” to each one to produce more background on your character. 
 
Exercise 4. Where? 
 

Describe the world or universe where the story takes place. (Of course the universe can be our 
very own! You will still need to describe it.) If it is another universe, what about it is different?  

 

Exercise 5. Chunkify Your Story 
 

Now that you have the story written out, it’s time to cut it into chunks. A chunk can be a word, 
sentence or paragraph, depending on the meaning or action that is being conveyed.  Each 
chunk will later become a scene or shot in the game.  With some things in your story, it will be 
immediately apparent what should be a shot or scene.  For example, “She put on her jetpack 
and flew into the night sky.”  Other things can be more difficult.  “She was sad when she 
heard the news.” Your job is to come up with an image or action that conveys the meaning of 
the written version. 

Show example from She Falls for Ages or He Au Ho or Wasagichuk. 

 

Exercise 5. Storyboard 
 
Draw a picture for each chunk. 
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Play 1 / Instructor: Pippin Barr 

What’s in a Game? 
An introduction to games and game design. 

 

 
Teaching Days, Time, & Length 
Monday July 9th, 1:45PM — 1HR 15M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1g69ovGPef49y_Mi6zKraDV6X_YMLhl34_iT5
mnwwv20 

 
Instructor Prerequisites 
The instructor should be a practising game designer. Additionally, the instructor should 
seriously consider writing this session from scratch to suit their own understanding of the key 
elements of game design. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 

- Understanding game design as creating a player experience 
- Developing a sense of the designed elements of a videogame 
- Building confidence in being able to design and develop a videogame 

  
Vocabulary 
Game design, player experience, player experience statement 
  
References 
Case study games referenced: 

● He Ao Hou: http://skins.abtec.org/skins5.0/game-download/  
● Grimsfield: https://escooler.itch.io/grimsfield  
● Dear Esther: http://www.thechineseroom.co.uk/games/dear-esther/  
● Firewatch: http://www.firewatchgame.com/  
● Braid: http://braid-game.com/  
● Inside: http://www.playdead.com/games/inside/  

 
 

 
Today 

1. What's in a game? 
2. The player experience 
3. The basic components of a videogame 
4. Case studies 
5. Technology and game design 
6. The most important things 
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What's in a game? 
We're here to design and develop a videogame in three weeks! This is a major 
challenge for all of us, but it’s also going to be deeply rewarding, and, above all, fun. 
Making games is fun. 

But what is a game anyway? How do people make them? This is a questions that people 
write books about, have YouTube channels about, and spend their lives working on, we're not 
going to be able to come to a definitive answer here. On the other hand, roughly speaking we 
all know what games are. They’re these things we play. We can all name games, whether 
they’re board games, card game, playground games, videogames, or other kinds of games. In 
short, we don’t actually need to worry about defining games. 

What we need to do is work. 

Key: Work. 

 

 
How do we design (and develop) a game? 
I want to emphasise that we can all do game design. We've all played games of one kind or 
another, and we can all come up with an idea for a game. Our first ideas might not be 
particularly good, but nobody said all game design was good.  
Good game design means we need to know the player experience and we need to move 
toward it and get better over time. Just like we can all tell a story. We're not all good at it right 
away, but we get better. How? By doing it. Work. 
Do not sit there thinking you need a three-yard beard, a giant board game collection and 
years of programming experience to be allowed to design and make a game. You just need to 
be prepared to work. 
So I want to talk about the practicalities of designing and developing a game in the three 
weeks we have, something I have a lot of experience with - most of my games take about the 
amount of time we'll be putting in (though it's usually just me!) 
Key: Anyone can do game design.  

 

 
The player experience 
Our objective as game designers to create a game that generates a specific player experience 
we're excited about. It’s a ‘second-order design problem’ because we’re designing a thing (a 
game) that we want to have a specific effect (a player experience). We can’t just reach out 
and make a person have an experience, we have to try to create it via our game. 
It is so important to remember that: the player experience refers to what we want the player 
to experience, not what we think a player would want. It's very easy to get stuck in thinking 
our game has to be fun or has to have shooting or has to be challenging or whatever. Those 
are all perfectly reasonable game experiences, but we define the player experience of our 
game. 
So we need to know what the player experience is to do good design, we can't assume we all 
agree. 

- Is it a particular emotion we want to generate? Sadness? Happiness? Regret? Pride? 
Combinations of those? 

- Is it a particular genre experience? The excitement of being hunted in a first-person 
game? The brain-bending difficulties of solving puzzles in an adventure game? The 
rollercoaster ride of a well-told and dramatic story? 

- Is it a particular idea we want to communicate? A game that helps us think about 
colonialism? A game that questions the use of violence to solve problems? A game 
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that teaches us about specific mo‘olelo? 
Before we start making a lot of decisions about our game, its design, and its 
development, we should have created a Player Experience Statement. This should be 
a really tight statement of the experience we want our game to create. You could 
think of it as a kind of ‘elevator pitch’: the words you would say to explain what our game is 
to someone in order to have them understand the overall idea. 
The most important thing about our Player Experience Statement is that it will help us make 
decisions. Whenever we’re making a decision, we should ask “how does this support the 
player experience?” 

- Should the avatar have a specified gender? 
- Should we model in low-poly or realistic 3D? 
- Should the villagers be humans or anthropomorphic bears? 
- Should getting up the mountain be a challenge or easy? 
- And on and on. 

Key: Any time we need to make a decision, we should ask "how does this support the player 
experience?" 

 

 
The basic components of a videogame 
We could break games down in all kinds of fancy ways (see MDA, Game Design Workshop, 
Half-Real, and more), but for our purposes I want to talk about game elements specifically in 
terms of production since we need to be fairly practical. This approach isn’t formal and it isn’t 
the only set of things you can think about, it just happens to match a lot of what we’ll be 
doing in this workshop! 
Storytelling 
The storytelling elements of a game include any overall narrative arc or arcs it might have, 
any scripted dialog it has, any narration either in-game or in cinematics: that is, the 
storytelling can often be approached with words. 
Visual aesthetics 
The visual aesthetics of a game include its 3D modelling and texturing, lighting, and 
cinematics. The visual aesthetics strongly set player expectations for the kind of world they’re 
entering because they are (literally) the first thing the player sees. 
Audio design 
The audio of a game chiefly encompasses music and special effects (SFX). Here we’d need to 
make decisions about voices and voice acting, say, or the particular sound of a footstep, as 
well as the emotional tone of any background music that players. 
Environment design 
A big part of many games, and likely our own, is the actual spatial layout of the world being 
created. It is a big outdoors environment that the player explores, or is it a series of rooms in a 
dungeon? Is it outer-space with different planets to visit? Is it a platformer level that’s 
particularly tricky to overcome? 
Game mechanics/interactions 
We of course need to decide what the player actually does in our game. Do they walk around 
on a planet trying to find hidden objects? Do they jump from platform to platform and avoid 
falling? Do they dance hula? Do they throw kukui nuts at Kamapua‘a? 
Key: One way to think of the parts of a game is to divide it into the key tasks/areas of 
storytelling, visual aesthetics, audio design, environment design, and game 
mechanics/interactions. 
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All together now! 
An extremely important thing to know about making games is that none of those 
components of a game are separate from any other. That’s what’s so beautiful about 
working on a game, everything is connected. Each area works with each other area. 
Consider something like environmental storytelling. This is another approach to storytelling in 
which the story isn’t told through dialog or narration, but rather through the place itself. The 
way the place is structured (environment design), the things you find there (visual aesthetics), 
the sounds you can hear (audio design), and the ways you can interact with them (game 
mechanics) all combine to tell the story. 
Similarly, consider the idea of giving the player some kind of challenge to overcome. All of the 
different parts of the game are important here, not just the obvious idea of the game 
mechanics. With the storytelling you could create a complicated murder mystery plot that the 
player has to uncover. With the visual aesthetics you could many similar objects and 
challenge the player to find the correct one. With audio design you could ask the player to 
navigate only by sound through a dark place. With the environment design you could create a 
game of hide-and-go-seek between two players. 
You're going to be learning about all these things in the various other sessions, what I want is 
for you to keep in mind that they all concern game design and that the most vital question is 
always the design of the player experience 
Key: Game design doesn’t belong to any one team or person, everybody is doing game design 
the whole time as they work to create the game together. 

 

 
Case studies 
Other games are a vital resource for us to understand how others have designed and created 
games in the past. They can often be highly relevant to what we want to do and might teach 
us a lot about design approaches that have been successful of interesting. 
One really important approach to design is simply taking ideas from other games and 
combining them in interesting ways to create something new. This is a great reason to play 
some games while you’re at the workshop: you never know where you might find the next 
great idea! 
Here I want to talk about set of games that in some way reflect on the kinds of things Unity is 
particularly useful for and which the team is specifically prepared to teach the technology and 
skills for. 

● He Ao Hou (3rd person adventure game, dialog-based storytelling, minigames) 
● Grimsfield (3rd person adventure game, low poly, fetch quests and puzzles, 

dialog-based storytelling) 
● Dear Esther (largely linear spatial navigation, experimental storytelling) 
● Firewatch (exploratory spatial navigation with extra mechanics, environment and 

audio storytelling) 
● Braid (platformer, high skill challenge, time puzzles, environmental and textual 

storytelling, metaphor) 
● Inside (platformer, low skill challenge, spatial puzzles, environmental storytelling with 

no language!) 
Key: Other games are great reference points for taking inspiration both through stealing their 
ideas and through reacting against things you think you could do better 
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Technology 
The technologies we use when we’re making a game have a big say in the kind of 
game we end up making. Just like you probably wouldn’t write your next novel in 
PowerPoint, you wouldn’t make a 3D game with Twine, a piece of software for making 
text-based games. 
In this workshop we’ll be learning various pieces of software to help make our game a reality, 
and each piece of software will have its impact on the kind of game we can make. For now I 
just want to talk briefly about Unity, the game engine we’ll use. 
Unity is very much an engine that rewards creating spaces that you navigate with an avatar 
(3rd person, first-person, skill-based, exploration) - you can essentially make anything with it, 
but these are the easiest kinds of games to make. 
Technologies can be frustrating when you're learning them. Blender is pretty complicated. 
Unity is pretty complicated. I haven’t tried it, but I bet Reaper is pretty complicated too! It's 
okay to feel like it's difficult to work with them in the beginning, don't be hard on yourself! 
Given our time frame, it's also okay to acknowledge that we’re not going to be able to 
imagine something and easily create it - making games is hard work. Making worlds is hard 
work. For that reason, it makes sense to be driven somewhat by the technology we have and 
what it facilitates. If Unity is good at making 3D explorable worlds, maybe we should go with 
the grain. 
As a general rule of thumb for our expectations, we should think about what we already 
know we can do plus what we figure we can learn plus the support we have around us. That 
gives us a pretty big set of possibilities with all the talent in the building. 
One last note about technology, though: All design is ultimately influenced by the technology 
we make it with and that's something to be aware of. It’s good to let your tools help you to 
make better games and to go with the grain, but also try to be aware of their influence on 
your decisions and fight back sometimes! (Why can't the avatar float around on its head? 
Why shouldn’t the water flow uphill? What happens if the avatar is bigger than a tree?) 
Key: Technology can be a struggle for all of us, but what we will make with it at this 
workshop will be beautiful. Have faith in your dark times and help others when you’re in the 
light. 

 

 
The most important things 
The player experience! 
Our objective is always to create the player experience we decide on, whether that's 
knowledge of a specific story, a particular emotional tone, a specific level of skill challenge, 
etc. 
You can do game design! 
It's not an arcane skill practised only by masters. 
Every aspect of making a game involves game design! 
3D models, spatial layouts, dialog scripts, the placement of a tin can, minigame designs, the 
expression on a character's face. It’s all design. it all affects the player experience. 
The technology is part of the design 
Make friends with it, but don't get too friendly! 
Key: The player experience!  
If you only remember one thing from this entire session, remember we're trying to establish a 
desired player experience and that every creative move we make should seek to reinforce it. 
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We need a short and sweet Player Experience Statement so we’re all on the same 
page. 
Finally, remember that we define the player experience we want our game to create, 
there’s no imaginary player out there demanding a fun game or a scary game or a 
silly game. It’s your game.. 
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Play 2 / Instructor: Victor Ivanov 

Environmental Storytelling / Navigation 
An exploration of how players’ navigation through crafted worlds 
allows designers to tell a variety of stories without a single line of text. 

 

 
Teaching Days, Time, & Length 
Tuesday July 10th, 3:45PM — 1 HR 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/173hNBqMYTEZA1QCKvm67T0PGRJbLQdmESIzI7ktk
0Ds/edit?usp=sharing 
 
Instructor Prerequisites 
The instructor should be familiar with level design, narrative design, and navigation systems. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 
To gain an overview of what level design consists of, and how stories can be told through 
environmental means. 
  
Vocabulary 
Environmental storytelling, communication, evocative spaces, enacted stories, embedded 
narratives, emergent narratives, navigation, linearity. 
  
References 
First level of Bioshock is almost exclusively environmental storytelling, and sets setting for 
entire experience. 
https://www.youtube.com/watch?v=88Pzhk1UdPA 
https://www.youtube.com/watch?v=mn-vORCJmzU 
 
Implicit narratives’ exposition through environmental mood (talk about navigation in DS). 
https://www.youtube.com/watch?v=8ma-l-9zC3M 
 
Environmental storytelling in Deus Ex. 
https://youtu.be/USVr936aKzs?t=192 
 

 

Environmental Storytelling 
 
Each medium has its strengths and weaknesses, and games are no exception to the rule. 
Ultimately, each form of expression we choose shapes how we express our message in the 
first place. For this reason, it’s useful to know where games shine, so that we can use them as 
effectively as possible. 
 
Communicating, in the case of many games, takes the form of a story. Narratives permeate 
every inch of our world. From the history of an object, to the design decisions made when 
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creating a brand new product, there is a story of its creation, its purpose, its fate. 
When you look at the world around you, these stories are not always apparent. Often 
enough, however, we can make some good guesses, can’t we? 
 
When something is damaged, we know it’s been through a rough time. When 
something is clean and pristine, we know that it was artificially created and deliberately 
made to be aesthetically pleasing. When something is missing a part, we can assume it was 
removed because it was broken, or perhaps stolen? 
 
This is the essence of telling stories through environments. Nobody told us the story, but the 
characteristics that make up an object, and the space around it, give us information that we 
can use to extrapolate its story. Put enough of these items together, and the space in which 
they’re in, their position in relation to one another, collectively tell their own story. 
 
This experience is, at its foundation, non-linear. In games, the player is rarely forced on a 
completely linear, camera-locked path. That’s more of a cutscene than gameplay. And 
certainly, telling a linear story through a non-linear experience, like a game, can be a 
challenge. That’s why we stick to more traditional, linear media, like movies, to express those 
parts of a story. But there’s more to a world’s narrative than a linear adventure, and this is 
where environmental storytelling truly excels: world-building and non-linear stories. 
 
Let’s cover 4 types of narratives that an environment has the capacity to express effectively. 
 
Evocative Spaces 
 
First and foremost, we have “evocative spaces”, which are environments that resemble 
something which is already familiar to us. Imagine this: 
 
You walk down a glossy, futuristic hallway. Around you, soldiers in white costumes pass by, 
each looking virtually identical to everyone else. Past a pair of sliding doors is the equivalent 
of a space-garage: the opposite end of the room only has a forcefield between the neat 
interior and empty, cosmic void. Black ships with spherical cores and hexagonal wings are 
being repaired. 
 
Granted, writing it out doesn’t equate to navigating the environment, but already, there’s a lot 
of inferences to be made. If I add the visual support of environmental exploration, it becomes 
really clear that this world is about Star Wars. The stormtroopers, the spaceship environment, 
the tie fighters, these things are recognizable landmarks of the Star Wars universe. 
 
The point here is that even though no one explicitly mentions “Star Wars”, it’s completely 
evident that the environment is consistently drawing links to it. This is an evocative space: an 
environment that draws links to another world, evoking existing memories. It’s done primarily 
through imagery that resembles familiar visuals, and it’s important this imagery remains 
consistent so as to establish that link. 

 
Enacted Stories 
 
“Enacted stories” are stories we, as players, experience through gameplay. These stories can 
take place on a small, micro scale, or a large, macro scale. 
 
For instance, say you’re Commander Shepard in Mass Effect. Your job is to save the galaxy, or 
something on a relatively similar scale. This is your objective throughout more or less the 
entire game, and you spend your time acting out this story. This is a large-scale (macro-scale) 
story that you play out through gameplay. Now imagine, you’re still Commander Shepard, but 
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this time you’re resolving Garrus’ issue with his faulty firearm by looking for rare 
materials on a desert planet. This is a small-scale (micro-scale) story, as it’s only part 
of a larger collection of small stories that eventually lead to the accomplishment of the 
larger goal. 
 
These narratives are, by nature, a lot less linear or “tied together” than in traditional 
storytelling. Because players can choose which missions to complete, where to go, and in 
which order, these narratives are much more episodic, much looser, and less dependant on 
one another. That doesn’t mean that spatial stories are badly constructed narratives, it simply 
means they evoke a different aesthetic, and put the focus on player choice and spatial and 
narrative exploration, as opposed to plot development. 
 
In the case of micro-scale stories, especially, they excel at doing what games do best: 
world-building. They provide disconnected (though consistent with the world) bits of narrative 
that typically do not advance the larger plot, but provide depth and width to the world at 
large. Nearly all open-world games utilize this form of world-building. These are the 
side-quests, and games like The Witcher, Watch_Dogs, Elder Scrolls, Grand Theft Auto, Mass 
Effect, Fallout, have an abundance of them. 

 
Embedded Narratives 
 
“Embedded narratives” are stories that convey narrative information through their 
scenography. 
 
Simply put, it’s environments that suggest a story, like we spoke about earlier. These stories 
are almost always non-linear, since level designers must account for the fact that players will 
come across different parts of the story at different points in time, and potentially choose to 
navigate an environment through different paths. 
 
This differs greatly from traditional media, like film, where the director has full control over the 
order of the scenes, the time spent on each one, and so on. Instead, embedded narratives 
take place in an open-ended, information space of sorts. More specifically, the environment 
can be considered a memory palace, and as the player navigates it, they decipher and 
reconstruct the plot that occured within it. 

 
Emergent Narratives 
 
“Emergent narratives” are stories that occur dynamically, usually as a result of circumstances 
and mechanics set in place by the author. 
 
Emergent narratives are very much unique to games, as they require the proper environment 
created by the author, but also the player’s engagement with this environment in order for 
those narratives to be realized. For this reason, emergent narratives can never be fully 
planned. The level designer doesn’t know what form they will take, because they depend, at 
least partially, on the player’s input. 
 
Take The Sims, for instance. It’s a sandbox game, which suggests players can do more or less 
whatever they like (within the technical limitations of the game, of course). And obviously, not 
every single possible set of actions is scripted. Instead, developers craft a set of rules and a 
world to explore, and let the player navigate the mechanics to create their own stories. 
 
A less open-ended, yet just as viable example, is any “immersive sim”. This is a game genre 
that emphasizes player choice, typically in an action-y setting. Examples include Deus Ex, 
Fallout, the newer Elder Scrolls, Dishonored, and Thief. These games all provide a space with 
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a potential for meaning, rather than a set, hardcoded story. 
 
Here’s an example. You’re playing Splinter Cell, a game all about sneakily infiltrating 
enemy territory to conduct secret military operations. You’ve spotted an enemy in a 
building, and have knocked them out. You also noticed that the enemy had installed a 
turret in the hallway. These turrets were programmed to not shoot at people wearing a 
specific outfit, so you decide to hide behind the body of the enemy you’ve knocked out to 
make your way around the turret. You hack the turret. Curious to find his partner, the enemy’s 
friend comes searching for him. You’ve fortunately had time to hack the turret, so it shoots at 
anyone, and the enemy’s friend is killed by the turret. What an interesting turn of events! 
 
What’s important to remember is that that story was not scripted. These were systems set 
in-game that the player learned to utilize, and it was the interaction between systems (turret, 
enemies, stealth, hacking, etc.) that allowed for this unique moment to happen! 
 
“Emergence”, in this case, discusses games’ capacity to evoke complex behavior as a result of 
the interaction between multiple systems. It aims to emulate the large possibility space of real 
life. 
 
On the topic, emergent stories are obviously not exclusive to games. In fact, this is a largely 
discussed subject in urban planning. Kevin A. Lynch, a renown urban designer, argues that 
physical spaces should (much like the digital environments that allow for emergent 
narratives) provide a space for potential. 
 
The observer himself should play an active role in perceiving the world and have a creative 
part in developing his image. [...] A landscape whose every rock tells a story may make 
difficult the creation of fresh stories. [...] what we seek is not a final but an open-ended order, 
capable of continuous further development. 
 
Kevin A. Lynch, The Image of The City, 1960 

 
Navigation 
 
Navigation is the primary form of interaction a player can engage with an environment. As a 
result, navigation is a driving force in the player’s experience of the game world. Whether it 
be for narrative purposes, or just for pure fun, it’s important to consciously design a 
navigation system that helps convey whatever message and / or theme the game aims to 
express. 
 
Let’s take a look at a few popular types of navigational systems. As a side note, these 
systems are not absolute, and many games have different sections which might each call for 
different types of navigation. 

 
Linear 

 
Linear navigation systems are, as their name might suggest, based on having the player 
follow a static path through the game. As a general rule, the more linear a game is, the less 
player choice it has, and the more ‘tightly’ the director can express their message. 
 
Of course, linearity doesn’t have to be consistent. Many games do a more bubble-chain 
approach, where players are given a large freedom of choice, but eventually brought back to 
the primary path. Games like the first Mirror’s Edge do this very well, by having sections of a 
level that allow the player to traverse their environment in many ways, but with each one 
ultimately leading to the same general location. 
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This makes a lot of sense for Mirror’s Edge, as it’s a somewhat story-driven game, so 
it’s reasonable to want a linear path in order to tell a linear story. It’s also a game that 
requires pretty specific level design, so too much freedom might expose players to 
situations where level design isn’t as refined. But then, it’s also a game about 
movement, and much of the fun comes from spotting paths and executing the maneuvers 
necessary to navigate them, which is exactly where the more freedom-centric sections come 
in. 

 
Branching 

 
Branching navigation systems focus creating multiple relatively linear paths that the player 
may choose to follow or not. These are a compromise of sorts between linear and open-world 
narrative structures, since they allow for linear paths, yet give the player freedom in the “hub”, 
where they choose which path to go on. 
 
Take Dark Souls, for instance. It features a very well-crafted environments, and takes place in 
an interwoven world. It contains a hub (the bonfire) where the player can rest and upgrade 
their abilities. Throughout their adventures, players undergo the following loop: rest at the 
central bonfire, go on one of the many paths available from the central bonfire, go on an 
adventure, eventually unlock a path that leads back to the central bonfire. 
 
These shortcuts are essential, and they’re everywhere in all Dark Souls. They allow the maps 
to feel like they’re full of interwoven paths, and keep things interesting by minimizing 
backtracking. Unlocking a shortcut (that is, adding a new possible path) is a form of 
progression in Dark Souls. 
 
This makes perfect sense for Dark Souls. Its difficulty is one of its most important factors in its 
design. So what does branching have to do with this? It gives players choice. The choice, in 
this case, to go elsewhere and tackle challenges that are less daunting. Forcing players to 
face the same challenge can be very frustrating if they have trouble completing it. Once they 
have the choice to go elsewhere and train to be stronger, or just relax from the fighting. 
 
Not to mention, Dark Souls is also about resource management. The Estus Flask, the primary 
healing item, only has a limited number of uses. Knowing that there might be a shortcut right 
around a corner is motivational, and creates an interesting decision-making scenario where 
the player must choose between moving forward, or returning back to recover health. 
Already, this is great material for some fun emergent narratives. 

 
Open 

 
Open navigation systems make a large portion of the gameplay space available to the player 
very early on. Open-world games are especially effective at conjuring feelings of exploration 
and discovery, because player choice is at the forefront of how one navigates the 
environment. 
 
Often, open worlds make use of other systems for short periods of time. For instance, in 
Breath of the Wild, and in Skyrim, there are more confined environments (interiors, caves, 
temples) that take on a more linear, or perhaps branched approach. These sections are for 
more linear storytelling and plot development. 
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Instanced 

 
Instancted (or level-based) navigation systems deliberately divide up levels (instanced 
areas), often with a hub that allows players to choose a level. 
 
This type of system is more about how players get into levels (which themselves can take on 
any navigation system). It is often used in MMORPGs (massively multiplayer online role 
playing games) like Phantasy Star Online, Warframe, or Vanguard, where each level is 
essentially presented as a “mission”. Instanced levels make it easy to have players repeat 
existing levels, which is common in grindy (repetitive) games. 
 
Often enough, however, it is difficult to incorporate a solid narrative into such navigation 
systems, because players can easily play through the same levels repeatedly. Designers 
therefore have little capacity to predict the story’s pacing. Unless designers deliberately break 
away from the system at a given pace in some way, they also need to take into account the 
downtime between missions. 
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Play 3 / Instructors: Victor Ivanov 

Composition 
A study on how design is a form of problem-solving and communication, and 
how visual composition acts as a dialect of the language of design. 

 

 
Teaching Days, Time, & Length 
Wednesday July 11th, 1:30PM — 1HR 
 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1QiFpoNXucBYT3jQiGQ9fxG3PnJHy0Zd10MNJICOez-
4/edit?usp=sharing 
 
Instructor Prerequisites 
The instructor should be familiar with visual composition techniques, color theory, and some 
applications of this knowledge in games. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 
To explore visual design and see how visual images can be composed to maximize our 
control over the viewer’s attention. 
  
Vocabulary 
Composition, order and chaos, crop, focus, detail, balance, layout, weight, scale, color, 
harmonies, contrast, symmetry, direction, movement, depth, foreground, background. 
  
References 
Strong, scenic compositions. 
https://bit.ly/2JnRDtM 
 
Composition theory. 
https://www.youtube.com/watch?v=O8i7OKbWmRM 
 

 

Composition 
 
Composition is a fundamental practice in any visual media. With that in mind, this lesson will 
pull from various sources, including photography, film, games, illustration, and so on. Good 
composition is a visual skill that’s applicable to any visual medium, so I encourage you to 
retain this information for whenever you work on any visual piece. 
 
First, what is the primary purpose of composition? It is to direct focus. A proper composition is 
one that leads the viewers’ eyes and interest on an intended path. In the context of a game, 
this is often used to naturally lead the player towards certain directions, towards certain 
goals, or to hint at possible actions. 
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Second, are there any other purposes? Certainly. Those would be to provide 
compositional meaning (to draw visual metaphors), as well as to make imagery 
aesthetically appealing. 
 
Third, what can we do to achieve these purposes? There are a selection of principles 
that help develop a critical eye for composition, we will review them in this lesson. 
 
And very importantly, things get complicated when travelling through a scene. That means 
that all of these principles must be considered in motion, as well as in static compositions, as 
well as in successive compositions. 
 
Before we get into it, it’s important to remember that composition, like any design practice, is 
ultimately a problem-solving process. This means that the solutions to your unique problems 
will, themselves, be unique. So what makes a “good” composition depends on what you are 
aiming to achieve. 
 
With that being said, these principles are handy tools to navigate the concept space of 
composition. I will mention what a “typically” good composition does with each of them, 
however these are more suggestions than rules. 

 
Order and Chaos 
 
It’s no surprise we begin on such a philosophical and wide topic. The spectrum of chaos is a 
marker for visual interest. Going too far towards either order or chaos can make a 
composition seem boring or messy. With that being said, it all depends on the intent! 
Sometimes, extreme simplicity can be very elegant, and at other times, over the top 
complexity can be awe-inspiring. 
 
The safe zone remains somewhere in the middle, however, where the most important parts 
are focused and visible, and the not-so-important parts are cut out, hidden, or in some other 
way attracting less attention. 

 
Crop 
 
One easy, but incredibly powerful way of directing attention is by cropping a composition 
appropriately. To crop is to cut out the edges of a composition. Maybe there’s a character that 
isn’t appropriate, maybe there are some details in the background we don’t care for, maybe 
someone’s feet are less important than their face. Cropping is an invaluable tool that easily 
gives the composer power to tighten the focus on a subject. 

 

Focus / Detail 
 
Focus, especially on cameras, is another fundamental factor to proper composition. More 
specifically, however, good focus means good detail. The human eye is attracted to detail, 
and spends less time on blurrier, less detailed objects. This way, the composition is not 
saturated with information, and provides more information where the attention should be 
directed towards. 

 
Balance / Layout 
 
Balance deals with the distribution of visual elements, their characteristics, and their 
proximity, within a given space. It’s sort of an all-encompassing word, because a few 
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different principles come together to create pleasant balance. 

 
Layout is a more specific term to describe the placement of visual elements in a given 
space. Layouts can be broken down from general elements to detailed elements. 
Typically, aesthetically pleasing layouts strike a balance between boring uniformity, and 
uneasy contrast. That is to say, they use negative space in a way that does not feel unnatural, 
but remains interesting. Putting all the visual elements into one corner of an image, for 
instance, can create a large-scale contrast between positive and negative space, which is 
ultimately not very ‘balancing’. So in that regard, proximity is another important factor of a 
good layout. 
 
Layout is a big topic, and it’s difficult to summarize proper layout principles, as appropriate 
execution of it largely depends on the content within the visual elements, and the context in 
which it’s viewed. As a general rule, however, it helps to use grids to organize a composition 
so they retain a sense of order, and then skewing the composition so that it does not become 
hyper-organized. 

 
Weight / Scale 
 
Weight is the visual ‘heaviness’ of elements. If an element is very thick, like bold text, is very 
dark in relation to its neighboring elements, or is large in comparison to its nearby elements, it 
feels as if it is heavier. Good balance means that weight should be relatively well-distributed 
in a composition. It’s important to mention that weight also works in tandem with layout, so 
having a heavy element that’s far from anything else can balance things out, and make for an 
interesting path to guide the eye. 

 
Color 
 
Color is… well, color. (Additional details will be discussed in one of the audio and atmosphere 
lessons). 

 
Hue, Value, and Saturation 

 
Color can be divided into 3 parts: Hue, Value, and Saturation. Hue determines the color. Value 
determines the brightness of a color. Saturation controls the vibrance of a color. For example, 
a dark, desaturated green is a color whose “HVS” is green in hue, low in value, and low in 
saturation. These are good ways to communicate colors to others, and will, through repeated 
use, help you deconstruct moods associated to specific parameters of a color. 
 
As a general rule, saturation is what dictates focal points. A highly saturated color is higher in 
‘intensity’, especially when surrounded by more desaturated colors, and will attract a lot of 
attention. If this saturated color is a warm color, it will attract even more attention. High 
saturation can be overwhelming if there is no place for the eyes to rest, and low saturation 
can be underwhelming if nothing attracts attention. 
 
Value serves a similar purpose, but on a larger scale. Value is what defines lighting, so 
depending on how shadows spread in a scene, can be used as a way of dividing up a 
composition into sections. Value can also be used for details, to create texture. 
 
Hue determines the ‘color mood’ of a composition. Hues are what we would call “colors” in 
our day to day lives. Scientifically speaking, they are the different wavelengths, ranging from 
red to violet in ascending wave frequency. 
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Color Harmonies 

 
A color harmony is a system that establishes an abstract relationship between colors 
to help create color palettes. I emphasize that these are not hard rules, but simply good 
principles to use as a starting point and general guide. 
 
Achromatic is using no color, only shades of gray. 
Monochromatic is using a single color. 
Analogous is using two colors next to one another in the light spectrum / color wheel. 
Complementary is using two colors opposite of one another on the color wheel. 
Triadic is using three equidistant colors on the color wheel. 
 
The list goes on, but those primary ones are sufficient for starting off. Think of these as tools 
for getting out of an art block. My tip is, decide on a primary color you want to use, and then 
see what colors these harmonies propose. No matter which harmony you choose, do not use 
the 50 / 50 for analogous or complementary, 33 / 33 / 33 for triadic, and so on. Unless used 
very deliberately for a stylistic effect, most compositions work best when they have a primary 
color that leads a composition, as opposed to evenly distributed colors. 
 
One thing to note is how the most complex palette here has 3 different colors. There exists 
other harmonies that have 4, maybe more colors, but I want to emphasize that simple 
palettes are very often much more effective, as too many colors can make a composition very 
busy, very quickly. 

 
Tips 

 
Some additional tips: 
 
Shadows and highlights (light in general) are not devoid of color! If you’re aiming for 
photorealism, remember that practically nothing is pure black or pure white. Orange sun? The 
shadows will likely be cooler looking in comparison. Or, if you wish, make the shadows a 
darker orange to make things feel even hotter. 
 
And finally, don’t take color for granted. It is a powerful tool, and like everything else, should 
be used with intent. 

 
Symmetry 
 
Symmetry is the mirroring of elements in one or more axis. Symmetry can be beautiful, as it 
very easily provides order to a composition. Yet, it can also be quite boring, as too much order 
can render a composition dull. Similarly, centering elements can be appealing, and potentially 
boring. Repeating elements, same thing. Symmetry is, in general, appropriate for patterns; 
things like architecture, synthetic constructions, wide-field-of-view imagery in general, epic 
visuals. Asymmetry is good for organic, natural-feeling compositions. 

 
Direction / Movement 
 
Movement, in composition, can be tricky. Especially if the composition isn’t animated. But, 
movement, or direction, can still be expressed. Arrows do this quite well, but arrangements of 
elements in a pattern that appears tapered in a certain direction can do that, too. Having 
multiple, seemingly independent elements, collectively behave in a certain way suggests that 
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an exterior force acted on them, and this exterior force manifests itself as movement / 
direction. 

 
Contrast 
 
Contrast is the difference in visual characteristics of elements. Like focus, contrast can be 
used to highlight a subject, and keep attention away from other elements. Simultaneously, if 
done improperly, it can make for a harsh composition that calls attention to contrasting 
sections that might not be so important. Two elements that are vastly different from one 
another will create contrast. If an element contrasts with the composition as a whole, 
attention will be attracted to it. 

 
Depth 
 
Depth shows the third dimension in a composition. This is really important, as it grounds the 
viewer in a physical space. Unless you’re in VR, however, depth must be inferred through 
different ‘clues’, since compositions are displayed on flat screens. These clues are composed 
of all visual phenomena associated with perspective. 
 
That’s things like scale, where things that are closer to us appear bigger. 
 
Like parallax, where objects closer to us move across our field of view faster when we look 
around than objects further away from us. 
 
Like occlusion, where objects hide what’s behind them. 
 
A way to divide the depth-space of a composition is by looking at things that are in the 
background, the middle-ground or center, and the foreground. 
 
In the foreground reside the elements closest to the camera. These are easily visible, and can 
include interactables, or other elements in direct relationship to the player character. 
 
Foregrounds are typically simple, as the purpose is to use the foreground as an atmospheric 
element. By being simple silhouettes, for instance, they compensate for the fact that they’re 
closer, and keep the player’s attention away from the foreground, while still framing the 
composition. 
 
A foreground, like any frame, can make things feel tight or spacious, depending on how it 
contrasts with the rest of the composition. Low contrast makes for a spacious scene, as it 
doesn’t stop the flow from the middle of the composition to the edges (both in 2D and 3D), 
and high contrast does the opposite. 
 
In the middle-ground / center resides the focus of your composition. In a game setting, this 
means the player, and for the most part, what they interact with. It should stand out from the 
background and foreground, which can be done with some dedicated lighting. 
 
In the background resides the rest of the world. This features atmospheric elements, elements 
that communicate scale, arouse curiosity, establish context, and so on. Typically, the 
background should not be too detailed, but it can be stylistically incorporated into a 
composition to allow the eye to explore further back after it’s investigated the middle-ground. 
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Play 4 / Instructor: Jason, Pippin & Rilla 

Going Analog  
Get some fresh air and discover how the rules followed in the 
schoolyard are both nostalgic and relevant 

 

 
Teaching Days, Time, & Length 
Wednesday July 11th, 3:45PM — 1HR 
 
Instructor Prerequisites 
The instructor(s) should have one or more traditional games in mind, ideally those that do not 
involve a great deal of equipment and ideally those that are accessible to diverse bodies and 
abilities 
 
Participant Prerequisites 
Participants must be ready to describe and facilitate the play of a traditional, playground or 
other physical game of their choosing 
 
Equipment/Software Materials 
None, other than any props required for specific games 
 
Objectives 

- “Breaking the ice” between participants, instructors, and others by playing together 
- Learning about the differences and similarities between traditional games from 

different cultural backgrounds 
- Identifying cultural values embedded in game systems 
- Practising basic game design by changing rules of play 

  
Vocabulary 
No specialised vocabulary should be needed to understand and participate in this session 
  
References 
Simply by way of example as a Google search can uncover the rules of many traditional 
games: 

- http://www.traditionalgames.in/home 
- http://www.informationng.com/2016/03/9-childhood-games-anyone-who-grew-up-i

n-nigeria-can-never-forget.html 
- https://en.wikipedia.org/wiki/List_of_traditional_Japanese_games#Children's_games 

 
 

 
Overview 
In this session we will gather together as a group, ideally outside in a park or similar 
environment, and play traditional games from the cultures of the participants and instructors 
as a way to think about games, play, design, and culture. 
 
Getting there 
Guide everybody to the designated play area, waiting until everyone is present before 
beginning the brief explanation of the activity. 
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Introduction 
Explain the basic premise and structure of this session: 

- We’re here to play traditional games brought along by all of us 
- The main reason to do this is that it’s fun, but it’s also a first way for us to 

think about how games work in a casual way 
- While we’re playing we can and should talk about how the game itself works 
- As we play a game, we can and should think of ways we could change the game to 

change the experience 

Notes: 

- Everyone is free to propose a game to play 
- It’s likely we won’t have time to play every single game brought along, but we can 

always play the missed games at other break times 
- Our objective is above all to enjoy ourselves and embrace the play of each game with 

good will 
- If anyone has any physical or other concerns about playing a specific game, they’re 

free to abstain from playing it 

 

Playing the games 
The instruction solicits a suggestion of a game to play especially from the participants. If we 
run into a situation where the participants are too shy to start things, the instructors will 
provide a game they have prepared for the session. 

The person proposing the game names it and describes its rules and any other 
considerations. 

The person proposing the game helps the rest of the group to organise themselves to play the 
game and guides play as necessary once the game has begun. 

At a certain point, after the game has been well-experienced, the instructors ask whether 
anyone has any thoughts about how you could change the game to make it feel different, or 
perhaps to be about a specific subject or metaphor. If anyone has a suggestion, the group 
plays the game again with the rule changes and talks about how the game is different. 

When the game has been fully explored or simply when the instructors decide, the group 
moves on to another game. 

Eventually, with at least 10-15 minutes remaining, the instructors call a halt to play in order to 
move on to a debrief session. 

 

Debrief 
Before ending the session, the instructors should facilitate a conversation with the 
participants about what they take away from playing these games. Questions can include: 

- What did you learn about games, play, and even game design? 
- What was your favourite game and why? 
- What was the most interesting game and why? 
- What game didn’t really work for you and why? 

 

Bull Rush (New Zealand) 

Set up 

1. There are two teams, the runners and the chasers/catchers/taggers. 
2. At the beginning there is one chaser and everyone else is a runner. 
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3. Played in a large open space, ideally a playing field of some kind which has a 
rectangular area the runners will try to run across.. 

Play 

1. The runners stand at one end of the play area. The chasers stand in the 
center. 

2. The chasers call one runner out by name, who must then attempt to run all the way 
across the play area without being caught or going out of bounds. 

3. If the runner is tagged before reaching the other side, they become a chaser and the 
process begins again. 

4. If the runner makes it to the other side, they call “Bullrush!” and all the other runners 
attempt to run across the play area at the same time, with the chasers trying to tag 
them. Again, anyone who is tagged becomes a chaser. 

5. It’s not clear that there is a winner or an ending. The point is just to play! 
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Play 5 / Instructors: Pippin Barr & Rilla Khaled 

Rapid Prototyping Experiments 
Modifying existing games to create new experiences. 

 

 
Teaching Days, Time, & Length 
Thursday July 12th, 10:30AM — 2HRS 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/11Xm8-cby5JcVanryi-CevqegDxMeUfejFNahd
RvUNKA 

 
Instructor Prerequisites 
The instructor should be a practising game designer. The instructor should select a specific 
game to be modified by participants according to his/her/their preferences. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
4 decks of standard playing cards. (Or other equipment depending on the game selected.) 
Assorted prototyping materials as available (paper, pens, blocks, pipe-cleaners, etc.) 
 
Objectives 

- Making the basic process of game design accessible and non-intimidating 
- Understanding and experiencing the relationship between designing for player 

experience and the player experience itself via the design-test loop 
- Expressing ideas through game rules/mechanics 

  
Vocabulary 
Game design, player experience, game mechanics, rules, playtesting, prototyping. 
  
References 
Rules and variations of Go Fish (As an example, if another game is selected, its rules should of 
course be included.) 

- https://en.wikipedia.org/wiki/Go_Fish 
Fullerton, Tracey. Game Design Workshop. CRC Press. 2014. 
 

 

 
Introduction 
Today we will be focusing on the basic flow of game design by doing it ourselves in a 
controlled situation. We will be modifying a pre-existing game (Go Fish) in order to see how 
design works. 

Before we start, we will talk briefly about the key elements of this process and what we 
should be thinking about while we do it. 
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Games have rules 
An important quality of any game is the set of rules that define how it can be played. 
Videogames often have their rules implemented in the programming, while board 
games and card games often have their rules specified as instructions for play. In Monopoly 
one rule is that you collect $200 each time you pass the “Go” square. In Blackjack one rule is 
that if your cards total more than 21 you go bust. A full set of rules defines how a game is 
played. 

Game design emcompasses much, much more than the rules of a game, but working with 
rules is an important way of thinking about games because they have a huge impact on the 
player experience. 

 

 
The player experience 
The most important thing for a game designer to think about is the player experience. That is, 
when a player plays the game, how should they feel? What should they think about? What 
should surprise them? What should confuse them? How should they work out what to do? 
And so on. 

The designer’s skills and job lie in a) thinking of interesting/valuable/fun/exciting/strange/other 
player experiences, b) working out how to design a game that supports them, and c) testing 
whether or not what they want to happen is happening. 

 

 
Rules make meaning 
The rules of a game are a key tool for shaping the player experience. In particular, fairly small 
changes to the rules of a game can radically change the kind of experience the game 
provides. 

Consider the “platformer” genre of videogames. In these games the basic rules tend to be 
more or less the game over and over again. The player controls a single avatar or character 
that can move and jump. They navigate the avatar through a designed 2D space from left to 
right using these skills, usually also trying to avoid some things (e.g. spikes, falls), attack some 
things (e.g. shooting or jumping on enemies), and collect some things (e.g. coins, points). 

Super Mario Bros. is the classic example of the genre. You move through the level from left to 
right, you avoid falling and touching Goombas, you jump on Goombas, you collect coins, and 
you try to reach the flagpole at the end. It tells a very simple story of a plumber rescuing a 
princess by making it through a dangerous land. 

But with small changes, this basic formula can take on new meanings and experiences. 

Super Meatboy changes the game chiefly by altering its level design to be far harder to 
navigate and thus requiring much higher mastery of the controls the player is provided with. 
The physical behaviour of the avatar is also changed as a part of this, to allow for more 
intensive play. (We can see something similar to this for Mario in Kaizo Mario.) 

Inside removes a great deal of the complexity of spatial navigation in favour of extremely 
beautiful and evocative environments that the player is invited to look at and think about in 
the context of the story, a wonderful form of environmental storytelling. Instead of require 
physical skill to control the avatar, the player is asked to think about what is happening in the 
world as well as to solve largely fairly simple puzzles. 

Braid adds rules to the platformer that allow the player to control or experience time in 
different ways, slowing it down, speeding it up, freezing it, rewinding it, and so on. These lead 
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to different ways of playing the game, with levels ending up more like puzzles. It also 
allows the game to address the idea of memory and regret in its story. 

There are countless more platformers that offer different twists on the basic formula 
by changing, adding, or subtracting rules and adjusting the other elements of the 
game in accordance (such as visuals, sound, story, and more). 

For us today, the main thing to remember is simple: changing the rules or mechanics of a 
game changes the player experience. 

 

 
Modding as game design 
Game design doesn’t have to begin with a blank page (and in fact it very often doesn’t). 
Instead, we often start with some set of pre-existing conventions/mechanics or even a whole 
game and use those to construct something new. 

Given this, a great way to get ourselves used to the idea of game design is to start with 
modifying (or ‘modding’) existing games. The key benefit here is that we already have a 
pre-existing game with all its rules and previous play-testing: we know the game we start 
with works in important ways. 

Taking the starting design, we can practice game design by changing the game’s rules. 

How, you might ask? 

 

 
Approaches to modding 
There are naturally as many ways to approach game design as there are game designers, but 
for the purposes of our modding exercise for rapidly prototyping new game ideas, let’s focus 
on three basic ideas. 

Just come up with an interesting-sounding rule change and see what happens. 

Quite often when we play a game we immediately have thoughts about ways we might 
change it to make it more fun or interesting to us. It’s completely reasonable to use this as an 
approach to modding. What if Monopoly had bank robberies in it? 

Think of a player experience or meaning we want to create and work out how we could 
change the rules to support it. 

A more organised approach. Here we have a goal for how we want the game to be 
experienced and we need to explore how we create that experience. We should choose to 
change/add/subtract rules based on our desired experience or meaning. What if we wanted 
to change Monopoly to be about friendship? 

Combine rules from other games. 

Another classic approach to design is to combine the rules or mechanics of games together to 
create new experiences. Here we are relying on the same idea that established games have 
good or interesting sets of rules that we could reuse elsewhere. What if we added the idea of 
finding a murderer from Cluedo to Monopoly? 

 

 
Keep it small! (For now.) 
When designing a game it is incredibly tempting to design something enormous and 
complicated, and that’s a lot of fun. But for this session (and really for this workshop) it’s 
important to keep our objectives pretty small. Perhaps we should focus on just 
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changes/adding/subtracting one rule at a time for example, so we don’t get 
overwhelmed, and so we can really see what effect it has. 

(The examples from the previous discussion are all probably way bigger than working 
with a single rule, for example. 

 

 

Let’s do some design! 
For this session we’re going to modify the card game Go Fish (note to instructor: obviously 
you should substitute for whatever game you find suitable here). It’s a very simple card game 
with only a few rules that will allow us to really think about what a difference simple changes 
can make. 

The rules of Go Fish are: 

● 3-5 players. 
● Each player is dealt 5 cards from a standard deck of 52 playing cards. 

The objective is to create sets of four cards with the same value (e.g. all the 4s, all the 
Qs). 

● When a player has made a set of four cards, they lay them down in front of them and 
they count as a point in the game. 

● The remaining cards are placed in a stack face down in the centre (or in some 
variations in a messy pile - can you think of why?) 

● The player to the left of the dealer plays first and play continues clockwise around the 
group. 

● In each turn a player is allowed to ask any other player if they have any cards of a 
specific value (e.g. “Do you have any 4s?”). 

○ If that player does have any of those cards, they hand them all over to the 
asking player, who then gets another turn.  

○ If that player does not have any of those cards, they say “Go Fish!” and the 
asking player takes a card from the pile in the centre. 

● Play continues until all of the sets of four have been made, and the player with the 
most sets is the winner. 

For the rest of the session we are going to redesign the game, using the following set of 
activities. 

 

 
Activity: Play 
Play Go Fish! 

Form teams of 3-4 and play a round or two of Go Fish! to experience the game as it is 
originally. While you are playing, discuss what you think of the game, what it might be 
“about” (is it about fishing?!), and what kinds of changes could be made (but don’t make them 
yet!) 

Come back into the full group and discuss briefly what we think of Go Fish! as a game, what 
it’s about, what the player experience is. 

 

 
Activity: New rule 
Change a single rule and test it! 

Having played Go Fish!, discuss in your group about a change to the rules. You can add, 
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subtract, or change exactly one rule in this activity. Just one! Once you’ve decided, 
play a round or two of the new game and discuss what difference the changed rule 
has made to the way the game plays. 

When all the teams have made and tried their rule change, come back into the full 
group and tell everyone what your change was, and how the game felt afterwards. 

 

 
Activity: New experience 
Choose a new experience or meaning for the game and create rules to create that experience 
or meaning 

Now that you’ve experienced the effect of a rule change, try to come up with a new idea for 
what Go Fish! could mean to players as an experience. Could it be a game about space 
travel? Could it be a game of storytelling? Could it be a game that teaches a song? Could it be 
a game that makes people feel sad? Could it be a game about the effect of dishonesty on a 
community? You could potentially make it be about anything! 

Once you have the new experience in mind, add/subtract/change a minimal number of rules 
(ideally just one or two) to help Go Fish! be about that experience. It’s better to change fewer 
rules each time you test it so you can understand how they work. 

Try out the new game and talk about it. If it’s terrible or not fun or broken, talk about that - 
that’s game design! 

When you’ve been able to try out a couple of rule changes for your new version of the game, 
make sure you give your game a Title. 

Once you’ve got your game, come back together in the full group and tell everyone about your 
new game and your experience of designing it. 

 

 
Activity: Play time! 
Time permitting, let’s swap group members around so that groups can try our each other’s 
games. You’ll need people from each team to swap into the other teams so the knowledge of 
the games is distributed. 

 

 
Activity: Talk time! 
Before we wrap-up, let’s talk about what we learned about game design from our session. 

- What did you learn? 
- How does the technology (playing cards) shape your ideas (think about physical form, 

cultural form, symbolism, ...) 
- What kinds of rule-changes felt like they worked best? 
- Now that you've done it, what is game design? 

 

 

 

Links 
None. 
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Paper Prototyping C / Instructor: Pippin Barr 

Prototyping Play 
A look at game mechanics, environments,  
and designs related to our current ideas. 

 

 
Teaching Days, Time, & Length 
Monday July 16th, 10:00AM — 2HRS 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/12KSugKQN-0yLPYq-K4Rrzhy19Z6dASxcu66
8upTu_14/edit?usp=sharing 

 
Instructor Prerequisites 
The instructor should be comfortable with non-digital prototyping techniques. 
 
Participant Prerequisites 
Participants should have an established understanding of the game’s proposed story, visual 
aesthetics, and mechanics. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Physical prototyping materials (paper, pens, scissors, board game pieces, etc.) 
 
Objectives 

- Create prototypes that allow us to explore key game design elements for the game 
- Create prototypes that allow us to explain our design approach to the larger group (in 

the playtest session) 
- (Ideally) Create prototypes that specify what we will do in Unity itself 

  
Vocabulary 
Prototype, game mechanic, player experience statement. 
  
References 
None. 

 

 

 
Note to instructor 
This session is heavily dependent on how the workshop has proceeded to this point and will 
have to be responsive to the needs of the participants and where they are with their ideas. 
The following outline assumes a fairly good understanding has been reached of the overall 
game and that the goal is to establish a set of simple prototypes to lock down game design 
decisions that can then be tested and shown to the full group. 

 

 
What is a prototype? 
A prototype is any representation we can create of our game that conveys a specific aspect 
of that game so that it can be tested and thought about. It is a proposal for how we could 
design some part of our game. Crucially, it is tentative not final. It asks questions, it doesn’t 
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give final answers. It is probably ugly rather than beautiful. It should be made quickly, 
not carefully. 
Prototypes serve two key purposes in the design process: 

- They help us to try out a specific design idea before we commit to it, finding 
out whether it works the way we thought it would 

- They help us to show others what our design is, rather than trying to explain it to 
them in words 

 

 
Our prototyping context 
At this point we know many of the key overarching design ideas about our game. We know: 

- The narrative of the game, which helps shape its overall flow 
- The visual aesthetics of the game, which helps us understand what will be possible in 

terms of representation 
- The basic game mechanics of the game, which we now especially need to refine 
- The game engine we are using, which is Unity, and which shapes what we know we 

can make in our time-frame 
We also have the advantage of the rest of the team being in close proximity. If we have 
questions about the story, we can go and ask the story team. If we have questions about the 
visuals, we can go and ask the visuals team. Communication is essential to make sure we 
create the most useful prototypes possible. 

 

 
What we could prototype 
This will depend on where we are in our understanding of the overall game, but there are a 
number parts of the game that we might predict needing to make prototypes to explore and 
explain. 
The environment design 
Whatever genre our game is in, it is highly likely it involves playing in one or more spaces. 
Those spaces need to be laid out and designed. In some cases, the layout and design may 
have very specific implications for the player experience, notably if it involves skill challenges 
(e.g. a platformer, hidden objects), or involves environmental storytelling (e.g. how to 
encourage a specific player path through the environment to tell a story). 
Minigames and special mechanics 
Outside the likely mechanic of needing to move around in a space (again, whether platformer, 
adventure game, or first-person exploration), we may have other core game mechanics we 
need to think about how to make. Is there combat? Is there a dancing? How will these things 
be experienced in the game? 
Story integration 
How will we tell the story in our game during play? Is it going to be done with cinematics? 
How will they be triggered and when? Is it going to be dialog? Where will the characters you 
speak to be in the world? How will you find them? Is there going to be environmental 
storytelling? 
Anything else? 
We don’t have to limit our prototyping to those three ideas. If there’s some other part of the 
game that seems like it’s our job to prototype, we should think about it now too. 
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How we could prototype 
To some extent, we need to come up with prototyping approaches based on the 
specific kind of idea we need to explore - there’s no single answer for everything, and 
your intuitions for what to do will most often be right. We should just always make sure to 
ask whether our prototyping approach is going to help us to answer the key question: how 
does this part of the design impact on the player experience? 
Still, there are some traditional approaches to prototyping that might be helpful for us in the 
situations that will probably come up. 

- Maps are a natural way to express the layout of the space and places that will make 
up the world of the game. A standard top-down map would be a huge help if we’re 
creating terrain in Unity and then placing the key assets, for example. Making it 
roughly to scale is even better for the person making the terrain! Pen and paper are a 
good and simple way to make maps. Grid paper might help drawing them to a scale. 

- 3D maps are a way to add consideration of the vertical element that 2D maps lack. If 
there’s a mountain, it would be great to see the mountain! We could use LEGO or 
modeling clay to create a topology of the environment. 

- Playing on our maps is a good way to think about how the player might explore the 
world. If we make a big enough map, we can have a little marker to represent the 
player and move it around on the map to explore the space. We could include other 
markers to indicate important or interactive parts of the map and could act out or talk 
through what each one does. 

- Level diagrams might be useful for something like a platformer, where we want to 
think about a very specific spatial layout of platforms in terms of jump distances and 
so on. Grid paper will be helpful for this. 

- Video prototyping with live action iis a quick way to explain how a mechanic or 
minigame could work. Here we take a camera (like a cellphone) and make a video of 
ourselves acting out a mechanic. We could make a video that shows the player being 
challenged to a hula competition and having to copy the moves of the dancer. We 
could show a combat sequence to explore what moves we might have. We could 
show a first-person camera exploring an environment (maybe a park!) to find a 
hidden object and think about how to hide things.  

- Video prototyping with stop motion can help us to explore visual ideas that are 
impossible for us to do live. We could make a stop-motion animation of drawings or 
other physical pieces to illustrate a mechanic like a series of daring jumps across the 
tops of trees in a platformer or an avatar shooting lasers out of its eyes to carve 
words on a mountainside. 

- Roleplaying is similar to video prototyping, but focused more on the experience of 
some particular game rather than explaining it. With roleplaying one person can act 
as the player, while one or more others help to simulate some part of the game for 
them. Imagine we have an adventure game with a puzzle and we have a player and a 
‘dungeon master’ who describes the environment and asks the player what they want 
to do, telling them what happens with each decision. Or imagine we have the hula 
game again, but this time you actually do it live with a player who has no idea what 
you’re planning - will they understand the challenge? What do you have to tell them 
for them to be able to do it? 

- Audio recording might be helpful if we want to be able to trigger dialog in one of our 
prototypes - we can pre-record and then press play at the right moment when 
playing the prototype. 
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Discussion 
What parts of the game do we need to prototype? 
What prototyping approaches could we use to prototype them? 
What are we trying to find out with our prototypes? 
Who wants to do what? 

 

 
Work 
Let’s work! 

 

 
Debrief 
Let’s show each other the progress we’ve been making. 
What do we need to work on tomorrow? 
How can we make sure we have helpful things to show the rest of the group at the playtest? 
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Production 1 / Instructor: Nancy Townsend 

Intro to Production 
Define game production, explore supporting tools + the case for game 
cinematics. Learn how to avoid mental and physical strain. 

 

 
Teaching Days, Time, & Length 
Monday July 9th, 3:15 PM — 1HR 30M 
 
 
Supporting Materials 
Nancy’s Intro Slides 

- https://docs.google.com/presentation/d/1RrQJ76oc-45Wc69IXWtx6FU--LtlWGFjWm
F--SMMaI0/edit#slide=id.g3d1be5cb97_0_32 

Presentation Slides 
- https://docs.google.com/presentation/d/13gMWDZoY-dtPNQr9kffSOvIqenV4TOFqQy

XW42Fwrp0/edit 

 
Instructor Prerequisites 
Instructor should be familiar with project management software being used and know how to 
access & play video game library  
 
Participant Prerequisites 
N/A 
 
Equipment/Software Materials 

● A presentation screen on which to show PowerPoint 
● Google Chrome Installed 
● Steam & Games installed 
● Previous Skins games downloaded 
● Slack installed 

  
Vocabulary 
List keywords here. 
  
References 
“Papo & Yo” Wired Article, 2012 

Review: Autobiographical Story of Child Abuse Papo & Yo Pushes Games Forward, 
Awkwardly 

https://www.wired.com/2012/08/review-autobiographical-story-of-child-abuse-papo-yo-pus
hes-games-forward-awkwardly/ 

 

Introducing Nancy (5 min) 
- See Google Slides 

 

Introducing Production Purpose (5 min) 
What does a producer / project manager do exactly? 

- In larger companies, this is actually two different roles, but in my indie development, 
usually one person wears both hats.  
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PRODUCER (Pre-Production & Post-Production) 

- Obtains funding and manages budget 
- Interviews and hires staff 
- Arranges & participates in promotion (marketing, festivals, competitions, etc.) 
- Troubleshoots high-level issues (lack of funds, bad press, staff problems) 
- Yells at project manager for going over budget 
- Ensure comfort and health of team 
- Assist with creative decisions where needed 

PROJECT MANAGER (Production) 

- Assesses a project’s staff, equipment and time needs 
- Keeps project scope in check 
- Assigns and follows up on individual tasks to ensure project deliver 
- Troubleshoots internal issues (lack of time, dividing resources, pipeline bottlenecks) 
- Yells at producer for impossible deadlines 
- Ensure comfort and health of team 
- Assists with technical production where needed 

CONCLUSION: 

These roles are as essential as art & programming. There’s no use making a game that you 
hemorrhage money to make and no one ever sees. Both require strong communication,  
organizational & stress-coping skills, which many of the most talented artist and 
programmers do not have. We will visit those roles in detail later on in the workshop.  

 

Standard Game Development Workflow vs. Skins Game Development Workshop (5 min) 
Pre-Production → Production → Post-production  

1. NO ONE PERSON DIRECTS/DECIDES: Like the borg, Skins uniquely has a joint 
creation. All participants have an equal voice in choosing the game story, graphics 
and gameplay.   

2. STORY-BASED: Game can branch from a theme, concept, mechanic OR story. Skins 
aims to branch from stories first.  

3. NOT PERFECTLY LINEAR/EFFICIENT: Technical training peppered in between working 
sessions. Teams divide and reconvene. Encouraged to “cross the streams” and 
explore a production branch you have never touched.  

4. PROFESSIONAL POLISHING 
5. CINEMATICS: for those who want to make their mark and enhance 2D skills, allows to 

explore separate style and away from Unity Engine.  

 

Case for Game Cinematics (10 min) 
What is a “Game Cinematic”? 

Any time the gameplay action stops, sometimes with little or no character control, with a 
pre-set “scene”. May or may not have dialog. Can also be “Quick Time Events” pre-animated 
with little to no user input to do a “finishing move”.  

“A cutscene or event scene (sometimes in-game cinematic or in-game movie) is a sequence in 
a video game that is not interactive, breaking up the gameplay”  (Wikipedia) 
 
Why Game Cinematics exist #1? GAMEPLAY 
- Based on older generation game consoles that could not handle the real-time rendering 
now possible. “Cinematic” scenes we pre-rendered to add to the significant story moments.  
- No longer necessary and in fact, arguably, detrimental to “player immersion” 
- Still used, though? Why? 
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- Reward for players! (ending movie in an epic) 
- A break for players 
- Introduce new gameplay element (eg: a spell or finishing move) 

 
Why Game cinematics exist #2? STORY 
- Formal Intro & Ending 
- In RPGs (role playing games) especially, helps forge relationships with the characters 
- Usually, can be skipped. So why not?  
 
Why Game cinematics exist #3? GRAPHICS 
- Real-time rendering is still not completely up to par with cinematic rendering. Large war 
scenes, for example, with millions of models need to be pre-rendered and help build a sense 
of urgency.  
- For marketing purposes (WoW) 
- Allows exploration of a different style (American McGee’s Alice) 
 
SLIDE 15: Squall is pretty! 
;) 
 
SLIDE 16: Why Skins uses “Game Cinematics”? 
- Allows 2D artists to enhance their craft and have a larger role in production 
- Can be created quickly, filling story gaps that may not have time to be developed through 
3D interaction. 
- Allows participants to explore an alternative art style 
- Tech wise, can be created completely separately from Unity engine and thus reduces 
pipeline bottlenecking (ie: those interested in creating the cinematics can start much before 
the 3D asset team have completed their models) 
- Option to explore 3D cinematic rendering, a la Pixar  

 

Our Game Production Toolbox (2 min) 
● LOGINS / USERNAMES / PASSWORDS  

○ Info on the backside of nametags. Note two addresses due to Google account 
constraints. 

○ Both forward to same gmail inbox, so no worries 
○ Google group created so that one address can reach everyone via email and 

chat and sharing new files 
● SOFTWARE 

○ Steam (for playing  games) 
○ Unity (for making games) 
○ Adobe (Photoshop for graphics & After Effects for cinematic animation) 
○ Google Suites (for document sharing) 
○ Plastic Gluon (for version control) 
○ Blender (for 3D asset creation) 
○ Slack (for chatting) 

 

Organization Tools 1 - Logins, Google Docs (5 min) 
● GOOGLE TEAM ACCOUNTS (CHROME, GMAIL, DRIVE) 

○ Explain how team accounts allow you to more easily share and manage files 
than regular gmail accounts 

○ Open Chrome browser 
○ Go to gmail.com 

■ LOGIN to Google Account 
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■ For skins workshop work only please! Will be re-configured 
after workshop end.  

■ Emails and messages  sent to group address 
abtecskins@skins.abtec.org will be received by everyone 

● GOOGLE DRIVE 
○ Go to drive.google.com → add to bookmarks bar 
○ See shared drive files, everyone has access 
○ Test writing in new gdoc. All can work on same doc at once! 
○ We will be using too often for prototyping files, while getting used to 

versioning system for tech lessons and asset production 
○ Versioning system will be used for Game Project files, but we can have simple 

image and file sharing via Google Drive or if you want to troubleshoot with 
each other or just document a funny error 

 

Organization Tools 2 - The Blog (5 min) 
● OFFICIAL Skins 6.0 WEBSITE 

○ Find blog at skins.abtec.org/skins6.0/ → add to bookmarks bar 
○ All lesson plans accessible with password skinsabtec 

■ as an “open source” workshop, we encourage these lesson plans to 
be shared 

 

Organization  3 - Slack (5 min) 
● Powerful chat tool 

○ How to adjust your settings & avatar 
○ Direct messages  
○ Channels for group messages 

 

STAYING HEALTHY (20 min) 
● Presentation by visiting Chiropractor on how to exercise while at a desk 

 

STEAM & SKINS GAMES (10 min intro - play until the end) 
OPEN STEAM 

○ Use account details on nametag 
○ If for any reason you need to reset, validation email will go to your @skins.abtec.org 

gmail account. 
○ Games for individuals and many more on Steam Obx (presentation computer) to play 

during breaks.  
 

● INTRO TO “NEVER ALONE” 
○ Donated by Upper One Games, also known as Kisima Inŋitchuŋa ("I am not 

alone") based on traditional Indigenous Alaskan tale "Kunuuksaayuka".  
○ First recorded by master storyteller, Robert Nasruk Cleveland 
○ Complete puzzles as a girl named Nuna and her Arctic Fox companion. 
○ MADE WITH UNITY ENGINE 
○ View Cinematic Trailer (1:55)  

 
● INTRO TO “PAPO & YO” 

○ Donated by small indie studio, Minority Media (where Nancy used to work as 
Project Manager) 

○ Created by Vander Caballero of Brazil  
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○ Award winning example of a personal experience being translated 
into fantastical and interactive. 

○ MADE WITH UNREAL ENGINE  
○ View cinematic trailer (4:12) 

 
INTRO TO PREVIOUS SKINS GAMES 

● Skins 3.0. Skahiòn:hati: Rise of the Kanien'keha:ka Legends 
○ MADE WITH UNITY ENGINE 

● Skins 4.0. Ienién:te and The Peacemaker's Wampum 
○ MADE WITH CONSTRUCT 

● Skins 5.0. He Ao Hou 
○ MADE WITH UNITY ENGINE  

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

Production 2 / Instructors: Nancy Townsend & Sabine Rosenberg 

Project Management Tools 
Learn how to track project progression, stay organized and 
access/share files via Plastic Gluon. 

 

 
Teaching Days, Time, & Length 
Wednesday July 11th, 9:15AM — 2HRS 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/16nb7By2CJVmaZC2oGFc1NYLb2uY2_81KDo
8MLTCct5Y/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 

- Access (login/password) to server hosting Skins 6.0 related repositories. 
- Completed a workspace update on all repositories, tested connection and ensured 

proper functionality and project structure. 
 
Participant Prerequisites 

- Access to hosting server (login user and password). 
 
Equipment/Software Materials 

- A presentation screen on which to show slide show presentation. 
- Black or white board with pens or chalk available. 
- Plastic SCM server: configured as a local central server, made available to all 

participants via the LAN/WAN.  
- Individual computers for each participant with the following software installed: 

Plastic Gluon. 

Objectives 
- Teach the fundamental concepts of Version Control within the context of the 

workshop: to keep organized, be able to collaborate with others, and keep production 
efficient with minimal hiccups. 

- Go through a live demonstration with all Participants: configure the Gluon client, 
access the Plastic SCM server and go through a standard workflow. 

  
Vocabulary 
Folder structure, PascalCase convention, Version Control, Collaboration, Repository, Exclusive 
Locking, Checkout, Checkin, Add, Configure, Changeset, Load, Unload. 
  
References 
Plastic Gluon software guide: 

- https://www.plasticscm.com/documentation/gluon/plastic-scm-version-control-gluon-
guide.shtml 

- https://www.plasticscm.com/gluon.html 
- https://www.plasticscm.com/gluon-in-detail.html 
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Staying Organized: Overview 
Begin by stressing how important it is to keep folders and files organized. When 
working in large groups with everybody sharing files, things can inevitably get a little 
messy. To ensure that everything is easily findable, every file should have a specific 
LOCATION and a specific NAME. 

 

Folder Structures 
Explain how in-progress art work files and completed, exported game assets are kept in 
different folder sets. Include screen shots of this exact structure from the test project SVN. The 
setup should be as so: 

MASTER PROJECT 
1. Animation 

a. Animation Clips 
i. Characters 
ii. Environment 
iii. Props 

b. Animator Controllers 
i. Characters 
ii. Environment 
iii. Props 

2. Art Assets 
a. 2D Art  

i. Textures 
1. Characters 
2. Environment 
3. Props 

ii. Sprites  
iii. User Interface  

b. 3D Art  
i. Characters  
ii. Environment   
iii. Props  

3. Audio 
a. Dialogue  
b. Music  
c. SoundFX  

4. Prefabs 
a. Characters 
b. Environment 
c. Props 

5. Resources 
a. Script Assets 

6. Scripts 
a. Game Scripts 
b. Scriptable Objects 
c. Utilities 

7. Third Party Assets 
 

WORK IN PROGRESS ART ASSETS 
1. Concept 

a. Concept Art 
i. Characters 
ii. Environment 
iii. Props 

b. Documentation 
c. References 

2. 2D Art 
a. Textures 

i. Characters 
ii. Environment 
iii. Props 

b. Sprites  
c. User Interface 

3. 3D Art 
a. Characters 
b. Environment 
c. Props 

4. Audio  
a. Dialogue 
b. Music 
c. SoundFX 

5. Cinematics 
a. Scene01 - intro 

*Note: only finished exported assets (.png, .fbx, .wav, .mp4, etc) should be in the Master 
Project (no raw file such as .psd, .aup, or .blend). All in progress assets should be in the Work 
In Progress Art Assets. The only exceptions are scripts which should always be created and 
worked on in the Master Project. 
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Naming Conventions - Rules 
Explain how in-progress art work files and completed, exported game assets are kept 
in different folder sets. Include screen shots of this exact structure from the test 
project SVN. The setup should be as so: 

In order to ensure that our files move easily between operating systems and servers, there are 
some basic rules we need to follow. 

1. General  Rule: a descriptive title  
<ObjectTitle>_<ObjectDetail> 

2. All files with multiple words must be written using one capital letter at the beginning 
of each work (called Pascal Case convention).   

ThisIsPascalCase 
3. Since we are using a version control software, we don’t need to keep local versions of 

our files. So for that, we want to avoid giving our work in progress version numbers in 
their names. We can fetch previous versions within the version control software. 

4. Assets must only use alpha numeric values (a,b,c,…123…underscores). NO SPACES. 
NO PUNCTUATION (e.g. $#%@&^). 

 
 

GOOD EXAMPLES  BAD EXAMPLES 

Arrow.blend  object1.blend 

MagicianBoy_Hat.blend  magician boy hat.blend 

BowAndArrow.blend  Bow&Arrow.blend 

 
 

Naming Conventions - Linked Files 
Every item created should be already named in the Game Features List. This name is what 
you use to refer to that object from then on, changing the convention based on what it is or 
where it is placed. The idea is to have separate parts of an object have the same name so 
that we know they are linked. 

 
For example, a character model in her second outfit would be called “Eve_Possessed.blend”. 
Therefore, all the files associated with her would be called “Eve_Posessed_eye.psd” and 
“Eve_Possessed_cloak.png”. 
 
Or, if you have one model that has many different materials, it could be named as: 

- FoldingChair_Metal 
- FoldingChair_Plastic 

 

Remember, these items are going to be listed numerically and alphabetically. Similar items 
should be listed as close together as possible. 
 

 

Introductions 
Instructors and Local Instructor give personal / professional introductions (15 minutes) 
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Version Control: Overview 
- Enables multiple people to simultaneously work and collaborate on a single 

project. Each person edits his or her own copy of the files and chooses when 
to share those changes with the rest of the team. Temporary or partial edits 
by one person should not interfere with another person's work. 

- Gives access to historical versions of the project files. This is insurance against 
computer crashes or data loss. If any team member makes a mistake, they can roll 
back to a previous version. One can also undo specific edits without losing all the 
work that was done in the meanwhile. For any part of a file, one can determine when, 
why, and by whom it was ever edited. 

 
Repository and Workspace Definitions 
Any Version Control System uses a Repository (a database of changes) and a workspace 
where any given team member does their work. 
 

- The workspace is a single team member’s personal copy of all the files in the project. 
They make arbitrary edits to this copy, without affecting the work of their teammates. 
When they are happy with their edits, they upload the changes to the repository. 

- A repository is a database of all the edits to, and/or historical versions (snapshots) of 
the team project. In the simplest case, the database contains a linear history: each 
change is made after the previous one. 

 
The Centralized Paradigm 

- There is just one central repository for a project. 
- Each team member has access to their own workspace. 
- Team members edit, update, add files to their workspace. 
- Team members will perform a checkin operation in order for any changes made to the 

workspace to be uploaded to the central repository. 
- As soon as any team member performs the checkin operation, other team members 

can update their workspaces in order  to see and use the changes. 

- Requirements: 
-  A server setup to host the central repository - either on a LAN/WAN or 

hosted by a cloud service. 
- Client software on every team member’s machine responsible for 

synchronizing the central repository with the working copy. 
- Each member has to be able connect to the central repository  

 
Why Plastic Gluon? 
There are many different version control tools and each has its advantages and 
disadvantages (out of scope in this discussion): So why Gluon? 
 

- An easy to use, uncluttered and intuitive Client GUI: 
- a workspace Explorer enabling one to: 

- browse & modify what they have loaded locally. 
- view previous versions of files 
- synchronize changes made to files with the Central Server  
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- has a configuration mode in order for a team member to choose 
which files and folders (from the central repository), they want to have 
access to as part of their workspace. 

- Load/Unload parts of the repository dynamically 
- useful when the repository is large & team members need only a subset of 

files 
- Switch workspaces: have easy access to multiple repositories 
- Work on file per file basis while checking in/ checking out - without breaking the 

repository 
- Exclusive locking: an effective and simple strategy for collaboration: ensures that only 

one team member can edit a file/asset at any given time. 
- Can handle large binary files  
- Direct Integration with Unity 3D 

 

How to use Plastic Gluon: Connect to the central server & access a repository 
This workshop uses local Plastic SCM server, accessible on the LAN, to host the repositories. 
Plastic Gluon, the client software, is used to allow every team member to have access to the 
Version Control system on their local machines. The repositories used in this workshop have 
already been setup and configured, based on the folder structures discussed.  
 
For this lesson, we will be using the repository called Project_Management_Lesson, in order 
for everyone to get used to using Plastic Gluon in a centralized paradigm. 
 
Group Task: All lesson Participants and Instructor go through the required actions live: 
 
The  Project_Management_Lesson repository already exists on the central server, and the 
goal of this section is to go through the necessary steps for setting up and configuring a 
working copy of the repository on every team member’s machine. 
 
There are 4 steps to setting up the repository on a  computer (N.B one can link to more than 
one repository and have multiple workspaces - more on this later): 
 

1. Enter the location of the server: one can find the server address on the front page of 
the Game Features List. One can also hit the Scan Network button to find the server 
if they are connected to the network. Hit Connect once one has the server selected. 

2. Once connected, one should login with the predefined user information. Input the 
account name, followed by the password (both found on your name tags) and hit 
Check. If the information was input properly, one should get a confirmation message 
appear next to the Check button 

3. Next, one needs to choose the repository. Select the Project_Management_Lesson 
from the list. 

4. Finally one needs to tell Gluon where to store the working copy. Please keep the 
default location (C:\user\wkspaces\Project_Management_Lesson) - Gluon will make a 
wkspaces folder for you. Then hit the apply button. 

 
Everyone should now have their  our first working copy LINKED to the 
Project_Management_Lesson Repository. Keep Gluon open... 
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How to use Plastic Gluon: Common Operations 
This lesson will cover the following Plastic Gluon operations (listed below) as a group. 
Every participant will need to perform these operations live on their own machines. 

- Loading and unloading files 
- Adding new files/folders to workspace and synchronizing with central server 
- Check out (in order to edit) 
- Check in (synchronize changes) 
- Update local workspace  
- Reverting to a previous version 

How to use Plastic Gluon: Configuration Mode (Loading Files) 
Plastic Gluon, unlike most other version control systems, allows you to choose which files to 
load from the repository. You can select the individual files you want to have local access to.  
 
Group Task: All lesson Participants and Instructor go through the required actions live 
 

- Select the Configure Tab within the Gluon Interface 
- Select the files and/or folders  you want to load by checking the checkbox on the left 

of each item 
- Hit apply - at this point all the files/folders selected will be copied into your configured 

local workspace automatically. 
 
How to use Plastic Gluon: Configuration Mode (Unloading Files) 
The opposite of loading files is unloading files/folders. Plastic Gluon also allows you to choose 
which files to unload from the repository. Unloading is in general far less common then 
loading, but it is useful if you find that your local workspace is taking up too much space, and 
there are files and or folders that you have previously loaded that you feel that you do not 
need.  

Unloading files does not change the contents of the central server, it only changes which 
files you have downloaded from the central repository into your local workspace. 

Group Task: All lesson Participants and Instructor go through the required actions live 
 

- Select the Configure Tab within the Gluon Interface 
- Select the files and/or folders  you want to unload by checking the checkbox on the 

left of each item 
- Hit apply - at this point all the files/folders selected will be removed from your 

configured local workspace automatically. 
 

How to use Plastic Gluon: Configuration Mode (Adding Files/Folders) 
Scenario:  

- You have created a new file (i.e. a photoshop file) and have saved it inside a folder in 
your working directory.  

- If you look at your Plastic Gluon GUI - you will see that this new file / folder has the 
status: private.  

- This means that the item in question is not under version control. It cannot be 
accessed by your team members, nor will Plastic SCM keep a working history of any 
changes made.  

- At this point then - the goal is to to add the file to version control. 
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Group Task: All lesson Participants and Instructor go through the required actions live 
 

- Within the Gluon Interface: 
- Select the file/folder in question 
- Right click on it to access the submenu and select Add to Source 

Control 
- At this point the parent directory that this added file/folder is within, will 

become checked out (indicated by a red symbol). This basically indicates 
that there are local changes that are not being reflected in the central 
repository.  

- Therefore, in order for other team members to have access to the new 
file/folder: we will need to checkin the parent folder. 

- Go to the Checkin changes Tab, write a descriptive comment and click the 
Checkin button. 

- If you were successful - the red symbol on the parent folder should be gone 
and the status of the parent folder should be: Controlled. 

 

How to use Plastic Gluon: Checking-Out Files 
Whenever you want to start working on a file that already exists within the repository, MAKE 
SURE YOU ALWAYS CHECK IT OUT FIRST. This is extremely important because once a file 
is checked out, it cannot be overwritten by anyone else until it is checked back in. This 
reduces the risk of more than one person modifying a file at the same time, which would 
cause conflicts within the versioning system.  
 
Task: request 1 or 2  participants to checkout a file(s) 

- Within the Gluon Interface: select a file and right click (for submenu) 
- Select Checkout. 
- At this point you should see that the status of the file within the Gluon interface has 

changed to checked-out. 
 

Task: Every other participant update your workspace: 

- Click on the Update workspace button 
- You should see that the status of the items that were checked out by your team 

members have changed: 
- The files should be exclusively locked. The Gluon Workspace Explorer will 

display who has locked the file(s), indicating that you cannot edit the file (but 
you can view it). 

- REALLY important to mention: Do not attempt to edit files that are locked - 
this will incur conflict issues - specifically that you will never be able to save 
your changes and have those changes reflected on the central repository. 

 
How to use Plastic Gluon: Checking-In Files 
Scenario:  

- You have checked out a file, opened it, made changes and saved those changes. 
- When you look at the status of the file within Gluon, it should be checked out | 

changed.  
- This means that you have only saved those changes on your own machine.  
- What we really want is for those changes to be made available to the other team 

members - so you will need to “check-in” those changes to the central repository:  
  
Task: request that the SAME participants who checked out the files in the previous task 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 

67



 

perform this task: 
- Open the file(s) which you checked out, make a couple of changes and save. 
- In the Gluon GUI check the status of the changed file: should be checked out | 

changed. 
- To check in the file: right click on it and select checkin. This will take you automatically 

to the checkin changes tab. 
- You must now write a descriptive comment (what changes did you make to the file? - 

one line is sufficient). 
- Hit checkin button - Success? 
- If you were successful: the status of your file (within Gluon Workspace Explorer) 

should be controlled. 

Task: request everyone else to update their workspaces: 
- Click on the Update workspace button 
- You should see that the status of the items that were checked in by your team 

members have changed. They should no longer have the locked status. 
 
In Summary: 
The checkout - checkin workflow is very important, as this strategy is what enables teams to 
collaborate on the same project files: 

- BEFORE opening a file for editing, ALWAYS checkout the file first. This will ensure 
that the file is exclusively locked and cannot be edited by anyone else. 

- EDIT the file(s) on your machine and save …  
- When you want your changes to be SAVED onto the central server, be sure to 

checkin the file (using the Gluon workspace explorer). This will also allow other team 
members to be given the chance to edit the file. 

- Always make descriptive comments in the checkin stage. 
 

How to use Plastic Gluon: Update 
The Update process was briefly explained during the checkin & checkout tasks - but the 
process is important enough that it needs to be reiterated. 

- The Update Workspace action is the ONLY way to ensure that your local workspace 
is synchronized with the central repository.  

- Whenever someone else, adds new material, checks-in or checks-out files or folders, 
their changes will be reflected in your Gluon workspace explorer but ONLY if you click 
on the Update Workspace button. 
 

Group Task: Update Workspace  

- Instructor performs an add & checkin operation for a folder of new content (within a 
version controlled directory) 

- All participants click on the Update Workspace button in order for the changes to be 
reflected. 

- Every time you start working, intend to checkout a the file, BE SURE to UPDATE first! 
- Green check marks means that your local workspace is synchronized with the server. 

 
How to use Plastic Gluon: Commenting in order to complete a checkin operation 
Everyone in the lesson had the opportunity to add a new file, check it in and provide a 
descriptive comment. However, the focus of the task was adding a file. In this slide one needs 
to reiterate the importance and necessity for making descriptive comments in order to fully 
complete a checkin operation. 
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Group Task: Commenting 

- All participants add a new file to source control (gets checked -out) 
- Right click on the new file and select checkin 
- Add a descriptive comment: What is the change and why? 
- If your checkin is successful: the file you added will have a green checkmark next to it.  

 
Review: the checkin operation is needed every time you add a new file to the repository 
and/or update, modify existing files. Please add appropriate comments relevant to the task. 
 
How to use Plastic Gluon: Viewing changesets 
This tab in the Gluon Workspace explorer will suddenly make all the comments that you have 
been asked to make (to complete a checkin) relevant! All the changes made by any team 
member are stored in the changesets and are viewable at any time. You can see all the 
additions, checkins and updates that your entire team made. This is super useful as it allows 
all team members to access the history for every file that is under version control. 
 

Group Task: Viewing changesets 

- All participants should access the changeset tab in the Gluon Workspace Explorer 
- Instructor will briefly walk through what each of the fields indicate including the 

revision number 
 
How to use Plastic Gluon: Reverting files 
This lesson has so far focused mainly on the COLLABORATIVE component of Version Control. 
This section of the lesson will therefore focus on the the VERSION control component. 
The changeset view was introduced in the previous slide which allows team members to 
easily view a the list of changes per file.   
 
More importantly Plastic SCM and the Gluon client respectively, allows one to not only VIEW 
the history of a given file, but also REVERT back to a specific historical point in the file. 
 
Scenario:  

- A team member checks out a file, makes changes, saves the changes and checks the 
file back in.  

- They later realize that those changes were not necessary, were wrong etc…  
- What to do? 
- Revert to an older version of the file 

 
Group Task: Reverting a file 

- Each participant should perform this operation on a DIFFERENT file (otherwise there 
will be conflict issues) 

- Select the file that you wish to revert. 
- Select the relevant specific file changeset on the right of the Gluon interface: 

- You will see all the previous versions for that file with a specific 
changeset number, the person who checked in the file and the date. 

- Right below that, is a text box that displays the comment for each 
changeset 

- Simply right click on the version you wish to revert to and select revert 
to this revision. 

- A dialog box will open asking the participant to confirm that they would really 
like to perform the revert operation. (Note: how the dialog box is green - it is 
not an error message rather a notification…). Select YES. 
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- As a result of the revert operation, the participant’s workspace will be 
updated: 

- The selected revision is “bolded” in the History View 
- The reverted item is CHECKED OUT and has a new status: 

REPLACED. 
 

Please Note: reverting a file is considered a local operation and WILL NOT be reflected in the 
central repository UNLESS you check in the reverted file. 
 
How to use Plastic Gluon: Save the Reverted file to the central repository 
Group Task: Save the Reverted file to central repository 

- Each participant should have performed the revert operation on a distinct file. 
- Since the reverted file is a local operation, one will need to checkin this change in 

order for it to be reflected in the central repository. 
- Right-click on the file and select checkin (as before) 
- In the checkin changes view add a descriptive comment and select the checkin button 
- Now if everybody updates their workspace, they should have the updated files 

synchronized in their respective workspaces. 
 
 
Version Control: Conclusion 
This section concludes the lesson on Plastic Gluon. Participants should feel comfortable in 
performing the common operations and using the interface in general. Plastic SCM & Plastic 
Gluon are tools, which allow for simple intuitive collaboration and version control strategies to 
be implemented.  

But: Effective Collaboration relies on team members communicating with each other all the 
time, not just software! If any team member, at any time is not sure if a file is already locked, 
being updated, they should ALWAYS talk to their team members first! 

Common Operations to remember: 

- If a file is checked out, it cannot be modified by other team members, so be sure to 
regularly checkin when a file has been locally updated - allow others also to access 
the file. 

- Checkin Often 
- Update the local workspace often 
- ALWAYS use the Gluon interface to access files, you MUST checkout the file before 

opening it 
- In general, there is no need to delete files. Remember, this is a team initiative, 

multiple people sharing files. 
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Production 3 / Instructor: Nancy Townsend 

Game Design Documents & Prototyping Procedure 
Explore game development workflow, pre-production roles and design 
documentation. Review Story / Mechanics / Style decisions  in 
preparation  
to prototype. 

 

 
Teaching Days, Time, & Length 
Monday July 16th, 9:15AM — 30M 
 
Supporting Materials 
Presentation slides 

- https://docs.google.com/presentation/d/1FtTn1j5gGww2O8bRjbaYayDRouzgsOIKeOc
IkXa_Dk8/edit#slide=id.g37b3c3dd55_1_35 

 
Instructor Prerequisites 
The instructor should be familiar with project management tools and has been present 
throughout design discussion sessions.  
 
Participant Prerequisites 
Students must have made the basic decisions of their game foundation 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 

- Split into 3 different groups to build upon decisions made by the group 
- Refine decisions and produce blueprints 
- Prepare to present blueprints to team 

  
Vocabulary 
Prototype, draft, blueprint 
  
References 
N/A 

 

Game Development Roles -- Traditional vs. Skins  
Review the “Game Development Workflow” Poster. Reminder of team splits. Individual 
participants can choose their preferred route and IIF staff try to encourage an even split. 
 
“It Takes a Village...or not” 
Ubisoft vs. Artifact 5: large and small studios can, in fact, make similarly detailed and scaled 
games. It depends on time/talent/efficiency.  
 
Game Industry Jobs - Administration  
ADMINISTRATORS/EXECUTIVE BRANCH: This branch is in place usually before anyone else 
and have the most power but also most pressure. Balance of ensure a project has a content 
staff but is also profitable, sometimes at the risk of a terrible product.  

○ Executive Director: usually takes on the bulk of the risk in bringing a project to 
life and financing it. Makes high level decisions for all teams.  

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 

71



 

○ Creative Director: less business, more “look”. Keeping constraints in 
mind, has final vision/say of how a project will look and feel.  

○ Producer: gets funding, promotion and arrange team to get projects 
started and afloat. Ensures project is viable.  

○ Project Manager: familiar with all tools being used, assigns tasks to 
employees, follows up, and assists in compiling. 

 
Game Industry Jobs - Pre-Production 

○ Writer: writes the general story, dialogue, scenes and game flow.  
○ Game Designer: Plans interactions, maps, battle systems, etc.  
○ Concept Artist: under creative director’s instruction, creates artistic concepts 

for characters and environments that the production artists will use.  
 
Game Industry Jobs - Production TECH 

○ Software Developer: can use a pre-built engine or work from scratch 
○ Programmer: uses the engine and customizes 
○ Level Editor: builds maps, add art assets 
○ UX, User Experience Testing: makes sure the game is comprehensible, 

intuitive and flows without instruction. 
 
Game Industry Jobs - Production ART 

○ Modeling / Texturing 
○ Animator 
○ 2D Designer 
○ Audio Engineer 

 
Game Industry Jobs - Post-Production 

○ Marketing 
○ Quality Assurance 
○ Distribution  

 
And Many more! 
AAA Companies have hundreds if not thousands of employees and the list of roles is 
constantly updating as games and gamers change.  
 
Skins Pipeline/Roles 
GROUP OWNERSHIP 
How our project will be different, and yet the same. Note that we have GROUP 
BRAINSTORMING, which is far from typical.  
 
Skins Pipeline/Roles 

- Divide into 2 teams and then 4 
- There will be plenty of time to decide which role you want to fill 
- Everyone will do an intro to ALL software 
- Will revisit again, later in the workshop, once participants have a better sense of their 

preferred roles 
 
PROTOTYPING TEAMS - Plan features 
Story - goal is to write all dialogue lines, cinematic scenes scripted & storyboarded 
Graphics - moodboard created, technical drawings for characters & key items, environments 
sketched 
Play - level maps planned, primary interactions tested, interactivity maps 
TOGETHER: Create Physical “Scope” Board and a Game Design Document. After 
presentation, complete Game Features list.  
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PRODUCTION TEAMS - Create Features 
[Graphics / Engine]  
3D Animation 
2.5D Cinematics 
Audio & Atmosphere 
Programming 
 
CAUTIONARY TALES: 

- Don’t make big changes without consulting other groups. Remember, there is 
no ONE director, though we encourage teams to choose delegates to visit 
other teams. Cross-pollinate but understand that no one person can make big 
changes at this point.  

- Timing: don’t bite off more than you can chew! Include “nice to have” elements 
but don’t depend on them.  

- Avoid bottlenecks: modeling especially, characters or animated objects takes 
priority as they require additional animation work. Finish basic skeleton prior 
to decorative details.  

- Remember - polishing coming later. Choose your “pet” element you are 
excited about.  

 
Officially divide into teams for prototyping. 
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Production 4 / Instructor: Nancy Townsend & Sabine Rosenberg  

Project Management Review 
Review development workflow, roles and tools. Reminder to prioritize 
physical and mental comfort throughout production. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 4:00PM — 45M 
 
Supporting Materials 
Presentation Slides 

- https://docs.google.com/presentation/d/1VrAc667F88LS_TWNYLhsygOhrKulchmT7rt
nPohDM0w/edit 

 
Instructor Prerequisites 
Familiar with the project management tools. 
 
Participant Prerequisites 
Students must have experience with Plastic Gluon. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 

- Reminder of how to keep project organized. 
- Reminder to stay healthy!  

  
Vocabulary 
Commit, Workspaces, PascalCase Convention. 
 
References 
Pascal Case versus Camel Case Naming conventions: 

- http://www.dofactory.com/topic/1141/camelcase-pascalcase-vs-camelcase-pascalca
se.aspx 

Plastic Gluon software guide: 
- https://www.plasticscm.com/documentation/gluon/plastic-scm-version-control-gluon-

guide.shtml 
- https://www.plasticscm.com/gluon.html 
- https://www.plasticscm.com/gluon-in-detail.html 

 
 

 
Review - Folders & Naming Conventions (10 min) 
Folder Structures 
Explain how in-progress art work files and completed, exported game assets are kept in 
different folder sets. Include screen shots of this exact structure from the test project SVN. The 
setup should be as so:   
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MASTER PROJECT 
1. Animation 

a. Animation Clips 
i. Characters 
ii. Environment 
iii. Props 

b. Animator Controllers 
i. Characters 
ii. Environment 
iii. Props 

2. Art Assets 
a. 2D Art  

i. Textures 
1. Characters 
2. Environment 
3. Props 

ii. Sprites  
iii. User Interface  

b. 3D Art  
i. Characters  
ii. Environment   
iii. Props  

3. Audio 
a. Dialogue  
b. Music  
c. SoundFX  

4. Prefabs 
a. Characters 
b. Environment 
c. Props 

5. Resources 
a. Script Assets 

6. Scripts 
a. Game Scripts 
b. Scriptable Objects 
c. Utilities 

7. Third Party Assets 
 

WORK IN PROGRESS ART ASSETS 
1. Concept 

a. Concept Art 
i. Characters 
ii. Environment 
iii. Props 

b. Documentation 
c. References 

2. 2D Art 
a. Textures 

i. Characters 
ii. Environment 
iii. Props 

b. Sprites  
c. User Interface 

3. 3D Art 
a. Characters 
b. Environment 
c. Props 

4. Audio  
a. Dialogue 
b. Music 
c. SoundFX 

5. Cinematics 
a. Scene01 - intro 

*Note: only finished exported assets (.png, .fbx, .wav, .mp4, etc) should be in the Master 
Project (no raw file such as .psd, .aup, or .blend). All in progress assets should be in the Work 
In Progress Art Assets. The only exceptions are scripts which should always be created and 
worked on in the Master Project. 

Naming Conventions - Rules 
Explain how in-progress art work files and completed, exported game assets are kept in 
different folder sets. Include screen shots of this exact structure from the test project SVN. The 
setup should be as so: 

In order to ensure that our files move easily between operating systems and servers, there are 
some basic rules we need to follow. 

1. General Rule: a descriptive title  
<ObjectTitle>_<ObjectDetail> 
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2. All files with multiple words must be written using one capital letter at the 
beginning of each work (called Pascal Case convention).   

ThisIsPascalCase 
 

3. Since we are using a version control software, we don’t need to keep local 
versions of our files. So for that, we want to avoid giving our work in progress version 
numbers in their names. We can fetch previous versions within the version control 
software. 

4.  
5. Assets must only use alpha numeric values (a,b,c,…123…underscores). NO SPACES. 

NO PUNCTUATION (e.g. $#%@&^). 
 
 

GOOD EXAMPLES  BAD EXAMPLES 

Arrow.blend  object1.blend 

MagicianBoy_Hat.blend  magician boy hat.blend 

BowAndArrow.blend  Bow&Arrow.blend 

 
 

Naming Conventions - Linked Files 
Every item created should be already named in the Game Features List. This name is what 
you use to refer to that object from then on, changing the convention based on what it is or 
where it is placed. The idea is to have separate parts of an object have the same name so 
that we know they are linked. 

 
For example, a character model in her second outfit would be called “Eve_Possessed.blend”. 
Therefore, all the files associated with her would be called “Eve_Posessed_eye.psd” and 
“Eve_Possessed_cloak.png”. 
 
Or, if you have one model that has many different materials, it could be named as: 

- FoldingChair_Metal 
- FoldingChair_Plastic 

 

Remember, these items are going to be listed numerically and alphabetically. Similar items 
should be listed as close together as possible. 

 

 
Review - Plastic Gluon (10 min) 
This section concludes the lesson on Plastic Gluon. Participants should feel comfortable in 
performing the common operations and using the interface in general. Plastic SCM & Plastic 
Gluon are tools, which allow for simple intuitive collaboration and version control strategies to 
be implemented.  

But: Effective Collaboration relies on team members communicating with each other all the 
time, not just software! If any team member, at any time is not sure if a file is already locked, 
being updated, they should ALWAYS talk to their team members first! 

Common Operations to remember: 

- If a file is checked out, it cannot be modified by other team members, so be sure to 
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regularly checkin when a file has been locally updated - allow others also to 
access the file. 

- Checkin Often 
- Update the local workspace often 
- ALWAYS use the Gluon interface to access files, you MUST checkout the file 

before opening it 
- In general, there is no need to delete files. Remember, this is a team initiative, 

multiple people sharing files. 
 

 

 
STAYING HEALTHY - Chiropractor (20 min) 

- Presentation by visiting Chiropractor on how to exercise while at a desk. 
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Graphics 1 / Instructor: Dominick Meissner 

Game Aesthetics 
Basic design language for games and the concept art process.  

 

 
Teaching Days, Time, & Length 
Tuesday July 10th, 1:30PM — 45M 
 
Supporting Materials 
Presentation slides, ArtDoc 

- https://docs.google.com/presentation/d/1cTWziOI6tm_zbB6OncjHGdqOrhXs0qpnqm
XOntLLDD8/edit?usp=sharing 

Presentation slides, Conception 
- https://docs.google.com/presentation/d/141iAOd0zbziQfHXs8VgZQSwfMuAass7Q7

WYMqHOcpvk/edit?usp=sharing 
 
Instructor Prerequisites 
The instructor should be comfortable using Photoshop. 
 
Participant Prerequisites 
Students should have some knowledge of video game art, and or experience or interest in 
video game art. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 
Be a natural extension of last years ‘Concept Art & Style Design’ Lesson, by showing the 
conception and art direction of Flingimals (a title released in Canada by Behaviour). 
 
Two of of objectives for this presentation is to: 

A) Show the inspiration for stylistic and art direction choices, including an art bible. 
B) Show how the games aesthetics coupled with simple game rules are needed to 

clearly communicate ‘how the game works’ and ‘what to do’. 

We will start with the conception and show how that impacts the art direction, then back 
again. 
  
Vocabulary 
List keywords here. 
  
References 
N/A 
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Graphics 1: Game Aesthetics 
Flingimals Conception Doc  
Here we will show the conception of Flingimals and a focus on a few of its variations 
during the development. 

 

Title (Slide2): 
Here is the final logo and the sky background of the game. Here we already evoke some of 
the mood and feeling of Flingimals. Circus, colorful, cute, sky, etc are thoughts that come to 
mind. It’s also obvious, even without seeing any characters, that there are going to be animals 
in Flingimals. 

 

 

Project History(Slide3): 
Not to dwell on this slide too much, but it's nice to show just how many variations were 
created during the full development of Flingmals. 
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Initial Concept (Slide 4): 
This drawing is the actual first concept for Flingimals. It was imagined as a simple 
arcade style kids game where stunt animals are fired from a cannon to hit bumpers 
and break balloons, thus scoring points. It clearly had a cute animal and circus theme. 

Fortunately, the person whom had the idea is also very visual and able to draw in very good 
details. But that by no means you cannot conceive and communicate your own ideas to an art 
team.  

 

 

Level Design concept (Slide 5): 
During the initial planning stages there was a fear that the game depicted on the previous 
image may in fact be too simple. So we did some variants on how we could add some depth 
to the game.  
Here is a stretch of a level design concept where the levels were scrolling up and even 
included branching paths. This idea was ultimately scrapped. 
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Basic Actions & Verbs (Slide 6): 
As we begin to design how the game will function, we brainstorm some key actions 
and verbs. Here we have a series of simple actions and items that the player could 
interact with. We use these for inspiration and before we begin to make some basic 
prototypes. 

Even though I can not say I can draw, I am constantly doodling on white boards in meetings 
to communicate my ideas. If I can do this, that is proof that you can visually communicate 
without being able to draw ;) 

 

 

Advanced Actions & Verbs (Slide 7): 
This shows some deeper thought into game mechanics and other concepts. 
The point of this slide is simply to explore all of your ideas, doodle or write them down, 
regardless of if they ever get used. 
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Core Gameplay (Slide 8): 
Through brainstorms and prototypes we continually returned to the core concept of 
the Fiingimals themselves and being shot from cannons through hoops. Here we see 
variants of cannons and different hoops. 

 

 

Platforms & Cannon Variants (Slide 9): 
Here you can see some further development and ideas for various platforms and cannons. 

Of notes, the bouncy pads, the ‘teleporting’ magic hat, the fire cannon, etc.  
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Flingimal Troupe (Slide 10): 
So we have been looking at lots of drawings about mechanics and cannons and 
hoops and bouncy pads… what happened to the Flingimals? 
We always wanted the Flingimals to be stars. It’s their show after all. We noticed that 
when the Flingimals were shot from the cannons they would obviously curl up in a 
ball, effectively becoming an pinball bouncing about. This didn’t provide with much 
opportunity to showcase them during gameplay. And since we wanted children to collect 
many Flingimals we wanted to feature them more and give them a chance to show their 
warmth and charm. 

Here is an initial sketch of some not-fully-formed Flingimals bouncing off each other and 
doing balancing stunts. We really wanted to allow kids to feel that the Flingimals were doing 
cool stunts and allow them to choose the order in which they took turns doing stunts. 

 

 

Flingimals ‘Stacking’ (Slide 11): 
Here you see a more developed concept from the previous. Furthering the concept of ‘stacking 
up’ your Flingimals.  
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Mature Concept (Slide 12): 
As Flingimals went through many variations, these 2 sketches are quite instrumental. 
These were both drawn over the weekend by different team members and then 
compared. Notice how they are nearly the same in features. We were finally coming 
around the bend to concept and gameplay that really felt right. 
Note: the Star held by the Flingimal on top of the pole in the Left image. This became a core 
features in that the player’s goal is to collect 3 stars while stacking your Flingimals on the 
pole.  

 

 

Flingimals World & Constellations (Slide 13): 
Now that we had a good grip on where we wanted to go with the gameplay, we were still 
developing the ‘world’ of Flingimals. See on the right how the earth and constellations are 
rotating. Each start in a constellation represents a level, and when a player completes all the 
stars in a constellation, it would be complete. Initially we wanted the sky to rotate slowly in 
real time offering the player different constellations at different times. This ended up not 
happening, and we allowed the players to select their constellations by swiping left or right. 

 

 

Before finishing with this doc, I want to switch to the art doc to go over it. We shall return 
to finish this doc after. 
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Graphics 1: Game Aesthetics 
Flingimals Art Doc  
While all of these game design variations were going on, we were also developing the 
look and feel of the game. This is the working art bible and style guide for Flingimals. 
 

Visual Style statement (Slide 3): 
Here is the artistic vision statement.  
Invoke imagination in our players mind through an unique visual style inspired by all cultures 
around the world and a wide array of performing arts.  
Bringing together the magic from the circus, the mesmerizing costumes designs, the amazement 
from spectacular music shows, all combined with the vivid colors, creativity and funny atmospheres 
will create from Flingimals an unique vibrant visual experience for boys and girls of all ages. 
 

 

 

Style Definition (Slide 4): 
Very important slide showing the vision of shapes and shaders. We wanted a very tactile and 
3D feeling that was very clean and obvious to ‘read’. This pages speaks to these goals very 
well. 
The visual style what will be applied across all the assets of the game (from the buttons to 3D 
models, characters or environments) is a resultant from the UI rendering development done for the 
project and can be described as “Sophisticated Imitation of Vinyl plastic”.  
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3D Objects Style Breakdown (Slide 5): 
Note: Flingimal and structure are not to scale. 
 
Carefully we will craft all the objects with the same attention do detail but most importantly sharing 
similar sizes for borders, bevels, frame thickness. 

Those similarities are the key element for our visual style. All of those small details, added together, 
will clarify the uniqueness of Flingimalls.. 
 

 

 

Rendering and Texture Style (Slide 6): 
- Clean and minimalist textures 
- Soft shadows 
- Beautiful highlights 
- Subtle rimlight 
- Used of flat saturated colors 
- Some broken corners in textures 
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Color Palette (Slide 7): 
Color palette and UI interface samples. 
 

 

 

Artistic Vision Characters (Slide 8): 
Inspired by true animal breeds, the Flingimals are a unique blend of street performers, stuntmen and 
stage artists. Always happy and optimistic they travel around the world to present for their friends 
the most amazing shows.  

Beside their beautiful and colorful costumes, they always wear an unique HELMET representing 
features from their specific breed.  
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Character Style and Rendering (Slide 9): 

This is the final style (after many iterations) for the Flingimals themselves. Pretty cute 
no? 
 

 

 

Character Helmets (Slide 10): 
Showing how we used the Helmet to accentuate each breeds features. Looking for a readable 
silhouette at nearly all angles. 
 

 

 

 

   

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

Artistic Vision Environments (Slide 11): 

Flingimals live in a world full of Wonders, magic and imagination. The Stardust magic will 
be present everywhere and it represents the soul of the environments. There is no 
mechanical machines, no fuel of electrical objects. All whole world is driven by magic and 
beauty. 
 

 

 

Evironment Explorations (Slide 12): 
A couple of structures we explored but were ultimately not used. While very stylish, these were a bit 
too busy in the end. 
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Artistic Vision Inspiration (Slide 13): 

We will drive our inspiration from different sources, from surrealistic paintings to amazing 
cultures around the World; the Universe of Flingimals will have to make the player travel 
into our imagination ! 
 

 

 

General Inspiration (Slide 14): 
Mood boards to help define the overall style, serves as inspiration. 
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General Inspiration (Slide 15): 

More mood boards. 

 

 

Surreal Paintings (Slide 16): 
Mood boards to help define the overall style, serves as inspiration. 
 

 

 

Excetera. For slides 18-22. 

Now we will return to the previous Concept Doc 
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Graphics 1: Game Aesthetics 
Flingimals Conception Doc  
 
Game Concept (Slide 14): 
Here we show the final game concept, very similar to the sketches but with final game 
assets! 
 

 

 

Game Concept (Slide 15): 
Here you can see how the constellations turned out along with the a look at the Flingimals 
collection. 
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Final Look! (Slide 16): 
Here we show the final game concept, very similar to the sketches but with final game 
assets! 
 

 

Thanks! 

 

WEB RESOURCES & BOOKS: 
Drawing Fundamentals: https://androidarts.com/art_tut.htm  
Anatomy: http://www.alexhays.com/loomis/  
Concept Art Tutorials: https://www.youtube.com/user/FZDSCHOOL  
What is Concept Art?: http://howtonotsuckatgamedesign.com/2014/02/lets-get-real-concept-art/  
Technical Drawing & Design: https://www.youtube.com/user/scottrobertsondesign  
Colour in storytelling: https://www.youtube.com/watch?v=aXgFcNUWqX0  
Composition in storytelling: https://www.youtube.com/watch?v=CvLQJReDhic  
Digital Art Podcast: https://www.youtube.com/channel/UCyGGrJ-wQlvcWujLKHzB42w/featured  
 

Great video series on the history of video game graphics: 
https://kotaku.com/a-history-of-video-game-graphics-1661368568 
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Graphics 2 / Instructor: Vance Martin 

Intro to Photoshop  
Explore Photoshop Capabilities  

 

 
Teaching Days, Time, & Length 
Tuesday July 10th, 2:15PM — 1HR 15M 
 
Instructor Prerequisites 
Access (login/password) to hosting server 
Completed an update, add and commit  on the server test prior to lesson and set up folder 
structures for the projects already discussed 
 
Participant Prerequisites 
Access (login/password) to hosting server 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint 
Individual computers for each student with Photoshop installed 
 
Objectives 
Teach the students the tools of using Photoshop, keeping organized to keep production 
efficient and with minimal hiccups. Basic tools, layers, and saving. How Photoshop can be 
used in game production. 
  
Vocabulary 
Layers, Crop, Clone Tool, Blending Modes, Filters 
 
Photoshop Tutorials: 

- www.photoshoptutorials.ws/ 
- http://www.photoshopessentials.com/ 
- http://www.photoshop.com/tutorials 
- https://design.tutsplus.com/series/learn-adobe-photoshop--cms-1098 
- http://abduzeedo.com/tags/photoshop 
- http://www.digitalartsonline.co.uk/features/illustration/86-best-photoshop-tutorials-u

pdated/ 
 

 

What is Photoshop? 
Photoshop is a software used to create new or modify existing 2D images. Often used to 
professionally edit photos or create new images from scratch. As well as editing photos, 
Photoshop is widely used to create digital art, using the advanced brush tools. A combination 
of both the photo editing and drawing tools will be used to create game assets and concept 
art. 
  
Getting Started 
To Make a new File choose File> New 
  
In the “New” dialog box that appears you can set different settings for the new file. 
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Name: defines the name of the file (remember your naming conventions) 
Width and Height: specify the size of the canvas 
Resolution: “crispness” of the file in dpi (digital pixels/inch). Higher resolutions increase 
file size 
  Web is usually 72 dpi , Print is usually 150 or 300 dpi 
  Large digital paintings (like concept art or promo materials) should be >300 dpi 
  Resolution can always be downscaled but is very hard to scale up 
Color Mode: RGB colour for digital, CMYK for print 
Background: White or transparent, can be changed later 
  
Leave the advanced options as they are. 
  
Introduction to Layers 
Photoshop works with Layers to display images. A new document always starts with only a 
Background Layer. All important elements in a single file should be on separate layers. This 
allows for non-destructive editing and enhances the workflow and adjustment of different 
elements. 
  
Layers are also great if you are unsure of a modification you would like to make to your 
design. Simply create a new layer and try your idea out. If it doesn’t look good you can simply 
delete the new layer and all of your previous work will be unaffected. 
  
There are a lot of other options in the layers panel (see .ppt). You can link layers to 
move/resize them together as well as group them for better organization. You can add special 
effects, masks, and adjustment layers as well as change how the layers “blend” together 
(blending modes). 
  
Blending modes determine how layers should blend together. Each setting performs a 
different set of calculations on the pixels to “mix” them. The blending mode can be accessed 
in the layer panel. Cycle through the options with the arrow keys once the blend mode options 
are open. Experimentation is key! Also try changing the opacity of the blend mode since at 
100% the effect is usually too strong. 
  
Some helpful shortcuts for this panel: 
CTRL + E: merge selected layers 
CTRL + SHIFT + N: new layer 
CTRL +  J: duplicate layer 
  
Introduction to Tools 
Photoshop features many tools with diverse functions. However, in this lesson we will only 
focus on the most essential tools to us. 
  
Marquee Tool:   

The Marquee tool is used to select an area for editing. You can select with a rectangle 
or ellipse selection and is useful for selecting perfect geometric shapes. Once the 
selection is made, edits can only be made inside the selected area. To invert the 
selection, right click and select “Select Inverse”.(edits can only be made OUTSIDE the 
selected area) and CTRL + D will deselect any selection. 
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Lasso Tool (L): 
The Lasso tool allows for freeform selection. The Magnetic Lasso tool will 
adhere to sharp contrasts in colour, “guiding” the selection. Hold ALT to 
subtract areas from the selection and hold SHIFT to add areas. 

Magic Wand (W):  
With the Magic Wand, you can select areas that have a common colour. This is 
especially useful if you would like to change the colour of a relatively solid area of 
colour but it has an uncommon shape. Ex. The sky behind the leaves of a tree, dirt 
between pebbles on the ground. 
  
Once the Magic Wand is selected, in the toolbar, there is a setting called Tolerance. 
The Tolerance determines how strict the Magic Wand will be when it selects pixels of 
a similar colour. For example, if you click on the whitest area in a black to white 
gradient, a tolerance of 0 will select only the white pixels you clicked on. A tolerance 
of 20 or 30 will select some of the grey areas. Higher tolerance values make the Magic 
Wand less “picky.” The maximum value for Tolerance is 100. 
  

Crop Tool (C): 
The crop tool adjusts the canvas size of your image. You can make a new crop 
selection, or enter the exact size in the crop tool bar at the top of the screen (only 
active when the crop tool is selected). Hold SHIFT while resizing the crop box to keep 
the same aspect ratio for the new area. In the toolbar, you can also set a new aspect 
ratio to crop to. 
  

Move Tool (V):  
The move tool allows you to move and transform the currently selected layer. If a 
selection is active, it will only move and transform that selection instead. The move 
tool will only move the current layer, no matter where you click. To be able to select 
and move directly from the canvas instead of in the layers, check the Auto-Select box 
in the toolbar. 

   
Transform (CTRL + T): 

To transform the selection, use CTRL + T. From here, you can move, rotate, and resize 
the selection. Right click to see more options as well. Hold SHIFT while resizing to 
keep the proportions. Use the arrow buttons to move more precisely. Press ESC to 
cancel the transformation or ENTER to confirm it. 

  
Brush  Tool (B): 

Used to draw! There are lots of brush settings that can be adjusted to mimic different 
kinds of traditional brushes or to create patterns. (ex. pencil, inking, pastel, 
watercolour) You can also download brushes from the internet. Working with a 
drawing tablet greatly enhances the use of this tool. 

  
Hold SHIFT to draw perfect horizontal and vertical lines. 
Use the { or } keys to adjust the size the of the brush. 
Right click to quickly access your brushes and some brush settings 
  

Clone Tool (S): 
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The clone tool is very important with working with textures. It allows you to 
“clone” one area of an image to duplicate it elsewhere. To select the cloning 
source, hold ALT and click. Then you can use source to edit another area. 
Right click to change brush settings like size and hardness. Soft brushes can 
help make the brush look more natural. 

  
Eraser Tool  (E): 

The eraser tool works exactly like the brush tool, except it erases! Different brushes 
can create different effects, and the eraser brush settings can be edited just like the 
Brush tool. 
  

  

Adjustment Layers 
Adjustment layers are non-destructive layers that can be used to adjust the colour 
and tonal quality of the image. To create a new adjustment layer, simply click on 
the respective icon and you will be prompted with the type of adjustment layer you 
would like to make. 
  
There are many types of adjustment layers: 
  Brightness and Contrast: adjusts the tonal range of the image 
  Levels: adjusts the shadows, midtones, and highlights of the image 
-Curves: can adjust the tonal range of the image very precisely 
-Hue/Saturation: adjusts the hue & saturation of the entire image or specific colours 
-Color Balance: changes the mixture of colours, brings out or lessens certain colours 
-Gradient Map: converts the grayscale range of the image to have a gradient fill 

  
Be careful when applying Adjustments, it is often tempting to overuse these layers. 
Subtlety is often key, and if they are too strong, the adjustments can make an 
image look “synthetic”. Experiment with the settings and even the blend modes of 
the adjustment layers to achieve the most successful image. A useful tip is to flick 
the adjustment layer visibility on and off to see if your image has improved or not. 
  

  
Filters 
Photoshop filters can be accessed from the top menu bar. From there, you can pick from 
many kinds of filters such as Blur, Distort, Stylize, etc. Each filter also has multiple settings to 
adjust. Experiment is key! Finally, filters can be applied more than once to strengthen their 
effect. 
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Some common filters: 
       Gaussian Blur: blurs the image by an adjustable amount 
       Add Noise: applies random pixels to the image, can simulate a more realistic look 
       Sharpen: improves a selections clarity   
  
Mask Layers 
A mask layer is a layer that modifies the visibility of the layer it is attached to. To create a 
mask make sure you are on the layer you wish to mask, then click the mask icon in the dialog 
box. Notice that when the mask layer is selected, the foreground and background colours 
automatically switch to black and white. The mask layer only reads in grayscale, white = 
visible, black = invisible, 50% white = 50% visible. Using this feature, you can finely tune 
where exactly you want your layer applied to the image. 

  
Ex. if you are editing a mask applied to an adjustment layer, you will be editing what parts of 
the image the adjustment layer affects. If you paint in black on the adjustment layer, those 
parts of the image won’t be affected, and if you paint in white, the adjustment layer will 
apply. This is useful if you only need to edit parts of an image, like making a ground texture 
brighter but keeping the sky the same colour. 
  
  
Exercise: Collage Self-Portrait 

1. Find 5-10 photos you could use in your self-portrait. Be creative! Find images of 
people, animals, nature, etc. 

2. Create a new file(File > New) 
1. start with a 1920 x 1080 canvas, you can always crop it later 
2. 72dpi 

3. Import all your photos (File > Place) 
1. Click on the eye icon in the layers panel to hide the photo layers 

4. Open a picture of yourself if you want for reference, or just use your imagination! 
5. Use the selection tools (marquee, lasso, magic wand) to “rip up” the photos to get the 

parts you want 
6. Use the move tool (V) to move the pieces around 
7. Once you are finished, save your photoshop file as a .psd so you can edit it later 
8. Then, go to File > Save As.. and pick .png 
9. Done! 

  
Import Photoshop Document into After Effects 
Photoshop documents can be imported into After Effects while retaining the layers from the 
.psd file. This allows you to animate layers separately. For example, if you have created a 
scene of a car driving on a road in photoshop, since the car is on a separate layer from the 
rest of the image, in After Effects you can simply animate the car moving across the image. 
As well, the layers can retain the blending modes and layer styles from Photoshop, so the 
image will remain unchanged when importing into After Effects. 
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Graphics 3 / Instructors: Kahentawaks Tiewishaw & Ray Caplin 

Intro to Blender 
Making sense of the interface - Basic navigation and selection. 

 

 
Teaching Days, Time, & Length 
Friday July 13th, 1:30PM — 1HR 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1YsDS6K6JXLgVqlgr3TyeDct-vHfNhYz4TObh
ohfMjMo/edit?usp=sharing 

An example of what Blender can do, Operation Barbershop: 
- https://www.youtube.com/watch?v=mN0zPOpADL4&t=3s 

 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.79), enough to foresee 
wrong keystrokes that the participants might make. The instructor should also be familiar 
with the basics of modelling techniques in Blender. 
 
Participant Prerequisites 
The participants should have very little knowledge of the Blender interface. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender Version 2.79 
Plastic Gluon 
 
Objectives 
Learn the Blender tools and be able to model a very basic object for their games. Understand 
the Blender interface, navigation, and selection. 
 
Vocabulary 
Splash screen, viewport, outliner, mode menu, timeline, orthographic, perspective, navigation, 
selection, manipulators.  
  
References 
Blender website: 

- http://www.blender.org/ 
Blender Tutorials: 

- https://www.blender.org/support/tutorials/  
- https://www.blenderguru.com/tutorials/blender-beginner-tutorial-series   

 

 
Intro to Software: Blender 3D 

The production of a character requires several steps: concept, modeling, UV mapping, 
texturing, rigging, animating, and rendering.  All these steps can be done using the free and 
open source 3D software Blender. 

Show some examples of films and images made in blender: photo real, stylized and abstract. 
Other examples of common software used in the industry: Maya and 3DS Max. The interface 
we will set up will have a similar navigation to those and to Unity, the game engine we’ll be 
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using, to ease your way into learning those if you ever were interested.  

 

Basic Blender Interface 

The interface for Blender is very intimidating at first glance. There are many different panels 
and tabs on the screen that all do different things. Fear not! By the end of this workshop you 
will have an idea of what most of them are for.  
 
Splash Screen 
The splash screen is the very first thing you see when opening Blender. It contains useful 
information such as… 

- Version Number 
- Recently Saved Files 

 
Viewport 
The viewport is the main area of the screen, it it you will find: 

- grid 
- mesh 
- light 
- camera 
- 3D cursor ( a marker or a placeholder for things) 
- Toolbar panel (left) (T to show or hide this panel) 
- Properties panel (right) –display options are in properties panel (N to hide/show this 

panel) 
- -  X, Y, Z axes: X and Y are like the familiar Cartesian plane we’ve all seen in math 

class. X and Y represent horizontal and vertical directions. In 3D however, there is a 
third axis: depth. The Z axis completes the third dimension, which goes up and down, 
perpendicular to the Cartesian plane. 

- IMPORTANT: Unity’s axes are different than Blender’s in the fact that Y is up and 
down, while Z goes into depth. 

- Tab to toggle between object and edit mode. Object is to move around the whole 
mesh as is, while edit is to move selected parts of it; to change the mesh itself. For 
now, we remain in Object mode. 

 

Outliner 

- shows you everything in the scene 
- quick selection of various elements 
- shows hierarchy, layers of elements  

 
Mode Menu 

- texture paint 
- weight paint 
- vertex paint 
- sculpt mode 
- edit mode 
- object mode 

 
Timeline 

- for animation 
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- show scrubbing back and forth 
- To revisit later, when learning about animation (not too detailed here!) 

 

Setting up Unity/Maya-style navigation 
 
Setting up our 3D navigation for it to match Unity and Autodesk Maya, one of the most 
used 3D imaging softwares in the videogame industry, without conflict with the Blender 
shortcuts.  
The workshop leaders may want to do this in advance, or explain it to the participants so 
they can set it up the same way at home.  
 
In the Blender User Preferences (Ctrl+Alt+U), under the Input tab, the Interaction presets 
(on the left)  can be changed to Maya. This will change the selection behaviour, like 
selecting with the left-mouse button rather than the right.   
The Key Configuration presets (on the right) should be left untouched as the Blender 
preset, to be able to refer to them when watching tutorials for instance. To be able to 
navigate in the Viewport the same way you would in Unity or Maya, while maintaining the 
typical Blender shortcuts, we need to change the camera view settings manually.  
 
Change Camera View Settings 
 

- Under 3D View > 3D View (Global);  
- Alt + Left mouse button:  rotate view 
- Alt + Middle mouse button: move view 
- Alt + Right mouse button: dolly view 

 
Careful! While scrolling the mouse wheel dollies (zooms) in and out, Alt+Mouse wheel 
scrubs the animation timeline.  
 
Change Shortcuts 
 
Then, to avoid conflict with the other typical shortcuts (shortcut assigned twice): 
Under 3D View > Mesh; 

- Click the arrow next to the first Loop Select menu and change Press to 
Double-Click.  

- Similarly, under 3D View > Weight Paint, the first Weight Gradient menu must be 
changed from Press to Double-Click.  

Similar action should be done if there is another conflict of shortcuts in another editing 
menu.  
Remember that these changes will remain during all mesh editing operations.  
 
Remember to SAVE your User Settings at the bottom of the page when you’re all done.  
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Views: Orthographic and Perspective 
What’s the difference between orthographic and perspective views? Put simply, 
perspective view uses foreshortening when displaying an object , while orthographic 
does not. Perspective makes judging relative distances difficult while modeling an 
object. 

- Perspective: Foreshortening makes it difficult to judge the real size of things. 
- Orthographic: No foreshortening means the size of everything on screen is accurately 

represented. 
- Switch Between Orthographic and Perspective views by pressing Numpad 5 

 
Orthographic Numpad Shortcuts 

- numpad 1: front view 
- numpad 3: right view 
- numpad 5: switch between orthographic and perspective views 
- numpad 7: top view 
- numpad 9: bottom view 

 
Note: check the top-left corner of your window for the view you’re in!  
As well, the keys 2, 4, 6 and 8 help to rotate the view around in increments. With this you can 
achieve a Left view easily if needed, starting from the front view.  
 
Splitting/Joining Views: 
This will become more useful when you are doing things which require you to see more than 
one view. For example, when we get into UV mapping, you’ll want to see your model and the 
UV Editor. 
  

- Split: 
-  On both the bottom left and upper right corner of each window there are cross 
hatched areas. Drag them to split views 
-  You can split as many times as you need, but don’t split it too many times or you 
might get confused! 

 
- Join: 

-  If you’ve split too many times or simply don’t need the extra windows anymore, 
Grab that same corner and drag it towards the other window. 
-  An arrow will appear; Blender would like to know which way you want to collapse 
the window. It points to the one you will be taking away. Move your mouse in the 
other direction to change the direction of the arrow. 
-  Let go of the left mouse button and you have joined your windows. 
Another way to do this is to hover the mouse at the intersection of two views and 
select Split Area or Join Area, then move the mouse to choose which way to split or 
join, and confirm by left-clicking. 

 
Other Screen Layouts 
Blender also has a lot of screen layouts built in that you can choose from depending on what 
kind of task you are working on. Those layouts are also customizable, and you can make 
some new ones of your own, so once you  get a bit more comfortable with the software it 
might be something to try out.  
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Viewport Shading 
Viewport shading controls the way your object is displayed. The options in this menu 
are: 

- rendered 
- material 
- texture 
- solid 
- wireframe 
- bounding box 

 
When modeling the most useful viewport shadings are solid and wireframe. This is because 
it makes the model itself easier to see. 

- to toggle between solid and wireframe, push the Z key.  
 

 

Selection, Navigation, and Manipulators 

In order to acquaint participants with navigation, lets practice using the famous blender 
monkey (names Suzanne!) To add Suzanne to the scene: 

- Shift + A to open the Add menu 
- select Mesh > Monkey  

 

Selection & Navigation 

- Select Suzanne using the LMB 
- The A key is for both selecting, and deselecting everything in the scene 
- Alt + LMB to rotate around an object 
- Alt + MMB to pan around an object 
- Spin MMB to zoom in and out 

 

Axes and Widgets 

The colored lines you see on the grid correspond to different directional axes. The colors also 
match the arrows that appear on a selected object. These arrows (or widgets) can be used to 
apply manipulators. (Covered very soon!) 
 
Blue is the Z axis = Up and Down 
Red is the X axis = Side to Side 
Green in the Y axis = Front to Back 
 
IMPORTANT NOTE: In Unity the Y axis is Up and Down. 
 

Manipulators 

There are three manipulators in Blender: 

- Scale: make something bigger or smaller by pressing S (Scale) 
- Rotate: rotate objects by pressing R (Rotate) 
- Translate or Move: move something by pressing G (Grab) 

 
These three tools have easy-to-use visual manipulators (or widgets) that can be found on the 
header, traditionally at the bottom of the viewport. Those are the little arrows on the object 
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that are color-coded the same as the axes. 
 
Alternatively, if you would like to learn how to move objects around without the help 
of widgets, you can press G and then type the letter of the axis you would like the 
transform to follow  (X, Y or Z). You can then either move the mouse around and 
confirm with left-click, or even move the object precisely by entering a numerical value before 
left-clicking to confirm. The same kind of logic can be transferred to the Scale (S) and Rotate 
(R) manipulators. These kinds of shortcut-based manipulations, while initially harder to get a 
hang of, are part of why many 3D artists choose to use Blender professionally.  
 
 

Note: As we are about to start working, here is a reminder: 3D software is prone to 
crashing. 
 
Save often! SAVE. SAVE. SAVE!  
Even better is to have a good naming scheme, understandable by you and by others on 
your team. 

 

Make a Snowman 

1.  Shift + A to add an object. All sorts of objects are there, some simpler than others.  

2.  Hover the mouse on Mesh; Choose UV Sphere 

3.  Go into Front View (1) 

4.  By default, the translation (or grab) manipulator should be shown. Move the sphere 
where you like with the help of those arrows.  
Note: If the widget is not showing, you can make it appear by clicking on its 
designated enable/disable icon on the header (traditionally under the viewport). 

5.  WITH WIDGET: Duplicate the sphere (Shift + D) and instantly left-click to confirm. 
This places the sphere down at the same place at the first, and lets the translation 
manipulator appear. Use the arrows to move the sphere on top of the first one.  

WITHOUT WIDGET: Duplicate the sphere (Shift + D) and instantly press the Z key. 
This should lock its translation into moving up and down, for the moment. Left-click to 
confirm the height at which you’d like it to be, on top of the first sphere.  

6. Scale it down a little bit (S) and adjust its position again with the translation widget, 
or by pressing G for grab, then the Z key to lock the translation in that direction, and 
confirm by left-clicking.  

7.  Duplicate it once more (Shift + D), doing the same manipulations as in step 5 and 6 to 
place the third sphere on top of the two others.  

8. Check side views (3) and top views (7) 

9. Orbit around to see it better (Alt+Left Click and drag). 

10. DONE! 

11. Save scene: Save as snowman.blend to your USB key or desktop folder. 
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Graphics 4 / Instructor: Kahentawaks Tiewishaw 

Intro to Blender Modelling 
The essential basics of 3D modelling in Blender -  
Why we love edge loops and modifiers.  

 

 
Teaching Days, Time, & Length 
Tuesday July 17th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1DUUex6NOiVSQD2albX2xWf8V63S8diQMb
h6slvr3evQ/edit?usp=sharing 

 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.79), enough to foresee 
wrong keystrokes that the participants might make. The instructor should also be familiar 
with the basics of modelling techniques in Blender. 
 
Participant Prerequisites 
The participants should have very little knowledge of the interface (camera controls, 3D 
cursor, nurbs vs. polygons, T-pose) They should also have completed the previous snowman 
exercise.  
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender 2.79 
Plastic Gluon 
 
Objectives 
Learn the Blender tools and be able to model a very basic object for their games. 
  
Vocabulary 
Mesh, vertex, edge, face, normal, move, rotate, scale, selection, extrusion, mirror, subdivision 
surface, front view, top view, side view, modifier, 3D cursor, X, Y, Z axis, snapping. 
  
References 
Blender website: 

- http://www.blender.org/ 
Modelling Tutorials: 

- https://www.youtube.com/watch?v=guu2UuM4-Go  
- https://www.youtube.com/watch?v=Dut5qb3KR74  

 
 

Meshes 

 
The term mesh, here polygon mesh, is applied to a collection of vertices, edges and faces that 
shape an object in a 3D environment. It’s the most common way to make 3D assets for 
games. We will learn about vertices, edges, and faces, and their purpose in 3D modeling. 
Finally, we will be modeling a more advanced version of the Snowman from the previous 
Blender lesson. 
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Mode Menu 

 
In the header, you can access a menu to different editing modes in Blender.  Click on 
the “Object Mode” menu to see different options: Edit mode, Sculpt mode, Weight 
paint mode… Toggle between those modes with Tab, specifically between the two last used 
modes. 

 

Edit Mode 
 
Let’s go explore the Edit mode. This is the mode that allows us to view and edit vertices, 
edges and faces, amongst other things. Think of vertices as coordinates, edges as vectors, 
and faces the representation of flat planes connected by those vectors.  
In the Edit mode, you can select individual faces, for instance, and translate, rotate and scale 
them at will to shape your object. You can do that with the same hotkeys we’ve been using 
before;  
G for Grab (Translate) 
R for Rotate 
S for Scale  
Alternatively, you can access those in the Tools panel (T)  
 
As you might guess, since it’s standard for software nowadays, you can use Ctrl+Z to undo. 

 

Selecting 
 
Left click to select vertices, edges or faces 
Shift + Left click to select them one at a time, for a selection of multiple 
A to select all/deselect all 
B for the Box selection. Click and drag to create a box which will select everything inside of it. 
C for Circle selection. Click and drag to “paint” what you want to be selected.  
 
Vertices, Edges and Faces 
 
Vertex (plural vertices):  A point, or position in 2D or 3D space. It’s each angular point of a 
polygon.  
Edge: Two connected vertices make an edge, similarly to a vector.  
Face: A closed set of edges form a face. Selecting 4 adjacent vertices will select the face that 
connects them. A face with three edges is a Triangle and a face with four edges is a Quad 
(Quadrilateral).  
Faces with five or more (so-called N-gons) should not be created in Blender; try to create 
objects with Quads (4 sides) as much as possible, since objects made only with quads are 
much easier to edit and shape into other shapes.  
 
Multiple mesh selection methods 
 
Multiple selection tools are provided in Blender to select parts of the mesh. The simplest of 
these tools can be found in the viewport header. By default it's set to selecting the vertices. 
You can use this menu to switch to edge or face select mode. 
 
Now, you might want to have all of these modes or some of them available to you... You can 
do that by Shift-clicking 2 or all the modes. Avoid this as you’re starting out; generally 
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speaking, you should be able to work with only one mode at a time, and it’s going to 
be much less confusing.  
 
Learn your Hotkeys! It allows you to perform simple tasks much faster. 
Tab: Toggle between Object and Edit mode, or between the two last used modes.  
Ctrl+Tab → switch between selection method (vertex, edge or face selection) by clicking or 
with 1, 2, 3 
When in doubt, check your cheat sheet!  
 
Transformation 
 
In this part, we will be looking at different tools that help us transform our meshes into new 
shapes and objects. 
 
Scale, Rotate and Grab 
 
Either through the mesh tools part of the Toolbar (T) or just like in object mode, with G for 
grab/translate, R for rotate and S for scale. 
 
Snapping 
 
Shift+Tab enables snapping (by default in increments, following the grid) 
Or click on the header’s magnet icon to switch snapping off and on. 
Snapping helps with accurate transformation on the grid. Try “front view”, Left click inside the 
little white circle that connects the translation arrows and move the object around. You will 
see that it moves and snaps to the grid. 
 
Snapping is NOT only limited to the grid!  
On the snap menu, choose Increment for the grid, Vertex to snap to one vertex, Edges, Faces 
or Volume for the entire object.  
 
Example: Enable Vertex snapping. Select one vertex and press G to grab it. You’ll see how it 
immediately snaps to other vertices, even if locked to an axis (snapping to that vertex’s 
position to that axis). This can be very helpful for precise modeling. 
 
Ctrl+Shift+Tab is the hotkey to switch between these modes of snapping.  
Even when snapping is off, you can always hold Ctrl when moving an edge or vertex and 
activate snapping for that specific move.  
 
Duplicating and Deleting 
 
Duplicating different parts of a mesh is the exact same process as duplicating in Object mode. 
You can duplicate either from the Toolbar (T) or hit Shift+D.  
Careful that you are selecting the ENTIRE mesh (with A  for the entire object or L for linked 
polygons), else you will duplicate only your selection.  
 
Deleting is done by hitting X, or Delete, and then confirming. Unlike Object mode in which you 
only have the option of deleting the object, in Edit mode you are given the option to delete 
vertices, edges, faces… or even dissolving them, which removes that part of the geometry 
without leaving a hole in the mesh.   
 

Adding objects to a mesh 

 
Shift+A to add a mesh, same as in Object mode.  
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Immediately after adding an object, you're given the option to edit that object on the 
left hand side menu. This menu is only available immediately after adding the object! 
If you click away accidentally, you can access it again with F6, which brings up the 
specific options of the last used tool. Suppose you hit S, you can hit F6 again and 
bring up the scale menu and fine tune your object more! 
 
The difference between adding a mesh in Edit mode in comparison to Object mode, is that 
now those new polygons are part of the same object. If I go back in Object mode, the two 
shapes will be manipulated at the same time; scaling, rotating and translating together. This 
is a way to combine (join) multiple objects.  

Now you have separate meshes inside of one “object”. if you press A, you will select 
everything. How to select only one of the two? click a vertex/edge/face and press CTRL + L for 
Linked.  

 

Extrusion 

 
The extrusion tool allows you to extend parts of your object to create new forms. It's available 
through the toolbar, Extrude region or Extrude individual, or you can use the hotkey E.  
 
Should you extrude by region or individual?  
Let’s say you select 4 faces that are next to one another. If you extrude per region, they will all 
extrude together, as one extension of the object. If you extrude individual, they each will 
extrude a face surrounded by other faces, and point in separate directions.  
As always hit Ctrl+Z to Undo. 
 

Modifier 

 
Modifiers can be found in the Modifiers tab of the Properties window, typically located on the 
right.  
Its menu is indicated by the little wrench icon. Those are powerful tools for creating objects 
fast.  
 

Adding a Modifier 

 
By clicking Add Modifier, we find many options categorized under 3 groups: Generate, 
Deform and Simulate. For this lesson, we'll explore only three useful modifiers: Mirror, 
Subdivision Surface and Array. 
 

Mirror 

 
Hit Tab to switch to Edit mode. Right now, we only have a cube. For now our modifier doesn’t 
seem to have done anything, but if we move our cube, we can see the mirrored object as well. 
Because X is checked on the mirror options, it is perfectly mirrored along the X axis. We can 
try checking all 3 axes. We start seeing the mirrors of our object along all axes.  
If you click the Clipping option (especially for a human face) it allows you to restrict the 
transform past the central axis. This allows you to keep things locked and prevent having 
holes in the center of your model.  
 
Note: If you're working with the clipping option enabled, remember to remove the face that is 
in the middle of the model, because we do not want any interior faces separating the inside of 
our model.  
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Careful! Blender forgets what the shape was like once the transform is confirmed and 
clipped on the center axis. You won’t be able to pull the shape out!  
 
Array 
 
This modifier creates instances placed at an offset from one another. Instances are different 
than duplicates in the fact that they are not separate objects from the original mesh; they 
inherit all of its transformations.   
Count: How many instances of the mesh are generated 
Constant offset: Offset as calculated by the grid 
Relative offset: Offset as calculated by the object 
 
Subdivision 
 
The Subdivision Surface Modifier is used to split the faces of a mesh into smaller faces, giving 
it a smooth appearance. This modifier is applied to entire object; it might not be what you 
want to use for smoothing only a section of your mesh, depending on what you are modeling.  
View: The number of subdivision levels shown in the 3D View.  
Render: The number of subdivision levels shown in renders.  
You might want the subdivision level to appear as different in the Viewport than in Rendering 
for optimization purposes.  
 
Modifiers can be deactivated/hidden with the eye icon on top of them, and can be deleted by 
clicking the  X located at the top right of their individual windows. They are never fully 
confirmed and applied until you click Apply, after which the changes are permanently part of 
the model.  
 

 

Let’s get to work 

Now that we have some basic information about modeling in Blender, we will be modeling an 
advanced version of the Snowman done as an exercise for the previous lesson.  

This exercise will simulate the procedure for creating objects from our Technical drawings. 
You will learn how to import and set up technical drawings as well as how to model basic 
shapes from them. 

 
 

NOTE: For this lesson participants should open the provided work file from Plastic Gluon 
(Course Assets > Course Material > Graphics > IntroToBlenderModeling.blend) and follow 
along with the slides. 

 

 
Setting up Technical Drawings 
In order to be able to model easier in blender from our technical drawings, we have to bring 
them into Blender first and set them up as background images to use as a reference. We 
have the concept, as well as the front and the side view. We will be loading these images up 
into Blender and setting them up to be view specific. What it means is that you will set up 
each view to a specific background image, so that each time you toggle into a specific view, 
the background image will also change.  
 

- Switch to front view (hit 1 on Numpad) and get out of perspective mode (hit 5 on 
Numpad).  
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- Hit N to bring up the properties panel and go to the Background Images 
section.  

- Click the box beside it to activate it and toggle down the arrow.  
- Click Add Image. A small box appears underneath.  
- Toggle down the new arrow and click open to load a new image. (Try to keep 

your blender files and images near each other on your computer, and named clearly 
with our convention) 

 
Select the Snowman_RefFront.png from the directory and click open. It immediately appears 
in the front view. If you switch to other views like side view (press 3) or the camera view 
(press 0), you will still see it. 
Go back to the Front view by pressing 1.  
  
Let’s look at some of the options that are available to us through the Screen Properties panel 
(N) to modify our background image.  
First option is Opacity that by default is at 0.5. Lowering the opacity helps to better view the 
grid. You can use it as a slider, or enter a numerical value. The number that you choose for 
transparency is based on personal preference.  
Next option is Size. For now we will leave it at 10, the default number.  
Next are X and Y values. Again, you can change their number by sliding or entering a new 
number. Let’s increase the value in Y to approximately 4.6, so that the bottom guideline on the 
picture matches the bottom of the grid, with our snowman sitting on top of the grid.  
 
The next thing we’ll be looking at is the Axis option which by default is set to All Views. 
Change the Axis to Front for the Front view. In order to change the axis for the Right view, 
first we have to click on Add Image to upload our side view image to Blender. Add the other 
image, Snowman_RefSide.png, and go through these steps again.  
 
After uploading this image we could also split the workspace into 2 parts (Front and Side 
view) as this is the logical way to work with technical drawings.  
 
The Size of a model has to be decided based on where it will be used. In the case of making 
video games, it is very important that everyone agrees on a scale that will be used 
everywhere. You will use this to approximately set the size of your technical drawing on 
Blender.  
For example, 1 Blender unit = 10 cm.  
 
Make a new save file out of it. IMPORTANT to SAVE SAVE SAVE all the time! 

 

Initial Setup 

 

Since we’ve already seen how to add and move sphere meshes, and because we have a lot 
of things to cover in this lesson, we will provide you with the base to work on for the following 
steps.  

Here we have the basic file that we are going to use in this lesson. The workspace is already 
subdivided in 2 views (front and side), the technical drawings are already in place, and they 
are aligned with the base of the model (the 3 spheres).  

 

Snowman: Nose 

 

First, we are going to make some facial features for our snowman.  Let’s start with the nose. 
In our case, the nose is simply a cone. Before creating a cone, we want to make sure it will be 
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created outside the existing meshes so it is easier for us to see and manipulate. We 
will do this with the 3D cursor, as the workspace is currently made so that new 
meshes appear where that 3D cursor is.  

To place the 3D cursor in Blender, simply Right click where you want the cursor to be.  

Note: Remember that the space is in 3 dimensions! If you ever want to place it precisely, you 
should do that in an orthographic view, so to not lose it in the depths of the viewport.  

Next, press Shift + A to add a new mesh and choose Mesh > Cone.  

 

As you can see, our cone needs to be rotated to be in the same orientation as our nose. Press 
R to rotate the cone. For this manipulation, we want to rotate the cone 90 around the X axis - 
the red line. To do this, press R to rotate, press X to lock the rotation on the X axis, and enter 
90 on the numpad. The cone is now pointing in the right direction.  

We now need to move the nose into place and to resize it. Switch to the Right view by 
hovering your mouse over it and move (G) the base of the nose to the edge of the face. 
Afterwards, switch back to the Front view and center the nose on the face of the snowman.  

 

Our nose is in the right place, but it’s still too big, so we’ll need to resize it. Let’s scale it with S. 
In front view we want to modify only the base of the cone which is now on the XZ plane. To 
scale only the XZ plane, start scaling either the X or Z axis (red or blue line) and press shift+Y 
once. This will lock the Y axis and allow you to scale only the XZ plane, which is what we 
want. Scale the nose to the appropriate size.  

The base of the nose is the right size now, but we still need to make the nose slightly shorter. 
To do this, switch back to Right view, press S and drag the green line (Y axis). Place it into the 
right position (G).  

Save the document with Ctrl+S. 

 
 
 

Snowman: Eyes 

 

We will start by creating one eye, and mirroring it to create the other.  

To create the first eye press Shift + A and choose UV sphere. The sphere is the shape that 
we want, however it is too detailed for our needs. In video games it is a priority to avoid 
unnecessary polygons. To lower the polygon count (or poly count) go to the mesh creation 
menu appearing under the T menu as you created the sphere, and lower the segments to 6 
and rings to 10.  

Scale (S) first, then move (G) the first eye to the desired location. To scale the object 
proportionally in all directions, click inside the white circle when scaling. 

Press Z to enable/disable seeing the object in Wireframe, in transparence with the 
background image behind it. You can also do that from the header.  

 

We have now created the first eye. However we still need the second one. To mirror the first 
eye, go to the Modifiers menu (wrench icon), click on Add Modifier and choose Mirror. In the 
properties, choose X as the axis, and in Mirror Object put Cone. This will mirror our eye to the 
other side of the nose, which is exactly what we want. Click Apply to apply the modifier. 
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Now that we have all of the facial features, we want to group them into a single 
convenient mesh, so they move and transform together. To do this, Shift+Select all of 
the objects (Eyes + Nose) and hit Ctrl +J (Join). 

 

Snowman: Arms 

 

Now that our snowman has eyes and a nose, we will create his arms. To avoid creating 
unnecessary meshes, we will do this by modifying our existing torso mesh. Select the torso 
and press Tab to go to Edit mode. Pick Face as the selection mode and select 4 faces closest 
to the arm hole in the side view. 

 

Note: You’ll notice that in Blender, only one object at a time can be edited in Edit mode. Keep 
this in mind as you’re modeling, you might have to go back to Object mode to switch object 
selection, or select it through the Scene Graph or Outliner.  

 

As they are still selected, switch to front view and hit E to Extrude these faces as a region 
(extruded as a group). Next, move those faces into the approximate position of the arm’s end, 
where the hand would be. You can change the angle of the faces by rotating them, and you 
can also scale them if you want.  

 

Now that we have a rough shape of the arms in position, we need to create the elbow bend. 
To do this, we first need to add an Edge Loop. An edge loop is basically a contour line (a set 
of edges) that goes around a shape, through two other edge loops, and often reconnects with 
itself.  

To create an edge loop hit Ctrl+R and hover your cursor over the region where you want to 
create it, between the shoulder and the end of the arm. Notice the purple line. This is where 
the edge loop will be created. By default, it is at the center of your shape, and stays there until 
you move the mouse and/or confirm it by left-clicking. You can change the number of edge 
loops by scrolling with the middle mouse button, however in our case we only need 1. 
Left-click to confirm.   

 

Notice that Blender automatically selects the newly created edge loop. You can always 
reselect an edge loop by holding Alt and double-clicking on one of the edges forming the 
loop (This is a custom shortcut considering the Maya-style navigation we set up. Normally, 
the shortcut is Alt+Single Left click). Move the edge loop into position to form the elbow. 

 

Now select all of the faces forming the forearm. To do this fast, press the button on the 
header to turn off Limit Selection to Visible and press B for the Box selection tool, with which 
you can click and drag to make a box selection.  

Once selected, add a Mirror modifier. The faces will by default mirrored as compared to the 
center of the sphere, which is what we need. Alternatively, you can also create the other arm 
manually, but then it might not be identical. Hit Tab to come back to Object mode. 

 

We have now finished modeling the snowman!  
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Tip:  A neat trick when navigating around the viewport is to refocus on objects before 
zooming in on them. This helps not getting lost in the 3D view, and might be useful 
especially if you haven’t activated Rotate Around Selection in the Blender User 
Preferences, as suggested in the Intro to Blender class. To do this in Object mode, 
either press the period key (.) on the numpad, or position your cursor on the object or 
place you want to focus on and press Alt+F.  
 
 

Optional Exercise: the briefcase 

Note: This exercise is meant to further practice using the tools learnt above, but the 
instructor may choose to skip it if there is not enough time for the participants to finish it in 
class.  

 

As an additional exercise, we will create a briefcase for our snowman.  

Create a cube mesh with Shift+A (Mesh>Cube) and resize it to fit the dimensions of the 
briefcase as indicated in the technical drawings. It’s important to resize the mesh in Object 
mode for this stage, in order to keep the center point at the center of the mesh.  

Scale it in X and in Y. (S to Scale then hit X or Y to lock it in that axis. Move it around, again, 
with G) 

 

Now that we have the basic shape of the briefcase, we are going to create the handle. In 
order for the handle to be perfectly symmetrical, we are going to cut the briefcase in two, 
create half of the handle and apply a mirror modifier.  

First, in your Right view, go into Edit mode (Tab). Next, add an Edge Loop (Ctrl+R) that 
divides the briefcase in two, and delete one of the halves. To delete something in Edit 
mode, select the objects you want to delete (here, the faces of one side of that briefcase) 
and press X or Delete. Once pressed, Blender will offer you the option to delete Vertices, 
Edges or Faces. Since we want to delete the half completely choose Faces.  

 

Why Delete Faces, and not Dissolve Faces? Dissolve will remove the geometry and fill in 
the surrounding geometry, to keep the model closed. For this operation, we want the 
briefcase to be empty, with no face cutting through the two halves we’ll get by mirroring 
the object. This is why we want to delete.  

 

In order to create the handle, we first need to switch to top view (7 on numpad). 
Afterwards, we will need to Inset (I) the top face to create the base of the handle. Once you 
pressed I, move the mouse to decide the size you want the inner face to be. You can also 
resize it after confirming by scaling it the way we usually do, by selecting and pressing S. 
You can also resize the newly created face by selecting the different edges and moving 
them with G to fit the position on the technical drawing. 

 

Now, select the newly created face, and switch to the Right view. We will Extrude the face 
so it stops exactly in the middle of the briefcase, where it would connect with the other side. 
To do this, we first need to activate snapping. Turn on snapping (Shift+Tab) and set it to 
Vertices. Next, extrude the face (E), confirm the extrude, rotate it -90 degrees, and snap it to 
the middle of the briefcase by hovering over one of the vertices of the middle of the 
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briefcase. After this is completed, you can move around the viewport out of Side view 
and Delete the face by hitting Delete>Face.  

We now need to make sure the handle is flat, so to be able to hold it. Back to the 
Right side view, create an edge loop (Ctrl + R) to divide the handle and move that 
loop to give that 90 degrees angle we want.  

 

We now have half of our briefcase. To create the other half, select all of the contents of the 
mesh by selecting one face and hitting L (linked), and add a Mirror modifier with the axis 
set to Y. 

Exit Edit mode (Tab), and move the briefcase under the snowman’s arm (G). Press Alt+Left 
click to rotate the view and admire the results of your work! 

You’ve done it! 
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Graphics 5 / Instructor: Ray Caplin 

Simple Character Modelling 
Begin modelling a basic character in Blender using technical drawings. 

 

 
Teaching Days, Time, & Length 
Tuesday July 17th, 3:15PM — 1HR 30M 
 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.78), enough to foresee 
wrong keystrokes that the students might make. The instructor should also be familiar with 
the basics of modelling techniques in Blender. 
 
Participant Prerequisites 
Students should have basic knowledge of modelling in Blender and experience modelling 
simple objects. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint 
Black or white board with pens or chalk available 
Individual computers for each student with Plastic SCM and Blender installed 
 
Objectives 
Model a simple character that can be animated for game. Introduce topology concepts and 
strategies, and more advanced modelling techniques. 
 
Vocabulary 
Edge loops, mirror modifier, extrude, 3D curso 
 

Procedure 

Set up technical drawings as we’ve done before. Have them be centered, locked on the 
appropriate axis, with the feet sitting on top of the grid 

Software tutorials  Topology 

http://thilakanathanstudios.com/2016/09/why-do-we-need-topology-in-3d-modeling/ 

http://forums.newtek.com/showthread.php?98754-Polygon-Table-Help-Building-One 

Character Modelling: 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-1--cms-19723 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-2--cms-19914 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-3--cms-20358 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-4--cms-20547 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-5--cms-21211 

https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-6--cms-21357 
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Procedure 

Set up technical drawings as we’ve done before. 

Have them be centered, locked on the appropriate axis, with the feet sitting on top of 
the grid. If you wish, you may set your workspace to be in split into two windows, for 
Front and Side view.I personally like to switch in between both of them manually, as it keeps 
me on my toes looking at my mesh in Perspective view more often. 

  

WHEN WORKING AT HOME ON YOUR OWN PROJECTS: 
As much as possible, make a new save file with a different name (a new version) if you: 

1. Are coming back to working on the file for the first time that day. 
2. Have just finished a big chunk of progress. For instance, here we’ll make a new 

save file after finishing each major part of the body. 

 Many people have their own way of naming their files. The way I usually do it, for my 
private “work in progress” files, is like this… 

ObjectName_Version#_LastStepDone.blend 

Object Name: The file or scene name. Here, it’s Magician Boy. 

Version#: To be safe, make sure your number padding lets you keep this organised. For 
instance, if I think there will be many iterations to the file, instead of numbering my file 1 
(only one digit, goes from 0 to 9), I’ll name it 01 (two digits, going from 00 to 99) or 001 
(three digits, goes from 000 to 999). 

LastStepDone: Let’s say I’ve just modeled the feet, I’ll name that part Feet, or ModelFeet. 

From that example, to start ourselves up this time you could name it something like… 

MagicianBoy_00_SceneSetUp.blend 

Why do we do that? It’s because you want to have a backup of your work as you’re 
working, so that if you make a big mistake, that your computer crashes or that your file 
becomes corrupted, you haven’t lost ALL your work. At home, you might also want to 
periodically backup your files onto another computer, a USB memory key, an online server 
or an external hard drive. 

FOR THE WORKSHOP: 

The logic is very similar to what was just explained. The difference is that our files are all 
saved together on the repository of Plastic SCM/Gluon, which handles the version control 
(which would have been our version number). Therefore all you need to think about to 
check the file into the repository  is the Object Name and the Last Step Done. 

 To name your file, all you need to know is the Object name. 

Our current file needs only to be called MagicianBoy.blend 

 When you’re going to check the file into Gluon, the software will log the file in as a version 
under your name, timestamping it with the date and time. 

 Finally, you use the comments section to write what the last step you’ve done is, along 
with any other important changes since the last version. Something like “Feet modeling 
done, started modeling hands”. 

 

To start with a scene where the background images are already set up, use the 
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MagicianBoy_Phase01.blend file found in the Course Materials repository. 

  

The Torso 

Move the standard box mesh to the center of the body. 

Cut it perfectly in two vertically with the Edge Loop tool. 

Select the faces on the left hand side. 

Delete them. 

Select the rest of the mesh. 

Add Mirror modifier in X; you can enable Clipping if you like 

  

Go in Front view 

Start shaping the box at the hips by moving its edges at the side. 

Add an Edge loop in the middle, near the center, for the crotch space. 

Extrude all of the top faces to shape the torso. 

Extrude the face of the leg that will make the leg, leaving alone the inner face created by the 
Edge loop. 

  

Don’t create the arm yet! We’ll get there. Starting with only the torso and leg will help us 
shape the body in Side view first, before adding more detail. 

  

Add horizontal Edge loops to shape the leg and torso. 

Go onto the Side view to help shape the loops to the body. 

  

Add an Edge loop to the torso, going vertically across the side of the body. 

Grab the outer vertical Edge loops with Alt+Double click and shape the body into a softer, 
less boxy shape. 

Add another Edge loop going through the front of the leg. 

Now you can soften the inside of the leg without messing up its shape. 

  

Don’t limit yourself to only the side and front view. 

Remember that your character will be seen in 3D, from all angles. It might feel safer to 
stick to the original drawn design for details, but you can change the shape a little bit in 
Perspective view as you work to make place for a more organic design instead of 
something boxy. 
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Neat trick: 

Ctrl+E for Edge tools 

In the last section of the menu, there is Edge slide. 

  

Similarly, 

Ctrl+V is Vertex tools 

Ctrl+F is Face tools 

  

Notice how the G of Edge Slide is underlined? That’s because once you’ve pressed Ctrl+E 
to reach this menu, you can press G to access this tool. 

Its shortcut is underlined, and is usually the first letter of the word that has not been taken 
for the shortcuts of the tools above it in the menu. 

  

You can also notice that if, after using the tool, you press Ctrl+E again, the menu will be 
placed so that your mouse will hover over your last used tool. 

  

  

The Arms 

Similarly to how we modeled the legs by extruding certain faces at the bottom of the hips, 
you can model the arms by Extruding (as a region) the 4 faces closest to where the arm 
would be, and moving and rotating those new faces to where the wrist would be. 

You can then add horizontal edge loops for the elbow to be able to bend, for the shoulder to 
have enough geometry to move around as well, and for the detailing of the rolled up sleeves. 

  

Do not model the cast of his left arm (our right side), we’ll do that once we apply the 
mirror modifier at the end. For now let’s keep the model symmetrical by modeling it without 
the cast. 
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The Head 

Let’s Extrude from the neck up in Side View, first to the top of the neck/bottom of jaw, then 
Extrude again, making our new faces reach the very top of the head. 

  

Let’s add some Edge loops in between the neck and the top of the head. 

Press Ctrl+R and hover where you’d like the loops to be placed. Scroll your mouse wheel as 
the loops are still Pink; more loops should appear. Let’s put 3 loops down now. 

When you click, they should be formed, and you can still move your mouse around to set 
exactly where they should be placed on the model. Click again to confirm. 

  

Let’s add an Edge loop across the arm from the wrist going to the neck, to give us more 
quads for modeling the head. 

From here, let’s grab our vertices and start shaping the profile. 

Once you’ve shaped the profile, look at the Front view. It’s still very boxy! Let’s grab the faces 
on the side of the head and move them outwards, and start shaping the head manually. 

Use the vertices that we selected in Side View to shape the nose, and use them to shape the 
nose in front view as well. Do the same with the neck. 

Don’t forget to go back in Perspective view once in a while to adjust things as needed. 

Eventually your character is going to start looking like a human! Keep it up! 
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Note: For this character, we won’t need to model the ears, as they will be hidden by his 
hair. If you wanted to make ears, do as we usually do and extrude from the faces on the 
side of the head, adding horizontal edge loops if needed, shaping the ear as you go. 

  

For the sake of this exercise, and to keep things simple, we’re not going to model the 
face; only the basic shape of the nose. The rest of the face will be painted on with the 
textures. 

  

And easy way to make facial features is to either Inset or Extrude the polygon faces 
inwards to make them cave in to the head, but this method is not very conductive to facial 
animation, so only consider it for basic models. 

  

  

If you couldn’t keep up, you can reach the current modeling progress with 
MagicianBoy_Phase02.blend 

  

  

The Feet 

For the feet, do exactly as we’ve been doing, and extrude from the bottom of the leg in Side 
view while rotating the extrude forwards as you go. Once the initial rotation is done, bring the 
tip of your next extrude to the end of the foot as seen in the Side view, rotating those faces 
upwards as happens with most shoes. 

  

Once that is done, have a look at the edges located at the bottom of the foot. Only the center 
edge loop touches the grid. Let’s fix that. 

  

First, make sure that your Snap tool is set to Vertex. One by one, select the vertices that 
should be touching the grid, press G to enter the Grab/Translation tool, press Z to lock the 
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translation vertically, and while holding Ctrl to snap this one manipulation, hover your 
mouse over one of the vertices that is currently placed on the “floor” or right at Grid 
level, and click to confirm. This should have set your selected vertex to the same 
height as the other one, placing it on the “floor”.  

  

Now, let’s add some edge loops in between the heel and the tip of the toes, to give us a better 
chance to shape the foot into something organic-looking. 

Press Ctrl+R and hover where you’d like the loops to be placed. Scroll your mouse wheel as 
the loops are still Pink; more loops should appear. Let’s put 3 loops down now. When you 
click, they should be formed, and you can still move your mouse around to set exactly where 
they should be placed on the model. Click again to confirm. 

 

 

This is where it’s important to keep your loops clean; while rotating the extrudes we made 
as we were initially forming the foot, it was important to look at the loops and keep them 
tight. You can do that by manually moving the vertices, or by scaling as you’re placing the 
loops to flatten them. This way, as you create new loops, those will stay clean too, and the 
flow of your topology will stay clean and easy to edit. We call this having good edge flow; 
it’s basically having a mesh that’s made in a clean way, where the structure can be 
understood at a glance. 

  

“The word topology refers to the geometric surface characteristics of a 3D object. 

Modelers strive for "clean" topology, typically illustrated by a 3D mesh with efficient 
polygon distribution, proper placement of polygonal edge-loops, few or no triangular faces 
(as opposed to 4-sided "quads"), and clean precise creases that minimize stretching and 
distortion.” 
https://www.lifewire.com/topology-in-3d-animation-2181 

  

Note: More resources on good (functional, optimised) and bad (messy, disorganised) 
topology can be found linked at the top of this file. 

  
http://thilakanathanstudios.com/wp-content/uploads/2016/04/topology1.jpg 

https://blenderartists.org/forum/attachment.php?attachmentid=296473&d=1390165903 
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Looking good! But if you look at the foot in Front view, it definitely does not look like a 
foot. Go in Perspective view and adjust the vertices for the foot to look more like it 
should. 

  

Before continuing with the hands, add extra Edge loops around the knees, and elbows; more 
also around the shoulders and hips. Articulations need more topology to bend properly 
without deforming the body. 

  

For the students who have more ease with Blender, here’s something to consider. 

When you’re done modeling the entire shape of the body, and want to ensure that the 
geometry bends properly once the character is to be animated, you can consider adding in 
your own triangles to the mesh, splitting the quads in two. 

Don’t use triangles unless you know WHY you’re using them, and are comfortable with 
the software. 

The most common places to put them are at the knees and elbows, to have more precise 
control on how the mesh is going to bend. More resources can be found linked at the top 
of this document. 

  
https://sites.google.com/site/facaelectrica/_/rsrc/1386790335380/topology-1/joints/ex4.jpg 

http://68.media.tumblr.com/fec2b8d3a5e7a696ba36b98a9f431129/tumblr_inline_oj0sy2wzf01qb9x1g_500.gif 

 

 

For the students who have more ease with Blender, here’s something to consider. 

When you’re done modeling the entire shape of the body, and want to ensure that the 
geometry bends properly once the character is to be animated, you can consider adding in 
your own triangles to the mesh, splitting the quads in two. 

Don’t use triangles unless you know WHY you’re using them, and are comfortable with 
the software. 

The most common places to put them are at the knees and elbows, to have more precise 
control on how the mesh is going to bend. More resources can be found linked at the top 
of this document. 

  
https://sites.google.com/site/facaelectrica/_/rsrc/1386790335380/topology-1/joints/ex4.jpg 

http://68.media.tumblr.com/fec2b8d3a5e7a696ba36b98a9f431129/tumblr_inline_oj0sy2wzf01qb9x1g_500.gif 

  

Take the time to adjust your model’s vertices to more closely match the shape of the body and 
clothing. 

For example, the fold at the bottom of the pants, the fold of the shirt tucked into the pants, or 
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the collar of the shirt… 

  

Don’t worry about adding a few horizontal Edge loops if you need them for detail; just 
be careful about vertical edge loops, as they will change the number of polygons 
we’ll have for the hands, and we want good control over that. On a model like this, vertical 
edge loops will change the amount of polygons on the entire body; we want the number of 
polygons to be balanced all over, and for detail to be relevant. Most of it will be done in 
Texturing, so don’t worry. 

  

At this point, don’t only use the technical drawings as reference, trust your own judgement for 
how things should look in 3D space. 

 

Getting closer! At this point, all that’s missing is the hands and hair. Those will be the trickiest 
parts, which is why we’ve kept them for last.  

If you couldn’t keep up, you can reach the current modeling progress with 
MagicianBoy_Phase03.blend 

  

The Hands - Set up 

Because the hands are much more difficult geometry to handle, and because  we want to be 
able to model them upright, we will use a different method of separating the mesh by 
duplicating the edge loop  

of the wrist, setting that loop down to the bottom of the grid, and once we’re done modeling, 
combining the mesh to one piece once more. For the sake of clarity, we will also work on the 
hands on a separate layer. 

  

There are many other methods to do this, but we’re going to go through that one since it’s 
a much different and very efficient process which is unique to Blender. If the students 
prefer to model the hand directly off of the body, they may do so, and the instructor can 
teach them how to do it using Empties for Image References. 
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The first thing we’re going to want to do is add a new reference picture for the 
hands. 

Go into the scene properties menu (N) and disable the visibility of our two last 
technical drawings by clicking on the Eye icon at the top-right. You may also want to 
collapse them by clicking on the arrow on the top left. 

Let’s add a new technical drawings of the hands, as we’ve done with the other ones before. 
This time, you only need to add one image. We’ll keep the axis of this new image as All 
Views, and simply model place the hand in a way that will still allow for modeling with them 
as reference. 

  

The next step is very different from what we’ve done until now. 

Go into Edit mode, and delete the faces at the end of the arm. Make sure the vertices are in a 
shape that looks kind of like a wrist, a bit flatter in one direction than the other. 

Select the Edge Loop of the wrist. 

Press P for Separate, and choose Selection. 

  

What we’ve now created is a separate object, consisting solely of the Edge loop of the wrist. 

You should now be in Object mode. Stay there. 

Remove or Disable the Mirror Modifier on the new wrist loop. 

 

With the Loop still selected, press M for Move, and select the 2nd layer (on the right of the 
darkest box, second from the top-left). 

As you might have guessed, we have just moved that loop to the 2nd layer. Let’s go to it. 

With the loop still selected and in Object mode, press Ctrl+Alt+Shift+C and select Origin to 
Geometry. This sets the Origin or Pivot Point to the center of the geometry, in the middle of 
the edge loop. 

  

Now let’s press Shift+S, then Cursor to Selected. This brings our 3D cursor to the same place 
as our loop’s Origin point. 

With Shift+A, create a cube. This will ensure that we have an object with the 3D cursor’s 
current position as its origin, so we can snap our 3D cursor back there  in case we 
accidentally move it away. 
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Select the new wrist curve, press Ctrl+A and select Location. This will tell Blender that 
the position of our curve is its 0,0,0, basically resetting it in 3D space. 

  

Now let’s go to Edit Mode. 

Extrude the Loop in the direction of the hand, then extrude one edge in the direction that the 
thumb would be, towards the front of the 3D space, in the direction that our character was 
facing. This will give us a visual idea of the direction of our hand as we’re going to move it to 
the grid. 

 

EXTREMELY IMPORTANT! Go back to Object mode before moving the wrist to the grid! 

Go in Front view, and move the hand to the bottom of the grid where we’ve placed the 
background image. 

Rotate it while locking the rotation to Z so that our extruded edge is in the same direction as 
the thumb. 

You can also scale it up to the size of the hand in the image. 

  

DO NOT APPLY THE LOCATION/ROTATION/SCALE IN THE CTRL+A MENU. This would 
remove the possibility of resetting the hand’s location to where it was in comparison to the 
body. 

 

In Edit mode, you may now delete the face we had extruded for the thumb position. 

The Hands -  Modeling 

Let’s start modeling the hands. 

Remember not to touch the bottom (wrist) loop for now. 
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We can fix it later once it’s positioned against the body again. 

Note: The technical drawing provided includes the shape of the hand, and the shape 
of the cast around the hand in a different colour. For now, only focus on the shape of 
the hand itself. 

  

Extrude to the top of the palm, before the fingers. 

If you want to flatten a loop that’s got vertex going everywhere, just Scale it (S) in Z. 

  

Select the Edge loop > Ctrl+F > Fill Grid 

Oops! If we continued like this we would only have 4 fingers including the thumb, because we 
only have 3 sets of faces to extrude from. 

This is not what we want. There are multiple ways that we could get around that problem 
and fix it, but for now let’s keep it simple and just add an edge loop vertically to add another 
space for the fingers. 

 

 

Remember: As much as possible, don’t move the vertices and edges at wrist level! We’ll 
take care of this later once the hand is attached to the body again. 

  

If you want to equalize the space at the top of the fingers, you can go ahead by sliding 
those edges. 

 

 
If at any point some of your faces look much darker than the rest, it’s probably that their 
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Normals are flipped. Select the whole thing with A, and then either press Ctrl+N or 
press Ctrl+F (Faces menu) and then click Recalculate Normals. This will make Blender 
understand that you want all of those faces to point outwards of the object, not 
inwards.  
 
   
What are Normals?  
“The normal vector, often simply called the "normal," to a surface is a vector which is 
perpendicular to the surface at a given point.” 
http://mathworld.wolfram.com/NormalVector.html  
 

 

 

 
For our purposes, consider it a vector perpendicular to a vertex, edge or face that indicates 
where it should be pointing/facing (inwards/outwards of the object) and therefore how it 
should be shaded in 3D space.  
 

And now, just as we’ve repeated it so many times before, we’ll extrude the fingers out of the 
hand. 

But first, let’s manually create some polygons which will be the space in between the fingers. 

For this step, we will use the Knife Tool (K). 

The Knife Tool works by clicking where you want there to be a new vertex, creating edges at 
will. You have to be VERY CAREFUL when using it, to not create random polygons. 

 

And now, just as we’ve repeated it so many times before, we’ll extrude the fingers out of the 
hand. 

But first, let’s manually create some polygons which will be the space in between the fingers. 

For this step, we will use the Knife Tool (K). 

The Knife Tool works by clicking where you want there to be a new vertex, creating edges at 
will. You have to be VERY CAREFUL when using it, to not create random polygons. 

 

It’s easier to do this if you turn off Limit Selection to Visible.  
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As you click, little green boxes will appear, with a red rim to indicate if you are connecting 
your new edge to an existing vertex, and turning red once it is placed down so you can click 
ahead to the next. 

Confirm by pressing the Enter key. 

 

You can now select sets of faces and get ready to extrude them. 

 

 

If you couldn’t keep up, you can reach the current modeling progress with 
MagicianBoy_Phase04.blend 

  

Starting to look like a hand. 

Before adding edge loops for the fingers, try and make sure your model is of a good shape. 
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Do that by rotating and translating pieces of the model. Try and start making those 
fingers a little rounder, less boxy. 

If it helps, disable Limit Selection to Visible.  

Remember not to touch the base of the model at the wrist! That lower edge loop 
must stay intact. 

  

Reminder of your selection tools: 

B: Box Selection 

C: Circle Selection 

Alt+Double Click: Select an edge/face loop 

A to Select/Deselect (Use only to deselect right now! So to note move the wrist vertices) 

  

Don’t worry if the side view doesn’t match up, because the drawing was drawn too rotated. 
Since I am the modeler and the artist who drew the model, I can make the decision to keep 
the hand straight when I’m working in 3D. 

 

  

Once the hand is looking good, Add Edge Loops for the joint separations of the fingers, place 
those the way you need them to be, and then add two more edge loops framing the first to 
help with deformation. 

You may also add one extra edge loop at the base of the fingers to make sure they bend 
properly. 
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The hand is done! 

  

  

The Hands -  Joining it back to the body 

Go back to Object mode. 

With the hand selected, press M (Move) and bring it back to the first layer. Go to the first 
layer, where your character and their hand are supposed to be. 

Make sure the hand is selected. 

  

Press Alt+R to reset its rotation. 

Press Alt+S to reset its scale 

Press Alt+G to reset its location. 

 

Now we have to bring the hand back to its original position. Gladly, we have the cube set 
where our 3D cursor should be. 

  

Select the cube. 
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Press Shift+S and pick Cursor To Selected. The 3D cursor will now be at the center of 
the box. 

Select the hand. 

Press Shift+S and pick Selection to Cursor. The hand will now be back where it initially 
was. 

  

Delete the box. 

Chances are your character will now have a monstrously big hand. (Don’t worry we can fix it 
soon) 

What’s important is that now, the two wrist loops are perfectly placed one against the other. 

 

Before joining them back together, you might remember that we had added an edge loop to 
the hand that was not part of the arm. Let’s add an edge loop at the same place on the body, 
to match the hand. 

You can see where the loop is missing from Edit mode, or just visually by looking at the model. 

  

Note: Because we had removed the faces at the interior of the wrist, the loop we’ll make 
won’t follow from over the arm to the side of the body. We’ll need to create two loops on each 
side of the arm. 

  

Making sure that your Snap tool is set to Vertex mode, select the final vertex of your new 
edge loops, press Ctrl to activate the snap, and snap it to the vertex of the hand. 
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Go back to Edit mode. 

Select the hand, then the Body. (To connect the hand to the body, not the other way around, 
to preserve the mirror modifier) 

Press Ctrl+J for Join. 

  

Go in Edit Mode and select the entire model (A), and either go in the T menu to find Remove 
Doubles under the Tools tab, or press Space and write Remove Doubles and select it. 

This will ensure that the vertices we just snapped together are combined as one, and that you 
can keep modeling as you see fit. 
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The body is now in one piece again! 

Re-enable the body technical drawings in the N menu. 

Go in Edit mode. 

Rotate and resize the hands the way they need to be. (Trust your own judgement in 3D 
space) 

Try to align the vertices of the wrist with the hands. 

  

If you need, you can explore the different rotation modes (global, local, normal, gimbal, view). 

If the students need, they are explained here. 
https://wiki.blender.org/index.php/User:Rking/Doc:2.6/Manual/3D_interaction/Transform_Control/Transform_Orientati
ons 

 

 

 

All that we need to finish the Magician Boy is the hair! 
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If you couldn’t keep up, you can reach the current modeling progress with 
MagicianBoy_Phase05.blend 

  

  

  

The Hair 

We kept the hair for last since it’s a little bit easier than the hands. It’s the second to last step 
to modeling our character. 

  

Select the faces at the top of the head. 

Press Shift+D to duplicate them, and G then Z to move them up on the Z axis. 

Press P and pick Selection to separate it as another object. 

Go to Object Mode to pick our new hair object. 

 

Let’s shape it into hair by extruding and shaping it the way we want it to be. 

For our purposes, since the hair will be immobile and glued to the head, you don’t need to 
worry too much about topology. 

What we want to do, basically, is shape it like a helmet. 

Switch from front to side view often, making sure you’re encircling the head. 

You can extrude individual edges to make strands of hair if you like. 
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Once you are satisfied with the shape, you can apply the mirror modifier and start working 
asymmetrically. 

 

 

When you’re all done, you’ll want to make the hair 3D instead of entirely flat. 

Remaining in Edit mode, select the entire object with A, and press Shift+D, and instantly 
press S to scale it down. 

If you want to see what you’re doing a little better, just press A to select everything and move 
the entire object upwards. 

  

Select a piece of the inner hair helmet and press L to select it all. 

Press Ctrl+F to access the Faces menu and click the first option, Flip Normals. This will make 
it so the inner layer points inside, towards the head. It will allow us to connect both parts of 
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the helmet. 

  

Grab matching segments of the outline of both helmets, and with Ctrl+E (Edge menu), 
select Bridge Edge Loop. This will create geometry connecting both halves of the 
helmet. Do so until the entire helmet is connected. 

 

Note: After you’ve started, you might not be able to use Alt+Double Click as we’ve been 
using it before, because this would select one single loop, connected by the parts you’ve 
already bridged. 

  

The hair is done! You may now select it all and pull it back down over the head. Just make 
sure to check all of its sides so that the skull doesn’t poke through. 

  

  

If you couldn’t keep up, you can reach the current modeling progress with 
MagicianBoy_Phase06.blend 

  

The Cast 

  

All that remains is to join the body together, join the hair to the body and edit the two arms to 
make them separate. 

  

Let’s start by joining the body together. 

Apply the mirror modifier. Since the Clipping option was enabled, we don’t need to Remove 
Doubles as would normally be done to make sure both halves are sewn shut. 

  

Now let’s join the hair to the body. 

In Object Mode, select the hair, then select the body, and press Ctrl+J. 

That’s it! In the Scene Graph/Outliner, you can go and rename the object to MagicianBoy by 
double-clicking it. 

  

  

The Bowtie 

While it is not covered in this lesson, you can create the bowtie either as part of the same 
model, or as a separate object which you can then join in with the main model with Ctrl+J. 

(On the Course Material blend files, it has not been added until later) 
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You can now work asymmetrically.  

As we’ve done in the past, add edge loops horizontally to the arms and use that new 
geometry  to create the shapes of the two different arms; the character’s right hand will have 
a long sleeve, and his left hand will have a rolled-up sleeve and a cast. 

Just make sure to keep enough topology at the wrist and at the elbow to allow for bending 
and deforming while animating. 

 

 

 

Before we’re done, let’s set the pivot point or Origin of our object to be at the grid center.  
Press Shift+S (Snap) and select Cursor to Center. This should snap our cursor to the perfect 
center of the grid, at 0,0,0.  
With our character selected and placed at the center of the grid, press Shift+Ctrl+Alt+C and 
select Origin to 3D cursor. Alternatively, you can find the origin settings at the bottom of the 
Tools tab of the T menu.  
 
That’s it! 
We are done!!! 
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Giving the mesh a smooth finish 
If we wanted a smoother finish for our character, we could simply click Smooth under 
the Shading option in the T menu, but then as you might notice, the entire character is 
smoothed, which does not look natural.  
 
 vs.   
 
How then do we preserve sharp edges? 
First, activate the modifier Edge Split under the Generate column.  
Deactivate the Edge Angle checkbox.  
 
In Edit mode, select the edges you need, press Ctrl+E for the Edge menu, and select Mark 
Sharp. This will turn our edge Blue. If you go back to Object mode, you’ll see its rendering will 
have changed.  
 
   
 
Place those sharp edges wherever you want them to be.  
 

Giving the mesh a smooth finish 
If we wanted a smoother finish for our character, we could simply click Smooth under the 
Shading option in the T menu, but then as you might notice, the entire character is smoothed, 
which does not look natural.  
 

 vs.   
 
How then do we preserve sharp edges? 
First, activate the modifier Edge Split under the Generate column.  
Deactivate the Edge Angle checkbox.  
 
In Edit mode, select the edges you need, press Ctrl+E for the Edge menu, and select Mark 
Sharp. This will turn our edge Blue. If you go back to Object mode, you’ll see its rendering will 
have changed.  
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Place those sharp edges wherever you want them to be.  
 
 
The resulting model from this lesson can be found on the file MagicianBoy_Phase07.blend 
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Graphics 6 / Instructor: Ray Caplin 

Textures & Materials 
Understanding how Material properties define objects, the variety of 
texture maps, and utilizing texture placeholders for texturing. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 9:15AM — 1HR 30M 
 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.5) and Photoshop, as well 
as have experience using materials. They should also have extensive knowledge of 
Photoshop material layers, i.e. comfortable with normal maps, and other sorts. 
 
Participant Prerequisites 
Students must have their assets/characters modeled, and they will have already done Art 
Module 9: UV Mapping. They should be comfortable with UV mapping in general in 
preparation for materials in Photoshop. They will also have received brief instruction on 
selecting faces and applying materials to them, in Introduction to Modelling (Art Module 5), 
and have had an introduction to Photoshop in Art Module 11. Intro to Photoshop. 
 
 
Equipment/Software Materials 
 A presentation screen on which to show PowerPoint 
Cameras to take pictures to use as textures 
 
 
Objectives 
Understand the concept and process of Materials, and apply them to their models. Create 
custom textures using cameras and Photoshop. 
. 
  
Vocabulary 
Material,  Shader, Diffuse, Transparency, Specularity, Lambert, Textures Maps 
 
WEB RESOURCES & BOOKS: 
Blender community: 
http://www.blender.org/ 
 Blender Tutorials: 
http://skins.abtec.org/skins2.0/Tutorials 
Advanced Materials & Shaders: 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/index.html 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/index.html 
https://www.pluralsight.com/blog/film-games/bump-normal-and-displacement-maps 
  
https://1stwebdesigner.com/image-file-types/ 
  
http://blogs.adobe.com/jkost/2015/01/how-to-create-a-seamless-pattern-tile-in-photoshop.h
tml 
https://helpx.adobe.com/photoshop/using/blending-modes.html 
https://helpx.adobe.com/photoshop/using/masking-layers.html 
  
https://www.blenderguru.com/articles/making-better-materials 
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How to make photoshop brushes 
http://danidraws.com/blog/2007/01/20/make-your-own-photoshop-brushes/ 
How to install photoshop brushes 
https://creativemarket.com/blog/how-to-install-use-photoshop-brushes 
  
http://www.blenderguru.com/videos/create-realistic-materials-with-cycles/ 
 

 
 
What are materials? 

Materials are essentially what you want your mesh to be “made out of”. They define how your 
3D mesh reacts to light and shadows, if it’s reflective or transparent, for instance. They also 
allow you to apply textures to your mesh more globally, without necessarily using a UV map. 

 Shaders represent different aspects of a material. You can have multiple shaders for one 
material, having multiple properties coming into play. 

For instance, think about an orange; it is bumpy, has a bright colour, it is kind of shiny… 

  

Considering out materials don’t transfer into Unity, we’ll only have a quick look at how to set 
them up in Blender. We will learn enough to help us work inside of Blender and Photoshop to 
create good texture images which will be used in Unity. 

 We will work with the Lambert shader, which is one of the simplest and most standard 
shaders shared by multiple 3D software as default. 

 Here is some material properties that we’ll explore in this lesson: 

-          Diffuse/Albedo 

-          Transparency 

-          Specularity 

-          Normals maps 

Diffuse/Albedo 

The Diffuse is what basically acts as the base colour for your object. You can set it as a single 
colour in Blender, or you can make an image file according to a UV map and set that as a 
diffuse. Its equivalent in Unity is called Albedo.   

Transparency 

As you might imagine, you can use this to make your model or part of your model 
see-through. You can use the Alpha slider to define how opaque or transparent the mesh 
should be.  

Specularity 

Specularity is what defines the shine and reflectivity of your object. By reflectivity, we mean 
like the reflection of light on jewelry or a shiny metal, and not like a reflection in a mirror. 

Normal (versus Bump & Displacement) 

Normal maps are what we’ll use to simulate depth in the detail on some of our textures. They 
basically give information to our 3D software on how the light will react to polygons in 
accordance to the position of their normals, and is painted in detail. As you might see in our 
example below, while the definition and depth this map gives to our texture is great, it doesn’t 
actually deform our object in any way. 

 For the workshop we’ll focus our attention to Normal maps only. 
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 http://i8.photobucket.com/albums/a46/MichaX/025_3k_s.png 

https://slm-assets1.secondlife.com/assets/7116894/view_large/3D_HARDWOOD_SAMPLE1.jpg?1360191610 

Specularity 

Specularity is what defines the shine and reflectivity of your object. By reflectivity, we mean 
like the reflection of light on jewelry or a shiny metal, and not like a reflection in a mirror. 

 Normal (versus Bump & Displacement) 

Normal maps are what we’ll use to simulate depth in the detail on some of our textures. They 
basically give information to our 3D software on how the light will react to polygons in 
accordance to the position of their normals, and is painted in detail. As you might see in our 
example below, while the definition and depth this map gives to our texture is great, it doesn’t 
actually deform our object in any way. 

  

For the workshop we’ll focus our attention to Normal maps only. 

  
http://i8.photobucket.com/albums/a46/MichaX/025_3k_s.png 

https://slm-assets1.secondlife.com/assets/7116894/view_large/3D_HARDWOOD_SAMPLE1.jpg?1360191610 

  

Don’t get confused between Bump and Displacement maps, which can look like the same 
if you follow tutorials online. 

-          Bump maps are basically the “old” way of giving fake depth and detail to 
our objects, which was done with a grayscale map. 

-          Displacement maps, or height maps, are also greyscale images, except they 
actually do deform your object, and therefore require more subdivisions onto 
the model to handle them. 

  
https://static1.squarespace.com/static/55d63e06e4b0cafd401252ff/t/571ee1f62eeb8154a24a1bf3/1461641729
175/ 

 

About Resolution and Optimization 

Understanding image resolution is crucial to working on large projects with many 
collaborators. 

 When shooting your own references, and using textures or images for your work, it’s best to 
choose images with the most resolution and the least compression possible. This will allow 
you to keep the maximum amount of detail for your images as you are working. 

 When you are ready to export your file to use it in the game, alternatively, smaller files are 
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better, as they can be processed faster by the engine. 

Another option is to use the same texture files for multiple objects, to only load it once; 
you can do this by placing the UVs of multiple small objects together before doing 
their texture. 

 Without going into too much detail, for the entirety of the workshop we will stick to the .PNG 
file format. 

 
https://www.winxdvd.com/windows-10/pics/good-bad-video-compression-quality-comparison.jpg 

  

In this lesson, we will explore: 

-          How to paint textures for specific 3D models using their UVs in Photoshop. 

-          How to create and use tileable textures.  

How do materials work in Blender? 

In order to see the material assigned to our object and its textures, you will need to change 
the viewport shading settings to Material. Understand that you’ll need to move your light 
around (by default, the lamp) to see how it affects the material.  

 If you wanted to only see the texture, but not the material, you’d have to choose Texture in 
the viewport menu, and make sure that the appropriate texture file is applied to the mesh in 
Edit mode over all of the polygons, in the UV/Image Editor. This is more appropriate for 
working on painting your diffuse onto the character. 

 This basically does the same as with Textured Solid enabled in the N menu, except with a 
quick light pass. 

  

There are two tabs relevant to materials and textures in the Properties panel of Blender. They 
are accessible only after having selected the object you’re meaning to work with; the 
materials shown will only be those connected to the object selected. 

First let’s look at the Materials tab, the rightmost sphere icon. 

 

As you can see, one object can have multiple material slots. This allows for different parts of a 
single mesh to react to light and show reflections in their own way, for example. For the sake 
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of simplicity, we will limit ourselves to one material slot per object. 

 

If you had other materials assigned to other objects inside the 3D scene, you could 
access those and assign them to your mesh as well, using the menu right under the top 
material slot box. 

  

If a 0 is shown to the left of one of these materials, it means that it is unassigned and will 
automatically be deleted the next time the Blender file is closed. If you mean to keep an 
unassigned material from being deleted, simply click the F button to the right, stating Save 
this data block even if it has no users. 

  

 

Now to go and look at the texture files applied to this specific material. Let’s go to the textures 
tab, the little checkerboard icon. 

 

One material can have many texture slots, to include texture files like Diffuse maps, Normal 
maps, Specular maps… You add those in by picking a texture slot and adding a file at the 
bottom with Open. 

 You can then scroll down and define what their influence, or function, is. 
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You might notice another box appearing under the image input slot, called Source. 
This slot serves to tell Blender where to find the image file in your computer folders, and 
independently renaming it inside Blender for your own work. If you change the Source file 
to something unreachable, Blender won’t be able to access the file anymore. 

  

In order to delete a material, you select it and remove it with the minus (-) button on the right. 

In order to delete a texture, you select it and remove it with the X button at the bottom right. 

 

This covers the basics! 

 

Fetch the resulting model from the Character Modeling class, 
MagicianBoy_Phase08.blend 

  

Solid colour placeholders for Photoshop 

In order to have a better idea of how to paint over our UV map in Photoshop, we might want 
to create some colour placeholders in Blender to keep as an image file. These will be flat, 
bright and varied colours we will slap onto our mesh, along with some drawn markers, to 
know what’s what once we transfer the UV map to Photoshop. 

  

First, create a new image in the UV/Image Editor view. 

  

There are two ways to go about this. 

The first method, which is a little bit more precise in regards to the UVs, requires you to 
move between Edit mode and Texture Paint mode. First, in Edit mode, pick the faces you 
would like to be one colour; let’s say a bright blue, for his arm cast. Once the faces are 
selected, go in Texture paint mode, make sure Face Selection Masking for Painting is 
enabled, pick the Fill paint method, choose the colour you want, set it at 1 in Strength, and 
click in the viewport to fill those faces with the colour. 
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The faces should now be filled with a nice blue. 

The second method is simply to keep Face Selection Masking for Painting disabled, and 
using the default TexDraw paint method with a radius of your choosing, draw onto the faces 
to give it whichever markers you like. For instance, I drew a simple face, shoelaces, fingernails, 
buttons for the shirt, and R (Right) and L (Left) letters on each side of the hair to know what’s 
what. We are not trying to make things pretty, simply distinguishable, to make our texture 
work a little easier. 

Of course, both methods can be used together without a problem. 

 

Blender offers enough options to be able to do basic texture and colouring work within itself, 
so feel free to explore! 

When you are done, make sure to Save as Image. It is time to import both this image and our 
UV map in Photoshop 

 Syncing Blender and Photoshop 

In the Blender User Preferences (Ctrl+Alt+U or File > User Preferences), under the File tab, 
you can add Photoshop as your Image Editor. This will make it so when you click Edit file 
externally, it will open it directly into Photoshop. 

The path to Photoshop is most likely something like this: C:\Program Files\Adobe\Adobe 
Photoshop CC 2017\Photoshop.exe  

Back to Photoshop 

Let’s bring our images to Photoshop. Drag-and-drop them into Photoshop, one at a time. 
They should stack one on top of the other. 

  

You can try making your own setup, but here is a suggestion: 
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Leave the UVs on top. They are mostly transparent, and can be toggled on and off. 
Then, add your markers and placeholder colours. Those can also be toggled on and 
off. At the bottom, add a solid colour layer. This way we will be sure not to have any 
transparency issues, as we will see if there is a whole in any of our shapes. You can 
make this any colour you want. 

 

 

Making a clean, separated canvas 

With the Magic Wand tool (W), select all of the black areas on the Placeholder texture 
layer. 

Make a new layer. 

Press Ctrl+Shift+I to Inverse your selection, or click on Select > Inverse. 

Pick a colour of your choice, and using the Fill Bucket tool (G), fill in all of the shapes we 
now have selected. 

Lock the transparency on that layer. 

You can now duplicate that layer and use the Rectangular Marquee Selection tool (M) or 
the Lasso tool (L) to select shapes to delete, and create layers for different body parts that 
you’d want to work on separately. 

  

While working on your textures, you may want to see your progress as it appears onto your 
3D model. 

For this, consider letting the texture files you enter onto Blender for your character be .psd 
files as you’re working. You can then refresh the .psd file as you go to see your progress. 
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Now that you know how it all works, start playing around! 

  

The resulting model and textures from this example can be found on 
MagicianBoy_Phase09.blend 

 

What are tileable textures? 

Tileable textures, as the name implies, are textures that are made for tiling one next to the 
other. They are also called seamless textures. They are made so that if you were to place 
many of them one next to the other, it would look like a never ending pattern. This is good for 
brick, concrete, wooden patterns, etc. You can use them on all sorts of Photoshop projects, 
but they are especially useful for 3D textures. 

 How to find them? 

Textures.com offers many such textures for free, of which you can download up to 15 per 
day. 

https://www.textures.com/ 

 Else, an easy way to find them is to search for them on your favourite search engine. On 
Google, for instance, you can use the Tools menu, and under Usage Rights you can search for 
some that fit the kind of project you are working on. 

Make sure that you have the rights to the images that you use! Look for some under Creative 
Commons licenses, and make sure to give credit where credit is due. 

  

How to use them? 

The easiest way to work with those, although it can get rather time-consuming, is to 
drag-and-drop the tileable texture  into your Photoshop workspace, duplicate it a few times 
(Right-click the layer and choose Duplicate Layer...) and move those layers around with the 
Move tool (V). 

You could then merge them together to make them be one single image (Shift-select all 
relevant layers and choose Merge Layers). 

Once the layers are merged, you can scale and rotate your new single image, and explore 
some of the Transform tools such as Warp and Perspective. 
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You can also change its Blending modes for it to interact with the other layers in different 
ways, such as Overlay 

  

You can find a definition of those blend modes here. 

https://helpx.adobe.com/photoshop/using/blending-modes.html 

 

Finally, you can play with transparency, either with the Opacity slider of your layers, or 
through the use of Layer Masks. 

Some resources on layer masks can be found here: 

https://helpx.adobe.com/photoshop/using/masking-layers.html 

Here’s some alternative methods for making patterns, if the students are comfortable with 
Photoshop: 

  

Open your tileable image in Photoshop by itself. 

Edit > Define Pattern. Give it an appropriate name. 
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This pattern will now be available when using: 

Edit > Fill, 

Layer Styles, 

Pattern Fill Layers, 

the Pattern Stamp, 

Healing Brush, 

Shape Tools (for both Fill and Stroke) 

and when creating Brushes (using the Texture attribute). 

 The tools you will most likely use are the Paint Bucket tool (G), which you can then customize 
to use a pattern 

(you cannot scale the pattern with this tool); 

 

The Edit > Fill function, which will fill a selection of a layer with the pattern chosen 

(you cannot scale the pattern with this tool); 

 

And Layer > New Fill Layer > Pattern, which creates a fill layer which you can use to rescale 
the pattern at will until it is rasterized. It also comes with a layer mask on which you can 
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paint the shapes you want it to affect or not. 

 

Some definitions: 

  

Rasterizing is the process of turning vectors, or text layers, or layer effects, or any other kind 
of graphics, into a simple bitmap image made of pixels. 

A word of warning: In Photoshop, once you have rasterized a text layer, you will no longer be 
able to edit it as a text layer. 

 Rasterizing converts these to ordinary pixels, so when you scale them you lose quality BUT 
you can edit them in the same way as other photographic elements. 

 To rasterize a layer, simply Right-click it and select Rasterize layer. 

 

On this layer, the patterned  box on the left is the fill layer, on which you can double-click to 
change  

 

 

the fill settings and rescale the pattern. 

You cannot edit that layer’s pixels by hand until you rasterize it. 

 The white box on the right is a layer mask. 

Layer masks are a fundamental tool in image manipulations. They allow you to selectively 
modify the opacity (transparency) of the layer they belong to. This differs from the use of the 
layer Opacity slider as a mask has the ability to selectively modify the opacity of different 
areas across a single layer. You can add a mask to a layer and use the mask to hide portions 
of the layer and reveal the layers below. 

 The chain link between them indicates that the mask is linked to the layer it is on, and that 
manipulations done onto them will affect the both of them. You can click in the space 
between the two boxes to enable or disable the linking, and be able to edit them separately 
from one another. 

 https://www.quora.com/What-does-rasterizing-a-layer-do-in-Photoshop 
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https://helpx.adobe.com/photoshop/using/masking-layers.html 

https://www.gimp.org/tutorials/Layer_Masks/ 

 

How to take pictures with a camera to use as a texture 

Digital Cameras will be provided as a tool to capture images. Using the cameras provided 
you will go outside to look for appropriate textures in the environment that would suit the 
game you are working on. Below are tips on what to look for and what to avoid when 
shooting a texture. 

Setting up your camera: 

1.  Turn Camera on 

2.  Make sure the camera's resolution is set to the highest setting. 

3.  Set the focus on automatic. 

4.  Keep the flash turned off; this will allow you to capture more natural-looking textures. 

Note: Each of these settings can be found in the in the menu settings of the camera. 

  

What makes a good texture for games? There are different kinds of textures you’ll be 
looking for when gathering visual elements for games. 

For example: 

1. Flat, repeatable textures. 
1. These are textures that would be made seamless, so they can be “tiled”, or 

repeated. 
2. Tiled, seamless textures are applied to assets in the game which normally 

cover a large area, like the ground or a road, and buildings. 
3.  
4.  

2. Textures meant to add particular detail to assets in-game. 
1. These textures can be something that will add an extra element of realism to 

an item. 
2. They can be used for patterns, wrinkles, adding rust, scratches or a rougher 

look to assets. 

 Taking a shot: 

Keep it flat 

When shooting a texture, it’s best to capture it as flat as possible. Point straight-on to ensure 
the best representation possible. When in doubt, take multiple shots of the same subject at 
slightly different angles. There’s only so much we can fix in photoshop. 

 Distance from subject 

For textures meant for tiling backgrounds, do not stand too close to an object, as it makes it 
hard to tile. Think about having a little bit of space around the texture you’re shooting, so that 
you have an easier time in Photoshop later. You can always crop the picture then. 

  

If you’re going for detail and aren’t sure how large or small to make it, it doesn’t hurt to get 
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three differently-zoomed shots of the same texture. 

 Check your Focus 

It’s a good habit to pick up to preview your photos while you’re still in the field, 
zooming onto them to make sure they are in focus, and not blurry. Without a tripod, you are 
trusting your hands not to shake as you take the picture; it might take a few tries before 
getting it right. If it looks foggy in the viewer, it will look foggy in the game! 

  

Tips: 

1. Make each pixel count. Make sure you are only shooting the part of the texture 
that you need and want to use; no need to take a picture of an entire building if all 
you want is the brick on the side. 

2. Avoid reflections/flash, unless reflections are absolutely needed to be in the 
texture. You can always tweak a model to be shiny in-game, no need to put the 
reflections in its texture. 

3. Pay attention to lighting conditions - too much light or not enough light. The light 
source should come from in front of the surface you are shooting to ensure even 
lighting. 

4. Remember: lighting can always be adjusted in Photoshop. 
5. Avoid depth of field. Depth of Field relates to focus and for textures you want to 

ensure that what you shoot is completely in focus. You have to be the right 
distance from a subject to ensure the focus is right. 

6. Look for unique surfaces that apply to the textures you will need for the game and 
assets you will be making. Keep your energy for textures you could not find online; 
it’s easy to find a wood floor texture, not so easy to find the pattern of your 
favourite clothing! 

  

  

How to make your own tileable, seamless texture 

Once you’ve gathered the textures you want to use, pick one and open it in Photoshop. 

For this example, I’ll use the flat picture I took of a cork board in our office at Obx. 
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We could technically work with an image this size, but it is standard to make tileable images 
of 1.1 ratio. You can skip this next step if you like. 

 Using the Crop tool (C) set at 1:1 aspect ratio, crop the image into a perfect square and 
confirm with the Enter key. 

 

 

If any adjustments with the Levels or Hue/Saturation must be done, leave it for the end; you 
may want to make multiple versions of your texture. 

 Let’s have a look at what the image looked like if it was tiled. 

Filter > Other > Offset 

Set the Offset tool to Wrap Around and use the sliders to move the horizontal and vertical 
edges so they move near the center of the image. This tool helps to show you what the edges 
of the tileable texture would look like as they connect. For our cork board image, the top and 
bottom were nearly a perfect match, but the left and right still need some work. 
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Let’s use the Clone Stamp tool (S) to paint over our seams. Hover your mouse over the part 
you want to clone, hold Alt down, and click. Then, you can click around and the stamp tool 
will paint using the clone region as a source. For instance, if you paint to the right, it will pick 
the pixels that were on the right of the initial clone region. You can adjust the size of your 
Clone tool the same way as with the Brush tool, either with the Brush properties or by 
holding down Alt and Right-Clicking and dragging. 

 The clone tool has a soft feathered edge initially, but you can change that if you wish. 

If you use the feathered edge, which blends the new pixels with the old, your image might get 
a little fuzzy by using the Clone tool too much, so be mindful of that.  

 Try not to touch the edges of the picture too much as you clone, or else we’ll have to start 
tiling all over again! 

 Speaking of which, when you’re done, you can bring your image back to its original position 
of 0 offset by accessing the menu again at Filter > Other > Offset. 

 In this case, with minimal editing, it gave a texture like this. 

 

For more information: 

http://blogs.adobe.com/jkost/2015/01/how-to-create-a-seamless-pattern-tile-in-photoshop.h
tml 

  

  

Creating Normal, Specular and Transparency Maps out of the diffuse 
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Keep all of those different maps grouped as layers under your Diffuse, keeping it as 
one master PSD file. It will be much easier to tweak the maps then, if they’re all 
together in the same file, if you were to ever change the diffuse. 

For the project we’re making, generally, a Diffuse and a Normal Map should be 
enough, but we’ll introduce a little bit more just in case you’d want to use it. 

How to create a Normal Map 

To generate texture maps, there are all sorts of software existing to do it, like Crazy Bump 
(paid) or xNormal (free), but there is a simple tool that already exists built-in with Photoshop. 

Select the layer you want to make into a Normal map and duplicate it, to be safe. 

Filter > 3D > Generate Normal Map. 

As you can see, a preview of your normal map will appear onto a 3D object. 

Use the Invert Height, Blur and Detail Scale options until you have something to your liking, 
then press OK to confirm. 

You can either tweak it by hand in Photoshop, for instance if you want only certain parts of 
the model to be affected, or if you want to smudge certain parts (Smudge tool is under the 
Paint Bucket tool, click and hold to access it). 

When you are done, save it as an image file named appropriately. 

Something like MagicianBoy_Normal.png 

 

External Normal Map Software: 

http://www.xnormal.net/Faq.aspx 

http://www.crazybump.com/ 

How to create a Specularity map 

Specular maps are traditionally in grayscale, ranging from black (no reflection) to white 
(highly reflective). We could use colour, but for this workshop we’ll limit ourselves to 
grayscale. 

Therefore, the first thing to do is to take out the colour from our image. Open Hue & 
Saturation (Ctrl+U) and bring down Saturation to -100. 
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Invert the image with Ctrl+I if you need to. For example with the bricks below: 

The first set shows pale bricks to a dark wall. The bricks will be much more shiny than 
the wall. The second set shows dark bricks on a pale wall. The wall will be much more 
shiny than the bricks. 

 

 

About Specular Maps 

  

Specular maps are the maps you use to define a surface’s shininess and highlight colour. 

The higher the value of a pixel (from black as lowest to white as highest), the shinier the 
surface will appear in-game. Therefore, surfaces such as dry stone or cotton fabric would 
tend to have a very dark specular map, while surfaces like polished chrome or plastic would 
tend to have lighter specular maps. 

  

The colour of a pixel is also used, to calculate the resulting colour of the surface. A very 
saturated specular map will have a very different visual effect than a grey specular map. If 
you need a more "neutral" highlight on a surface, your specular map should use the 
inverse of the diffuse map's colour. Using the same colour on the specular as on the diffuse 
will result in a more saturated highlight when viewed in the game. 

  

You can use contrasts in specular to make a surface appear more visually interesting in the 
game - for example, this door has a very dark specular for the wood while the metal parts are 
much lighter, which will make the metal stand out more as a shinier surface when light hits it. 
This sort of contrast can help make surfaces in the game appear more realistic too. 

  

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 

159



 

 

http://wiki.splashdamage.com/index.php/Specular_Maps 

How to make a Transparency map image file 

Make sure that there are no pixels drawn on the area of the texture that you want to 
be transparent. In this example, it is the shoes of the Magician Boy that I deleted on 
every visible layer, making sure to hide the background solid colour layer as well. It shows me 
this checkered pattern symbolizing transparency. 

 

Save it as a .PNG, which preserves Transparency (or Alpha). 

In Blender, in the Texture tab, make sure to check the texture as BOTH Diffuse and Alpha. 

Furthermore, in the Material tab, under Transparency > Z Transparency, bring Alpha down 
to 0. 

Save it as a .PNG, which preserves Transparency (or Alpha). 

In Blender, in the Texture tab, make sure to check the texture as BOTH Diffuse and Alpha. 

Furthermore, in the Material tab, under Transparency > Z Transparency, bring Alpha down 
to 0. 

 

 

This method should also work for low-opacity pixels, to let you have gradients of 
transparency on a character. 

  

You should now be all set to create textures to your liking! 

REMEMBER TO SAVE OFTEN! 
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Stylized Textures 

Since we are going to work with rather low-poly models, it would be a good idea to 
stylize our textures as well, since we are not going for a photorealistic look. 

The best way to get stylized textures is probably to paint them by hand, although this 
would take a lot of time. Fortunately for us, there are ways to get the look of a stylized 
texture in only a few steps, thanks to Photoshop Filters. You can explore them yourself, or 
use the 

 Quick Texture Stylization Tutorial 

Here are the steps, in short, as described on the Unity Community. You can find the link 
below. 

1. Filters > Noise > Despeckle. 
2. Filters > Sharpen > Sharpen. 
3. Filters > Blur > Smart Blur… 
4. Filters > Sharpen > Sharpen. 

http://wiki.unity3d.com/index.php/Stylized_Texture_Tutorial 

Customizing Colour 

You can also customize your texture’s colours and contrast very quickly using the 

Hue and Saturation (Ctrl+U), 

Colour Balance (Ctrl+B), and 

Levels (Ctrl+L). 

You could even paint over an existing texture with the Brush tool! There are no rules, so 
just have fun. 
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Custom Brushes 

Having your own custom brushes can be quite nice, once you’re getting used to 
Photoshop as a whole. 

Here are some online resources on how to make your own, or install some found on the 
web. 

 How to make photoshop brushes 
http://danidraws.com/blog/2007/01/20/make-your-own-photoshop-brushes/ 

  

How to install photoshop brushes 
https://creativemarket.com/blog/how-to-install-use-photoshop-brushes 
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Graphics 7 / Instructor: Kahentawaks Tiewishaw 

UV-Mapping 
Prepping for textures - a guide for painless  
and efficient unwrapping of a 3D model. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1WrQZf0ho7YYQClTt2nms9-En5pRD8Rweb0
c7SqH051c/edit?usp=sharing 

 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.79) and Photoshop, as 
well as had experience unwrapping complex models for proper seam placement. 
 
Participant Prerequisites 
Participants must have an idea of what kinds of textures they will be using on their 3D 
models. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender 2.79 
Plastic Gluon 
A small stuffed animal 
Scissors 
 
Objectives 
Understand the concept and process of UV mapping, and apply it to models. Unwrap models 
efficiently to create usable UV maps. 
  
Vocabulary 
UV Map,  UV Editor,  Seams (Make Seam/Clear Seam),  Unwrap, Weld, 
Stretching/Compression,  Normals/Flipped Normals,  Pin 
  
References 
Blender website: 

- http://www.blender.org/ 
UV Tutorials: 

- https://www.youtube.com/watch?v=V6OXSR5Ynyc&index=18&list=PLa1F2ddGya_8V
90Kd5eC5PeBjySbXWGK1 

- http://www.chocofur.com/uv-mapping-tutorial-in-blender.html  
- http://www.photoshoptextures.com/texture-tutorials/seamless-textures.htm  

 
 

About UV Mapping 

UV mapping is the 3D modeling process of projecting a 2D image to a 3D model's surface for 
texture mapping. Think of the UV map the same way you think of wrapping paper, or sewing 
clothing. Just like you need to sew flat fabric pieces together to make a shirt that will wrap 
over your torso, in 3D you must define how a 2D image will be placed onto the 3D object so 
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that you can paint its textures properly.  

In short, UVs are not the colours and materials that you put down, but the canvas you 
stretch over your model to be able to paint on it.  

UV maps have seams in specific areas to minimize stretching and compressing of the 
textures you put on your model; a bit like with a stuffed animal or a piece of clothing, we want 
to avoid to see those seams to be too obvious.  

UVs are the coordinates, exactly like vertices on your model, which tell the UV map where 
things go. The letters "U" and "V" denote the axes of the 2D texture because "X", "Y" and "Z" 
are already used to denote the axes of the 3D object in model space. 

 
 
Cutting apart an object to illustrate texture projection (10min) 

In this exercise, we will demonstrate flattening 3D creations by taking apart clothing and 
laying the pieces flat on a table. We may also use a stuffed animal, to show the same process 
on a “character”. 

See the difference between two identical stuffed animals; one already taken apart and 
flattened out, and one whole and untouched, to compare. 

NOTE: For this lesson participants should open the provided work file from Plastic Gluon 
(Course Assets > Course Material > Graphics > UV_Mapping.blend) and follow along with 
the slides. 

 

UV Editor 

In Blender, change an  interface area to UV Editor by either splitting your view in two as 
we’ve done before, or changing the animation timeline to UV Editor. Adjust the views so you 
can see both the 3D View and the UV Editor clearly as you’re working.  

This is where you will be able to watch your UV map develop. Anything you unwrap will 
appear here.  

Navigate by panning around by pressing the Middle Mouse button, and zoom in and out with 
the mouse wheel.  

 
Unwrapping a Model 
Have a look at what the current UV Map of our object looks like. To do this, select the entire 
model in Edit mode with A, press U and choose Unwrap.  

Your UV map will be displayed inside the shaded grid area in the UV Editor. As is usually the 
case, it looks pretty bad! Meaning, it is pretty hard to tell what you’re looking at. This is 
because Blender is trying to show you the flattened version of a UV map where every polygon 
is still connected together.  
 
You will need to put in seams, which allow the UV map to be as flat and as even as possible, 
while describing the model in a way that makes texturing easier. Remember, your UV map is 
a perfectly flat, 2D representation of your 3D model.  
 
UV mapping essentials: 

- No overlapping UVs;  
- No twisted faces: as much as possible, try to keep the representation of a 

polygon similar to what it actually is;  
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- Good size ratio: it’s good to have relatively even spacing of UVs 
throughout your model, except in areas which don’t really show (more 
stretch is allowed) or where you need to add extra detail (tighter UVs 
than other areas). Moreover, make sure that an unimportant object, 
like a ring on a finger, does not get bigger than an important part of 
the model, like the face.   

 
Something else to keep in mind as you’re unwrapping is that you don’t want to put seams in 
areas that are highly visible. The face, for instance, should be one solid piece. This is because 
it will be very hard to match textures so that you can’t see the seams; you want to be sure 
you put these in the least noticeable places, like under the arms or at the base of the neck, for 
example. 
 
Go into the 3D view of your mesh.  
Select vertices along the seam you’d like to make (Alt+Double click to select an edge loop), 
and choose Mark Seam in the Shading/UVs tab of the Object Tools menu (T). Alternatively, 
you can go to the Edges menu with Ctrl+E and select Mark Seam.   
 
You can keep creating seams if you have a good idea of where they should be, or delete them 
(Clear Seam), as you see fit.  
Press U and pick Unwrap to see the UV map you’ve just created in the UV Editor, split by the 
seams you just defined. 
 
The great thing about Blender UV mapping in comparison to some other 3D programs is that 
you can check how your seams are affecting the UV map as you go along by unwrapping 
each time you make a change. The seams will be evident, as they are bright red and stay 
visible on the model as you work. 
 
If you’d like to see which UVs correspond to which vertices, try turning on the Keep UV and 
Edit mode Mesh Selection in Sync option, which is located in the header of the UV Editor 
window.  

Stretching 
 
Next you will want to check for stretching, as it will affect your texture’s placement. You don’t 
want to stretch the UVs too much, as it will make your texture less detailed, causing a blurring 
on the surface of the model. This is especially bad around the face, where we need a lot of 
small elements to be clear. 
 
A great way to do this is by applying a checkerboard texture to the model. Visually, you will 
be able to see if there is stretching on your model’s UVs by verifying that the squares 
displayed are equal between their height and width.  
 

● Click the New + icon, located in the header menu of the UV Editor. 
● A menu will pop up, where you will name the image you will be using (Checkerboard), 

as well as choose the resolution by pixel count (4096 x 4096 is the highest). For now 
we can stick to 1024x1024. 
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● For Generated Type select “UV Grid” to create the checkerboard pattern. 
● Press Ok.  
● Make sure all your faces are selected in the 3D View (A) and select the 

Checkerboard image you just created from the drop down menu in the UV 
editor’s header, to the left of where we just created the pattern. This will apply 
the checkerboard on the 3D model, but you won’t see it yet.  

● Save the scene.  
● Save the image; an asterisk has appeared next to Image in the header of the UV 

editor view. Click on Image and  choose Save As. 
● To make the checkerboard appear on the model, go into the Properties panel (N). 

Under Shading, check Textured Solid.  
● If you would like to display your model’s material again later, for instance if you’ve 

applied a material to selected faces, uncheck Textured Solid. 
 

 
 
Flipped Normals 
 
Once checkerboard is on, you will be able to see if there are any normals flipped. Normals 
control the direction in which Blender views the faces head-on. If they are flipped, the texture 
will not display properly; it will darken the mesh.  
 
How do you flip them back in the same direction? 
Select the faces without texture on them, then in the header select  Mesh>Normals>Flip 
Normals, or press Ctrl+F to access the Faces menu and click Flip Normals.  
Alternatively, select the entire model, and and press Ctrl+N for Recalculate Normals, which 
can also be found in the Faces menu (Ctrl+F), which does the job automatically.  
 
Editing the map 
 
Sometimes your UV’s get a little messy, so you may have to tweak your map by hand, or at 
least discover where to add new seams. I suggest trying to avoid moving the UVs by hand, as 
it’s a painstakingly long process that can be achieved using other tools.  
  
If you’re not sure where the problem is, hit the Keep UV and edit mode mesh selection in 
sync button, and select the problem area in the UV editor. This way you can see exactly 
where on the model the issues are. That way you can target the rogue vertices and edit the 
map to suit the model better.  
 
When manipulating the UV islands by hand to move them around the image space, you… 
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Select them in Face selection mode by hovering your mouse over them and pressing L.  
 
Move them around with G as usual. Initially, you might be in soft selection mode, 
selecting vertices through a gradient. Adjust this with the mouse wheel until you only 
select the linked vertices of the island you selected by pressing L.  
 
You may also want to put sets of objects together, like the shoes, the legs, the arms, etc, to 
understand the shapes in Photoshop easier.  
 
Some Useful Tools 
 
Stretch Display 
You may prefer to work with the Stretch Display on in the UV editor, as it’s easier on the eyes 
than the dots and lines over a checkerboard pattern. It helps keep track of which areas need 
to have more or less seams, by keeping an eye on the stretching.  
Blue signifies no stretching is occurring; red signifies a lot of stretching. 
To access this, access the N menu of the UV Editor, and under Display, check Stretch.  
 

 
 
Pinning and Unpinning - P and Alt+P 
You can pin UV islands with P, and unpin them with Alt+P. Pinning them will lock them in 
place as you continue with other Unwrap operations. Each time you Unwrap, you start with a 
new UV map and will lose all your previous edits, unless the UVs are pinned down.  
 
Pack Islands - Ctrl+P 
The Pack Islands tool generates a optimized UV layout with non overlapping islands that tries 
to efficiently fill the texture space.  
 
 

Try to keep some space between the separate UV islands, to avoid bleeding when applying 
the textures. Bleeding is what happens when two textures are too close to one another, 
and the 3D software or game engine considers that they share coloured pixels. While this 
can be fixed by using larger image files, for the sake of optimization we’d rather make it so 
the UVs have more space in between them. Tools like Pack Islands, while great for creating 
a nice layout of our UV islands, can sometimes bring them too close together as in the 
image below, forcing you to move them by hand to give them a bit of padding. 
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While you might want to move them out of the image box for editing, make sure to bring 
back all of the UVs inside the box before you’re done!  
The checkerboard image repeats seamlessly on the sides, which keeps the pattern on the 
faces in the 3D view, but ultimately that also means that the UVs outside the box would 
overlap with the ones inside the box, sharing their texture, which is not what we want 
unless they are perfectly mirrored pieces.  
 

 
 

 

Minimize Stretch 
As the name implies, this tool helps minimize the stretching of the UV islands you’re working 
with, to space them out and fix the areas of distortion. We call this relaxing the UVs.  

Select the island you want to perform this action on by hovering your mouse over it and 
pressing L (Linked).  
Go to UVs and select Minimize Stretch, or press Ctrl+V.  
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Scroll the mouse wheel to relax the UVs and minimize their stretch.  
 
Average Islands - Ctrl+A 
Using the Average Island Scale tool will scale each UV island so that they are all 
approximately the same scale, by averaging out their size and spacing. Select the UV 
islands you’d like to be affected.  
  
Keep playing around with these tools until you have a good result.  
Don’t forget to save! 
 
If you need to do any changes to the model, try to do so before doing its UVs, as the UVs do 
not update automatically to the changes you do on the mesh. 
  
Save the blender file each time you make a major change, until you are ready to export the 
image for use in Photoshop. 
  
Export your map, and you’re ready to bring it into Photoshop. 

● Go into UVs in the UV Editor’s toolbar and choose Export UV Layout. 
● Choose the appropriate folder, and export as .png as something descriptive, like 

cube_uvs.png 
  
You should now be ready to texture the model!  
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Graphics 8 / Instructor: Ray Caplin 

Photoshop for 2.5D & 3D 
Create assets for games and stylized cinematic 2.5D cutscenes. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 1:30PM — 1HR 30M 
 
Instructor Prerequisites 
The instructor should be comfortable using Photoshop CC, able use to the basic animation 
tools in Photoshop.  
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Software Adobe Photoshop CC 
 
Objectives 
This lesson will focus on creating a parallax effect entirely in photoshop. This exercise will 
present concepts needed to understand 2.5D, The dementation will introduce one of the 
many ways to create assets for a 2.5D Cinematic.  

  
Vocabulary 
Parallax Scrolling. 
  
References 
Adobe Photoshop 

- https://www.adobe.com/ca/products/photoshop.html?sdid=KKQIN&mv=search&s_kw
cid=AL!3085!3!247828176853!e!!g!!photshop&ef_id=WYzbJQAAAHnHRFzB:2018062
6012552:s 

 
Photoshop animation tools  

- https://www.youtube.com/watch?v=maW9Q8IzMVQ 
 
Photoshop landscape tutorial  

- https://www.youtube.com/watch?v=Nl-rEEA9WQw 
 
Parallax Principle 

- https://www.youtube.com/watch?v=STwoa-9jxi0 
 
Parallax in AfterEffects 

- https://www.youtube.com/watch?v=KP0MVG8wA78 
 

 

What is 2.5D?  

The two-and-a-half-dimensional (2.5D, alternatively three-quarter and pseudo-3D) 
perspective is either 2D graphical projections and similar techniques used to cause images or 
scenes to simulate the appearance of being three-dimensional (3D) when in fact they are not, 
or gameplay in an otherwise three-dimensional video game that is restricted to a 
two-dimensional plane or has a virtual camera with a fixed angle. By contrast, games using 
3D computer graphics without such restrictions are said to use true 3D. 
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2.5D used in video Games today 

In the early days of video Games 2.5D was used as a compromise for software limitations or 
as a stylistic choice, some video games today. such as. Diablo 3 (2012), which uses a 3D 
game Engine with 3D model characters and Monsters, but its Background Elements are 2D 
painted planes, but they seamlessly fit within the 3D world, this is achieved by having the 
Camera fixed in one angle, so that the Flat Painted Elements that make up the background 
are fixed Facing us. if we were to move to rotate the Camera, we would clearly see that they 
2D planes in a 3D world.  This inclusion of 2.5D can be entirely for the sake of Stylistic 
choices, but also for optimization for video games, as 2D Planes have less polly then 3D 
shapes.  

 

 

 

There are Video Games,  composed entirely using a 2.5D style,  such as Darkest dungeon 
(2016), where the Characters are flat 2D animated plans. and the background is composed of 
2D painted planes, but the Game engine has positioned the 2D backgrounds in such a way 
that there is sense of 3D depth. The Background elements are placed at a distance in the 
back in 3D environment, along with props and other background elements, The Player 
Characters rest on a closer plane, closest to our point of view. This slight distance between 
the background and Player Characters is enough to create the illusion of depth. 
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This Illusion is made more apparent when The Player Characters traverse, as they 
travel along a 2D plane, distant objects such as the background move at a slower 
pace relative to the player. while near objects move at a similar speed to our own. 
This creates a Parallax Scrolling effect, which is an essential component to 2.5D 

.  

 

2.5D in Cinematics  

2.5D cinematics is often seen a very stylistic aesthetic, often times presented with painterly 
backgrounds and characters, or flat coloured with minimal or great detail. most often 
characters are composed of segmented elements, some seamless to fit a painterly style or 
others show there edges and present a more paper cut out look. whichever look is chosen the 
foundation is usually the same. 2D segmented planes arranged in a way to give the illusion of 
3D depth or perspective. sometimes the engine nesting the environment itself is not 3D and 
often just 2D images alone mimicking 3D. 
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Parallax scrolling Principle  

 

 

One element that is critical to 2.5D is the Parallax scrolling. Parallax scrolling is a technique in 
computer graphics where background images move past the camera more slowly than 
foreground images, creating an illusion of depth in a 2D scene and adding to the sense of 
immersion in the virtual experience. The technique grew out of the multiplane camera 
technique used in traditional animation, since the 1930s.  

There are different methods to achieve a Parallax scrolling. many of which have been 
constructed over time as hardware and software evolved, example 

Layered background method. Some display systems support multiple background layers that 
can be scrolled independently in horizontal and vertical directions and composited on one 
another, simulating a multiplane camera. On such a display system, a game can produce 
parallax by simply changing each layer's position by a different amount in the same direction. 
Layers that move more quickly are perceived to be closer to the virtual camera. another 
method.  

Sprite method. Programmers may also make pseudo-layers of sprites—individually 
controllable moving objects drawn by hardware on top of or behind the layers—if they are 
available on the display system. For instance Star Force, an overhead-view vertically scrolling 
shooter for NES, used this for its starfield, and Final Fight for the Super NES used this 
technique for the layer immediately in front of the main playfield. 

 

Creating Parallax Scrolling in Photoshop for 2.5D 

The Parallax effect is a simple yet effective illusion and can be easily constructed with very 
few tools. we’re be using Photoshop to create and protype our Parallax Scrolling.  

We will construct a simple 2.5D Forest Background environment with a Character.  
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Step 1 : Start by creating a blank canvas and Add 6 Layers, name each Layer and 
start by the Top Layer with this naming convention.  

- Top Layer: ForeGround,  
- Second Layer : Character and Props.  
- Third Layer: Background. 
- Forth Layer: Distant Background. 
- Fifth Layer:  Backdrop with clouds. 
- Sixth Layer: sketch layer.  

 

As you can see, each Layer will harbor a different portion of our background environment, 
We’ll work on each layer independently until entire environment is completed.  

 

Step 2: Draw 5 Horizontal lines on the Sketch layer spanning from both ends, make sure to 
draw each line separate from each other. the purpose of his is to establish the planes in which 
the background elements will rest and travel along. These lines are placeholders as to where 
you’ll place each background element as we construct our environment. 

 

 

Step 3: Start with foreground Objects on the ForeGround Layer, Its Ideal to make narrow 
things such as Trees or naked bushes here, or anything that won't totally obscure all the 
objects in lower Layers. keep these objects away from the centre and distant from each other. 
These objects don’t have to be resting on the Foreground line, its ideal they span past the 
canvas from below.  

.  
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Step 4: on the Character and Props Layer, create Characters and props, make sure 
they are resting on the established sketch line, as we touch up on each Layer, we 
move up ever so slightly the canvas,  

 

 

Step 5: On the Background layer, you need to fill the space from bottom to the edge of 
background sketch line. to give a better illusion add more details such as mountains or trees.   

(important) when creating background elements or anything that will continue on off the 
canvas, make sure to create extra background that expands far past the canvas, so that 
when the background is Scrolling, we don’t see the edge of the background so immediately.   

 

 

Step 6:  On the Distant background layer,  ideally you would place buildings or mountains 
here. The distant mountains in this scene is resting behind the mountains in the Background 
Layer. a nice trick is to hide objects behind other objects to cut corners on production.  
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Step 7: Backdrop Layer, a simple colour fill could work, but to get more out of this 
illusion, add something such as Clouds or a Gradient fill to bring it to life. like the 
Distant background Layer, you can hide a part of the Backdrop layer behind the 
Distant Background Layer. 

 

 

At this point your image is completed, you could add more Layers in between existing ones to 
better create the illusion of depth, once all elements are on their appropriate Layers and we 
are satisfied with our image, we can move on to prototyping the environment for a Parallax 
scroll. using Photoshop’s basic animation tools. 

 

 

Animating a Parallax within Photohop.  

This method is a quick and dirty way of viewing your progress of your 2.5D Environment, you 
could export your project to After Effects and take the time to set it up and prototype it from 
there. but while in photoshop you have added benefit of modifying the assets in real time.  

Step 1:  Switch your photoshop work station to “Motion” and click “Create a timeline” to 
create and view the animation timeline. 

Step 2: start with the first Layer Foreground, click the dropdown and you’ll see the 
stopwatches and their attributes, make sure your cursor in the timeline is at the beginning. 
Press the Position stopwatch to place a keyframe at the beginning of the timeline. 

In the timeline, navigate to the end of the timeline or until you reach 5 seconds, there place a 
keyframe by also clicking the PostionStopwatch. 
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Step 3. While your cursor is on th3e last Keyframe in the timeline, Press V to select the 
Vector Tool, where you’ll click on the ForeGround Object in the canvas. then while holding 
shift. Drag it across till the object beyond the canvas. if you press space you play back the 
Tween animation you've just created, 
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Step 4: Moving on to the Character and props Layer, you’ll repeat the same process 
by placing a keyframe at the beginning and end of the timeline. however, when you 
drag the Character and props Layer. make sure to drag them at a far less distance 
compared to the Foreground Layer. 

 

 

Step 5: moving on to the background Layer, you repeat the same process as Step 4, but 
placing keyframe and dragging the object ever so less than previous Layer, however, if you 
want to establish Great dethpe, you drag the Layer across the screen at a shorter distance. 
the farther an object is in distance, the slower it will move across the screen.  

 

Continue on with each layer, until all Layers have movement to them. the end result you 
should have a parallax scroll effect. with the assets you’ve created here, you can easily import 
them into After effects, unity or any other software that supports a digital camera, of course 
you’ll have to rearrange them in their respected order.  
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Paper Prototyping B / Instructors: Kahentawaks Tiewishaw & Ray Caplin 

Technical Drawings, Color Palettes & Environments  
From 2D to 3D—Create and use precise drawings as references  
for 3D modeling.  

 

 
Teaching Days, Time, & Length 
Monday July 16th, 10:00AM — 2HRS 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1JdDKJ3hvulrvfOHDj_DiHheQsCmVYHM-TC_
neygCXsE/edit?usp=sharing 

 
Instructor Prerequisites 
The instructor should have some experience with 2D illustration, and be comfortable using 
Blender and Photoshop. Additionally they must understand placement and use of the images 
to be created, including knowledge of orthographic (direct) views. 
 
Participant Prerequisites 
Participants  should have some experience in drawing or an interest in learning to draw. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender Version 2.79 
Plastic Gluon 
 
Objectives 
Learn basics of what makes good design for games. Covers research methods and colours, 
and goes through the concept art process. Understand technical drawing for 3D models, and 
its relation to Blender. 
  
Vocabulary 
Research, mood, colour, silhouette, turnaround,  T-pose, Orthographic (direct: front, back, side) 
views 
  
References 
Blender website: 

- http://www.blender.org/ 
 
Character Research 

- https://www.youtube.com/watch?v=jPZMxWCiA40 
 
Environment Research 

- https://www.youtube.com/watch?v=qXnp7wSevRE  
 
Colour in Storytelling 

- https://www.youtube.com/watch?v=aXgFcNUWqX0  
 
Technical Drawing 

-  https://www.youtube.com/user/scottrobertsondesign  
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The Process 
There are some standard steps that artists should take when creating new characters 
and environments for video games. These steps help the artist to envision and create 
stylistically consistent assets. These steps are: 

- research 
- concept drawings 
- technical drawings 

 

Research 
Research is the first step to creating awesome new characters and environments. It is 
extremely helpful to get a solid idea of what you want to create.  

 
Mood Boards 
Mood boards are a collection of images that an artists uses to inspire the creation of either a 
character or an environment.  The images used in a mood board should revolve around a 
specific idea or style that the artist has in mind. These images are found, and then constantly 
refferedback to when drawing a character or environment.  This helps the artist to remain 
stylistically consistent.  

You can use just about any online search engine to build a mood board. All you have to do is 
find images that inspire you! However it does help to bring these images into an image 
editing software so you put them all together in one big board. However it doesn't necessarily 
have to be a software as intense as Photoshop. You can create a mood board in something 
as simple as Microsoft Paint! 

 

Color Palettes 
Color palettes are very similar to mood boards in that they are a collection of color swatches 
that represent the color scheme you intend to use for either your character/environment. They 
can also be created in either a professional software like Photoshop, or in something as 
simple as Microsoft Paint.  

Hint: Try looking at the mood board you’ve created to see what kind of colors you’re drawn 
to, and put a few together to see how they look! Alternatively, there are many prebuilt color 
palettes online that you can look at for inspiration.  

 

The Importance of Colour 

While we don’t have much time here to talk about the meaning and uses of colour in media, 
keep in mind that it can drastically help enhance the feelings and meaning you are trying to 
imbue in your designs, and in your game.  
 
In Pan’s Labyrinth, the cold and dark reality versus the warm, bright fantasy world of 
Ophelia’s mind.  
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Giving pure, symbolic colours to objects of importance like in The Sixth Sense 

 
 
Planning out colors for a scene, a level, or a location in a game like in a film. 
Pixar uses colour scripts. 
“The colour script is an early attempt to map out the colour, lighting, emotion and moods in a 
film. It’s not about making a single pretty piece of art; the color script evolves throughout the 
early stages of the film, hand in hand with story development.” - Pixar Animation blog by 
Joshua Vardanega 
 
Similarly, you can plan the colours of an object, a person, or a location in a game as a whole 
in pre-production if you feel it’s something you want to explore for storytelling, instead of only 
focusing the functionality of colour for gameplay.  
 
What about games? 
 

 
Firewatch is a narrative game that uses colour to emphasize certain feelings throughout the 
game, while enhancing its natural environment, and making stark contrasts between different 
moments of the day. It also uses it to emphasize story elements.   
 

 
Abzu, a game which mostly uses its environment to tell its story, uses colour not only to 
differentiate between different environments and story arcs, but also a large difference 
between the mystical “magic” world and reality.  
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Concept Drawings 

Start sketching! You’ve gathered inspiration and references, but you can’t get stuck 
there! The real work happens now, as you start drawing your piece. Don’t commit to 
anything yet, just doodle many versions of the same thing; throw things at the wall 
and see what sticks. No one created a masterpiece with their first 5 brush strokes, so don’t 
limit yourself, explore and have FUN! Try different styles and shapes, colours too if you wish, 
but don’t get caught up in details. You’ll be able to edit all of this later once you have a better 
idea of what you want it to be.  
 
A good way to start out is by creating thumbnails, representing the basic shapes of your 
design. This is basically working with the silhouette, which will ensure that your piece will 
communicate well, since you would be able to read it from afar.  
 
If you feel like something is missing, don’t be afraid to go back to look for more references. 
Just make sure that most of your time here is spent drawing. The more iterations you make in 
this exploration, the more chances you might end up with something you like that also works 
with its function in the project.  
 
Gather Feedback 

Once you have a few drawings that might fit the bill, find a few people with whom you can 
share the pictures and who understand the function of your design for the project and ask 
them to critique your work. Then, using that feedback, go back to the drawing board and 
improve what you’ve worked on! This step is especially important because it helps to ensure 
that your design is understood by others around you. You may think that your design is 
undeniably X, but then another person would interpret it as Y, and you’d have to make a few 
adjustments.  
 

About feedback 
What we’re looking for here is constructive criticism. This is neither positive nor negative 
feedback, simply a way to give an opinion that is about the work (not about the artist) that 
explains clearly what parts are appropriate or not in relation to the project, and why. 
 
Bad feedback: 
“Well this design is stupid and I hate it.”  
(Not very helpful) 
 
Good feedback: 
“This design is the one I like best because it really shows how stable the mayor is as a 
character, he’s really grounded, but I think you should make the mustache even longer on 
the sides, since in the story all he does is talk about it. It should be the focal point!”  
(Is precise, helpful and prompts a conversation) 
 
Remember that in the end, your piece is your own, and you get to decide which 
feedback you want to follow and which one you want to discard. Just be careful not to 
get too attached to a piece just because you’ve worked longer on it!  

 
Decide on Your Final Image and Finish It 
In the scope of this workshop, this will not be a fully rendered and coloured picture but rather 
a detailed sketch to help us build in 3D... unless of course those are designs for 2D assets in 
the game! If what you’re making is a character or a complex object which we’d see many 
sides of, you should do a model sheet of it, detailing all of its different sides for modeling in 
Blender.  
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Technical Drawings 

Getting ready for Blender! 

 

Technical drawings for characters: 
 

When making your technical drawings, it is important for you to know what your character is 
going to look like at all angles. 
  
Once you have the concept down, if you haven’t already: start imagining what goes on 
around the areas you aren’t able to see from your initial sketch-up view. You must think of 
how clothing will look around the contour of the body, from the back, how the hair style falls, 
what the profile of the face will be, etc. 
  
Technical drawings bridge character 2D concepts with 3D models; they must fully describe 
your character in a way that a 3D modeler can understand. You must leave the least amount 
of gray area possible, so that you minimize guessing by the modeler, and possible 
misinterpretation. One view is not enough to make a 3D representation of a character, seen 
as we will be able to see it from all sides.  
 
Orthographic / Direct Views 
 
A typical set of technical drawings consists of a front view, a back view and a side view. Only 
one side view drawing is necessary if the character is completely symmetrical; two if not. 
  
These direct views are generally called orthographic in 3D space as they are straight-on, flat 
views, and the drawings themselves will only be visible in the orthographic views when 
imported into Blender. 
 
T-Pose 
 
It’s easiest to start with the front view, since it’s instinctive to think of your character/object 
that way. 
First, let’s think about our drawing in terms of modelling and animation. 
  
You must draw your character in what is called a T-Pose, with arms and legs separated from 
the body and each other, respectively. Think of the Vitruvian Man… 
  
T-Poses allow limbs to be animated freely. If the arms were modeled as if glued to her sides, 
the animator would not be able to move them at all. If the legs were glued together, the 
character would have to hop around rather than walk. In this way, a 3D model is just like a 
puppet or action figure.  
 
Decide to which degree you must separate the limbs. They don’t necessarily have to form a 
perfect “T”.  
 
Guidelines  
 
Next, you’ll be making the other views. Keep in mind those things which wrap around the 
body—they will have to match up!  
 
There are ways to edit them later, or work around them if detail isn’t extremely important in 
the problem area. A good trick is to have all horizontals in line with each other. This means 
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shoulders are at the same height, ears are at the same height, hands are the same 
length, etc. 
 
The best way to do this is to section off major landmarks in your model. If you’re 
designing a character, draw a horizontal line just under the head, at the waist, at the 
knees, and under the feet. When you’re drawing the side view/back view, use these lines as a 
guideline. You can draw those on paper, and make sure they line up properly in Photoshop 
later on; there are tools to fix it there too.  
 
Again, they do not match up perfectly, just do your best. You’ll be the modeler for this 
character/object, so you will be making final decisions in 3D. 
 
Character accessories 
 
If the character has important accessories that they carry around at all times but that do not 
wrap around their body (like a briefcase or a staff for example), it is worth making a separate 
front and side view for that object so you can model it later. 
 
To make your job easier: 

•        Use graph paper or loose leaf paper to sketch out your views. Tracing paper 
works wonders, too, for more complicated designs. Use tracing paper to make 
modifications on asymmetrical objects/characters.  

•        Trace over the front view to get the general shape for the back view. Flip the 
first side view and trace over to get the basic shape for the other side. 

•        Use a ruler to mark the guidelines.  
  
  
Technical drawings for buildings/environmental objects: 
 
Architectural elements and environmental objects follow the same general rules for technical 
drawings as characters, but with a few key differences.  
 
Scale 
When modelling very big or very small objects, it’s important to indicate a scale. Since the 
human being often refers to himself to gauge the size of things, drawing a small human figure 
next to an object usually does the trick. This is especially true for very big objects. However, 
you don’t need to be super precise, as you can always tweak the final result in 3D. 
  
In fact, for smaller objects it is often easier to determine the size that way. Put the object next 
to a character model and scale accordingly.  
  
 
Selective views 
 As opposed to characters, which can almost always be seen from all sides, architectural 
objects and natural elements sometimes have sides that remain hidden from the player at all 
times. It is worth thinking about this beforehand as to avoid drawing or modeling useless 
views for your objects. This will also save you a lot of precious 3D modeling time!  
   
 
Organic elements 
Some organic elements (trees, rocks, other natural elements) are actually easier to visualize in 
a perspective view than to try and understand how they would look like in orthographic 
mode. For these objects, it is often more useful to draw only the front view (to indicate the 
scale of the element) and a rough perspective, before jumping in and modelling directly in 3D.  
 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



186 1 Intro to Unity
192 2 Terraforming
195 3 Manipulating Assets
199 4 Unity Components and Prefabs
203 5 Animations and Mecanim
208 6 User Interface
214 7 Camera, Lights & Sounds
220 8 Blender & Unity Link

Engine

Engine



 

Engine 1 / Instructors: Sam Bourgault  & Corey Chang 

Intro to Unity 
Learn basic navigation tools by exploring a Unity project. 

 

 
Teaching Days, Time, & Length 
Wednesday July 11th, 2:30PM — 1HR 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/13f61A0WXgcNs23N5m3vADtwLZgbh5ls26
ZSH4Q5XU_A/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable using Unity. 
- Comfortable using Plastic Gluon as Version Control software. 
- Printed out “Assets Structure and Naming Conventions” for all participants to have. 
- Made sure to create a folder for each participant in Skins 6.0 Participants Games 

repository with a Unity project in it. 
 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to local versions of Skins 6.0 Template Game and Skins 6.0 Course Material 

from the hosting server 
 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon (synced to the demo project repository) 
- Unity 2018 

  
Objectives 

- Quick overview of what Game Engines are and what they can offer 
- Introduce the Unity interface and its functionalities 
- Import Standard Assets and begin an Explorable Landscape Game 

  
Vocabulary 
Game Engine, Hierarchy, Inspector, Standard Assets. 
  
References 
Software website: 

- https://www.giantbomb.com/profile/michaelenger/blog/game-engines-how-do-they-
work/101529/  

- https://unity3d.com/learn/tutorials/topics/interface-essentials  
 

 

 
What is a Game Engine? 
Back when game development was first starting to emerge it was 95% programming 5% 
everything else. Most teams were made up entirely of programmers with well-developed 
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knowledge of many different fields of programming. However, in the last decade, the 
need for deep, specific programming knowledge has lowered drastically thanks to the 
introduction of Game Engines. Game Engines are, at their core, platforms with built in 
modules and features to help speed up the development process of games as well as 
reduce the technical level needed to do so. 

These pre-built modules handle all of the low level programming involved in areas such as:  

- Graphics Rendering  
- 3D sound rendering and interpretation 
- UI tools 
- Physics simulations 
- Networking features 

Furthermore, most engines come with pre-built scripts and pre-designed functionality that 
one can start from. However, each engine have their own forces and weaknesses. And there 
are many to choose from:  

- Unity3D is one of the most well-known engines especially in the indie scene thanks to 
its accessibility and great documentation. Well known for creating mobile games such 
as Angry Birds and Hearthstone as well as many console games.  

- Unreal Engine 4 is another popular one with a high quality rendering engine and 
strong built in material editors. Many AAA games such as the Kingdom Hearts series 
as well as the Gears of War series were created using this game engine.  

- CryEngine is yet another game engine used by a number of AAA companies on 
games such as Far Cry and indie games such as Everybody’s Gone to the Rapture. 

The thing is, there are so many game engines to choose from, all of them with their own 
strengths. 

 

Why Unity? 
So why use Unity? In one word: “Accessibility”. It is one of the most accessible game engines 
to get into for a number of reasons: 

- First and foremost, it has a small learning curve. It doesn’t take long to get 
comfortable with this engine. Although it takes years to master like all other engines, 
in a matter of days, you can become more than comfortable enough to create your 
own simple game.  

- In depth documentation. Unlike many other game engines that require you to have a 
semblance of technical background in order to get your hands dirty with the engine, 
Unity has hundreds of well-crafted tutorials, examples and sample projects for any 
beginner to start with. From how to use the engine itself to well-crafted tutorials 
teaching programming concepts and practices. 

- Thanks to this, it has a huge community. But not just that, the Unity community is one 
of the most active and helpful communities when it comes to starting out and asking 
(or finding answers for) beginner or even advanced question. Unity has its own native 
forum on their website that is very active. Almost any question you may have will 
have been asked and answered and is a simple google search away. If your question 
hasn’t already been asked, it is normally a matter of hours before you will get an 
answer to a question posted on these forums. 

- Unity understands that not everyone has all the skills necessary to make a game from 
scratch and it leverages that idea quite well. It has a huge in house asset store where 
one can download any kind of asset, be it a model, script, system, shader, addon, the 
list goes on. Often these assets need to be purchased (most often at very reasonable 
prices) but there are also many free assets that one can download and work with no 
strings attached. The majority of all assets are user generated and new ones pop up 
daily. 
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- Lastly, Unity is free for all hobbyists and small studios. Unless you are making 
over $100 000 in a year using Unity, then it is completely free with no royalties 
or pay walls. A non-paying user has all the same features as a paying one. 

 

Unity Interface 
[Everyone should take the time to open up the template game to look at the interface 
directly inside of the game engine] 

Unity’s interface is set up into windows, all of which are moveable, scalable and dockable, 
that way one can set up their interface in the way that feels most comfortable for them. There 
are 4 core windows that all users will use throughout their foray into game development:  

- The project window: this gives the user a view of all the assets and directories within 
the project folder. Here you can select assets to use for specific scenes and also, 
modify existing ones as well as drag and drop new ones. 

- The hierarchy window: this demonstrates all gameObjects in the scene. We can select 
them in order to modify their components and values as well as create new objects to 
throw into the scene. 

- The scene view: this shows a 3D view of the in game scene and allows us to position, 
orient and scale all of our gameObjects in the scene. 

- Lastly if not most importantly, there is the Inspector view: this window shows all of 
the nuts and bolts of any asset selected (either from the project view or from the 
hierarchy or scene view). This is where we can see, modify and give or remove 
functionality to each and every object that will inhabit our game world. 

 

Project View 
The project view allows you to organize, modify and create assets inside the asset folder. All 
assets by default must exist here. It is extremely important to have a clean, understandable 
and pre-established assets structure before starting to develop, that way we don’t end up 
with a mess inside the asset folder. The messier the asset folder is, the longer it takes to find 
things and the higher the risk of creating doubles. We have created for you a clean assets 
structure and naming convention that you should follow for the purposes of this workshop. 

[Ensure each student has a copy of Skins 6.0 Folder Structure and Naming Conventions.] 

 

There are 3 core sections in the project view: 

- The Assets folder: holds all assets used in the game. We can navigate this area 
through the drop downs of each directory and all of the directory files will pop up in 
the file view. 

- The Favorites: holds all of each type of Unity asset. These sections collect all assets of 
each type so you can browse each type independently. Doesn’t have much use if you 
name and organize your files properly. 

- File View: shows all the files within the given context. If one has selected a directory 
within the asset folder, those files will be shown and it is possible to add files to that 
specific directory by right clicking or hitting the create button. If a favorite section is 
selected, all files of the given type will be shown in alphabetical order. Inside this 
view, there are 2 elements that can help with searching for assets:  

- The file view scale slider: allows to scale up or down the files inside the file 
view. This goes from simple name of file to large visible icon. This is good 
when you aren’t sure of the name of a file but know what the element looks 
like (i.e. mesh, texture, material, etc) 

- On the other hand, if you know the name of the file you are looking for, you 
can search for it in the search bar. This will filter out any file that doesn’t have 
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the search criteria in their name. Great for quickly finding files by 
name. 

 
Scene View 
The scene view allows us to see the 3D world we are currently working on. In here, we can 
move, rotate and scale any gameObject within the scene as well as move around in the 
scene. There are a number of hotkeys in order to work more efficiently in this view: 

- The QWERTY keys allow us to quickly switch object transform mode with the Q 
allowing us to move around the scene without selecting any object, the W allowing us 
to move an object, the E to rotate an object, the R to scale an object, the T to move, 
resize and rotate UI elements and the Y including the functionalities of WER all at 
once. 

- There are also a number of hotkeys with the mouse in order to help navigate inside 
the scene. The ALT and left mouse button allow us to rotate the view around the 
current view focal point. The middle mouse allows us to pan the scene, moving left 
and right in the current view. The ALT and right mouse button allows us to zoom into 
the view. Lastly, right mouse button alone allows us to rotate the view around the 
current viewpoint position. 

- Note that you can also navigate in a first person fashion using the right mouse button 
with the WASD to move horizontally and QE to move vertically. 

 

Hierarchy 
The hierarchy allows us to see all of the gameObjects currently in the scene. We can also add 
and create new objects to the scene in this view. In order to create new objects, we can either 
press the Create dropdown and select what we want to create or we can right click 
anywhere inside this window. If we want to bring an object from the asset folder into the 
scene, we can simply drag and drop the object from the project view to the hierarchy and it 
will be added to the scene. 

Aside from adding and creating new objects, there is an important concept that we need to 
understand. You see the arrows next to many of the objects in the hierarchy? It signifies that 
they have children gameObjects. Objects in a scene can share a parent-child relationship. 
What this means is that anything done to the transform of the parent (location, rotation or 
scale), will happen to the child as well. However, the actual values of the children objects will 
not change because they exist within the local space of their parent. All of their transform 
data is relative to the parent. This means that if a child is at the origin of the parent, it’s 
location will be 0,0,0 and if we move the parent 10 units to the right, the parent’s location will 
change and the child will move with it but the child’s location values will still be 0,0,0. This is 
the same for all the transform elements not just location, but also rotation and scale. In other 
words, parents always live in world space while children live in their parent’s local space. 

 

Starting your project in Plastic Gluon 
Since we want you to get use to Plastic Gluon workflow, we already created Unity project for 
each of you in the "Skins 6.0 Explorable Landscapes" workspace. 

Follow these steps to have access to your own project: 

- In Plastic Gluon, click on Switch Workspace at the right bottom of the window. 
- In the Action list, choose Create a New Workspace and in Repository, click on the 

three points “...”. 
- Select "Skins 6.0 Explorable Landscapes" and click Ok.  
- Once you reach the Action list window again, make sure the "Skins 6.0 Explorable 

Landscapes" is selected and click on Open from the list. 
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- Update your workspace before anything!! 

In this repository, you will find a folder with your name and with a Unity project inside. 
This is where you will build your Explorable Landscape and where you will have 
access to the other participants’ game. 

Once your own project opens, you will see a Main Camera and a Directional Light in your 
Hierarchy. Note also that your project folder contains many subfolders. The folder structure 
follows  “Skins 6.0 Naming Conventions and Folder Structure” document introduced earlier 
and is the same as the one that you will use for the final game. 

First thing you need to know is how to check out an element that you want to modify. Let’s 
say we want to change the intensity of the Directional Light. Since it is in the Scene Hierarchy, 
we need to check out the whole scene. 

- Go to the Scenes folder.  
- Click right on the Scene and go to Version Control > Check out. 

You will see a red lock icon appearing on the scene, this means that you have the object check 
out, so don’t forget to submit it when you are done. Now let’s say we modified the scene, we 
need to submit it so that other members of the project can have access. 

- Click right on the Scene that you just check out folder choose Version Control > 
Submit.  

- A window will pop up. Write a significant comment according to the changes that you 
just made in the Description and click Submit. 

Note that everytime, you save in a Version Control context, you are checking out the Scene 
unless someone has already checked it out, so you need to be careful and to check out your 
scene before you make changes to it. 

 

Inspector 
The Inspector view tells us all we need to know about a gameObject’s existence and purpose. 
It tells us its location in the 3D space, and it tells us what parts and behaviours make it up. 
This is the area where we can tweak any and all values in order to make each gameObject 
unique even if it has the same components. Let’s look at this example for a main camera. 

Here we see that the object’s name is Main Camera. A quick side note, it’s a very good idea to 
give each object a distinct and descriptive name. 

Here we are given the object’s transform data. This is all we need to know about its existence 
within the 3D scene. If this object has no parent, these values will be in world space, if it does 
have a parent, they will be in local space relative to the parent. 

This section here tells us that it’s not named main camera for no reason. We see that it has 
the component that gives it the functionality of a camera. Without it, even if we named it 
“Awesome main camera that does everything magically”, it would not act much like a 
camera. GameObjects are only as useful as their components and the inspector is where we 
can see and edit all of that. 

 

Standard Assets 
The Standard Assets are collections of assets made available by Unity for free. These 
collections include packages for Cameras, Characters, Environment, Particle Systems, etc. To 
access these packages, go to Assets in the menu bar, then Import Package, and select the 
appropriate collection you want to include in your game. 

In our case, we will import the Characters package. 
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Since we added assets to our project, we will submit them to version control. 

- You just imported the Characters package but for it to remain in your project, 
you will have to submit it to version control.  

- Click right on the new added Standard Assets folder and choose Version 
Control > Submit.  

- A window will pop up. Write a significant comment in the Description and click 
Submit. 

 
Guided Brief: Starting your Landscape 

1. Open the Lighting Menu in Windows > Lighting > Settings. 
a. Turn off “Baked Global Illumination” 
b. Turn on “Realtime Global Illumination” 

2. Add a plane to the scene. By clicking the right mouse button in the Hierarchy or the 
“Create” button at the top of the Hierarchy, go to “3D Objects” and select “Plane”. 
This is the floor. 

3. Add a cube and other shapes to the scene in order to create an abstract environment. 
Use the translating, rotating and scaling tools to get accustomed to them. 

4. In the Standard Assets folder, go to Characters > FirstPersonCharacter > Prefabs and 
drag and drop the FPSController in the Hierarchy. Note that the FPS Controller has a 
child, FirstPersonCharacter, which holds a Camera component therefore you must 
delete the Main Camera. Our context requires only one camera. 

You can now press the play button at the top of the Unity window and explore the world you 
just made.  
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Engine 2 / Instructor: Victor Ivanov 

Terraforming 
Exploring Unity’s terrain construction to craft  
environments suited for exploration. 

 

 
Teaching Days, Time, & Length 
Thursday July 12th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/16_FsfG7uN9GitR6Yr3qtK5b1bUJ9TP9enXpTiCn_zW
8/edit?usp=sharing 
 
Unity Download 
https://unity3d.com/ 
 
Instructor Prerequisites 
The instructor should be comfortable using Unity and its terraforming toolset. 
 
Participant Prerequisites 
Students must be minimally familiar with Unity’s interface and have a playable character 
gameobject. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Unity 2018.1.2+. 
 
Objectives 
Overview Unity’s terraforming tools and experiment with creating an environment. 
  
Vocabulary 
Terrain, heightmap, topology, paint, brush, opacity, alpha, textures, mesh, trees, details, grass, 
foliage. 
 
References 
Terrain and Heightmaps Introduction 
https://unity3d.com/learn/tutorials/topics/graphics/terrain-introduction-heightmaps 
 

 

Terraforming 
 
Unity has developed a system that’s meant to make building terrain easy, intuitive, and quick. 
It’s also really optimized; Since terrain can end up being really big in a scene, it’s important it 
isn’t taking up more resources than necessary. 

 
Terrain Object 
 
Using the tools provided by Unity, height maps can be dynamically altered in order to create 
landscapes entirely in-engine. Moreover, the terrain holds all tree objects, grass objects and 
terrain textures. All of these are compressed into a single object called a terrain object. This 
object controls optimization features like dynamically sizing the texture resolution based on 
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the texture coordinates’ distance from the camera. It does the same thing with trees 
and grass, dynamically making small objects visible and invisible based on how far 
the player is from them, and changing larger objects into flat planes when far away 
(called billboarding). 
 
A terrain object is created like any other Unity object: click Create in the hierarchy > 3D 
objects > Terrain. 

 
Heightmaps 
 

Unity’s terrain system relies heavily on one concept: the use of height maps to generate 
topology. A heightmap is a 2D black and white texture, where the color black is no elevation, 
and the color white is maximum elevation. When creating terrain in Unity, one is essentially 
painting onto this texture, which is then interpreted as height information by the terrain 
object. Of course, this means that a heightmap can only represent data on a single axis. 

 
Height Painting 
 

In order to modify the terrain topology, Unity uses height maps. An existing heightmap can be 
imported, but one can also be generated dynamically using Unity’s height painting tools. 
There are 3 options for the height tools: 
 
Raise/Lower, where the mouse can be used to paint the height of the terrain. Holding SHIFT 
lowers the topology. 
 
Paint Height, where a select point can be painted with a predetermined height. Holding SHIFT 
samples the target height before applying it. 
 
Smooth Height, where topology can be smoothed. 
 
All of these options share a number of features, mainly: 
 
Brushes, a selection of masks for height and texture painting. 
 
Brush Size, a control for brush size. 
 
Opacity, a control for how strongly each brush stroke should affect the topology. 

 
Textures 
 
Additionally, there exist texture painting tools for painting textures directly on the terrain 
in-editor. Textures can also be layered on top of one another for more dynamic materials. To 
create a material to use as a texture, select the edit textures button. If there are textures in the 
project, they can be selected to paint with in the same way as height painting. 
 
Worth mentioning, because the terrain object aims for optimization, it cannot use materials 
more complex than albedo textures with normal maps. 

 
Trees 
 
The terrain system also features foliage settings. Like textures and height, objects can be 
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“painted” onto the terrain. To do so, select “edit trees” and select the mesh to paint. 
Then, the mesh can be painted onto the terrain. This comes with a few parameters: 
 
Density, a control for how closely these objects are packed together. 
 
Height, a control for the height of these objects. Can be set to a random value to make 
environment feel more dynamic and natural. 
 
Lock Width to Height, a control that keeps these objects proportionally sized. 
 
Color Variation, a control for color variation, making an environment more visually varied. 
 
Holding SHIFT will erase all trees within the brush’s area. 
Holding CTRL will erase only trees of the selected type. 

 
Grass 
 
Like mesh painting, vertical textures, for things like grass, can also be painted. Select a 
texture with transparency, so as to only render the grass itself. Grass objects can have a wind 
effect added to them through the options in the terrain settings in order to achieve a more 
dynamic look. 

 
Details 
 
Additionally, “detail” meshes can be added for objects like rocks, or other static environmental 
details. 

 
Terrain Settings 
 
The terrain system as a whole has many values to tweak. For the most part, default terrain 
settings work well. There are a few, however, that can be modified to suit specific needs. 
 
The wind for grass settings modify how much wind affects the grass, as well as how it reacts 
to it: 
 
Speed controls the movement speed in relation to wind. The higher the value, the stronger the 
wind. 
 
Size affects the size of the ‘ripples’ that are created by the wind; the size between gusts of 
wind. 
 
Bending controls how much the grass bends with the wind. 
 
Grass Tint controls the color tint applied to the grass. 
 
The resolution settings control various parameters for the height map itself. The key values to 
play with are the terrain width, length, and height. These values scale the terrain and, by 
default, the terrain generated can be quite big. It’s a good idea to import an object that can be 
used as a scale reference, like a human-sized character, in order to see how the terrain should 
be sized. In general, though, keeping these settings at their default values works fine. 
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Engine 3 / Instructor: Sam Bourgault 

Manipulating Assets 
Learn the use of Light, Audio and the  
Asset Store to create an explorable landscape game. 

 

 
Teaching Days, Time, & Length 
Friday July 13th, 10:45AM — 1HR 45M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1SkNMiD-vqNi74DJuR0bmhAnxrsYH1ZhKFLh
v2-r5U3M/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable using Unity. 
- Comfortable using Plastic Gluon as Version Control software. 

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Participant Digital Landscapes repository 
- Access Skins 6.0 Course Material repository 
- Know the basics of Unity interface 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon   
- Unity 2018 

 
Objectives 

- Introduce what a GameObject is. 
- Introduce what Materials are. 
- Introduce the Asset Store. 
- Get an overview of Lights and Sound in Unity. 
- Learn to build a game. 

  
Vocabulary 
GameObject, Materials, Asset Store, Lights, Audio, Build. 
  
References 
Software website: 

- https://docs.unity3d.com/Manual/Materials.html  
 

 

 
What Makes up a Game? 
Everything in Unity exists as a GameObject. All models and characters are gameObjects, all 
light sources are gameObjects, trees are gameObjects, sound sources are gameObjects, the 
list goes on. Basically if the object exists inside the scene then it is considered a gameObject. 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 

195



 

If everything is a gameObject, what is the difference between the girl character and 
the audio source? The answer is: their components. Components are specific 
functionalities or behaviors that each gameObject contains. 

 

Materials 
Before we venture into the Asset Store, materials created within Unity are a good way to 
customize the basic 3D shapes that Unity offers. A material has a lot of parameters that you 
can play with to obtain very specific rendering.  

The most important element is the Shader that you are using. By default, it is set as Standard. 
The shader is a piece of code that tells the camera how to render the pixels of a certain 
gameObject. You can create very interesting effects with shaders, but we will not cover that 
topic since it requires some complex knowledge. We will rather explore the possibilities using 
the Standard shader. 

The Rendering Mode allows you to determine if the material is using transparency. Opaque, 
as it name suggests, doesn’t allow any transparency. The three other modes, Cutout, 
Transparent and Fade, offer transparency in different blending modes.  

The Albedo determines the color and the alpha channel of your material. The little square icon 
next to it allows you to add a texture map to your object. 

The Metallic parameter changes the shininess of the material and the Smoothness parameter 
affects the microsurface detail, which modify the reflectivity.  

Normal Map, also called Bump map, gives an appearance of bumps, grooves and scratches in 
a surface without changing the actual geometry.  

We will not cover the other parameters but you are encourage to explore them. 

 

The Asset Store 
The Asset Store is the Unity online market for assets, tools, extensions, and much more! At 
this stage of the workshop, we will take advantages of the free 3D art assets that you can 
easily find there. If you don’t see the Asset Store tab next to the Scene and the Game views, 
go to Window in the menu bar and then to Asset Store. 

In the search bar, you can type anything you would like to add to your world and there is a 
good chance you will find it. For the purpose of this exercise, we will only target the free 
assets so make sure you bring the Price cursor range to 0$-0$ and apply. 

Note that you can find 3D and 2D assets but also great skyboxes, useful tools and custom 
shaders. Tools that you might want to explore are: 

- Post Processing: To apply post-processing effects on your camera. 
- ProBuilder: To create more complex shapes directly in Unity. 
- Steam VR: To develop VR games. 
- Unity HDRI Pack: For free High Resolution Skyboxes. 

 

[Let the participants build their world for some time.] 

 
Directional Lights 
You probably noticed that you have a Directional Light in your scene that seems to be your 
only source of light. The Directional Light is one of multiple types of light in Unity. 

The Directional Light acts as a sun and imitates the behavior of a light source located at a 
great distance from the scene. Therefore the actual position of this light will not change the 
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lighting of the scene or the shadow orientation, only the rotation will. 

The most obvious parameters that can be modified on the directional light are the 
rotation, the color and the type of shadows (soft, hard or none). For the rest, you can 
explore them by yourself but we will also cover it later in the lessons. 

 

Ambient Light 
There is another source of light in the scene called ambient lighting. This can be understood 
as a global illumination on all objects from every direction. This type of lighting is particularly 
useful for outdoor scenes but can be annoying in other cases. 

To access this environment lighting go to Window in the menu bar, then Lighting and 
Settings. In the Scene Tab, you will see the Environment section. You can easily modify: 

- The skybox material and the sun source. 
- The source of Environment Lighting and the intensity to which the scene is affected.  
- The source of Environment Reflections and its intensity multiplier.  

To remove the ambient lighting, you can choose Skybox as the Source and bring the Intensity 
Multipliers to zero in the Environmental Lighting and the Environment Reflections sections. 
You can also select Color as the source of Environment Lighting and choose Black as the 
Ambient Color. 

Note that if you want a specific skybox that matches your environment lighting and that is 
seen by the camera, you need to modify the skybox in the Camera component settings. 

There is more to say on Lighting but this covers the basics of lighting a scene. 

 

[Make the participants modify the position and the rotation of the Directional Light in the 
Scene.] 

 

Audio 
Audio is extremely important to create a desired atmosphere. For a scene to have sound, you 
must include two things: an Audio Listener and an Audio Source. By default, there is always 
an Audio Listener on the Main Camera when you create a new project. In our current project, 
we deleted the Main Camera but we replaced it by the First Person Character that also holds 
an Audio Listener. The Audio Listener acts like an ear. The object that holds the Audio 
Listener becomes the location from which the sounds in the scene are heard. Make sure you 
have only one Audio Listener per scene! 

The other essential element is the Audio Source. As its name suggests, the Audio Source acts 
as a source of sound. You can have multiple sources in one scene, which can be music or 
ambient sound that will play continuously or sound effects that will play once as a 
consequence of an action. 

  

Guided Brief: Add Ambient Sound 
1. Create an Empty Object in your hierarchy. 
2. Rename the new Empty Object: Ambient Sound or Ambient Music. 
3. Make sure the Object is located at (0, 0, 0) in order to keep your objects well 

organized. 
4. Add the Audio Source component. Here the Empty Object is used as a container for 

the Audio Component. This is a very practical and clear way to incorporate music and 
sound in a scene. 

5. Add an Audio Clip to the Audio Source. If you don’t have sound files on your computer 
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that you can import in your project, go to the Asset Store and import free 
sounds. 

6. Make sure that the Play On Awake and the Loop checkboxes are checked. 
This allows the audio to start to as soon as the game begins and to loop 
continuously. 

7. Note that you can modify the volume, the pitch, the panning and the spatial blend of 
the Audio Source. For ambient sound we will keep the Spatial Blend to 2D as we don’t 
want it to vary in space. 

 

Building the Game 

Building the Game means to create an executable / standalone program that one will be able 
to play without having to download Unity. You will then be able to release and share your 
game to the world! 

Once you are happy with what you have created, go to File > Build Settings. Make sure that 
the scenes that make up your game are in the Scenes In Build section. If not, drag and drop 
them from your Scenes folder into there. In the Platform section, choose the platform you 
want to build your game for: PC, Mac, Android, etc.? And click on Build. 

Decide in which folder you want to save your game and click Select Folder. The building time 
can vary from few seconds to few minutes depending of the size of your game.  

Once it is done, go to the folder you saved your build in and double click on the executable to 
play. You will notice that Unity created many things in addition to the executable. These extra 
folders are required for the executable to run. So make sure you keep them together when 
you share your game. 
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Engine 4 / Instructor: Victor Ivanov 

Unity Components and Prefabs 
Introduction to Unity’s object structure  
(GameObjects and Components). 

 

 
Teaching Days, Time, & Length 
Tuesday July 17th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1aZp_KnqaYIGtHne9Ni1TBFKSWjIKdAhHyqY7v2l6IEk
/edit?usp=sharing 
 
Unity Download 
https://unity3d.com/  
 
Instructor Prerequisites 
The instructor should be comfortable using Unity. The instructor should also be familiar with 
Unity’s components system, and popular components like rigidbodies and colliders. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Unity 2018.1.2+. 
 
Objectives 
To learn about Unity’s underlying gameobject - component structure, and to experiment with 
colliders and rigidbodies in order to gain a grasp on physics. 
  
Vocabulary 
Gameobject, component, behavior, transform, mesh, collider, rigidbody, prefab. 
  
References 
Components Tutorial 
https://docs.unity3d.com/Manual/UsingComponents.html 
 

 

Game Objects 
Everything in Unity exists as a GameObject. All models and characters are GameObjects, all 
light sources are GameObjects, trees are GameObjects, sound sources are GameObjects, and 
so on. Simply put, if the object exists inside the scene, then it is a GameObject. What 
differentiates GameObjects from one another is their components. 

 

Components 
Components are the building blocks of all GameObjects. A GameObject can be thought as a 
container for components, and these components define the behaviors of that GameObject. 
Behaviors can mean many things, like the position, rotation, and scale of the GameObject, 
how this GameObject collides with other objects, how it reacts to physics, how it emits 
sounds, etc.. 
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Components can be described as many things. 
 
Functionality 
 
If we want a GameObject to play a sound, we need a component that handles sound 
emission. 
 
Behaviors 
 
If we want a GameObject to patrol an area and run after intruders, we need a component 
that finds intruders and moves the GameObject towards them. 
 
Data 
 
If we want a GameObject to hold the current state of an event or character stats, we need a 
component to hold that data. 
 
Ultimately, components are everything that we can see and manipulate in the inspector view. 
Every box within a GameObject’s inspector is a different component with a different purpose. 
 
Let’s take a look at a main camera GameObject. 
 
The camera needs to exist in the 3D space, so by default, it has a Transform. This tells the 
engine about this GameObject’s existence in the 3D world. It contains its position, rotation, 
and scale. 
 
Since we want the camera to act like a camera, we need it to have a Camera component. 
This component allows the camera to capture a rectangle view and use it as the game 
screen. 
 
Since this is a camera, we may also want a few other components. The Flare Layer allow the 
engine to draw an extra layer on top of the camera for each for the lighting effects. The Audio 
Listener makes the player hear the sound from the Camera’s perspective. Both of these 
components are technically optional for a basic camera, but they add useful functionality. 
 
Most of these components are built-in Unity modules. However, if you see a component with 
a C# icon, then those are custom-made components. 
 
Let’s go through the most common built-in components. 
 
Transform 

By default all GameObjects have a Transform component. This component controls the 
GameObject’s existence in the 3D space. It determines the position of the GameObject as well 
as its rotation and its scale. The position is calculated in Unity’s units, which are implicitly 1 
unit = 1 meter, but that relationship is not absolute. Rotation works in degrees, and scale 
modulates the size of a gameObject by multiplying its original size by the scale values for 
each axis. 

 
Mesh Renderer 

The mesh renderer component allows a mesh to be rendered in the game world. This 
basically allocates a mesh avatar for the GameObject in order for it to be rendered. Without a 
mesh renderer, the GameObject will not be visible in the scene. The mesh renderer component 
is created by default when you import an object with a mesh or when creating a basic shape. 
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It handles a few lighting options, such as controlling if the object should cast 
shadows, and if shadows should be rendered onto it. It also holds one (or more) 
materials that dictate how the mesh will look. Materials are created inside Unity, and 
can span a wide range of varieties. We will cover the details of materials in a later 
lesson. 

 
Colliders 

The collider component gives a GameObject a physical boundary that can be interacted with 
by other GameObjects, as well as player interactions. In short, colliders allow for collision. 
There are a number of different collider components, with the main difference between each 
being their shape. 
 
Box Collider 
 
Box shaped collider with a controllable size for each axis. 
 
Sphere Collider 
 
Spherical collider with only a controllable radius. 
 
Capsule Collider 
 
A mix of the box collider and sphere collider. Like the sphere collider, it has a radius to control 
its circular width. However, it also has a height to control how vertically stretched it is. 
 
Mesh Collider 
 
A collider that generates a complex mesh to wrap around the GameObject’s mesh. This 
collider can have a noticeable impact on performance if used on a higher-poly model. In 
general, it should be avoided unless used for specific cases. In most situations, one can use a 
combination of colliders to estimate the shape and size of a GameObject, as opposed to using 
a mesh collider. 
 
All colliders have a parameter called Is Trigger. This option dictates whether a collider should 
have a physical presence in the environment, or only a computational one. What this means 
is that if “Is Trigger” is selected, any object with a collider that touches this object will move 
straight through it, but a collision will still be recognized by the engine. This is useful if you 
want to use a collider to recognize when a player has entered an area, for instance. 
 
Rigidbody 

The rigidbody component allows a GameObject to simulate physics. It handles all of the 
physics calculations by default, while allowing us to program additional physics behaviors. 
This component exposes a number of interesting values that we can play with in order to 
customize the physics profiles of our GameObjects. 
 
Mass 
 
Allows us to specify a value (implicitly 1 = 1kg) for the GameObject’s mass. The higher the 
number, the more force is required to move it. 
 
Drag 
 
Allows us to specify a value that acts as a resistance to acceleration. The higher the value, 
the faster an object will decelerate when moving. 
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Angular Drag 
 
Controls the deceleration of rotational force or torque. 
 
Use Gravity 
 
When selected, this will constantly simulate the force of gravity and move the object 
downwards. 
 
Is Kinematic 
 
If selected, this will ignore all physics calculations. This may seem counter-intuitive for a 
component that simulates physics, however, in certain cases, we may want to have a 
rigidbody to modify, but without any ongoing physics calculations. For example, you may 
want on object to not react to physics for a short time while building up force, and then react 
to all of the built up force at once. 
 
Demo 

[Create physics playground scene.] 

 
Prefabs 

A prefab is an abstract, preconfigured version of a GameObject that is saved in your project 
folder, and can be cloned / spawned / “instantiated” during runtime. 
 
Why 
 
Prefabs are incredibly useful because they allow you to save a complex GameObject with all 
its components and values, and spawn in copies of it at any point in time. For instance, if 
you’re making a space shooter, you might make a bullet GameObject with all its necessary 
components. Then, you’d make a prefab, and spawn that bullet object each time the player 
shoots. 
 
How 
 
To create a prefab of a GameObject, just drag and drop this object from the hierarchy to the 
folder in which you want to save it. Having a folder named “Prefabs” in your project files is a 
good way to organize things. 
 
Once your prefab has been created, you can delete your GameObject from the scene. There 
are two ways to modify the prefab, now. 
 
First, you can change the prefab’s properties directly in the inspector by clicking the prefab in 
your project folder. 
 
Second, you can change the prefab’s properties in the inspector of one of its instances. An 
“instance” is a copy of the prefab in the scene. If you decide to modify a prefab in the scene 
(so, an “instance” of the prefab), you must press the “Apply” button at the top of the inspector 
after you’ve finished making changes. This will apply the changes onto the prefab, as well as 
all other instances. 
 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

Engine 5 / Instructor: Sam Bourgault 

Animations and Mecanim 
Introduce how to create animations within Unity  
and explore its animation system, Mecanim. 

 

 
Teaching Days, Time, & Length 
Tuesday July 17th, 3:15PM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1T2FZBUa3TNtfI7PhKgrxpndwE_LqKrcSEHD
9j2uJMGI/edit?usp=sharing 

 
Instructor Prerequisites 

- Comfortable with Unity. 
- Comfortable with Mecanim system.  

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access Skins 6.0 Course Material repository 
- Know the basics of Unity interface 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 

 
Objectives 

- Introduce how to create animations within Unity engine 
- Explore Unity’s complex but robust animation system: Mecanim 

  
Vocabulary 
Mecanim, Animations, Animator Controller. 
  
References 
Software website: 

- https://docs.unity3d.com/462/Documentation/Manual/MecanimAnimationSystem.html  

Software Tutorials: 
- https://unity3d.com/learn/tutorials/topics/animation/animation-view?playlist=17099  
- https://unity3d.com/learn/tutorials/topics/animation/animate-anything-mecanim  

 
 

What is Mecanim? 
Unity has a very sophisticated and robust system that handles everything related to 
animations. This system is called Mecanim. Mecanim provides multiple useful functionalities: 

- Animation creation within Unity. 
- Support for imported animations. 
- State Machine using visual coding tool to define the interactions between animations. 
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- Humanoid animation applied from one character model to others. 
- And much more. 

Mecanim handles all of this with very little programming involved. In this lesson, we 
will cover the standard workflow for setting up the animation system of a 
gameObject. 

 

Animation Clips 
The first elements we need in order to develop the animation system for any gameObject are 
the Animation Clips. The Animations Clips are generally specific to the bone structure of a 
rigged model. For humanoid model however, Mecanim enables the retargeting of humanoid 
animations, which allows a model to use animations from another one provided that both rigs 
are set as Humanoid and properly configure. 

The Animations Clips can be either created within Unity in the Animation Window or 
imported from an external sources. Therefore the animations created in Blender can be used 
by Mecanim in Unity. Complex animations will be created externally and simple movement 
will be done internally. 

 

External Animation Clips 
In some cases, external animation clips can come with the rigged model to be animated and, 
in other cases, they can come in distinct files. We will begin looking at the former option. 

When we import a model containing animations, we can access them by looking into the 
children of model file in Unity. The animations are represented by a white Play symbol inside 
a grey square. You can preview the animation in the inspector by selecting it. 

The most important step when importing external animation clips is to determine the 
Animation Type. To do so, click on the model containing the animation, this will open the 
Import Settings. In the Rig tab, you will notice the Animation Type dropdown. If your 
animation doesn’t apply to Humanoid character leave the type to Generic, if it applies to 
Humanoid and you want your animation to be used with other model than your current 
model, select Humanoid and Apply the change. If the model’s bone structure is standard, 
Unity will be able to map them automatically to its humanoid avatar system. Sometimes 
errors occur and a manual mapping is required. To access this feature, go in Configure and 
drag and drop the right bone transforms into the right slots. If it is still  

Then go into the Animation tab, you will see a list of animation clips imported with the model. 
You can check the Loop Time box for any animation you want to loop when executed. If the 
Animation Type is set to Humanoid, you will have to consider Root Motion to set up your 
animation properly. 

 

Root Motion 
If the Root Motion box in the Animator component of your gameObject is checked and the 
animation that you are using is moving that object, the animation will drive the character 
movement. To keep the model in place, uncheck the Root Motion box. This is necessary in 
order to control the displacement of your object through script or when using the Navmesh 
system. 

The Body Transform of a model is located at its mass center and is stored in the Animation 
Clip. The Root Transform is the projection on the XZ plane (the ground) computed at runtime. 
In the Animation Clip Inspector, you can control the Root Transform projection. 

Root Transform Rotation. If you check Bake into Pose, the gameObject will not be rotated at 
all by the Animation Clip. You will want to Bake into Pose the Animation Clips that have the 
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same starting and ending body orientation. 

Root Transform Position (Y). When Bake into pose is checked, the Animation Clip will 
not change the height of the GameObject. You can enable this setting on almost every 
animation clip except the ones that aim to modify the height of an object, like jumping 
or going down stairs. 

RootTransform Position (XZ). When Bake into pose, the animation will not affect the 
gameObject movement along the XZ plane. This setting is good when you want your object to 
remain in place, like in the case of an Idle animation. 

 

Animation Clips Created in Unity 
The animation window inside Unity allows us to create and modify animations directly inside 
the Unity editor. The main idea behind this view is to create time points for various 
components of a selected object and its children. These time points (better known as 
keyframes) will register the state of a particular value in a component and the animator 
(covered later) will transition the object between those two states within the time between 
them. 

The default view in the animation window is the dopesheet. This allows us to create 
keyframes within the timeline but that’s all the information we get. We can change the view 
to the curves view which will not only show us the key frames but will also show us the 
interpolation curves between them. This view gives us great control over the transition 
between keyframes. 

To create an animation for a specific gameObject, you have to open the Animation window 
and select the object in the hierarchy or in the Asset folder. Then click on Create, save the 
animation with a relevant name and add the properties you wish to animate in the 
dopesheet. 

Bring the white line cursor where you want to add a keyframe and change the desired 
property of your object in the Scene view or directly in the Animation window. Then click right 
in the dopesheet and choose Add key. Press the Play button at the top of the Animation 
Window to visualize your animation. 

 
Animator Controller 
The Animator Controller is where you build the state machine that will control the transitions 
between animations. To create the states you have to either drag the Animation Clips into the 
Animator Window or click the right mouse button in the Animator Window and select Create 
State > Empty. If you create an Empty State, you will have to define the Motion (Animation 
Clip) associated to this state in the Inspector. You can also choose to create a Blend Tree, but 
we will cover that option later.  

Note that the Orange State is the Default one, which means that the gameObject will 
automatically begin executing that animation when the game starts. You can change the 
Default state by clicking the right mouse button on the Animation you want to set as Default 
and select Set Layer as Default State. As its name indicates, the Any State is useful when you 
want an action to be accessible from any state. And the Exit, allow to quit the state machine. 
These two last nodes are not employed often. 

Once you have all your states in place, you can create transitions between them by clicking 
the right mouse button on any state and by selecting Make Transition. This will create a white 
arrow that you will have to drag to another state to which you want to transition. In our 
current example, we have a state machine for a character that can perform three different 
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actions: idle, walk and run. The Character begins with the Idle animation, which can 
transition to the Walk animation. Once the character is walking, it can transition to 
the Run animation or go back to the Idle animation. 

 
Transitions 
By selecting any of the arrows in the previous image (which represent transitions), we can 
manage that particular transition. We have a number of options we can play with here. 

- First we can toggle Has Exit Time on and off. If on, the transition will wait for the 
current animation to finish before transitioning to the next. Some animations 
(especially looping one) we don’t want to wait for the end. We want the transition to 
interrupt the animation so we will uncheck that box. 

- Inside the settings we have a few options. The main ones to understand for now are 
Exit Time and Transition Duration. Mecanim interpolates the transition between two 
animations and we can control how quickly it interpolates. This is the transition 
duration. Similarly, the exit time is how much of the second animation we want to 
play after the transition. Both of these values are between 0 and 1 (think of it as a 
percentage) and the transition duration will overlap the first animation with the 
second animation for the transition duration percentage of the second animation. 

It may be very difficult to understand this with just these values so Unity gave us a graphic 
representation for these values. The timeline below represents the transition based off of 
these values. If you are more comfortable working visually, you can actually change these 
values in this timeline as well by simply sliding each element. 

Lastly, we have the bread and butter of transitions: their conditions. Most transitions will 
require a specific condition in order to occur. By creating parameters (which we will go into 
details next) we can dictate the conditions in which the transition will be triggered. Note you 
can have a transition with no condition. In this case, the first animation will play once and 
then transition to the next. In order for this to work, Has Exit Time needs to be toggled on. 

 

Parameters 
Parameters allow us to create conditions for our transitions. However, these parameters can 
only be modified in code. We do however create them within the animator interface and then 
use them inside the transition inspector. On the left of the state machine, there is a window 
specifically for that purpose. By clicking on the small plus icon, we can create one of 4 
different types of parameters, all of which have different purposes: 

- Int: is a whole number such as 1, 12, or 25 436 for example. These are generally used 
when you want to count how many times something has happened. 

- Float: is a number with floating points such as 2.4, or 256.398 for example. These are 
generally used to keep track of speed or time for example. 

- Bool: is used to check whether something is true or false, on or off. This is generally 
used to check if something is still true, such as “am I still in the air” or “am I still 
crawling”.  

- Trigger: is used to call a transition instantly. This is generally used for calling 
animations that should just play once, often triggered directly by player input. 
Examples of these are jumping, attacking, recoiling from an attack, etc. 

 In our current case, we could define a float parameter for the Speed and define our 
conditions according to the change in that speed. 

Brief: First Animation System 
1. Open the FirstAnimationSystem project in Engine 5 of the Course Material. 
2. Create a basic shape: cube, sphere, etc. 
3. Create two animations clips for that shape using the Animation window. 
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4. Create an animator controller and add your two animations in it. 
5. Create reversible transitions between them and use a boolean as the 

condition to go from one to the other. 
6. Uncheck Has Exit Time in your transitions. 
7. Run the game and go into your animator controller to manually change the 

value of the boolean. Note that this is definitely not optimal and that we will look at 
how to modify a parameter through code. 

You should now have a better understanding of the workflow required to animate a 
gameObject. 
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Engine 6 / Instructor: Victor Ivanov 

User Interface 
Exploring tools and methods for creating  
responsive UI elements and layouts. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 9:15AM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1jT9QATMsegBTqyVkfOS5EyLLQqKTqB0gOkXuMz5r
5aY/edit?usp=sharing 
 
Unity Download 
https://unity3d.com/ 
 
Instructor Prerequisites 
The instructor should be comfortable using Unity and its canvas system. 
 
Participant Prerequisites 
Students must have minimal experience with Unity’s interface. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Unity 2018.1.2+. 
 
Objectives 
To study Unity’s user interface toolset for creating responsive user interfaces, and a look at 
user interface design. 
  
Vocabulary 
Interface, data, abstract data, spatial data, narrative data, action data, atmospheric data, 
interaction, platform, diegetic, feedback, canvas, anchors, panels, images, text, buttons, 
sliders. 
  
References 
Rect Transform and Anchors - Unity Dev Team. 
https://www.youtube.com/watch?v=FeheZqu85WI 
 
Cartoon hologram style UI. Consistent and involved interaction feedback example. 
https://www.youtube.com/watch?v=O161-WNZBP4 
 

 

User Interfaces 
 
The purpose of a user interface is, above all, to allow for communicate information between 
the game’s internal systems and the player. More or less any form of information can be 
communicated, however we can subdivide the topics into communication of resources, 
instructions, and feedback. 
 
Secondary to the technical communication UIs can accomplish, but important nonetheless, is 
their capacity to add style. Artistic renderings of UI can make a world feel more complete, or 
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to raise your character’s cool-factor, or maybe make it deliberately difficult for you to 
navigate in moments of high-anxiety. 
 
Additionally, from a compositional perspective, a UI can frame a shot. Most traditional 
UI elements reside around the borders of the screen, which can potentially provide 
interesting crops, or push / pull attention to / from points on the screen. 
 
Data Types 
 
One way to start things off is to look at the content we’re communicating, and this is true for 
pretty much all design. So, a question I always start at is “what am I trying to communicate”? 
And then, “are there existing strategies for communicating this?”, and finally, “can I think of 
any strategies that will communicate this more effectively?”. 
 
The first question is admittedly pretty broad. But, we can try to break down the common 
forms of data that we try and communicate through UI. Don’t put too much emphasis on the 
names, the purpose here is to get a feel for the breadth of information we can express. 
 
Abstract Data 
 
Abstract data encompasses all pure values. By that, I mean things like your health, your 
ammo count, your energy, your money, etc. All of these things are numbers related to the 
mechanics of the game. They’re not for style, but give the player fundamental information. 
 
The decision to hide or expose certain data can make or break a game, so these are quite 
integral to the player’s experience. Like in Monster Hunter, for instance, the monster’s health 
is not visible. These fights can last upwards of 20 minutes, so why not display the health? So 
as to not discourage players in the beginning, to make them more hopeful as they approach 
completion of a hunt, and to motivate them to figure out how the monster is doing based on 
its movement and visuals. If it had a visible health bar, hunts could be a lot less exciting and 
tense. 
 
Typically, abstract data is represented in visuals that make it easy to infer a value. Text and 
numbers are super common, especially for values that require precision, like money and 
ammo. Otherwise, more stylized graphics like (health) bars can do the job. They don’t require 
as much precision, so it’s alright if they’re not incredibly clear. Still, it should be easy to tell 
when you’re at 50% health when a bar is half the size of its container, so it maintains minimal 
clarity. 
 
Spatial Data 
 
Spatial data is data related to the game world, and objects’ locations in it. For instance, when 
an enemy attacks you, you might see a graphic that will hint at which direction you were 
attacked from. Or when you need to get to an objective, and have a floating marker that 
points to it. And certainly, mini-maps are a significant contributor to spatial data UI elements. 
Arguably, a crosshair in the middle of your screen to help you aim could also be considered as 
spatial information. 
 
Very often, this data is not displayed primarily as text, but as images or effects. In the case of 
spatial data, the positioning of these UI elements is much more significant. It’s far easier to 
use spatial position of the UI element to communicate… well, spatial information. It’s fast for 
humans to read, and it’s quite intuitive to follow a dot on the screen as opposed to emulating 
a coordinate system in our heads. Numbers can still accompany these spatial markers, so 
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that you know how far away you are from your objective, for instance, but the way 
spatial data is communicated is most often not text-driven. 
 
Narrative Data 
 
Narrative data includes things like objectives, narration, instructions, and so on. Basically, 
anything that’s meant to explain or instruct information to the player. This data is most often 
communicated through longer-form text. It’s usually quite static, and doesn’t provide as much 
feedback as other forms of UI. Be wary, however, that it can become bulky and overwhelming 
for the player to navigate so much data. 
 
For this reason, narrative data is usually found inside a menu, so as to remain hidden during 
active gameplay. The idea is to keep clutter off the player’s screen, especially since they don’t 
usually need to remind themselves of that information in a hectic gameplay setting. 
 
Action Data 
 
Action data is UI that communicates more complex ideas, like an ability, or an item. This UI, 
unlike what we’ve talked about until now, is often interactive in some way. So, clicking an 
ability triggers it, or drag and dropping an item moves it from one place to another. 
 
Very often, action data is primarily communicated through images. This is because, especially 
for abilities, things need to be recognizable as quickly as possible. What’s cool about these is 
that you can attach text to images very easily, so communicating some abstract information 
along with action data is not uncommon. It’s also typical to mouse over such UI elements to 
get more information about them in text form, like their stats, or narrative details. 
 
Atmospheric Data 
 
Atmospheric data is UI that provides aesthetics and atmosphere to a given location, and 
sometimes to act as feedback to in-game events. Things like water drops on the player 
character’s visor, blood around the screen when you’re hurt, having your glasses fog up in a 
hot room, a pulse that crosses the terrain when you scan an environment, etc.. 
 
These are commonly not fundamental to the experience, but can add a lot of polish and style. 
They’re communicated through effects, so they’re usually more complex graphics to develop. 
 
Interaction 
 
Of course, UI is not just there so the game can speak to the player, but also so the player can 
speak back to the game. What’s important to consider when it comes to interactive UI is how 
exactly players are expected to provide input. 
 
Is it by clicking an icon? That’s quick and responsive, but uses the mouse, so it needs to be an 
available form of input. 
 
Is it by moving a slider? That’s more slow-paced but allows for some extra precision. 
 
Is it by writing something with their keyboard? This is slow and awkward, but can be fun for 
terminal, hacking-game interfaces. 
 
Is it by drag and dropping? Very convenient for ordering things, especially in a grid. Feels 
tangible. 
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There are also important considerations be taken when it comes to input device. 
Button clicks and drag and drop is much more awkward for a controller, as a cursor 
can’t move across the screen with the same speed and accuracy as with a mouse. So 
it’s also important to consider how the user will cycle through elements in a menu. 
 
A mouse can simply hover over items, it has no limitations. A console controller’s 
awkwardness with this has many designers create a menu navigation system, where the 
user has an active selection of an item, and can navigate other items by using this selection 
as a sort of grid-locked cursor. 
 
Of course, now we also have mobile games. Some designers opt for emulating controllers 
through minimally-intrusive joystick + buttons UI, and others use touch-screen specific 
gestures to keep the interface to a minimum. With less screen real-estate than computer 
monitors or TVs, designers need to be extra careful with how much UI is in the way. 
 
Style 
 
As mentioned in the beginning, interfaces also have the capacity to provide artistic value to a 
game. The way they look, behave, react, as well as the way they’re integrated into the game 
world, all have an effect on the quality and level of interest a UI inspires. 
 
Diegetic / Non-Diegetic 
 
Let’s first deal with the most fundamental decision of UI integration: diegetic and non-diegetic 
UI. In less fancy terms, diegetic UI is an interface that is directly in the game world, as 
opposed to simply floating on your screen with no anchor to the game’s reality. 
 
Non-diegetic UI is far easier to make. By having something float over everything, it is always 
accessible to the player, and in general, a very clear form of communication. In-game UI can 
be difficult to read in certain angles, and large amounts of information can’t be communicated 
without turning the entire game world into a big interface in of itself (which sounds pretty 
cool, to be honest). 
 
With that being said, diegetic UI makes everything a lot more visually immersive, as 
everything is contained within the game world. It can be beautiful, and give a narrative 
functionality to in-game objects that would otherwise be meaningless props. 
 
It is not common to see both diegetic and non-diegetic UI working at the same time, with the 
same level of emphasis. Most often, unless a game has gone full diegetic, any in-game UI is 
meant as additional feedback as opposed to a primary source of communication. 
 
Complexity 
 
The complexity of a UI is typically determined by the quantity of information that must be 
communicated. 
 
Minimal UIs are great for games that put an emphasis on scenery, or unique graphics. In 
those situations, an interface gets in the way of a beautiful game. 
 
Super complex UIs have their own place, too. MMORPGs have dozens of abilities and multiple 
enemies to keep track of, and their UI reflects that. 
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Feedback 
 
An important principle behind interfaces is feedback. Feedback is both a stylistic 
effect, but a functional one, too. Feedback is the reactions elements exhibit when 
they’re interacted with, or updated. These dynamics go a long way to give UI life. 
 
Feedback can take many forms, since it manifests itself as a stylistic effect. The common 
techniques, however, are small changes in element properties. For instance, it might grow or 
shrink in size, or change color, or play an animation. 
 
Unity 
 
So how do we make UI in Unity? First, we need a place to put our UI elements. 
 
Canvas 
 
The canvas is the container for all UI. It is an invisible plane, typically projected directly on the 
camera (but not necessarily). All UI elements must be children of the canvas. And, since 
elements are predominantly 2D, they can be layered in the hierarchy view. The higher an 
element is within the hierarchy, the further “back” it is rendered. The order in the hierarchy 
represents the order in which the objects are displayed. Like in painting, the first element 
painted will be overlayed with the subsequent ones. 
 
Rect Transform and Anchors 
 
Aside from elements’ order, we also need to consider their anchors. An element’s anchor 
determines how it should react in relation to the screen resolution, which allows us to make 
responsive UI. What this means is that the UI will dynamically change to fit different screen 
sizes and resolutions. This is done by specifying what kind of anchor we want the element to 
have and where it is located. These options are located in the Rect Transform component, 
which comes by default on all UI elements. 
 
The key points of the rect transform are the positions, dimensions, and anchors. All of these 
values are used to determine where an element will be on the canvas relative to its parent 
element (as long as the parent also has a rect transform). Usually, one would set the anchors 
by using Unity’s presets and then tweaking things thereafter. Unity’s preset anchor settings 
can be found by clicking on the anchor presets button. This will open up a small, extended 
window with preset choices. Moreover, we can hold SHIFT while in this selection window and 
we can set the anchor as well as its pivot, which determines where the element will scale or 
rotate from. Consider it the element’s origin. Similarly, we can hold ALT in order to get options 
for instant repositioning and resizing of the element based on the anchor preset. 
 
Panels 
 
Panels are the UI equivalent to empty GameObjects, and can group elements together as 
their children. This is especially useful for collections of elements that have similar purposes, 
so they can be all turned on and off together. Unlike empty gameObjects, panels come with 
an Image script component. It also has a default sprite attached to it: ‘background’. This can 
be removed if you prefer to have the panel act as a container without visual support. 
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Images and Text 
 
Images and text are very common elements. The image element is very similar to the 
panel as it uses the Image script component. However, unlike the panel, it doesn’t 
have a sprite selected by default. If we modify the rect transform size, the image inside will 
stretch to fill it, but we can set it to preserve the image’s aspect ratio by selecting the toggle 
for it. 
 
The text element uses the Text component. This component allows us to modify the text 
displayed in the UI using the Text box. There are also generic text styling options like font, 
size, line spacing, alignment, etc.. 
 
Buttons 
 
Buttons are interactable UI that, once pressed,  performs specific tasks. In Unity, they exist as 
a button object with a child text object, so buttons can be accompanied by text. 
 
At its base, the button element, is simply an image with added functionality. The button has 
an Image component for visuals, but most importantly, it has a Button Script. This component 
controls what happens when the button is manipulated in different ways (hovered, pressed, 
etc.). The visual transitions between its different states can be simple color tints, changing of 
sprites or even full animations. More importantly, a button can perform a task when clicked. 
This is done by interacting with the lower element and adding functions from specific scripts. 
A button can run multiple tasks on a single click. 
 
Sliders 
 
Sliders display or control a value in a given range. These are generally used for resource data 
types and sliders inside options menus. Similarly to the button element, the slider is made up 
of a number of separate elements. It is made up of 3 images and one parent with the slider 
script. How these 3 images work together is fairly simple. 
 
Background: is the image that is displayed behind the fill area and handle. This can be any 
image. 
 
Fill Area and Fill: the fill area represents the area that the slider bar can fill. Similarly, the fill is 
an image within this fill area that can transition from one value to another. 
 
Handle slide area and Handle: the handle slide area is the area in which the handle can move 
within. The handle itself is just an image. 
 
The slider script controls the functionality of the slider and transforms these 3 separate 
elements into one system. Like with the button, we can control the transition of the slider 
when interacted with. This only affects the handle image. This component also controls the 
direction of the slider (left - right, right - left, top - bottom, bottom - top). We also have the 
minimum and maximum values, and the current value which controls where the slider handle 
rests. Finally, a task (performed each time the slider moves) can be attached to the slider 
using the slider script. 
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Engine 7 / Instructor: Sam Bourgault 

Camera, Lights & Sounds 
Explore Camera, Lights and Sounds in Unity, the main  
components to create great compositions. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1crtnqUgn7gvvaP9yuzJ8uXPDz1QZy3rM4Lp
V6AdPnKo/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable with Unity. 
 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Course Material repository 
- Know the basics of Unity interface 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 

 
Objectives 

- Introduce the roles of Camera, Lights and Sound in Unity. 
- Explore the properties of Camera, Lights and Sound in Unity. 

 
Vocabulary 
Camera, Directional Light, Spotlight, Point Light, Audio Listener, Audio Source, Audio Clip. 

 

References 
Software Tutorials: 

- https://unity3d.com/learn/tutorials/topics/graphics/cameras  
- https://unity3d.com/learn/tutorials/topics/graphics/lights  
- https://unity3d.com/learn/tutorials/topics/audio/audio-listeners-sources  

 
 

 
Camera 
The camera component creates a display from which the player can view the game world. 
This component has many values that we can play with in order to modify what is displayed 
and how things are displayed, such as the field of view, which allows us to create a fisheye 
effect or the projection type which allows us to choose between a perspective view and an 
orthographic view. In most cases, we will keep all of the values in their default settings. 
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Without a camera component attached to a gameObject in the scene, the player will 
only see a black screen. Note that when you create a scene, there is always a Main 
Camera to ensure the player to see something on play but this camera can be deleted 
and replaced by another one. 

 

Camera Properties 
The first relevant properties are the ones related to the Background. The Clear Flags 
dropdown gives access to the background type that will be rendered behind all the 
gameObjects in the scene. The skybox allows you to render a texture on the six inner sides of 
a box containing the scene. The default Unity skybox is a clear blue sky over a grey floor. To 
change the available skybox, you need to access the Lighting Settings in the Window tab of 
the menu bar. In the Environment section of the Scene tab, you can select your skybox 
Material. Note that when the Skybox is selected, the Background Color has no impact on the 
Scene. The Solid Color allows you to render a plain color of your choice in the background. 
The Depth Only is used when there are multiples cameras in the same scenes, a topic that we 
will not cover in this tutorial. The Culling Mask property defines what layer will be rendered by 
the Camera. By default the Culling Mask is set to Everything. 

Another important property is the Projection type. Unity offers two types: Perspective and 
Orthographic. Both have different qualities. The Perspective mode is a realistic view; similar to 
the eyes, it exhibits a diminishing perspective, a vanishing point. This projection type is used 
in most 3D games nowadays. The Orthographic mode shows a non-realistic view in which 
the gameObjects dimensions are preserved independently of their distance from the camera. 
This mode is used in real time strategy games, 2D games and to display of UI elements. 

In both cases, only the elements located inside their frustum are rendered. You can change 
the values of the near and far clipping planes delimiting the frustum and therefore what is 
displayed by the camera. In the case of the Perspective mode, you can modify the field of 
view, the angle of the frustum shaped as a truncated pyramid. In the case of the Orthographic 
mode, you can change the size of the frustum shaped as a rectangular prism. 

 
Types of Camera in Games 
It is essential to setup the camera accordingly to the type of game that you are making. 

- First person character: The camera is a child of the player and is located at eye level 
of that player. 

- Sidescroller: The camera is either a child of the player and is located on the side of 
that player or holds a script that makes the camera follow the player. 

- Third person character: The camera is also a child of the player and is located above 
and a bit behind the character.  

- Point-and-click game: The camera is a standalone gameObject and can be located 
anywhere according to the level design. 

- Top down shooter or puzzle game: The camera is a standalone gameObject and is 
located perpendicular to the scene. 

Note that there are other possible camera perspectives for other types of game out there but 
these previous ones are a good overview of what can be found in games. 

 

Guided Exploration on Camera 
 [Demo: Open the CameraLightsSound project in Engine 7 from the Course Material.] 
 

1. Open the CameraLightsSound in Engine 7 from Skins 6.0 - Course Material. 
2. In the Scene folder of the Project, open the scene Camera. 
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3. Select the gameObject CameraPerspective in the hierarchy and try out the 
different Clear Flags and Backgrounds. 

4. Still with the Camera Orthographic selected in the hierarchy, look at the 
frustum in the Scene view and play with the Near and Far clipping planes 
properties in the inspector. Once you understand what it does, go back to 0.03 for the 
Near and 1000 for the Far. 

5. Select the camera in your scene. In the first property Clear Flags, choose the right 
background. If your scene requires a background, choose Skybox and Solid Color if 
you want a plain color background. Note that Depth Only becomes handy when there 
are multiple cameras in a scene. 

6. In this scene, there are two cameras. They are not meant to be active at the same 
time but rather to show you the visual difference between the Perspective mode of 
projection and the Orthographic mode of projection. Note that the transform is the 
same for both cameras, so that you can clearly understand the way objects are 
rendered in both cases. 

a. The perspective view informs us about the distance at which an object is from 
the camera. The two SmallCubes in the scene doesn’t look the same size since 
one is further from the camera. The LargeCube and the closest SmallCube 
though look basically the same size from this view. 

b. The orthographic view however informs us about the size of an object in 
respect to the others. It is now obvious that the SmallCubes are the same size 
while the LargeCube is larger. 

 
Type of Lights 
A Light is also a component attached to a gameObject. When you create a light in the 
hierarchy, it consists of an empty object holding a Light component. The light component 
creates a light source at the gameObject’s origin, allowing objects hit by that light to be 
rendered accordingly. Without light, objects will not be rendered and the player will not be 
able to see anything in the 3D world. There are 3 types of light sources one can choose from: 

- Directional light: acts like the sun where the light has an infinite reach at a particular 
angle. The angle is used to calculate shadows and orientation at which the light hits 
an object. There is generally one directional light in all outdoor scenes. Respond to 
rotation only. 

- Spot light: similarly to the directional light, this light source has a direction in which it 
projects its rays however, it also has a specific range and radius. This are generally 
used by light sources such as light post, flashlight or any other small light that has a 
specific direction and range. Respond to rotation and translation. 

- Point light: has no direction and projects light in all directions. This light source acts 
like a sphere of light with a controllable radius. These are often used for small light 
sources with no particular direction to them such as torches or fire sources. Respond 
to translation only. 

You will notice also the Area light type followed by the notice Baked Only. In this tutorial, we 
will work only with Realtime lighting, which is doable using the first three types of light 
presented above. As its name suggests, Realtime lighting happens while playing the game 
and is useful when some gameObjects in a scene are moving in relation to the lights. The 
heavy computation power required for this lighting mode comes with more flexibility. The 
other available mode is Baked lighting. Even though we are not covering this mode, it is 
important to acknowledge its existence. When a light is baked, it means that its effect is 
computed before running the game and applied on gameObjects as a static texture. This 
mode improves the performance of a game but cannot be adjusted at runtime. 
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Aside from the type of light source, we can play with a number of other values: 

- Color: controls the color of the light and ultimately how the lighting will affect 
the tint of an object. This is useful for getting a nice sunset color or lighting 
from a colored neon light. 

- Intensity: controls how strong the light is. The higher the value, the more burn we get 
from the light. Generally we want to keep this value relatively low in order to get a 
more realistic lighting scenario 

- Shadow type: controls whether this light source should create shadows and how. 
- Range: spatial limits of the light (Point and Spotlight) 
- Cookie: pattern texturing the light (2D texture) 
- Flares: additional texture of a flare in front of the light. A Flare effect must be attached 

to the camera for this effect to be visible. 

 

Other Types of Lighting 
Remark that when you open a new scene and turn off the default Directional Light, you can 
still see things in the scene. This is because Unity adds a global artificial light by default when 
creating a scene. This artificial light comes from the Skybox. It can be very useful sometime, in 
outdoor scenes for example, but ineffective other times.  

This artificial light can be turned off by accessing the Lighting Setting of the scene. Go to 
Window > Lighting > Settings. A window should open. In the Scene tab, identify the 
Environment Lighting section. If your scene is outdoor and requires a sky, you can keep the 
Source as Skybox and define its intensity on the scene. If the scene is inside, it is 
recommended to turn down both Intensity Multipliers, the one for the Environment Lighting 
and the one for the Environment Reflections. 

Finally, gameObjects can also emit light if their material is emissive. An emissive material will 
be always visible in a dark context but its effect on gameObjects located in its surrounding 
will only be effective when baked. 

 

Global Illumination and Post-Processing 
There are some quick settings that you can change to improve greatly the lighting of your 
scene. We will start by going into the Camera inspector and check Allow HDR. HDR stands 
for High Dynamic Range and allowing it enables the pixels rendering to extend the range 
over 0 to 1. In Rendering Path, select Deferred and turn off the Allow MSAA. Deferred 
rendering path allows all lights that are affecting a gameObject to be taking into account but 
doesn’t have real support for anti-aliasing. We can take care of that later. Note that the 
Forward Rendering is the default path and will be automatically used if the requirements are 
not met. 

Then go into the Window > Lighting > Settings in the menu bar and check Realtime Global 
Illumination. Global Illumination (GI) is a system that takes into account the indirect lighting of 
a scene, meaning the light that is bouncing off a surface and onto another one. Global 
Illumination requires a lot of computation power therefore it needs to be precomputed on 
surfaces that will not be moving during the game. These objects must be set to Static in the 
Inspector. Realtime GI requires the precalculation of all possible light trajectories so it can 
adapt during runtime. Still in the Lighting Settings, note that you can lower the Indirect 
Resolution depending of your needs. 

Now in the menu bar, go to Edit > Project Settings > Player. In Other Settings, in the 
Rendering section, access the Color Space dropdown and select Linear instead of Gamma. 
This will give more depth to the colors, blacks will be darker and white brighter, which is often 
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something desired to enhance the contrast of the image. 

  

We can now install the Post Processing Stack. This package is a very powerful tool to 
apply different effects on the image displayed by the Camera. We find that package 
on the Asset Store and import it. This allows us to create Post Processing Profile by clicking 
the right mouse button in the Assets folder. These profiles have multiple parameters that can 
be customized in the Inspector, we will look only at some of them. To link the Post Processing 
Profile to the camera, we need to add the Post Processing Behaviour script onto the 
gameObject holding the Camera component. Then, we need to drag our Post Processing 
Profile into the slot of that script. 

In terms of the parameters, first make sure to check Antialiasing. Since we unchecked the 
Antialiasing of the Camera, we need another way to provide a smoother appearance to 
graphics. We also check Ambient Occlusion, which darkens the creases, holes and 
intersections between surfaces that tend to occlude light in real life. Finally, we enable Color 
Grading and select Filmic in the Tonemapper dropdown. Tonemapper allows a remapping of 
HDR values and the Filmic one increases the contrast compared to the Neutral. 

 

Guided Exploration on Lights 
[Make sure everyone open the scene Lights from CameraLightsSound project.] 

1. In the Scene folder of the project, open the scene called Lights. 
2. Go to Window > Lighting > Setting. Make sure you are on the Scene Tab and go to 

the Environment Settings. 
3. In the Environment Lighting property, change the source to Color and the Ambient 

Color to black (#000000). In the Environment Reflections property, turn the Intensity 
Multiplier down to 0. These actions will remove all the artificial ambient light from the 
scene. 

4. Select the Camera in the hierarchy and change the Clear Flags to Solid Color and the 
Background to Black. 

5. Now select the Directional Light in the hierarchy and play with the different 
properties. Begin with the translation and the rotation. You will realize that the 
translation has no effect on the lighting but the rotation does. 

6. You can also change Shadow Type at this point. You notice an important difference 
between Soft Shadows and Hard Shadows. Note that Soft Shadows look more 
natural but require also more computation power to render. 

7. Turn off the Directional Light and turn on the Point Light. 
8. Play with the different properties. Begin with the translation and the rotation. You will 

realize that the rotation has no effect on the lighting but the translation does. 
9. Experiment also with Range, Color and Intensity.  
10. Turn off the Point Light and turn on the Spotlights bundle. 
11. Unfold the Spotlights bundle and play with the individual Light properties of the three 

Spotlights. Try modifying the Range, the Spot Angle, the Color and the Intensity to 
create a nice atmosphere. 

12. Follow the steps described in the previous section: Global Illumination and 
Post-Processing. 

 

Audio Source 
The audio source component allows a sound clip to be played with the gameObject as its 
source. This component gives us a lot of control over when and how to play a sound. As you 
can see there are a lot of values we can modify. We will go over a few important ones to look 
at now: 
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- Audio clip: is the specific sound clip we want the source to play. This can be 
changed, played and stopped in code. 

- Play on Awake: causes the sound clip to immediately play when the scene 
starts. Useful for background music or ambient sound  

- Loop: allows the sound clip to repeatedly play on a loop. Again used for sound 
like background music or ambient noise. 

- Spatial blend: controls whether the sound should be a 3D sound or a 2D sound. 3D 
sounds will be specifically located within the 3D space and will only be heard if the 
player is within range of the gameObject holding the component. On the other hand, 
2D sound will render the sound audible wherever the player is in the scene. 

- Volume Rolloff (in 3D Sound Settings): determines the spatial dispersion of sound. It 
follows a curve that can be logarithmic (default), linear or custom. 

- Min and Max Distance: controls respectively the minimum and the maximum distance 
at which an Audio Source emits. 

 

Audio Listener 
There is only one Audio Listener in a scene for sound to work properly. The Audio Listener is 
equivalent to the ears and is attached to the Main Camera by default. Note that it can be 
attached to something else if desired. 

  

Guided Exploration on Audio 

[Make sure everyone open the scene Sound of the CameraLightsSound project.] 

1. In the folder Scene of your Assets folder, open the scene Sound. 

2. Unfold the gameObject Player and notice the AudioListener as a Component of the 
Camera. This corresponds to the ears of the player. 

3. Select the three cubes in the scene and add the component Audio Source. 

4. Bring the Spatial Blend slider all the way to the right. This action will result in the 
source behaving accordingly to a three dimensional world. 

5. Check the Play On Awake and the Loop box. 

6. Add a different clip to every box. 

7. Identify the animal inside each box. As a first person character, you can walk around 
and use the distance from each box and the panning to identify each animal. 

8. Select one box and notice the two blue spheres surrounding it. The smallest one 
correspond to the minimal distance at which you will hear the sound while the largest 
correspond to the maximal distance. You can change the diameter of these spheres in 
the inspector under 3D Sound Settings. These changes will affect the graph 
underneath. This graph represent the spatial intensity of the sound. Note that the 
default spatial dispersion of sound is a logarithmic curve but you can change it to a 
linear curve or a custom one under the Volume Rolloff dropdown menu. 
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Engine 8 / Instructors: Kahentawaks T., Ray C,, Sam B., & Victor I. 

Blender & Unity Link 
Teach the link between Blender and Unity for rigging, animating, 
importing models and texturing and how to integrate this pipeline  
within Plastic SCM. 

 

 
Teaching Days, Time, & Length 
Friday July 20th, 9:15AM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1oznWZYvBKxmn3VJoHr9fbD6xX7VLdv6as_HS35rX
GhA/edit?usp=sharing 
 
Unity Download 
https://unity3d.com/ 
 
Blender Download 
https://www.blender.org/ 
 
Instructor Prerequisites 
The instructor should be comfortable going through the art-to-engine pipeline using Blender 
for 3D modeling, rigging, and animating, Photoshop for texturing, and Unity for integration. 
 
Participant Prerequisites 
Students must have a sound understanding of at least Blender or Unity. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Unity 2018.1.2+. 
Blender 2.79+. 
 
Objectives 
To develop an understanding of the production pipeline of various 3D assets and their 
implementation in Unity. 
  
Vocabulary 
Humanoid, rig, blender, animation, texture, model, mesh, armature, material. 
  
References 
Blender Character Animation for Unity. 
https://www.youtube.com/watch?v=8181FF9zQlo 
 
Blender Character Creation. 
https://www.youtube.com/watch?v=ocLZNRasU64&list=PLFt_AvWsXl0djuNM22htmz3BUtH
HtOh7v 
 
Importing Humanoid Animations into Unity. 
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https://docs.unity3d.com/Manual/ConfiguringtheAvatar.html 
 
Human Avatars - Official Unity Tutorial. 
https://www.youtube.com/watch?v=pbaOGZzth6g 

 

 

Humanoid Rig in Blender 
 
Unity allows two animation types on a rigged model: Generic and Humanoid. The default type 
is Generic; it should be used for models that don’t follow a humanoid behavior, like inanimate 
objects. The second type, Humanoid, is specific to characters shaped like a humanoid 
structure. The strength of this type is its versatility, as it allows any humanoid animation to be 
applied to any humanoid model.  
 
In order to build a humanoid model that can be used as such by Mecanim, Unity’s animation 
tool, the rig must follow a standard bone structure. There are multiple ways to create joints, 
but to work properly, the hips should be the root element of the bones hierarchy, and there 
must be a minimum of fifteen bones in the skeleton. Unity suggests the following bone 
structure: 
 
1. Hips - spine -chest - shoulders - arm - forearm - hand 
2. Hips - spine - chest - neck - head 
3. Hips - upper leg - leg - foot - toe - toe end 
 
Note that since arms and legs come in pairs, a proper naming convention is required (eg, 
“armL” and “armR” for the arms and “legL” and “legR” for the legs). 
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Animations and Blender Export 
To create an animation in Blender, go in the Dope Sheet. In the first dropdown menu, 
choose Action Editor and click on New to create your first animation. You should 
rename the action with meaningful name (eg, Idle, Walking, Running, etc.). When 
creating the these animations, you will have to click on the plus (+) sign next to the animation 
title.  
 

 
 
Note that when creating multiple animations on the same model in Blender, you need to press 
on the F button next to the title for every new animation. This will create a fake user for this 
animation. If you ignore this step, the animation will be deleted when quitting Blender. 
 

 
 
Once your animations are done, you can export your model. In Blender outliner, select the icon 
of the Armature while holding the CTRL key, this will make sure all the children of the object 
are selected. Then go to File > Export > Fbx. In the left menu that opens up, check Selected 
Objects, select Armature and Mesh while holding Shift and click Export. 
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It is very important that you select the Version FBX 6.1 ASCII (rather than the Version FBX 7.4 
Binary), otherwise you will get rig errors in Unity. Note that Unity also has its own animation 
tool called Mecanim. Usually animations that deform the model itself are made in an external 
software such as Blender, and animations that don’t deform the model by dealing only with 
translation, rotation and scaling are made using Mecanim, or at least could be made in it. 
 

Import the Model in Unity 
 
Once you have exported your model, you can copy the file into the Unity project Assets folder, 
and it should appear in Unity. Placing the model in a subfolder named 3D Models is a good 
way of keeping things organized. Now, we have some settings to change. 
 
First, select your model in the project folder. In the inspector you will notice four tabs at the 
top. 
 
In the Rig tab, make sure to select Humanoid as a Animation Type if your model is humanoid. 
Also if you don’t need to get access to all the individual transforms of each bone of your 
model, you can check Optimize Game Objects. If you want to get access to only a few of them 
for reference purposes, you can define which one you need in the Extra Transforms to Expose 
List. 
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If the model has not been properly configured by Unity, you can press on the 
Configure button. this will bring you to another scene in which you can set up your 
character manually. The inspector will show you two tabs: Mapping and Muscles. 
 
In the Mapping tab we can see a 2D schematic of all of the avatar’s bones. It 
represents what Unity defines as “humanoid” in terms of rigging.  The circles and dots shows 
the bones of the model. Note that dots surrounded by a full line correspond to mandatory 
bones while the ones surrounded by a dashed line are optional. You have also two dropdown 
menu under the list of bones. In the Mapping dropdown you can Clear all the bones 
associated to the schematic (contraindicated) and Automap to get Unity automatic bones 
associations for your avatar (good starting point). In the Pose dropdown, Reset removes the 
current pose of the avatar and Sample Bind-pose placed the avatar in the pose in which it 
was modeled. You can also enforce a T-pose, which is strongly suggested as Unity works 
better under that setting. 
 
You also have a list of Bones that you can manually modify. When they are badly configured 
you can drag and drop the right  transform into the appropriate slot. You must apply the 
changes when you are done. Apply when you are done. 
 
In terms of animations, once in Unity, select the imported animations from the project folder. 
The animations might be children of your 3D model so you will need to select your model first 
and then unfold it to find your animations. Check for the animation type. If your model is 
meant to be a humanoid, change the animation type to humanoid. If not, keep the default 
Generic type. Apply the changes when you are done. 

 
Texture 
 
To create complex and realistic materials in Unity, we must first export our maps. Standard 
maps include: albedo, metallic / smooth, normal. These maps are regular image files, so they 
can be made with any software, as long as they match Unity’s standards. 
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“Albedo” is a regular color texture; the color map. 
 
“Metallic” determines how reflective and, well, metallic the surface is. Unity’s standard shader 
uses a single map for both metallic and smoothness (which are two different things). How? 
Well, smoothness / roughness is actually determined by the alpha channel of an RGBA 
texture. So, the more opaque a pixel is, the less smooth (rough)  it is. And vice-versa, the more 
transparent a pixel is, the smoother it is. 
 
The normal map adds information in terms of how light should interact with the surface of a 
mesh, so as to create the illusion of additional detail. Sometimes the normal map needs to be 
formatted specifically for Unity. In these situations, Unity will propose to “Fix” it for you, which 
works fine. 
 
To import textures into Unity, simply drag and drop them into Unity’s file explorer. 
 
Afterwards, they need to be put together into a single Material. A “material” is a shader. That 
is, it’s code that tells the graphics card how to draw a mesh. Unity has a shader called the 
“standard shader”, and it supports PBR shading, which stands for “physically based 
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rendering”. This is a powerful shader, because it was built to be very realistic, and to 
support a large variety of texture maps. 
 
Create a new material by right clicking in Unity’s file explorer, and click on “Create” > 
“Material”. Select the new material and there will be slots for “Albedo”, “Metallic”, 
“Normal”, and a few other maps. Drag the corresponding map to the slot in the material using 
the “Standard” shader. The normal map may need to be reformatted. If Unity suggests there’s 
a problem and offers a button to “fix” this issue, click it. 

 
Plastic SCM 
When you are done with your model in Blender. Here is the proper way to import it in Unity in 
regards to Plastic SCM: 

1. Export your model in .fbx format, use the . 
2. Drag and drop the .fbx file into the Unity project (in the /Assets folder, or any other 

subfolder). 
3. Submit your file: 

a. If you are comfortable using Unity, right click on the .fbx file in Unity’s file 
manager, click on “source control”, and click “submit” to check it in (this will 
check in the .fbx’s corresponding .meta file automatically). 

b. If you are not comfortable with Unity, check in the .fbx file and its 
corresponding .meta file through the Gluon client. 
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Audio & Atmosphere 1 / Instructors: Matt Sproat & Victor Ivanov 

Intro to Recording Dialogue & Music 
An introduction to producing the foundations of audio. 

 

 
Teaching Days, Time, & Length 
Monday July 16th, 1:30PM — 1HR 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1GQWU6x9q0jy79MXoAYtzE62McA-LxlbFkphpgGUb
_S4/edit?usp=sharing 
 
Reaper Download 
http://reaper.fm/ 
 
Instructor Prerequisites 
The instructor should be comfortable using Reaper, and should be familiar with generic digital 
audio workstation terminology and modules. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Reaper, version 5.91+. 
 
Objectives 
To provide an overview of the “audio and atmosphere” path, and introduce participants to 
Reaper as an audio production environment, along with its interface and primary modules. 
  
Vocabulary 
Digital audio workstation (DAW), timeline, track, mixer, transport, recording, samples, clips, 
effects, MIDI. 
  
References 
Reaper Beginners Tutorial – Recording Guitar and Vocals 
https://www.youtube.com/watch?v=NhRMM3RjbHM 
 
Audio Editing Fundamentals 
https://www.youtube.com/watch?v=kn2SlBMpzwY 
 

 

Introduction to Recording Dialogue and Music 
 
The audio and atmosphere path is primarily focused on audio, featuring one lesson on 
soundtrack design, another on audio engineering, and one lesson with more emphasis on 
atmosphere through graphics and design. The questions this path aims to answer are: 
 
- How can I communicate a mood; how can I communicate an emotional state in a game? 
 
- How can I add unique style to a scene? 
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- How can I record, compose, and produce dialog and music? 
 
- How can I experiment with audio, and create strange sounds for effects and 
background atmospherics? 
 
Audio is omnipresent in complex media, and much of what we will cover is applicable for 
standalone music, game soundtracks, soundscapes, sound effects, dialog for film, etc.. With 
that being said, an emphasis will be put on how audio is incorporated into games, and the 
more unique, game-oriented design decisions that go into its production. 

 
Reaper 
 
We’ll be using Reaper for our audio work. Reaper is a digital audio workstation, or “DAW”. A 
DAW is a program that includes a variety of features for audio and music recording, 
manipulation, and production. In a sense, it’s an all-in-one package for audio work. 

 
Navigation 
 
Reaper has a few key interface elements. Much, if not all, is navigated using the mouse. 

 
Timeline 

 
The timeline is the primary space where different clips are placed. The cursor on the timeline 
goes left to right, at the speed of the specified bpm. 

 
Tracks 

 
To the left of the timeline are the tracks. A track can be a source of audio in the case of MIDI. 
It can also contain a stack of effects for MIDI clips or audio samples. Each track has a volume 
parameter, as well as a pan parameter, which determines how the track outputs sound with 
a bias for the left or right speaker. 

 
Mixer 

 
The mixer, on the very bottom, shows each track. Like in the track options, the mixer can 
modify the volume and pan of the track, as well as solo and mute the track. The purpose 
behind a mixer is to see the volume of each track in a more convenient format, which is very 
useful for mixing. Otherwise, it’s virtually identical to the tracks view. 

 
Transport 

 
The transport, between the timeline and the mixer, keeps track of the timeline’s parameters. It 
determines the time signature, bpm (beats per minute),  where the cursor is on the timeline, 
and whether the timeline is playing or not. 

 
Options 

 
On the very top are a series of options that control how one manipulates parts of the timeline, 
along with the standard save, save as, undo, redo options. It also has a metronome toggle, 
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which is very useful for keeping count when recording or reviewing rhythms. 

 
Windows 

 
Some of Reaper’s interface is hidden inside windows. We’ll explain them as we come across 
them, but just be aware that there’s more to Reaper than is immediately visible. 

 
Recording 
 
To record, Reaper first needs to know what you’re recording with. In our case, that’s our 
microphone. To use it, click on Options > Preferences > Device, and in ‘Input device’, select 
your microphone. 
 
Then, we need to tell Reaper which track we want to record to. This is called to “arm” a track. 
More than one track can be armed, if you wish to record into multiple tracks. To arm a track, 
click on the ‘Record Arm’ button next to it, or in the mixer. Make sure the track’s Input is not 
expecting MIDI data. 
 
Then, click on the ‘Record’ button. Once you stop the transport, you will be prompted to 
decide on whether you want to keep the new recording(s) or not. 

 
Samples 
 
By recording, or simply dragging an existing file into the timeline, we’ve created a sample. 
This is a piece of audio in the timeline that we can now grab, move around, change track, 
copy and paste, and so on. 

 
Effects 
 
Each track, and even each clip, can have its own effects. “Effects”, in this case, are smaller 
programs that process audio in some specific way, each with its own parameters to 
determine how the audio processing happens. 
 
To use an effect on a track, click on a track’s “FX” button to open the effects stack. From here, 
clicking on “Add” will open a list of effects. Clicking on one will add it to the stack. 
 
To use an effect on a sample, double click on a clip, click on “Take FX”, and it will open the 
same effects stack. 
 
Effects can be reordered so they’re applied in a different sequence. 

 
MIDI 
 
Aside from samples, we can also record MIDI. MIDI is essentially a way of writing down notes, 
without locking it down to what instrument plays it. So, for MIDI to produce sound, it must be 
on a track that can interpret MIDI. 
 
To create a midi clip, hold CTRL and left click and drag in a track. Double clicking on this clip 
will open up the clip window where you may draw out the notes, their pitch, and their length, 
in a piano roll view. 
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Clip Manipulation 
 
The following is true for both samples and MIDI clips: 
 
To move a clip simply hold left click to drag it. 
 
To copy a parts of a clip, select it by dragging your cursor over the parts you’d like to select, 
and hold CTRL and drag your mouse to copy the selection. 
 
To duplicate a selection, press CTRL + D. 
 
To move a clip’s boundaries, hold ALT and drag a clip. 
 
To slice a clip at the timeline cursor, press S. 
 
To create a fade in or out, drag inwards from the top left or top right corner of a clip. 

 
Playing a Synthesizer 
 

To create a simple setup where we can mess around, create a new track by right clicking in 
the tracks area and then clicking .’Insert new track’ (or pressing CTRL + T). Click on “FX”, then 
on “Add”, and then search for Categories > Synth > ReaSynth. Click it, and click “OK”. Now, 
we’ve added a synthesizer to the beginning of our effects stack. 
 
Then, we need a way to play it. Go to the timeline, and create an MIDI clip by holding CTRL 
and left click. Double click on this MIDI clip, draw some notes using your mouse, and press 
“Play” on the transport! 
 
To add an effect, click on the “FX” button on the track, click on “Add”, and find an effect that 
seems interesting. I’ll be using Categories > Reverb > ReaVerberate, to add some reverb to 
my synth. 
 
Feel free to go back into the synthesizer and reverb module and mess around with its buttons, 
knobs, and sliders. 
 
Finally, we should find a way to make playing music more convenient, and since we have no 
MIDI controllers, we can try to use our keyboard! Click on “View” > “Virtual MIDI Keyboard” (or 
just ALT + B). This keyboard will allow you to use your actual keyboard as a piano roll. 
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Audio & Atmosphere 2 / Instructor: Victor Ivanov 

Mood & Style 
A look at structuring aesthetics to communicate  
emotional and narrative context. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 9:15AM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1U82RphHQKaLInrH5Ipylo5CLG6v3HHHjDcZQBgtt4
KY/edit?usp=sharing 
 
Unity Download 
https://unity3d.com/ 
 

Instructor Prerequisites 
The instructor should be comfortable using Post Processing in Unity. The instructor should 
also be familiar with visual composition and color theory, as well as some knowledge in level 
navigation design. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Unity 2018.1.2+. 
 
Objectives 
Introduce participants to Unity’s post-processing toolset, explain how post processing affects 
style, and explore (in varying amounts) light, audio, motion, atmospherics’, color, and 
environment navigation’s capacity to influence mood and style. 
  
Vocabulary 
Aesthetics, post-processing, color, contrast, effects, navigation, pacing, palettes. 
  
Web Resources & Books 
Color Theory Tutorial. 
https://www.youtube.com/watch?v=Qj1FK8n7WgY 
 
Unity Post Processing and Graphics Settings. 
https://www.youtube.com/watch?v=owZneI02YOU 
 
Moods built through combinations of discussed elements. 
https://www.youtube.com/watch?v=bkL94nKSd2M 
https://www.youtube.com/watch?v=nC19QTyFaHw 
https://www.youtube.com/watch?v=KkPaUA7WP0w 
 
Motion in scenes. 
https://www.youtube.com/watch?v=iYT-NiCoqHQ 
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Consistency in change of moods between different areas. 
https://www.youtube.com/watch?v=Oq_yt8RcnKY 
 
Using materials to tell stories, from an architectural perspective. 
https://www.youtube.com/watch?v=BjH95AbkErM 
 
Interview with Dishonored environmental artist. 
https://80.lv/articles/environment-storytelling-in-dishonored-2/ 
 
Duelist concept art color study. 
https://bit.ly/2JLIej8 
 

 

Mood and Style 
 
Integral to an aesthetically engaging experience, the mood and style of any given scene imply 
an underlying narrative. At the very least, a given mood tries to set up an aesthetic 
environment in the mind of the viewer. This environment determines how they will perceive 
parts of the game-world. 
 
In other words: a proper use of mood and style can provide a visually and sonically interesting 
space, and suck the viewer in through their engagement with this space. 
 
So what makes up the mood of a scene? This is not an easy question to answer. Mood can be 
characterized by cultural understandings of aesthetic elements, and that only makes it harder 
to create a mood that is consistent to a larger demographic. However, we are all human, and 
share general conceptions of what might constitute a happy scene versus a sad one, or a 
calm one versus an exciting one. 
 
Composition, as explored in a previous lesson, is a great abstract basis to begin from. This 
lesson is structured in a similar way, but with a more explicit perspective on tools we can use 
to evoke an emotional environment. We will go through a variety of technical features that 
we can use as tools in our composition of an aesthetically evocative space. 
 
Post Processing 
 
Post processing is an easy start, as it’s something that can be easily removed, or added to a 
visual. Its name, post processing, implies that it is applied after the primary production of an 
image. What post processing is, is effects added to an image after it’s been rendered. A 
variety of effects exist, but we’ll focus on covering the ones in Unity, and filter it to the ones 
that have a potential for style. 
 
Motion Blur 
 
Motion blur is fairly common in visual media. Originally, motion blur in film was / is produced 
through a camera’s slow shutter speed and movement in what it’s trying to capture. For 
instance, if someone is running in front of a camera, the camera will end up receiving 
information about that person’s position(s) as long as the camera’s shutter is open. If this 
lasts a long enough time for the person to move, then they will appear smudged and blurry in 
the photo. 
 
So why would we want that in a game? It sounds undesirable. The reason is, in part, because 
it looks more like how a camera in a movie would look like if it moved quickly. This can 
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potentially provide a more “cinematic”, action-y, smooth experience, however it is 
ultimately up to personal taste. 
 
Secondly, it’s arguably similar to how we see the world with our own eyes. When we 
dart our eyes around, the information we capture is not as clear as when they’re 
focused. This isn’t exactly motion blur, but it can be disorienting, and in some cases, motion 
sickness inducing to not have any motion blur, especially at higher framerates (it’s also 
possible that too much motion blur cause motion sickness, too). 
 
Depth of FIeld 
 
Depth of field, like motion blur, is a physical camera phenomenon. Humans do experience 
depth of field, however we cannot focus on the out-of-focus parts of our vision like we can 
the blurry parts of an image. 
 
Depth of field is another cinematic effect. It can pull attention to whatever is in-focus, create 
beautiful backdrops, and provide a sense of depth to a scene. During gameplay, however, it 
can be very obtrusive if done improperly. Depth of field in games works best if it’s subtle, and 
has as little effect on gameplay as possible. 
 
Tonemapping and Color Grading 
 
Tonemapping is an effect that maps HDR values onto a range suitable for screen display. 
HDR is “high dynamic range”, meaning that one can take an image where the whites are 
blown out, and bring back the detail by making them slightly darker. This ensures that no 
detail is lost, and makes an image appear more realistic, as our eyes have a dynamic range 
far higher than that of a contemporary camera sensor. 
 
Then, color grading deals with the coloration of a scene. You can selectively change the hue 
(the color itself), value (the brightness of a color), and saturation (vividness of a color). 
 
For example, if your scene has green flowers, but you want them to be red, then you may 
selectively map the green tones to redder ones. Or if the sky is bright, but not bright enough, 
then the highlights can be amplified. Or if an object’s coloring is bland, its saturation can be 
increased. 
 
Color grading is a very powerful tool, as it gives full control over how colors are represented, 
and can have drastic effects on the mood of a scene. 
 
Chromatic Aberration 
 
Chromatic aberration is a camera lens defect that causes colors, more so around the edges of 
a lens, to begin to separate, because the lens is incapable of focusing all light frequencies to 
the same convergence point. So, you end up with what appears to be purple and green (due 
to lens manufacturing) light ‘fringing’. 
 
Once again, this effect creates a sort of distortion that can appear more cinematic. It is used 
in horror games, or when something is meant to feel uneasy and discomforting. Or, when a 
scene is meant to be viewed through a camera, or old TV screen. 
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Special Effects (shaders) 
 
Lots of other special effects are shader-based. A shader is a piece of code that is 
compiled and executed on a graphics card. This code says what to render, and to 
which pixel(s). Shaders are actually the basis of all 2D and 3D graphics rendering in engines 
and software like Blender. All materials in Unity are actually shaders, but I digress. 
 
Shaders are not exclusively post processing effects, but most post processing effects are 
shaders. Graphic programmers deal with creating these programs, and this little blurb was 
just to let you know that there is a world of possibilities in graphics. 
 
Lighting 
 
Now, let’s move on to the more design-oriented techniques for creating mood and style. First 
off, light. 
 
Contrast 
 
Lighting is in some sense characterized by contrast. No contrast? No light. An environment 
with high contrast can make an things feel dynamic, moody, potentially gritty, organic, etc.. 
An environment with low contrast can feel sterile, artificial, clean, serene, soft etc.. 
 
The amount of contrast is also influenced by the amount of light. It’s important, however, to 
consider that the relationship between how lit a scene is and the contrast in a scene is a bit 
complex. 
 
A scene with high contrast has sparse, but typically strong lights. They have very few light 
sources that create hard shadows. So what produces good contrast is selective lighting, 
which naturally draws attention to whatever’s lit. Harsh contrast can be quite beautiful when 
using negative space effectively to hint at a shape that is otherwise not directly visible. 
 
High-contrast is especially common in horror games, where dark space is abundant. A key 
element to horror is the withholding of information, so that your imagination can fill in gaps 
with what you are most scared of. 
 
It’s good to remember that light bounces, so even a single light can potentially light an entire 
environment if it’s sufficiently bright, and there are brighter, smoother surfaces that are likelier 
to bounce light around. So to create contrast through lighting, the materials in an environment 
need to keep that light from propagating too much. 
 
A scene with low contrast can have only a few lights, but have them affect a large portion of 
the environment. Outdoor scenes do exactly this, and they often only have one source of light: 
the sun. 
 
The question of many lights comes up: how does the quantity of lights affect the contrast in 
an environment? It depends on their size and placement. If the light they produce is often 
occluded like in a cyberpunk alley, they cast shadows and create a complex orchestra of light 
and shadow, making for a dynamic, contrast-y scene. Otherwise, if they’re uniformly 
organized like in a laboratory, then it will produce a very consistent, low-contrast level of 
lighting. 
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Color 
 
Light is not light without color! And unless a scene aims to be greyscale, or 
deliberately sterile, its lights must have a color. Whether it be the sun, or indoor lights, 
very few lights are completely white. Colored light is a great way of applying color theory to 
an environment whilst keeping the materials of your scene from being unnaturally colorful. 
 
Shadows, like light, can also have a color! Warm lights will warm up the color of the object 
they hit, making the shadow look darker by comparison. Amplifying this effect by making 
shadows cooler, using color grading for instance, can make a scene appear much more vivid. 
The same applies for the other way around: a cool light will make a shadow look warmer by 
comparison. 
 
Audio 
 
The sonic environment provides an additional tone to the atmosphere of a scene. Music, 
naturally, has an emotional undertone that communicates how a scene might feel, so it’s 
quite potent. Because audio is such a huge topic, we’ll cover that in a later lesson. 
 
Motion 
 
Motion is arguably the most fundamental feature to add life to a scene. Without motion, a 
scene is pretty much frozen in time. So even the tiniest hints of movement can add dynamics 
to a composition. 
 
Animations are a standard way of doing this. A flashing light, a moving robotic arm, cars 
driving around, so on so forth. In more stylized graphics arts, animated sprites can be used to 
accompany motions to further amplify the sense of movement they exhibit. 
 
Wind, potentially paired with cloth, do a particularly tremendous job at this. The feeling of 
touch is obviously not satisfied through gameplay, but illustrating how unseen forces act on 
an environment make it feel like a real physical space. Wind and cloth movement hint at an 
atmosphere, which create that effect. 
 
Naturally, the amount of motion in a scene determines how active, and potentially chaotic it 
appears. A lot of movement can be overwhelming, but it also makes the world feel very alive. 
Small hints of movement, instead, communicate a calm environment. 
 
Atmospherics 
 
Still on the topic of movement, but with more emphasis on lighting, are atmospheric effects. 
These are effects that add visual presence to the air, or the items in the air. Things like 
skybox, atmospheric light propagation, fog, god rays, particles like rain, snow, sand, and so 
on. 
 
Much like wind, atmospheric effects make the (supposed) atmosphere of your game world 
more tangible. Not only that, but they play with lighting by describing how light travels 
through the atmosphere. 
 
Atmospherics affect weather and time of day, which in turn affect color and lighting. Foggy 
environments seem mysterious, surreal, and somewhat spooky. Clear skies are vivid and 
happy. Rainy nights are gloomy and create colorful reflections in the wet environment. 
Evening golden hour is a peculiar, super warm-colored transition between two states of the 
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day. Twilight is an anticipatory state before night sets in. God rays make a scene feel 
serene and majestic, but the air looks slightly dirtier (to allow for the light to bounce 
off materials in the air). Particles amplify motions if they’re attached to them, or they 
give physical presence to the atmosphere if they’re not particularly dynamic. 
 
The point is to see the atmosphere as a medium for your light, and a way to implicitly 
describe the air around you. This can add a lot of definition to a scene, especially if visible 
atmospheric phenomena is common in the scene’s setting. 
 
Color 
 
We’ve already discussed color in the composition lesson, but let’s now focus on its capacity to 
evoke emotions and narratives. 
 
Style 
 
In the “Composition” lesson, we spoke about how saturation is used to dictate attention, and 
value is used to segment a scene and add detailed texture. We also covered how saturation 
is something that often can be unpleasant if monotonous. It’s important to mention, however, 
that when talking about style, saturation is quite important in defining a mood. 
 
For the most part, cartoony styles are quite a bit more saturated than photorealistic styles. 
Realistic visuals are desaturated, as few materials in our day to day lives are that vibrant. A 
scene’s overall saturation speaks volumes about the level of ‘activity’ intended for a 
composition. In general, the more vibrant it is, the happier and more joyful it is. 
 
Shadows, in stylized forms, can also be more colorful. In some cartoon styles, shadows act as 
the secondary color in a palette, as opposed to a lower value of the material’s color. 
 
Emotional Associations 
 
We should start off by establishing that color associations to emotions are at least partially 
cultural. A traditionally western understanding of the color blue, for instance, might be quite 
culturally contrasted in China.  Because culture is so influential on our interpretation of color, 
it’s difficult to confidently put forth a theory that summarizes what one color “means”, besides 
our biologically ingrained interpretations of them. 
 
In the end, blood is red all around the world, the sky is blue for everyone, and grass is 
green-ish. So naturally, there are at least some associations to violence and/or passion with 
red, and natural serenity with sky blue and greens. So when trying to make a composition 
internationally engaging, it takes some research to figure out how to make something 
appealing to everyone (or make it achromatic!). 
 
Warmth 
 
Where warmth ends and cool begins has been subject to some disagreements, but as a 
general rule of thumb colors that are red, orange, and even brown, are warm. Colors that are 
blue, green, violet, are cool. The reasoning being that warm colors are predominant during the 
day (even though the sky is blue), whereas cooler colors are more present at night. 
 
It’s not an absolute rule, it’s more of a general idea of whether a set of colors communicates 
warmth and comfort, as opposed to coldness and stillness. These are useful notions when 
trying to think of a color palette, as it helps set up a foundation to what will eventually be your 
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chosen set of colors. Cool colors bring about notions of calmness, detachment, things 
that one might associate with cold weather. Warmth, on the other hand, suggests 
cosiness, family, agitation, things that one might associate with hotter environments. 
 
It’s important to know that a composition can be composed entirely using warm or 
cold colors. If done in a way that spans a sufficient number of shades, there’s still enough 
contrast to make an image interesting. This is useful for scenes where there’s a desire to 
really drill in an environment. For instance, a hot desert could work exclusively with warm 
colors to convey a sense of overwhelming heat. Or a futuristic spaceship could use only cold 
colors to establish a sterile and lonely environment. 
 
A mix between cold and warm colors, however, can provide great contrast and definition. A 
warm cabin looks a lot more cozy if it’s surrounded by blue-tinted snow on a wintery night. A 
cool ocean looks a lot more appealing when near a warm, sandy beach. And this works for 
lighting, as well, where a mix between warm and cool lights can define subjects in a visually 
interesting way. 
 
Palettes 
 
Beyond warm and cool, however, exist more detailed categorizations / systems for color. A 
palette is the set of colors used in a composition. For the most part, it is composed of a 
primary color, with a small selection of secondary colors used to smaller degrees. The primary 
color drives the foundational mood of a scene, and the quantity of the other colors pushes 
and pulls that mood in different directions. Once again, looking at the emotional associations 
one might have with colors is helpful in determining which primary color to use. And then, if 
an art block comes up, one could use color harmonies to find appropriate secondary colors to 
match with the first. 
 
Materials 
 
Colors alone do not fully capture the expressive capacity of an environment. Materials add 
texture and light interaction to the mix. Materials are not only ways of adding detail to an 
environment, but they’re also means through which to do some environmental storytelling. 
 
The materials on an object say a lot about its history. A material with scratches hints that 
sharp objects have hit it. The pattern of scratches might be random, so it could have 
happened over a long time. The scratches might also be relatively organized, so perhaps 
someone had cut into the object deliberately? Or they chopped things on top of this object? A 
grungy material expresses that an object has not been maintained in a long time. Smudges 
on an otherwise clean porcelain floor says that this floor has been maintained to be this clean, 
and someone has recently passed through the area. 
 
Not to mention, different materials are associated to different eras. Very often, futuristic 
environments have a lot of metal, contemporary have concrete, old have wood, and so on. So 
the material itself has some general historic standing, and any wear on it (or lack thereof) has 
a localized historic standing. 
 
Navigation 
 
Perhaps the most abstract design for mood and style is the way a player navigates an 
environment. 
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Pacing 
 
The speed at which players are allowed and encouraged to navigate is called 
“pacing”. This is a tool used in any time-based media, and it has especially good 
control over how intense a scene is. If a player is locked in a confined space with a lot of 
information in it, and are left, for instance, to solve a puzzle, pacing slows down immensely. 
Players are encouraged to go into their own head and decipher problems internally. Slower 
pacing is good for pensive moments, environmental narrative so that players can soak in the 
details of a scene. Basically: things that benefit from an increased attention to detail and 
given time to explore that. 
 
In contrast, a much more exciting scene, like a chase, or a big fight, has a lot of stuff 
happening at the same time. A level is layed out in a way that’s intuitive to navigate, and 
doesn’t require much thought, so as to keep the action going. In this case, the pacing is quick. 
Players must make quick decisions about tactical issues that come up. They are invested in 
the action that’s happening, which makes fast pacing very appropriate for anything 
demanding a higher narrative intensity. 
 
Complexity 
 
The complexity of the navigation has an effect on the degree of confusion players feel, as well 
as the amount of interconnectedness that players must keep track of to navigate their 
environment properly. Linear games work well as puzzles, or linear narratives, and their 
navigation is very simple and one-directional. 
 
In opposition is complex navigation, which makes a world feel quite large, because players 
spend a lot of time navigating it to find their way. It’s a great tool for adventure games, as it 
allows for players to feel like they’re potentially revisiting old areas, and gives them choices as 
to how they should tackle problems in the world. 
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Audio & Atmosphere 3 / Instructor: Victor Ivanov 

Soundtrack Design  
An exploration of soundtrack composition  
and experimental audio design. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/10GaypujNEWyssHpj1tq4tED312EbNrSdOUQAjIg_J
WY/edit?usp=sharing 
 

Instructor Prerequisites 
The instructor should be familiar with composition and music theory. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
 
Objectives 
To create a theoretical foundation for how music is designed, and how audio fits into games 
and the unique attributes of game audio. 
  
Vocabulary 
Order and chaos, chords, progression, instrumentation, frequency, ambience, music, dynamic 
soundtracks. 
  
References 
Adaptive Soundtracks Analysis 1 
https://www.youtube.com/watch?v=b0gvM4q2hdI 
 
Adaptive Soundtracks Analysis 2 
https://www.youtube.com/watch?v=oP0yROaRkDw 
 
Adaptive Soundtracks Analysis 3 
https://www.youtube.com/watch?v=B0YfSJuq2Rk 
 
Different versions of same soundtrack. 
Process of creating transition. 
https://www.platinumgames.com/official-blog/article/9581 
 
Approaches to soundtrack conceptualization. 
Use of unusual equipment for music. 
https://www.youtube.com/watch?v=1g-7-dFXOUU 
 
In-world soundtracks. 
https://www.youtube.com/watch?v=ItrmFD4_VLA 
https://www.youtube.com/watch?v=Cag03ru_HfY

 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

Soundtrack Design 
 
Soundtracks are musical and ambient compositions made, first and foremost, to 
accompany a game’s presentation. 
 
An effective soundtrack is capable of providing emotional support to in-game moments 
(whether scripted through events and/or triggers, or emergent). Not only that, but a good 
soundtrack tells part of a story. Whether it be more explicit, through lyrics, or more implicit, 
through the progression of a composition, a musical piece has the ability to branch from the 
storyline and effectively extend it. And of course, a soundtrack (especially ambient 
soundtracks) are meant to provide weight to an environment, and to associate a sonic profile 
to it. 
 
Theory 
 
Before we tackle the topic of soundtrack design at large, let’s establish a few composition 
principles that we can use as analysis tools when looking at soundtracks. The more technical 
musical production stuff will be covered in a later lesson. 
 
Structure and Chaos 
 
Audio, like a lot of other media, is in a constant balance between chaos and order. A fully 
chaotic piece is just noise: complete randomness. A fully ordered piece is monotonous, 
never-changing rhythmic taps. Well-produced audio sits somewhere in the middle. Where the 
perfect point of harmony lies depends on your preference. Some cases call for rhythmic and 
repetitive patterns, others call for unpredictable progressions that are difficult to keep track of. 
The point is that the intrigue generated through a piece is created by this harmony. 
 
And naturally, structured music expresses a different type of mood than chaotic. Orderly 
audio can be calming, hypnotic, futuristic, boring, dance-y. Chaotic audio can be raw, gritty, 
angry, confusing, annoying, unsettling. Things in-between cover the entire spectrum of 
emotion. 
 
It’s possible to think of this balance as independently applied on various parts of a 
composition. A song can have heavy distorted instruments (chaos) playing a very orderly 
melody. These combinations are more difficult to come up with a general rule for, but it’s 
normal to see the sonic quality of instruments as being a stylistic foundation, and the 
composition they’re playing as being the more specific emotional profile they’re aiming to 
express. 
 
Chords 
 
Chords are a collection of notes being played simultaneously. The notes’ relationship can 
convey happiness, sadness, hope, some relatively simple emotions. 
 
The reason chords sound nice is because the notes in a chord share a mathematical 
relationship that makes them consonant with the root / one another’s harmonics. That 
sentence is a bit charged, and we will elaborate on “harmonics” and their relationships in 
another lesson. 
 
The two points I want to ultimately make about chords are that: Humans have a generally 
consistent understanding of what notes sound good together, across multiple cultures. This is 
because notes that sound good together share a mathematical relationship. This can be 
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called “consonance”. But: Despite this, some cultures do not include so much 
consonance in their music, but this is not the norm, internationally. 
 
Progressions 
 
With a set of chords, one can string them together in succession to create a “progression”, or 
a “chord progression”. 
 
The principle of order and chaos is important in creating effective progressions, because the 
amount of chaos can fluctuate throughout a progression and be used as an expressive tool. 
 
Each chord has a “root”, which is, in simplified terms, the foundation of a chord. This root is in 
a key, and the dissonance between the chord’s root and the key’s root is what “order” and 
“disorder” can be characterized by in a chord progression. 
 
What does this mean? If you’re playing in C major, and play a C major chord, it will be 
perfectly consonant. This makes C major a very stable chord, and we will have a tendency to 
want to start and end progressions with it. 
 
Using that knowledge, we can arrange our chords so that they, for instance, start with a nice, 
powerful chord (like C major), and then eventually become increasingly dissonant. This makes 
every return to the first chord a relief of sorts. 
 
Or perhaps, we can start on a chord that’s not so stable, go to something even more chaotic, 
and finish a progression with a stable chord, so as to make the end of a progression feel even 
more more grounded, and each new bar; a re-entering into chaos. 
 
Not all songs need chord progressions. Especially when doing ambient or percussive tracks, 
the entire piece can be done using two chords, perhaps even a single chord (thought it might 
get a bit monotonous), or with little real concern for how one chord leads to another. Chord 
progressions are fundamental to music, but they’re also difficult to master. 
 
Instrumentation / Parts 
 
For ease of reference, we can classify the types of instruments / parts of a song. This part is 
quite simple, but it’s good to get a reminder of how we can deconstruct a song. Because my 
background is in metal and electronic music, this instrumentation will be a bit closer to that 
than other genres. But this information is ultimately applicable in every genre. 
 
Organized by where the instrumentation typically sits in ascending frequency: 
 
Percussion, The Drums 
 
These can range from low frequency kicks, to mid-high frequency snares, to high frequency 
hats and cymbals. Naturally, percussive instruments outline a piece’s rhythm. Depending on a 
track’s instrumentation, drums can provide a sort of grounding for everything else to stand on, 
but in cases where another instrument is very ‘stable’, drums can be more of an addition to an 
existing foundation. 
 
 
Bass 
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The bass can range from a simple tone that follows the main chord progression in 
more traditionally structured songs, to a lead in more contemporary electronic music, 
to a groovy low frequency addition that interacts with the lead, in funkier genres. 
Generally, the bass’ purpose is to occupy the lower frequencies so as to make a song 
feel more complete and grounded. For that reason, the bass works in tandem with the 
drums, and in certain cases can even compete with a kick of a relatively equal pitch. 
 
Rhythm 
 
Rhythm is difficult to define, as it can include a large variety of instrumentation. Simply put, 
the rhythm section deals with accompanying the lead, adding details to a piece, and / or 
establishing less significant melodies. The rhythm is not fundamental to a piece, but it fills a 
large frequency range, and like the bass, makes a song feel ‘fuller’. Often, rhythm tracks are 
also panned asymmetrically to make a piece ‘wider’. 
 
Lead 
 
The lead plays the primary melody, and it’s usually the most immediately recognizable 
instrument in a composition. If there are vocals, they are normally the lead. The lead typically 
sits slightly on top of the rest of the instrumentation in frequency, which is one of the reasons 
why it’s easy to recognize. 
 
Effects 
 
These, too, can range all over the frequency range. These can be ambient background audio 
to fill up the silence, or rising tones when doing a buildup, or even rhythmic-percussive stuff 
that just isn’t quite drums. Effects spice things up and add detail that can be very pleasant for 
more keen listeners. 
 
Types of Audio 
 
With everything in mind, let’s look at 3 general categorizations of the types of audio we can 
expect in a game. 
 
Ambient 
 
Ambient audio is not musical in nature, but used for atmosphere. A large portion of a game’s 
audio consists of ambient tracks with especially background-oriented, and relatively 
unobtrusive qualities. Such tracks give an environment a physical presence. Ambient sound 
can be things like wind blowing, trees rustling, an ominous hum in an underground area, 
water flowing, gears and cogs winding, metal grinding, and so on. It makes a big difference to 
an environment, and is quite easy to implement on a basic level. 
 
Musical 
 
Musical audio is... music. It’s a powerful tool for story-telling, and can cover a large emotional 
range. Music is used most prominently in cutscenes, cinematics, boss fights, basically during 
emotionally meaningful moments. Still, it is often also present during gameplay sections, but 
in ways that make it a sort of background accompaniment. Because players are likely focused 
on gameplay tasks, gameplay music (as opposed to cinematic music, or trailer music) is made 
to be seamlessly integrated to amplify an existing experience, not to build it from the 
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ground-up. Unless a game is designed for it, music during gameplay (not cinematics) 
tends to fall into the background. For that reason, background tracking is a bit less 
melodic, and doesn’t take up as much sonic space. 
 
For some examples regarding the range that musical audio can cover: A minimal, 
single-instrument song is very intimate, and is often used to portray more melancholic 
emotions. More complex arrangements can convey feelings of grandeur, epic-ness, 
adventure, hope, excitement, and so on. Synthesizers made up of simple waveforms without 
many effects can sound synthwave-y and convey a retro feel. Synthesizers with a wide 
frequency profile can sound futuristic and if they’re gritty, cyberpunk-y. 
 
Effects 
 
Effects are all the audio effects you might hear, like gunshots, footsteps, climbing sounds, 
reload sounds, interaction sounds, etc.. These effects are meant to act as feedback. They 
provide a sonic reaction to the actions in-game, which, like ambient sound, gives weight to 
these actions. Effects can be quite stylized, and can end up being a very interesting source of 
audio in a game, due to its capacity to describe materials, and how they move, which in turn 
can be used as a small narrative tool. 
 
Implementation 
 
An aspect of audio unique to videogames is how audio is implemented. 
 
Static 
 
The most standard practice is to play audio at predetermined points. So, things like scripted 
events, being in a menu, and cutscenes would trigger audio to play in-engine. 
 
Dynamic 
 
However, games are not so linear! Players do things in different orders, and not all behavior in 
a game is scripted. When emergent and/or unique behavior happens, a game with good 
audio should still be able to accompany the in-game experience. 
 
Through dynamic recognition of various moments (through player location, speed, action, 
enemy number, etc.), audio can be triggered / modulated to enhance these emergent 
moments. Dynamic audio can keep things sonically varied, and ensure that the game is 
providing appropriate music for different scenarios. In more specialized scenarios, it can also 
be used as a feedback tool. 
 
Not only can dynamic soundtracks change what song is playing, they can modify currently 
playing music. When walking around, a relatively calm soundtrack plays. As you enter into 
battle, a more aggressive version of that music might kick. Or in a puzzle section, each new 
room might add some instrumentation to a background soundtrack to provide sonic feedback 
you’re progressing. 
 
An especially interesting source of audio is in-world music, like characters playing music, or 
environment-based music. This sort of ‘diegetic’ music, like diegetic user interfaces, is a 
stylistic choice. 
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Audio & Atmosphere 4 / Instructor: Victor Ivanov 

Sound Engineering & Mixing 
An overview of sound theory, mixing techniques,  
and fundamental principles of audio production. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 
https://docs.google.com/presentation/d/1gSBaZogv4nHVcvd7zyrxjk1BBQ_MM0EXwrSIiYG01
Xo/edit?usp=sharing 
 
Reaper Download 
http://reaper.fm/ 
 
Harmor Download (Free Trial) 
https://www.image-line.com/plugins/Synths/Harmor/ 
 
Instructor Prerequisites 
The instructor should be comfortable using Reaper. The instructor should be familiar with the 
basic physics behind audio, standard audio effects, and have some knowledge in game audio 
implementation. 
 
Participant Prerequisites 
None. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Reaper, version 5.91+. 
 
Objectives 
To establish a mathematical foundation of audio and music theory, and to present tools that 
apply this knowledge to manipulate audio, both for production and game implementation 
purposes. 
  
Vocabulary 
Frequency, amplitude, waveform, harmonic, hertz (Hz), phase, equalizer, delay, reverb, 
compressor, modulation, mixing, dynamic mixing. 
  
References 
Complete Production Pipeline Tutorial Set. 
https://www.youtube.com/watch?v=UoRo80VzSEY&list=PLGYoE903Nir7qVmd-b333OT7Wj4
EAltGT&index=1 
 
Deciding on what is at the forefront (weapons). 
https://www.adsrsounds.com/news/the-sound-design-of-doom-exclusive-qa/ 
 
Sound processing can make anything sound into anything. 
https://www.youtube.com/watch?v=POtV24aOI5s 
 
Environments and keeping sonic quality consistent with overall aesthetic. 
https://www.youtube.com/watch?v=Oq_yt8RcnKY 
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Sound Engineering 
 
An important factor in creating sound is learning about the compositional theory 
required to create and arrange sections into a coherent product. If we compare this to 
drawing, we can think of this as learning how to visually compose a piece. However, we still 
need to learn to draw, and to know how we define our strokes, our line weight, its curvature, 
how we do perspective, dynamic poses, and so on. Think of this lesson as a dissection of 
audio in a similar way as one would dissect the art of illustration. 
 
Math 
 
At the basis of audio is physics. Sound is vibration that travels through a medium (like air), 
which eventually reaches small hairs in our ears whose vibrations are interpreted as sound by 
our brain. To understand how audio works, we need to deconstruct these vibrations into their 
constituents. 
 
Frequency 
 
Frequency is how ‘frequently’ a wave completes its oscillation. A wave is composed of a 
waveform that is repeated. Frequency is measured in hertz, which are oscillations per second. 
The human ear can hear between approximately 20Hz and 20kHz. So, twenty oscillations per 
second and twenty thousand oscillations per second. The higher / faster the frequency, the 
higher pitched a sound is. 
 
Amplitude 
 
The amplitude of a wave is how high and low the peaks of valleys in a wave. In a standard 
visual model of a wave, the middle is 0 (silence), and anything higher and lower is a tone. The 
more a wave diverges from the 0 line, the louder it is. Amplitude determines loudness. 
 
Waveform 
 
A waveform is the profile of a wave in a single oscillation. This determines the tone of a wave. 
Waves can be combined with other waves to create complex waves, which happens to be 
how we listen to music! All audio we listen to is complex waves, sampled dozens of 
thousands of times per second (44 100 times, by standard), different in each sample. 
 
Harmonics 
 
Harmonics are a bit more complicated. A harmonic is an overtone that shares a relationship 
with the fundamental. A harmonic is a multiple of the fundamental. So, for a signal of 400Hz, 
the first harmonic is 800Hz, the second is 1200Hz, the third is 1600Hz, and so on. 
 
Why are these important? Well, these harmonics determine the waveform’s shape. A perfect 
sine wave is only the fundamental, with no harmonics. A square wave has the fundamental, 
and every even harmonic. A triangle wave has the fundamental, and every odd harmonic. A 
saw wave has the fundamental, and every harmonic. 
 
Because harmonics determine the waveform, that means that they ultimately determine what 
something sounds like. The proper harmonics, at the right amplitudes, can recreate any 
sound. 
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Earlier we said that combinations of waveforms create complex waveforms, right? 
Well, if we take a sine wave, and we play it at every frequency where harmonics of 
the fundamental are supposed to be, we would end up with a saw wave. Using 
nothing but a combination of sine waves, played at different frequencies and at 
different amplitudes, we can create every possible sound. 
 
If you recall, we spoke about chords in an earlier audio lesson, but left out why certain notes 
sound good together in a chord. The reason why chords sound good is because notes in a 
chord are consonant with the chord’s fundamental. That is to say, chords are composed of 
notes whose harmonics match up relatively often. 
 
An example is that C and G have half of their harmonics line up, so they are consonant and 
sound good together. Same goes for C and F. However, F and G don’t have many that line up, 
and are therefore dissonant, which is why not all that many chords have C, G, and F in them. 
 
Obviously, this is not something that you can think of on the fly when playing music, but it’s 
very valuable to understand that the way different tones sound together depends a lot on 
how similar their ‘harmonic profiles’ are, if you will. The reason we find harmony pleasing is 
more of a neuroscience topic that we won’t cover right now, but I’d be happy to talk about it 
otherwise. 
 
Phase 
 
Phase is the point at which a waveform is being played. This is calculated in degrees, where 0 
degrees is the beginning of the waveform, and 360 is the end. So, over a single oscillation, a 
waveform goes from 0 to 360. 
 
What this is leading to is how different waves interact with one another in concordance with 
their relative phase. What does that mean? It means that some weird interaction can happen 
when two tones are played at the same time, and phase has an effect on their interaction. 
 
Two identical sine waves played simultaneously amplify one another. They are in phase. They 
become louder when played together. 
 
However, what if one of those waves has a phase of 180? One wave is played 180 ‘degrees’ 
into its cycle, so when the first wave is at its peak, the second wave is at its valley. It means 
that one wave is mirrored, basically. Well, then they cancel each other out and result in 
silence. This means they are completely out of phase. 
 
Generally, phase should be avoided in regards to the way different tracks interact with one 
another, since that cancellation can make a mix sound thin, or hollow. But obviously, our 
music isn’t just sine waves, and these very obvious interactions between signals become a lot 
more obscure and less noticeable with unique, complex waves. 
 
Phase can still be a problem, however, especially in situations when you record the same 
thing with multiple microphones simultaneously, like a guitar or a drum set. Or, when you 
create a copy of a sample, edit it in some way, and try to mix it with the original sample. 
 
The fix? Move your mics around a bit, account for the latency edits to a track might make, and 
sometimes all it takes is nudging one track by a few milliseconds to get the phase lined up. 
 
Design Tools 
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Now that we have a language to understand sound, we can use tools to manipulate 
audio. There are a plethora of effects and ways to change sound, and things can 
appear overwhelming. However, you will soon realize that practically all effects are 
based off of a few basic principles! 
 
Equalizers 
 
One of the, if not the most powerful tool in an audio designer’s toolset, is an equalizer. An 
equalizer is a tool that allows you to control which frequencies of a signal are stronger and 
weaker. Although quite simple, an EQ is very powerful. It allows you to clean up a signal by 
removing unwanted frequencies, to highlight frequencies you want to put emphasis on, and 
so on. 
 
Words like “filter” refer to this operation of “filtering” a set of frequencies. A “lowpass filter”, 
for instance, is a filter that lets the low frequencies pass, so it filters out the higher one. The 
opposite goes for a highpass filter. 
 
As a side note, if you ever wanted to know how to make the “wob wob wob” sound in 
dubstep, it’s using filters that are moving through frequencies over time. 
 
Delays 
 
Delays are used to in some way delay sound. What’s the point of this? When it comes to a 
simple, repeated delay, it creates an echo-like effect, giving the feeling of space. 
 
A ping-pong delay, which delays the signal asymmetrically between the left and right 
channel, gives off an even more spacious and floaty feeling. Asymmetry in a stereo signal 
makes audio feel wider, which can be used to make a mix more powerful. 
 
Effects like reverb, which emulate the way audio bounces off walls in a room, are built on 
things like delay, and some other modifications to the signal, as it becomes dampened 
through this reflection in a room. 
 
Compressors 
 
Compressors are a tool arguably as fundamental as equalizers. A compressor compresses 
volume. This means that the quiet and loud parts of a track are closer to being the same 
volume. So, compression reduces audio’s dynamic range. 
 
This sounds like a bad thing, and if maximum expressiveness through is a huge priority, then 
compression should be mostly avoided. However, compression is a very useful engineering 
tool that can be used to bring out quieter details, and make a mix louder overall. More 
complex versions of compression allow set frequencies to be compressed, giving designers 
control over what part of a signal is compressed. 
 
Effects like “limiting” are done through compression. A limiter is an effect that compresses 
anything beyond a certain volume down to a set threshold. This is useful to keep audio from 
clipping (which is when a signal is so loud it becomes distorted). 
 
Another fun effect called “sidechaining” is done through compression, too. Sidechaining is a 
way of making one track quieter when another is louder. Why do this? To give space for a 
part of the mix. For instance, if the bass and kick drum are competing for the lower 
frequencies, sidechaining the bass to the kick drum will make the bass quiet only when the 
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kick drum plays, giving the kick room to shine. 
 
Phasers 
 
Improperly synchronized phase, as we’ve discussed, is normally a bad thing. However, it can 
be used to our advantage. Effects like phasers, chorus, and flangers, all intentionally create a 
copy / multiple copies of the original signal, and offset its phase (with some added filtering 
and whatnot). This effect gives a signal a perpetually morphing sound. It’s difficult to describe 
in words, but it can give some life to a monotonous sound. It’s often used in electronic 
synthesis, and in guitar effect stacks. 
 
Modulation 
 
The final effect, ‘modulation’, isn’t so much of an effect, as it is a control model. The purpose 
of modulation is to take the parameters of a synth or effect, and change them over time. 
 
One of the ways to do this is through automation, which is quite simple. Automating a 
parameter has you set keys in a timeline that say what a value of a parameter should be at a 
certain point, and values between two markers are interpolated. 
 
Another way is envelopes, which are especially useful for controlling volume. Envelopes are 
like one-shot automations, and they are usually triggered each time a note is played. This 
means that envelopes can be used to describe, among many things, the volume profile of an 
instrument. Its attack, decay, sustain, and release. 
 
And, there’s LFOs, which are “low frequency oscillators”. These are waves that are far too low 
in frequency for us to hear, but can be used to modulate parameters. LFOs can be used to 
add vibrato to an instrument, or to do the “wob wob” of a sound using a filter. 
 
Sound Interaction in Games 
 
In the context of a game, there are a few unique quirks to how audio should be mixed. 
Because a mix is not a static and unchanging in games, programmers need to think about 
how to prioritize certain audio sources over others. 
 
In a shooter, it might be reasonable to prioritize sounds from weapons, as they’re central to 
the experience. In a racing game, it would be the vehicles. In a rhythm game; the music. In a 
narrative game: dialog. In games, the mix is changed dynamically to prioritize some audio 
over other. 
 
To understand how a mix works (both in games and in a static product, like a song), we need 
to understand how audio interacts with other audio. That interaction happens primarily in 
regards to frequency. 
 
The concern with frequency is when two signals of a similar frequency are played together. 
As we discussed earlier, one of the issues that can arise from this is undesirable phasing. This 
isn’t super common, so it’s not so much of a problem. However (this is typically more 
concerning for the lower frequencies), multiple signals can make things sound messy. 
 
A bass, for instance, very rarely plays chords. It instead sticks to single notes. This is because 
in the lower frequencies, notes are closer to each other in frequency, which can potentially 
cause phasing. Because they’re very low in frequency, we also can’t discern them as easily. 
So playing multiple notes makes things muddy. Or in the higher range, a high-hat can 
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compete with the lead’s harmonics and overpower what is supposed to be the central 
element of a composition. 
 
This is a big problem when considering that we don’t know when players will shoot, 
when explosions will happen, and so on. A game needs to have an audio 
management system that changes parameters for various audio sources to make sure all 
sources work together. 
 
This can be achieved with techniques like filtering one of the signals so that it isn’t as strong 
in frequencies that aren’t important for it. This is very common, and ensures that each 
instrument sits in its own frequency space, and leaves room for others. Sometimes a filter 
distorts sound too much, so a sidechain is more appropriate. At other points, maybe a melody 
can be played one octave lower, just to distance itself a little bit from whatever occupies that 
space. 
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Programming 1 / Instructor: Sam Bourgault 

Intro to Game Programming 
Introduce fundamental knowledge of programming using C# in Unity. 

 

 
Teaching Days, Time, & Length 
Wednesday July 18th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1Bl5yX7k7bYjCWCdT94laqojrhfrVrLpOaYPiIM
24gYw/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable with Unity. 
- Comfortable with programming in C# within Unity. 

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Course Material repository 
- Know the basics of Unity interface 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Split screen with the slides for Live Coding parts. 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 
- Visual Studio 2017 

 
Objectives 

- Introduce the basic concepts of programming and naming conventions 
- Introduce Start and Update Unity functions 
- Explore variables 
- Explore functions 
- Explore simple Conditional Logic 

 
Vocabulary 
Variables, Type, Function, Conditional Logic, Naming Conventions. 
  

 

 
How a Computer Understands Code 
Computers have greatly evolved since their creation in the mid-40s but they are by no means 
smart - at least not yet anyways. They do not understand human language, so how is it that 
we can program complex tasks using programming languages that resemble the spoken 
word? Well it’s possible thanks to complex software called “compilers”. Compiler understands 
and translates the programming language (which is high level, understandable by us human 
beings) into machine language (low level based off of electrical currents and 1s and 0s that 
the computer can use). 
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Using and Writing Scripts for Unity 
Unity allows us to program using C# or JavaScript. However we will be using C# in 
this workshop. When we create a new C# script, this script becomes available as a 
new component that we can add to any gameObject in the scene. For the most part, when 
we create a script, if we want to run it, we need to attach it to a gameObject in the scene and 
then it will run when we hit play in Unity. Let’s look at that. If we go into Unity and add a new 
C# script into our Assets folder by right clicking in the project view and selecting Create >  C# 
script and name it something recognizable (let’s call it SkinsTestScript), we can then go and 
add it to any gameObject in the scene. Select an object and hit the button Add Component, 
then type in the name of the script. Unity recognizes the new script as a potential new 
component. However, this script doesn’t do anything at the moment. We’ll get there. 

 

Getting Code to Run in Unity 
Unity has created a handful of ways for us to trigger code without us triggering them 
manually. These are part of Unity’s pre-built scripting modules. By creating functions with 
very specific names (don’t worry we will cover exactly what a function is in a minute) we can 
trigger lines of code at different times. Let’s look at two examples: 

- void Start() allows us to run whatever is within once and only once when the 
scene starts. 

-  void Update() allows us to run whatever is within it continuously every frame 
when the game is active. 

To look at one in action, let’s first create an Empty gameObject in the Hierarchy, create a C# 
script and attach it to the new gameObject. Then double click on the script, this will open 
Visual Studio (or MonoDevelop), the IDE (integrated development environment) that we will 
be using to write down our code. We starts by sending a message to the Console, a window 
displaying errors, warnings and messages. 

 void Start() 

 { 

 Debug.Log(“Hello World”); 

 } 

 

In C#, we always need to end a line of code with a semicolon. This tells the compiler that this 
is the end of a particular line of code. Each line of code acts as a specific task we want the 
script to run. In this case we are asking the script to print out the words Hello World on the 
console. Save your script and let’s try this out and see what happens. Go back to Unity and 
make sure your script is attached to a gameObject in the scene. Hit the play button and if you 
open the Console window you will see the words Hello World (notice it only prints it once). 
Now let’s see what happens if were to do the exact same thing using the Update function 
instead. 

 void Update() 

 { 

 Debug.Log(“Hello World”); 

 } 

 

Save your script and let’s run that again. If you open the Console, you should see it flooded 
with Hello World.  

 
Variables 
It’s nice that we can print out some words, but what if we wanted to do something more 
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complex. Let’s say we want to add two numbers together. We can do that easily: 

 Debug.Log(1+2); 

Since we want to see the result IN THE CONSOLE, we need to put it inside the 
Debug.Log() function. Save your code and let’s try it out. Unlike the Hello World, it 
no longer prints out what is inside the brackets verbatim, instead it performs the 
mathematical operation and prints out the result. That’s nice but what if we wanted to 
perform a more complicated mathematical operation in multiple steps? We would need a way 
to store the results of each step in memory. That’s where variables come in. 

Variables store different types of data in memory in order to be used in multiple places in a 
script. We create a variable by first telling the compiler what data type it is. There are many 
different data types but for now, let’s just look at the core primitive ones. 

- Int: a whole number positive or negative. Used in mathematical calculations. 
- Float: a number with as many decimal points as we want. Used in mathematical 

calculations. 
- Char: a single letter or symbol. Used for text manipulations. 
- String (string): a collection of characters. Used for text manipulations and text display. 

Once we have decided on what the data type that we want is, we need to give our variable a 
name. This name acts as a pointer for the computer to be able to find the variable in memory. 
Names need to be distinct, in other words, we can’t have 2 variables with the same name. If 
we do, the compiler will give us an error because we are trying to point to the same place in 
memory for 2 different variables. Furthermore, there are a few rules to follow when naming 
your variables 

- Cannot start with a number 
- Cannot contain any symbols except underscore 
- Cannot contain spaces 

The last thing a variable needs is a value. Once we have all 3, we can fetch it from memory at 
any time to use it in any context. Let’s look at an example by splitting up the calculation for an 
average of 3 numbers into 2 parts. 

// Declaring the variables 

 int number1; 

 int number2; 

 int number3; 

  

void Start() 

 { 

 // Initializing the variables 

number1 = 3; 

number2 = 6; 

number3 = 11; 

  

 // Calculating the average 

int sum = number1 + number2 + number3; 

  float average = sum/3f; 

  

 // Returning the result 

  Debug.Log(result); 

} 

 

We can notice a few things here: 

- We can store the result of calculations in a variable. 
- We can use a variable as if it was its value. Since number1 has a value of 3, we can 
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use the variable name in the calculation directly. 
- // symbol allows us to write comments in our code that will not be read by the 

compiler 
- A variable needs to be declared to exist and initialized to hold a value.  
- Lastly we can print out the value of a variable. 

The variable name acts as a pointer to the location in memory where the data for the variable 
is stored. Without a name, the compiler won’t know where to store or retrieve the information 

Note that unlike the ints, when we are working with a float, we need to add the letter f at 
the end of any number. This tells the compiler that we have decimal points in the value for the 
variable. If we were not to put the f next to 3, then our result would be rounded down. 

So let’s go back to Unity and test it. 

There is one more thing about variables that is very interesting in Unity. We can make 
variables visible in the inspector so we can change them on the fly. Let’s rework our average 
example so it works for that. 

// Declaring and initializing the variables at once 

 public int number1 = 3; 

 public int number2 = 6; 

 public int number3 = 11; 

  

 void Update() 

 { 

 int sum = number1 + number2 + number3; 

 float average = sum / 3f; 

  

 Debug.Log(average); 

 } 

 

By adding the keyword public and putting them outside of our Update or Start functions, 
Unity recognizes these values as visible and will make them available for editing directly 
inside the Inspector. Save your code and let’s go take a look. If you go to the gameObject 
holding the script, we should now see that there are 3 new values within the inspector. With 
this, we can change those values at any time without needing to go back into the script. Hit 
play and try fiddling with the values while it runs. 

Something important to notice before we move on: if we change values in the inspector like 
this during play mode, as soon as we hit play to stop, the numbers will revert. In other words, 
make sure not to make changes that you want to keep in the inspector during play mode. 
Also if some variables are modified in the Inspector, the new values will override the values 
defined before the Start function. 

Finally, it is possible (and in a lot of cases a good practice) to declare and initialize the 
variable all at once by concatenating the 2 steps into a single command. 

 

Functions 
Let’s say, for whatever reason, we want to find the sum of 3 different averages, we could 
rewrite the code we already wrote 3 times with different values but that would get messy 
very quickly. Functions allow us to group lines of code together to avoid repetition. They can 
be called anywhere throughout the script. The general syntax for creating a function should 
look familiar to you since you have been using functions already (Start and Update 
functions). 

 datatype FunctionName() 

 { 
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 //some code here 

 } 

 

Much like variables, we need to define the data type that the function can return. This 
means that a function can not only perform specific tasks, but it can also return a 
value of any type. We will look at a specific example of that in a second. However, if we take 
a look at the functions we have previously used, Start and Update, they do not return any 
data type, they just perform some tasks. When we want to create a function for just tasks 
performance without any return of data, we specify it as void.  

Again, much like a variable, a function also needs a distinct name. However, its name is not 
the only part of its identifier. Functions also have parameter list that allow us to pass specific 
values into the function in order to perform the same tasks under different contexts. The 
brackets next to the function name is the parameter list. There can be as few as no 
parameters to as many parameters as we want. Parameters need a data type and a name, 
much like a normal variable, however, we don’t specify a value; this is done when we call the 
function. Parameters are separated by a comma and if we don’t want to have any 
parameters, we still need brackets with nothing between them. Let’s look at a specific 
example. 

float CalculateAverageOfThreeNumbers(float n1, float n2, float n3) 

{ 

return (n1+n2+n3) / 3f; 

} 

 

Let’s break this function apart: 

- The float at the start specifies that we want to pull a result out of this function. We 
know 2 things from this, 1: we need to have a line that returns a value. This is done by 
using the keyword return at the start of a line and then by writing the value we 
want to return next to it. In this example we want to return the result from the 
average calculation. 2: we know that we want to return a value specifically of the 
data type float. Any other data type we try to return will give us a compiler error. 

- The name of the function is CalculateAverageOfThreeNumbers() and it has 3 
parameters: n1, n2, n3. We can tell what data types those parameters are by 
looking at the data type that precedes each parameter name. 

  

A function doesn’t do anything until it is called. By creating a function, we are setting up a 
bundle of code to be used but we need to call it in order to perform the tasks under the 
desired context. Let’s call the function inside our Start() function so we can see something 
happening 

void Start() 

{ 

Debug.Log(CalculateAverageOfThree(number1, number2, number3)); 

} 

 

As you can see, we can use an actual function as a variable if it returns a value. Since this 
function returns a value of type float, we can simply throw it into the debug much like we did 
for a variable of type float. Now let’s go one step further and use this function inside another 
function. 

float DistanceToAverage(float n1, float n2, float n3, float  n4) 

{ 

float average = CalculateAverageOfThree(n1, n2, n3); 

float distance = n4 – average; 
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return distance; 

} 

 

Here we are storing the result of the CalculateAverageOfThree() function  in a 
variable and we are calculating the difference between a forth value and that 
average. Once again though, creating the function doesn’t do anything unless we call it 
somewhere so let’s call it in our Start function. 

void Start() 

{ 

Debug.Log(DistanceToAverage(number1, number2, number3, number4)); 

} 

 
Calling this function now allows us to compute the distance between a value and an average 
of three values and all we need is a single line of code. 

 

Naming Conventions 
In order to write understandable code, it is important to follow an established naming 
convention. It makes it easier for everyone to recognize elements upon quick inspection of the 
code. C# has an industry standard for the naming of individual elements. There are three 
different types of element covered under these conventions: 

- Variable names: camel-case (thisIsCamelCase - first letter is lowercase and all other 
words are separated by uppercases with no space in between) 

- Function, method, class names: pascal-case (ThisIsPascalCase - first letter is 
uppercase and all other words are separated by uppercases as well with no space in 
between) 

- Constant variables: uppercase split by underscores (THIS_IS_A_CONSTANT) 

Aside from the format the names should be written in, it is important to follow three simple 
rules as well: 

- Each name should be descriptive and understandable 
- Names should be unique to avoid confusion 
- Names must not start with numbers and cannot contain symbols aside from an 

underscore 

 A good name should always follow the rules stated in the Naming Conventions  

 bool hasBeenVisited; 

 int playerScore; 

 float playerSpeed; 

 

Conditional Logic 
We now know how to store information and how to group tasks together in functions in order 
to create repeatable modular chunks of code, however, maybe we want to call code only 
under certain conditions. We do this using conditional logic. Conditional logic uses if 
statements in order to see if a condition is met: 

 if(thisIsTrue) 

 { 

 //do something 

 } 

 

In order to execute what is inside an if statement, we need to check if a condition is met. 
Generally, this is done by checking the state of a boolean value. Booleans are another data 
type that holds one of 2 values: true or false. Like any other variable, by making them 
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public, we can see their value in the Unity inspector. Let’s look at an example 

 public bool IsThisThingOn; 

You’ll notice, if we look at the inspector, that the bool comes out as a check box. If we 
check the box, then we are setting the value to true. If the box is unchecked, then it 
is false. Let’s create a practical example of a conditional statement using a simple boolean 
variable. 

public bool convertToMetric; 

public float degreesToConvert = 10f; 

  

void Update() 

{ 

if (convertToMetric == true) 

{ 

  Debug.Log(ConvertToCelcius(degreesToConvert)); 

} 

 else 

{ 

  Debug.Log(ConvertToFarenheit(degreesToConvert)); 

} 

} 

  

float ConvertToFarenheit(float degrees) 

{ 

return (degrees * 9f / 5f) + 32f; 

} 

  

float ConvertToCelcius(float degrees) 

{ 

return (degrees - 32f) * 5f / 9f; 

} 

  

There are a few things to note here 

- For one, when we are checking for a condition, we need to use the double == sign in 
order to compare the left value to the right. In English, this line of code would read “if 
convertToMetric is equal to true”. 

- You’ll also notice something new right below the if statement. Any if statement can 
have an else statement. else statements allow us to perform something different 
when the if statement comes out false. If we were to read this entire conditional 
logic in English, it would sound something like “if convertToMetric is equal to true, 
convert the degreesToConvert into Celsius. Otherwise, convert the 
degreesToConvert into Fahrenheit”. An else statement can only be used after an 
if statement but an if statement can be used without an else statement after it. 

Now by changing the value of ConvertToMetric in the inspector, we can toggle between a 
Celsius conversion and a Fahrenheit conversion. 
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Programming 2 / Instructor: Sam Bourgault 

Player Interaction and Movement I 
Further knowledge on object-oriented programming  
through the making of player movement. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 9:15AM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1JxNpVtgMUAdqPTSdVzytq9psl46VcM93A5
qv0_EPz0k/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable with Unity. 
- Comfortable with programming in C# within Unity. 

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Course Material repository 
- Know the basics of Unity interface 
- Know the basics of programming (covered in the Programming 1 Lesson) 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Split screen with the slides for Live Coding parts. 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 
- Visual Studio 2017 

 
Objectives 

- Introduce the concepts of Object Oriented Programming in C# for Unity 
- Walk the students through creating a script that interacts with user interface 

elements 
- Walk the students through creating a script that interacts with an animator controller 

 
Vocabulary 
Class, Array, Visibility, Loop, Methods. 
  
References 
Software website: 

- https://docs.microsoft.com/en-us/dotnet/csharp/programming-guide/classes-and-stru
cts/classes  

- https://docs.unity3d.com/ScriptReference/  
 
Software Tutorials: 

- https://hybrid.concordia.ca/cart253/object-oriented-programming-quick-lesson/  
- https://hybrid.concordia.ca/cart253/arrays-quick-lesson/  
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What is a Class? 
Classes are a key element in Object-Oriented Programming (OOP). They make up the 
majority of the programing tasks within an OOP project. 

Think of a class (also known as an object) as a custom component allowing you to 
define its data and behaviours. It is made up of 3 key elements: 

- Member fields (also known as class variables): These elements store data that can be 
accessed at any level of the class. 

- Methods (also known as class functions): These are generally procedures with specific 
purposes that give the object its functionality. 

- Constructor: Unique methods that allow an instance of the object to be created within 
other classes. These are unnecessary for classes in the context of Unity behaviors so 
we won’t go into much detail about them for the time being. 

 

Arrays 
Arrays are data structures that allow us to group a number of same data type values 
together in order to have an organized collection of similar data. Elements inside an array are 
organized by indexes, a numerical value determining their position within the collection. 

Similarly to variables, arrays must be declared and initialized before being used. Furthermore 
they can only hold a predetermined number of values set upon initialization. Once initialized, 
the number of values cannot be modified but the values themselves can: 

 float[] playerScores = new float[9]; 

This declares an array of floats named playerScores and initializes it with 9 slots for values. 
The number of slots is known as the length of the array. At this point, even though the array 
has been declared and initialized, its elements are set to their default values: 

- int, float: 0 

- bool: false 

- char, string: “” 

- All other data types: null 

Therefore it is also important to populate the array once it has been declared and initialized. 
The syntax for doing so involves giving a value to the element at a specific numbered position 
within the array. We do this by specifying the array index we want to access. The index 
specifies the location of the element within the array and always starts at position 0: 

 playerScores[0] = 152.6f; 

 playerScores[1] = 24.6f; 

 … 

 playerScored[8] = 221.6f; 

 

In other words, indexes will always go from 0 until 1-length. In this example, indexes go from 
0 to 8. 

 

Loops 
Loops can be used to simplify repetitive tasks (such as populating an array) by repeating a 
specified procedure until a condition is met. The most common type of loop is the for loop. In 
a for loop, we iterate through the procedure for a specific number of times. We do this by 
determining a starting integer at which the loop begins counting, by specifying a condition to 
check for in order to continue iterating or to break the loop, and then by defining a 
modification of the integer that is performed at the end of each iterations. 
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 for (int i = 0; i < playerScores.length; i++) 

{ 

 playerScores[i] = i * 100.0f; 

 } 

 

Here we iterate through the array by starting our loop with an integer i at value 0. We iterate 
until i is no longer less than the length of the playerScores array, and at each iteration we 
add 1 to the value of i. 

Foreach loops are simplified for loops that only work for iterating through a data structure 
(array, list, etc). It will iterate through every element inside the array until it hits the last one, 
then break out of the loop afterwards: 

 foreach(float score in playerScores) 

{ 

 score = 0; 

} 

 

This can be read like “for each float, that we will call score, in playerScores set score to 0. 

Here we specify what data type is within the array we are manipulating. Afterwards we give 
a temporary name used for all elements within the array. This name (much like the integer 
used in the for loop) only exists inside the loop context. Lastly, we specify which array we 
want to manipulate by using the keyword in and specifying the array name. 

While loops are another way to execute code repeatedly, depending only on one boolean 
expression. As long as the condition is true, the loop will run but as soon as it’s false, it will 
break. 

while (playerScore[0] < 10) 

{ 

Debug.Log(“Player 0  has not win yet.”); 

} 

 

You will not find while loops as much as for loops in programming because it is usually 
practical to define the number of iterations we want a piece of code to be executed. It is still 
important to know that it exists.   

 

Methods 
Methods are what give classes their functionality. Without them, classes just hold information 
(which may sometimes be desired) but they won’t be able to do anything themselves. Method 
is just another name for functions within a class!  

Don’t Forget: Function, method, class name use the pascal-case naming convention 
(ThisIsPascalCase - first letter is uppercase and all other words are separated by uppercases 
as well with no space in between). 

 

Scope and Visibility 
Scope is one of the most important concepts to understand early on when learning about 
programming. This dictates that a variable only exists within the context it is declared. In 
other words, if a variable was declared within a function, it only exists within THAT function. 
If a variable is declared as a member field, it exists within the whole class and is visible to all 
of its functions. Let’s look at a function to understand this concept better. 
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float CalculateAverage(float firstValue, float secondValue, float 

thirdValue) 

{ 

  float sumOfThree = firstValue + secondValue + thirdValue; 

  return sumOfThree / 3; 

} 
 

In the CalculateAverage() example function, we see that sumOfThree was declared inside 
the function, therefore we cannot use that variable inside another function since it only exists 
within the CalculateAverage() function. 

 

Exposing Variables and Methods to Other Classes 
In OOP, we rarely want things to only be visible within their own classes. We want to be able 
to communicate between objects. For example we may want a car class to communicate 
with a garage class to see if there is room for it to park. By default, things will only be visible 
within their own class however, we can control their visibility to other classes by adding the 
public or private keyword before a member field or class method. 

public class Car 

{ 

public Garage garage; 

private int parkingSpotNumber; 

  

private void TryToPark() 

      { 

if(garage.CheckParkingSpotAvailablity(parkingSpotNumber)==true) 

            { 

 Park(); 

            } 

      } 

  

private void Park() 

{ 

 //park the car 

} 

} 

  

public class Garage 

{ 

private bool[] parkingSpotAvailabilites = new bool[10]; 

  

public bool CheckParkingSpotAvailablity(int parkingSpotNumber) 

{ 

return parkingSpotAvailabilites[parkingSpotNumber]; 

} 

} 

  

Here we see how two classes can communicate with each other. By making the Garage 
variable public we can set the reference within the Unity inspector in order to specify which 
garage we want to park in. This is a Unity feature and we will see it in action shortly. By 
setting all other variables and methods in the Car class private, we lock those out of all other 
classes. This is a good practice when you know that a method is not intended to be called by 
another class so as to protect certain functionality and prevent possible errors. Inside the 
TryToPark() function in the Car class, we call on the public method 
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CheckParkingSpotAvailablity(), which returns a boolean value based off of 
which parking spot we are checking. This demonstrates that even though a member 
field is private, it can still be accessed if returned by a public function. This is also a 
good practice in order to protect variables from being accidentally modified by other 
classes when they should only be handled within the class. 

  

Introduction to basic C# functions in Unity 

Note that we created a cheat sheet in order for you to have a quick access to some of the 
basic C# functions in Unity. If you look in the References section, you will see a list of function 
used in different contexts. 

The first relevant functions are the ones that allow us to access gameObjects and 
Components. You can get gameObjects using their name, their tag or their type and you can 
get Components using their type as well. By storing these results into a variable, you then 
have access to all the functions associated to these objects and components. 

 

ComponentType compVariable = GameObject.GetComponent<ComponentType>(); 

GameObject gameObjectVariable = GameObject.Find(“name”); 

GameObject gameObjectVariable = GameObject.FindObjectOfType<Type>(); 

GameObject gameObjectVariable = GameObject.FindWithTag(“tag”); 

 

One of the most important component of any gameObject is its Transform. It can be accessed 
through code to modify the gameObject location, the rotation and the scale. Contrary to the 
other components, the Transform can be reached in a unique way: 

Transform.position = new Vector3(floatX, floatY, floatZ); 

Transform.rotation.eulerAngles = new Vector3(floatX, floatY, floatZ); 

 

We notice few things: 

- The position is a Vector3, which consists in a data structure (similar to an Array) containing 3 

elements. These elements can be accessed using .x, .y and .z on any Vector3. 
- Transform.position.x 

- Transform.position.y 

- Transform.position.z 

- The use of eulerAngles is specified to set the rotation. Note that Transform.rotation alone 

exists but belongs to the Quaternion class, which is a lot more complex to picture in space 

than a Vector3. The eulerAngles correspond to the respective angles between the gameObject 

orientation and the x, y and z axis. 

There is more functions on the cheat sheet to which we will come back in time and place. 

  

Guided Brief: Moving Ball 
Step 1: 

Open the project MovingBall in the CourseMaterial repository and open the Scene_Exercise. 
Note that you have access to the Solution if needed. 

Step 2: 

Add a Sphere to the Scene, make sure it is located at (0, 0, 0) and change its name for Ball. 
Add a Rigidbody Component to your Ball. Uncheck Use Gravity and Check Is Kinematic. As 
explained in an earlier lesson, this will make sure that the Ball is not affected by Physics, but 
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remains a Rigidbody, which will be useful when we begin coding around collision. 

Step 3: 

In the Scripts folder, create a script and call it BallMovement. Add the script as a 
Component to the Ball in your Scene. Finally open the script. 

Step 4: 

Before the Start function, declare and instantiate speedX and speedY: 

public float speedX = 0.1f; 
public float speedY = 0.2f; 
 

In the Update function, we will define new values for x and y by adding the speed to the 
position of the Ball in order for it to move. 

void Update () { 
        float newX = transform.position.x + speedX; 
        float newY = transform.position.y + speedY; 
  

        transform.position = new Vector3(newX, newY, 0f); 
} 

 

Note that to keep the ball in 2D motion, we set the z position of the Ball to zero. If we would 
like our movement to be tridimensional, we could define a non-zero value for the z. 

If you press Play now, you will see the Ball travelling to the top right corner of the window 
and disappearing. What we would like is rather the Ball bouncing off the Borders of the box. 
To achieve that we will need some conditions. 

Step 5: 

Write down the conditions on the x axis and the y axis separately. And, if these conditions 
are verified, invert the respective speed. 

 void  Update  () { 
if  (transform.position.x > borderPosition || transform.position.x < 
-borderPosition) { 

            speedX = -speedX; 

        } 

  

if  (transform.position.y > borderPosition || transform.position.y < 
-borderPosition) 

        { 

            speedY = -speedY; 

        } 

  

        float  newX = transform.position.x + speedX; 
        float  newY = transform.position.y + speedY; 
  

        transform.position = new  Vector3(newX, newY, 0f); 
} 

 

We flip the speed because we don’t want the ball to go any further in that direction. You can 
press Play and you will see that the Ball remains within the borders of the box. 
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Step 9: 

One detail that we can fix is to make sure the side of the Ball doesn’t cross over the 
borders of the box. For that, we need to include the radius of the Ball in the conditions. 

private  float  radius; 
 // Use this for initialization 

 void  Start  () { 
        radius = transform.localScale.x / 2f; 

    } 

  

 // Update is called once per frame 

 void  Update  () { 
        if  ((transform.position.x + radius)  > borderPosition || 
(transform.position.x - radius) < -borderPosition) { 

            speedX = -speedX; 

        } 

  

        if  ((transform.position.y + radius) > borderPosition || 
(transform.position.y - radius) < -borderPosition) 

        { 

            speedY = -speedY; 

        } 

  

        float  newX = transform.position.x + speedX; 
        float  newY = transform.position.y + speedY; 
  

        transform.position = new  Vector3(newX, newY, 0f); 
} 

 

Step 10: 

To add some spicy to the scene, replace the speed values by random numbers using the 
Random.Range function. 

void  Start  () { 
        speedX = Random.Range(-0.05f, 0.05f); 

        speedY = Random.Range(-0.05f, 0.05f); 

         … 

} 

 

Step 11: 

We will end this exercise by adding Balls to the scene when the left mouse button is pressed. 
For that we need to keep track of the player’s input and create a prefab of the Ball to 
instantiate it at runtime. 

First, drag and drop the Ball from your Hierarchy into the Prefabs folder. Then create an 
Empty Object in the Hierarchy and name it BallCreator. Create a C# script in the Scripts folder, 
call it CreateBall and attach it to the BallCreator object. Open that script. 

Step 12: 

In that new script, look for the player input and create a new Ball when the left mouse button 
is pressed. 

  

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 

265



 

public  class  CreateBall  : MonoBehaviour { 
  

public  GameObject ball; 
  

 // Update is called once per frame 

 void  Update  () { 
        if  (Input.GetMouseButtonDown(0)) { 
            Instantiate(ball); 

        } 

 } 

} 

 

Then drag and drop the Ball prefab into the inspector slot for the ball GameObject. When you 
press Play you will be able to create many Ball instances. We realized how useful are prefabs 
by allowing us to produce as much as clones of the original object as we want! 

  

Guided Brief: Coding the Animator 

We learn in an earlier lessons that the transitions between animation states had to be 
managed through code. The following exercise will focus on creating a third person character 
controlled by player input. 

Step 1: 

Open the AnimatingCharacter project in Programming 2 of the Course Material. And open the 
Scene_Exercise. Note that you have also the Scene_Solution if needed. 

Step 2: 

In Prefabs > Characters, find the xBot and drag it into the Scene. 

Step 3: 

In Animations > Animator Controllers > Characters, create an animator controller and name it 
xBotAnimatorController. In the inspector, add the Controller that you just created to xBot. 

Step 4: 

Open the Animator Window and drag the clips found in Animations > Animation Clips > 
Characters into it. You should have the Idle, Walk, Run and Jump animations. 

Step 5: 

Create transitions between Idle and Walking States and between Walking and Running 
States. 

Step 6: 

In the parameters list, add a float and call it Speed. 

Step 7: 

Set up the transition’s Conditions as the following: 

Idle → Walking: Speed Greater 0.1 

Walking → Idle: Speed Less 0.1 

Walking → Running: Speed Greater 2 

Running →  Walking: Speed Less 2 

Step 8: 

Now that the Animator is set up, it is time to code the C# script that will control the 
transitions. In Scripts > Game Scripts, create a C# script and call it XBotMovement. Add the 
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script as a component to the XBot and open it. 

Step 9: 

Declare an Animator variable and instantiate it in the Start function using the 
GetComponent<> function. Keep track of the horizontal input of the player (left and 
right arrows on the keyboard) and use that input to modulate the Speed parameter of the 
animator. 

public  class  XBotMovement  : MonoBehaviour { 
 public  float  speed = 3f; 

private  Animator animator; 
  

 // Use this for initialization 

 void  Start  () { 
        animator = GetComponent<Animator>(); 

 } 

  

 // Update is called once per frame 

 void  Update  () { 
        float  inputX = Input.GetAxis( "Horizontal" ); 
        animator.SetFloat( "Speed" , speed * inputX); 
 } 

} 

 

If you run the Game and press the right arrow key, you will see the character going from the 
Idle to the Run animation, but it stays in place. 

Step 10: 

We need to translate the body while running the animation in order for the character to move. 

void  Update  () { 
        float  inputX = Input.GetAxis( "Horizontal" ); 
        animator.SetFloat( "Speed" , speed * inputX); 
  

        transform.Translate( new  Vector3(0, 0, inputX / 10), Space.World); 
} 

 

The translation in z must be proportional to the inputX but we divide it by 10 in order to slow 
down the movement. This value can be adjusted to what feel right to you visually. 

Step 11: 

Note that the movement along the negative side of the z axis is not showing the right 
animations (the character is idling and going backward). This happens because the value of 
the speed becomes negative when the character is moving along that side of the axis, which 
is not considered in our previous code. To correct that, we will, first of all, take the absolute 
value of the inputX to modulate the Speed parameter of the animator controller and, second 
of all, we will flip the character’s body orientation according to its direction. 
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void  Update  () { 
float  inputX = Input.GetAxis( "Horizontal" ); 

  

if  (inputX > 0f && !movingForward) 
{ 

            Flip(); 

} 

else  if  (inputX < 0f && movingForward) 
{ 

            Flip(); 

} 

  

  

animator.SetFloat( "Speed" , speed * Mathf.Abs(inputX)); 
  

transform.Translate( new  Vector3(0, 0, inputX / 10), Space.World); 
} 

  

void  Flip() 
{ 

movingForward = !movingForward; 

Vector3 scale = transform.localScale; 

scale.z *= -1; 

transform.localScale = scale; 

} 
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Programming 3 / Instructor: Sam Bourgault 

Player Interaction and Movement II 
Develop the player interaction system using  
Unity Event System and Event Triggers. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1Z1naVKD5-qpCytbU6FxoqCG5f63krwbjZl1x
hjraYcg/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable with Unity. 
- Comfortable with programming in C# within Unity. 

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Course Material repository 
- Know the basics of Unity interface 
- Know the basics of programming (covered in the Programming 1 and 2 Lessons) 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Split screen with the slides for Live Coding parts. 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 
- Visual Studio 2017 

 
Objectives 

- Introduce how to use Unity’s Event System and Event Triggers. 
- Walk the students through creating a player interaction script that allows for 

movement to a point on a navmesh and movement to a location for an interactable 
object. 

  
Vocabulary 
Event System, Event Trigger, Navigation, Navmesh, Point and Click. 
  
References 
Software website: 

- https://docs.unity3d.com/Manual/EventSystem.html  
Software Tutorials: 

- https://unity3d.com/learn/tutorials/projects/adventure-game-tutorial  
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Point and Click Game 
A point and click games are often but not limited to adventure games in which the 
players use their mouse to move their character by pointing and clicking where they 
want it to go. This is the type of game that you will be encouraged to build during this 
workshop. This lesson will teach you how to create the character controls for a point and click 
game step by step. 

 

Navmesh 
The Navmesh system allows us to turn multiple mesh objects into a single recognizable area 
for Unity’s built in pathfinding system. We can find all of the Navmesh functionality in the 
navigation window (Window > Navigation in the menu bar). In this window, if we look under 
the Bake tab, we can see all of the information needed in order to set up an appropriate 
Navmesh system for our game: 

- Agent Radius: determines the amount of space each navmesh agent will take up 
horizontally. 

- Agent Height: determines the amount of space each navmesh agent will take up 
vertically. 

- Max slope: determines the highest slope a navmesh agent can handle before it 
determines the area as an obstacle. 

- Step Height: determines the highest vertical offset from the ground a navmesh agent 
can handle before it determines the area an obstacle 

Once these settings are set, we are a click away from having a functional Navmesh. By 
clicking “Bake”, it will bake all static gameObjects that fall under these established 
conditions into a navigation map - but only the static gameObjects. We will go over that in a 
minute. 

Step 1: 

Go to the Skins 6.0 - Course Material repository and create a local copy of the Unity project in 
Programming > Programming 3 - Player Interaction and Movement II. Open the 
Scene_Exercise scene. 

Step 2: 

Select the Environment object in the Hierarchy and check the static box at the top right of the 
inspector. A window will pop up, asking you to apply the change to all children, select Yes. 
We want to include every element of the environment in the Navigation mesh. 

Step 3: 

Open the Navigation window and, in the Bake tab, click on Bake. This will create your 
Navmesh. You will be able to see it, every blue part is a walkable zone for your Navmesh 
Agents and the rest is considered as obstacles. 

 

Navmesh Agent 
The Navmesh Agent is the AI counterpart to the Navmesh system. This component gives an 
object the pathfinding functionality that comes with the Navmesh system. Programming is 
required for the navmesh agent to function, however a lot of the data is visible for us to tweak 
inside the inspector although most of them should stay at their default values for our 
purposes. We mainly want to modify the Steering data: 

- Speed: controls the maximum speed the agent can move at 
- Angular Speed: controls how fast the agent can rotate on itself 
- Acceleration: controls how quickly the agent will reach its maximum speed 
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- Stopping Distance: the distance from the target destination the agent will stop 
at (generally want to keep at 0 for accurate movement) 

- Auto braking: forces the agent to stop at each destination point even if there 
are multiple. If checked off allows for fluid movement between target points 

Step 4: 

Take the Player from the Prefab folder and place it into your scene. 

Step 5: 
Add a Nav Mesh Agent component to the Player. Change the Stopping Distance to 0.5, the 
Angular Speed to 220 and uncheck the Auto Braking. For the rest, we will keep the default 
values for now, but we might have to tweak them later. We now have set up the two main 
elements in order to manipulate the AI of our point and click game.  

 
Event System  
Unity has an integrated event system that manages player input. It handles all of the low 
level programming needed in order to set up the necessary system that will recognize an 
event (or player input) and send a message to the appropriate objects. 

For the Event System to be active in your Game, you must add the Event System gameObject 
to your scene. In Create, go to UI and select Event System. This object has two components: 
the Event System script and the Input Module script. The input module handles all of the logic 
that recognizes the player input: keyboard, mouse, touch, or custom input. The majority of its 
functionality exists for interacting with UI however, there are a number of components that 
allow for interaction with the scene world and objects within. 

Note that the Input Module works in combination with different types of Raycasters, which 
must be attached to the camera to operate. Unity provides three Raycasters: 

- Graphic Raycaster - Used for UI elements 
- Physics 2D Raycaster - Used for 2D physics elements 
- Physics Raycaster - Used for 3D physics elements 

Step 6:  

In the Hierarchy Create button, go to UI and choose Event System. 

Step 7: 

Go to the Main Camera Inspector and add a Physics Raycaster component. Our scene is now 
reactive to Player inputs. We just need to associate these inputs to certain actions and 
reactions. 

Step 8: 

We need to begin programming the function that will handle the character reaction when the 
player click the navigable ground. First create a Script in the Scripts folder and name it 
PlayerMovement.  

Step 9: 

Add the following namespace at the top of your script: 

using UnityEngine.AI; 

using UnityEngine.EventSystems; 

 

The AI deals with the Navmesh functionality and the EventSystems with the player inputs. 

Step 10: 

We start the script by declaring two variables. 
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private NavMeshAgent agent; 

public Vector3 destinationPosition; 

We need a reference to the Navmesh Agent component in order to access its 
functionalities and the destinationPosition will allow us to define the next 
destination of the Agent. 

Step 11: 

Since the agent variable is private, we need to initialize it within the code. We do that in the 
Start() function. 

void  Start  () { 
 agent = GetComponent<NavMeshAgent>(); 

} 

Step 12: 

We now need the function that will be called every time the player clicks on a navigable 
surface. We will call it OnGroundClick().  

public  void  OnGroundClick() 
{ 

 Ray ray = Camera.main.ScreenPointToRay(Input.mousePosition); 

 RaycastHit hit; 

  

 if  (Physics.Raycast(ray, out  hit, 100)) 
 { 

 destinationPosition = hit.point; 

 agent.SetDestination(destinationPosition); 

 } 

} 

The ray catches the player input and the hit, where it fell in the scene space. We then set 
the destinationPosition to the point where the hit fell and set the agent destination to 
that value as well. 

 

Event Trigger 
The Event System also comes with a prebuilt component that allows us to add input 
functionality to an object directly in the editor. The Event Trigger component allows us to add 
as many reactions to events as we want, without ever needing to code it. As long as the 
object with the Event Trigger component has a collider attached to it then we can call any 
function from any object in the scene when the user interacts with the object in any way with 
the mouse. Keyboard inputs require a little bit of programming. 

By selecting what type of event we want the object to listen to, we can add an object 
reference to this event and select any public function attached to this object reference for the 
event to trigger. There is no limit to the number of functions we can call per event. The same 
goes for the number of event types allowed on an object, there is no limit. 

Step 13: 

One last step before having a first workable prototype. In the Environment object, locate the 
Floor children and add an Event Trigger component to it. Click on Add New Event Type and 
select Pointer Click. Click on the + icon and drag the Player object in the available slot. In the 
dropdown menu, choose the PlayerMovement script that we just created and select the 
OnGroundClick() function. That’s it! Now everytime you will click on the Floor object, the 
OnGroundClick() function of the Player will be triggered and will redirect the Navmesh Agent 
to a new destination. Note though that the agent is not animated yet. 
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Animating the Character 
Step 14: 

To animate the Character when moving, we first need to attach an Animator Controller to it. 
Link the Player Animator Controller to your Character.  

Step 15: 

A reference to the Animator Controller will be necessary in the code. Let’s add it as a private 
variable and initialize it in the Start function. 

... 

public  Animator animator; 
  

void  Start  () { 
 agent = GetComponent<NavMeshAgent>(); 

 animator = GetComponent<Animator>(); 

} 

Note that the Animator controller has one parameter the isWalking boolean to switch from the Idle 
animation to the Walking one. 

Step 16: 

It is now time to populate the Update() function. The Update() function will very rather the agent 
has reach or not its destination. If it hasn’t reached its destination, it will trigger the Walking 
animation and if it has, it will stop it and go back to the Idle animation. 

void  Update  () { 
 if  (agent.remainingDistance <= agent.stoppingDistance) 
 { 

 agent.isStopped = true ; 
 } 

 else  { 
 agent.isStopped = false ; 
 } 

 animator.SetBool( "isWalking" , !agent.isStopped); 
 } 

 

Here we verify if the remaining distance between the agent and its destination is less than its 
stopping distance, if so, we force the agent to stop, if not, we let it continue walking. Then we 
set the isWalking boolean of the animator to (the opposite value of) the isStopped variable of 
the agent. If you run the game now, you will see an animated character. 

 

Interaction with Objects 
Now that we can click on the environment to move to a point on the ground, we can start 
thinking about how to move to a specific interactable object and actually interact with it 

Step 1: 

For this, we need to create a new script that we can use for our Interactable objects. So let’s 
create a new C# script called InteractableObject. 

Step 2: 

Remove the template code. 
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Step 3: 

This script only really needs 2 things. 

- A reference to where the player should stand when interacting with the 
object. 

- A public function for the player script to call when the player should interact with the 
object.  

public Transform interactionLocation; 
 

public void Interact() 
{ 

Debug.Log(“Interact”); 

} 

 

We need the reference to a specific Transform in order for the player to use it as a target. The 
transform will indicate the position and rotation the player must have when interacting with 
the gameObject. Also since we want to see if the Interact function works, we throw a 
Debug.Log in there. We will work out the logic behind interactions later. 

  

Adding object interaction to the PlayerMovement script 
Step 1: 

We now need to go back to our PlayerMovement script and create a function similar to our 
OnGroundClick function but instead, that will work on the interactable objects. For this, we 
need to create a new member field to hold a reference of the currently selected interactable 
object. 

private InteractableObject currentInteractableObject; 

Step 2: 

Now that we have a reference to our interactable object, we need to create the function to 
control what happens when we click on an interactable object. Let’s call this function 
OnInteractableObjectClick(), however, unlike the OnGroundClick, we don’t want to pass it 
event data. We want to pass it a reference of the object we are clicking. 

public void  OnInteractableObjectClick(InteractableObject interactable) 
{ 

currentInteractableObject = interactable; 

destinationPosition = 

currentInteractableObject.interactionLocation.position; 

agent.SetDestination(destinationPosition); 

agent.isStopped = false; 
} 

 

The only key difference between this and the ground function is that when we select the 
interactable to move to (in other words once this function is called), we need to set the 
currentInteractableObject as the selected interactable Object. Then instead of moving to a 
point on the ground, we move to the designated point for the interactable Object. 

 

Setting up an Interactable Object 
Step 1: 

Choose one of the Cube from the Environment object’s children. Add the InteractableObject 
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as a component to that Cube. 

Step 2: 

Create an empty gameObject as a child of this Cube. Position this empty object where 
you want the player to be when it interacts with the object. You should also set the 
rotation of it as well. The blue Z axis is the player’s front. 

Step 3: 

Drag the empty object into the interactable Object’s interactable location slot. 

Step 4: 

Make sure the interactable Object has a collider and add the Event Trigger component.  

Step 5: 

Add a new pointer click event and set the player as the gameObject reference. 

Step 6: 

Select the PlayerInteraction script from the dropdown menu and select the 
OnInteractableObjectClick() function. You will notice that a new reference slot has 
appeared and it’s empty. We need to fill it with the Interactable object’s script. To do this, 
simply drag the component from the inspector into the event trigger’s empty slot. We are now 
ready to test. 

 

Facing the object location’s direction and triggering the interaction 
Step 1: 

You will notice that the player moves to the right position but doesn’t face the direction we 
want. This is another bit of logic that the navmesh agent does not do by default. This means 
that we need to take into account on which kind of element the user has clicked. So we will 
use the  currentInteractableObject variable to make the distinction and change the 
Update()  function this way: 

void  Update  () { 
 if  (agent.remainingDistance <= agent.stoppingDistance) 
 { 

 if  (currentInteractableObject != null ) 
 { 

Quaternion destinationRotation = 

Quaternion.LookRotation(agent.desiredVelocity); 

  

transform.rotation = 

Quaternion.Lerp(transform.rotation, 

destinationRotation, turnSmoothing * Time.deltaTime); 

  

agent.isStopped = true ;  

 } 

 else 

 { 

 agent.isStopped = true ; 
 } 

 } 

    else 
 { 

 agent.isStopped = false ; 
  

 } 
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 animator.SetBool( "isWalking" , !agent.isStopped); 
} 

 

Note that we are first equalizing the destinationRotation to the agent desired 
velocity orientation and, second, we are lerping the agent rotation between its own and this 
desired value. Note that we are using a turnSmoothing parameter to adjust the turning 
reaction of the agent. This variable is defined before the Start() function.  

At last, we need to manually remove the reference to the selected interactable object when 
we click on the ground. Ideally right below casting the data to a RaycastHit. 

currentInteractableObject = null; 

Step 2: 

Our movement is now complete. However, we need to be able to trigger the interactable 
Object’s interaction when the player reaches the object. We do this by adding one last bit of 
conditional logic within the Update function right after checking to see if we have a selected 
interactable Object 

if  (currentInteractableObject != null ) 
{ 

Quaternion destinationRotation = 

Quaternion.LookRotation(agent.desiredVelocity); 

  

transform.rotation = Quaternion.Lerp(transform.rotation, 

destinationRotation, turnSmoothing * Time.deltaTime); 

  

agent.isStopped = true ; 
  

if  (Quaternion.Angle(transform.rotation, destinationRotation) < 
10f) { 

currentInteractableObject.Interact(); 

currentInteractableObject = null ; 
} 

} 

If the angular difference between the character’s current rotation to the 
destinationRotation is less than 10 degrees, we can say that the agent has arrived to its 
final location and rotation. This ensures us that the movement is completed so we can then 
trigger the interaction and reset the currentInteractableObject to null. You should see 
the word “Interact” printed in the console. 
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Programming 4 / Instructor: Sam Bourgault 

Managers and Persistent Data  
(Singleton and Game Structure) 
Introduce the use of managers in a game and the concept  
of data persistence throughout the scenes. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 1:30PM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1krkSQ5FK4o7Kb4KCgaXHDY-anTtMzrNS33
6Oo7QMrlw/edit?usp=sharing  

 
Instructor Prerequisites 

- Comfortable with Unity. 
- Comfortable with programming in C# within Unity. 
- Knowledge on Singleton. 

 
Participant Prerequisites 

- Access to a Unity account (educational license) 
- Access to Skins 6.0 Course Material repository 
- Know the basics of Unity interface 
- Know the basics of programming (covered in the Programming 1, 2 and 3 Lessons) 

 
Equipment/Software Materials 

- A presentation screen on which to show PowerPoint and Unity 
- Split screen with the slides for Live Coding parts. 
- Black or white board with pens or chalk available 
- Individual computers for each student with the following software installed: 

- Plastic Gluon 
- Unity 2018 
- Visual Studio 2017 

 
Objectives 

- Introduce Singletons 
- Introduce various handlers/managers to handle most of the game functionality 
- Introduce the concept of data persistence and what happens upon scene load/unload 
- Introduce the DontDestroyOnLoad function 

 
Vocabulary 
Singleton, Handlers/Managers, Coroutines, Data Persistence. 
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References 
Software website: 

- https://docs.microsoft.com/en-us/dotnet/csharp/language-reference/ 
keywords/static  

- https://docs.unity3d.com/Manual/Coroutines.html   
 
Software Tutorials: 

- https://unity3d.com/learn/tutorials/projects/2d-roguelike-tutorial/writing-game-manag
er 

 
 

 
Importance of Managers in Game 
Managers are important in games as they help controlling all functionalities related to a 
specific purpose and maintaining continuity between scenes. Like managers of a store, they 
delegate tasks to other components and ensure the good communication between each part. 

There are multiple possible managers in a game: Game Manager, Scene Manager, Audio 
Manager, UI Manager, etc.; all of them being responsible of a specific game component. 
Unfortunately, there is not one good way to decide how many managers you will need and 
how you will use them. It depends of the game size and your own way to organize your 
project. This lesson aims to give you an overview of general rules used in programming useful 
and persistent managers. 

First of all, there must be only one instance of a manager in a game. To make sure of that, we 
will use a programming pattern called Singleton. 

 

Static Modifier 
Before we go into detail about managers, we need to explore the concept of making an 
element static. The static modifier is used to make an element belong to a class as a whole 
instead of belonging to a single instance of that class. 

 public class Objective 

 { 

 public float progressValue = 10; 

 public float missionProgress = 0; 

  

 private float objectiveMet = false; 

  

 private void ObjectiveComplete() 

 { 

 if(player contact  && objectiveMet == false) 

 { 

 missionProgress += progressValue; 

 objectiveMet = true; 

 } 

 } 

 } 

  

 public class MissionStatus 

 { 

 public Objective missionObjective; 

 private void CompleteMission() 

 { 

 if(missionObjective.missionProgress >= 100) 

 { 

 //move to next mission 

 } 
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 } 

 } 

 

If we look at a normal member field - let’s say a float called missionProgress inside 
a class called Objective, we could have multiple instances of the class Objective and 
each would have their own distinct version of missionProgress. Let’s say when the player 
comes into contact with the object Objective the missionProgress would increase. If each 
instance has their own version of missionProgress then coming into contact with the 
Objective would only increase each local version of missionProgress and none of them 
would ever get to 100. 

public class Objective 

{ 

public float progressValue = 10; 

public static float missionProgress = 0; 

  

private bool objectiveMet = false; 

  

private void ObjectiveComplete() 

{ 

if(player contact  && objectiveMet == false) 

{ 

missionProgress += progressValue; 

objectiveMet = true; 

} 

} 

} 

  

public class MissionStatus 

{ 

public void CompleteMission() 

{ 

if(Objective.missionProgress >= 100) 

{ 

//move to next mission 

} 

} 

} 

 

However, if we made the float static, then it is no longer dependent on the instance but 
becomes an element of the class as a whole. In this situation, as soon as the player comes 
into contact with the Objective, the missionProgress will increase. But since it is no longer 
tied to each instance, once the player comes into contact with a second Objective, the 
missionProgress will increase further, making it possible for the missionProgress to 
reach 100. This also makes the element visible to all classes without needing an instance of 
the object itself (as long as it is public). Although this now works, this isn’t a very well 
designed system. 

 

Data Persistence 
In Unity, by default, no data is set to be preserved between scenes. What this means is that 
once a scene is unloaded, all of the data that was modified from its starting state (as set in 
editor) will be lost. In other words Unity does not handle persistent data by default. So we 
need to come up with our own system for that. Let's take a look at what happens when Unity 
changes scene: 

Let's say we start the game in scene Mission 01. We have one object with 2 variables: int 
playerScore and float playTime. Once we complete the mission those values have changed. 
Let’s say we accumulated 52 points in 352.25 seconds. Now we want to go to the next 
mission in order to continue increasing our score and time however, once we unload the first 
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scene, these values are erased and (assuming we have a GameHandler in the second 
scene) those variables are back to their starting values (as set in the editor). 

This demonstrates that in order to have persistent data, we need to store relevant 
data in objects that are independent of the scenes. 

 

Maintaining Persistent Data 
There are a number of ways we can do that: 

We can set an object to not destroy on load through code using the function 
DontDestroyOnLoad(gameobject). By doing that, the entire gameObject will be preserved 
throughout the scenes and we can maintain data persistence within this item. 

This is useful when we want to save an entire object’s state and information such as the UI 
and its handler, or the AudioHandler so we can have sound play between scene however, this 
isn’t a solution for all objects. Some objects should exist only within their designated scenes 
such as interactableObjects, but we may want to be able to come back to a scene and have 
the interactableObject’s previous data restored. 

 
Game Handler 
The Game Handler controls all game events and game progression. If the game progression 
isn’t complex, than this handler isn’t always necessary. For our purpose, we only need this to 
handle the game events since the game progression will be fairly simple. 

Note that a Game Handler normally takes care of, but is not restricted to: 

- Initialization of the game: spawn the gameObjects and set the camera target. 
- Manage the different game states 
- Load new scenes 
- Control other managers 

 

Basic Structure of Game Handler 
First thing to do is to create an empty object that will hold our GameHandler script. The script 
will exhibit the following structure: 

1. A private and static instance of the GameManager itself. 
2. A verification of the preexistence of the GameManager in the Awake function that 

keeps or destroys the new instance according to the result. 
3. A persistency using the DontDestroyOnLoad function. 
4. Specific functions according to the type of manager. 

The following example shows this basic structure. 

public  class  GameManager  : MonoBehaviour  { 
  

// static instance of the GameManager 

public  static  GameManager  instance = null ; 
  

//example of variable stored in the GameManager 

public  int  score; 
public  bool  isDead; 

  

private  void  Awake () 
{ 

 // check if a GameManager instance already exists 

 if  (instance == null ) { 
      // if it doesn't, define the new instance as the main GameManager 
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 instance = this ; 
 } else  if  (instance != this ) { 
 // if it does, destroy the new instance 

 Destroy(gameObject); 

 } 

  

 // make sure to preserve the manager when a new scene is loaded 

 DontDestroyOnLoad(gameObject); 

} 

} 

 

Note that in your other scripts, you can call the variables stored in the GameManager by using 
the instance like shown in the associated image from the slide. 

 

Scene Handler 
The Scene Handler controls all scene related functionalities. It generally holds references to 
any scene specific objects that could be in every scene such as: 

- Player starting position 
- Intro/outro scenes 
- Ambient sound for the scene 
- Background music for the scene 

According to the size of the game the functionalities of the Scene Handler can be executed by 
the Game Manager. Note that to load new scenes you need the namespace “using 
UnityEngine.SceneManagement;” at the beginning of your script. 

Key functions generally found in this class are: 

- SetupScene(): simply sets up the scene on start 
- LoadScene(string sceneName, float delay): loads a desired scene 

 

UI Handler 
The UI Handler controls all user interface related functionalities. It holds a reference to all UI 
elements and groups. Key functions generally found in this class are: 

- DisplayUI(bool shouldDisplay): either shows or hides the UI based on the boolean 
based in the parameters  

- ScreenFade(int targetAlpha, float fadeSpeed): fades in or out the screen towards the 
targetAlpha value (1 fades to black, 0 fades back to scene) 

Note that to use UI related components and functions in your script, you need the namespace 
“using UnityEngine.UI;”. 

 

Audio Handler 
Key public functions generally found in this class are: 

- PlaySoundEffect(AudioClip clip): plays a specific audio clip 
- FadeAudioSource(AudioSource audioToFade, float targetVolume, float fadeSeed): 

fades the audio in or out towards the target volume 
- PlayBackgroundMusic(AudioClip clip): plays the background music. 

 

Coroutines 
Often, we will want to perform some tasks but wait until a condition is met in order to 
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complete the said task. This is where coroutines come in handy. Coroutines allow for a 
function to pause mid execution. Once the function is paused, the control returns to 
Unity and the rest of the functions and classes perform their tasks for that frame. 
Once the next frame rolls around, the paused function will resume where it left off if 
the conditions have been met. Coroutines are considered a special type of function. In 
order to turn a function into a coroutine, we need 2 things: 

- Mark its data type as IEnumerator 
- Call yield at least once inside the function 

IEnumerator is the return data type of a Coroutine function. It is nothing to be scared of even 
though it looks quite bad as a return type.  

Yield acts as a keyword that triggers the pausing of the function. Once the function reaches 
the yield, the function will pause and only resume once the yield condition is met. This would 
be the general syntax for a coroutine function: 

public IEnumerator CoroutineName(int delay) 

{ 

        //do something 

        yield return new WaitForSeconds(delay); 

        //do something else 

} 

 

This example will perform certain tasks, but once it reaches the yield line, it will pause and try 
to resume at every subsequent frame. Only once the condition set next to it, in other words 
once the number of seconds determined by delay has passed, will the function resume at the 
following line. This is extremely important when creating functionality that has a time element 
to it. 

Another example of a use-case for coroutines would be when we want to wait for a coroutine 
to finish before continuing the tasks within a function. Let’s look at this example: 

public IEnumerator SceneLoad() 

{ 

      yield return StartCoroutine(FadeScreen()); 

  

//load the next scene 

} 

  

private IEnumerator FadeScreen() 

{ 

        while(fader alpha is not 1) 
        { 

              //gradually fade the screen 

              yield return null; 

        } 

} 

 

In this example, we have a coroutine SceneLoad that starts the coroutine FadeScreen and 
waits until it is finished before loading the next scene. In the FadeScreen coroutine, yield 
return null simply waits until the next frame before continuing. This is especially useful 
when you want to gradually perform a certain task (like fading the screen in this case). We 
can loop through the task and when we get to the end of the loop it will pause until the next 
frame, check if we should continue the loop and if so repeat the process until we no longer 
need to be in the loop. Once we break out of the loop, since there are no other tasks in the 
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coroutine, it will be concluded and the SceneLoad coroutine can resume. 

 
Creating and Using a UI Handler 
Step 1: 

In the Course Material repository, open the ManagerPersistentData project in the 
Programming 4 folder. Go to Scene_Exercise. 

Step 2: 

Create a Canvas and add an Image as a Children. Add a Button Component to that Image 
and name it Inventory Button. Move the Inventory Button to -400 along the x axis. 

Step 3: 

Add a new image asd a Children of the Canvas, remove the image Component and add an 
Horizontal Layout Group Component. Name this new UI object Inventory Slots. Move it to 
-250 along the x axis. Make the spacing of the Horizontal Layout Group 50 pixels. 

Step 4: 

Create three other images as Children of the Inventory Slots and name them Slot1 to 3. Make 
them 70 by 70 pixels. 

Step 5: 

Add another Image as a Children of the main Canvas and name it Fader. Make sure the 
Image Color is Black and its size 1920 by 1080 (or larger if your screen is bigger). Add a 
Canvas Group Component to the Fader. And uncheck Block Raycasts. Note: It is normal (and 
desired) that the Fader is now hiding everything else in the screen. 

Step 6: 

Create a new C# script called UIHandler, remove the template code and add the 
UnityEngine.UI namespace. 

Step 7: 

Create a member field for the various UI elements and groups we want to manipulate  

 public GameObject canvas; 

 public GameObject inventorySlots; 

 public CanvasGroup fader;  

 

These will allow us to show/hide all of their children at once.  

Step 8: 

Turn this class into a singleton by creating a static instance property and setting the singleton 
logic in the Awake function.  

// static instance of the UIHandler 

public static UIHandler instance = null; 

  

// variable stored in the UIHandler 

public GameObject canvas; 

public GameObject inventorySlots; 

public CanvasGroup fader; 

  

private void Awake() 

{ 

 // check if a UIHandler instance already exists 
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 if (instance == null) { 

      // if it doesn't, define the new instance as the UIHandler 

 instance = this; 

 } else if (instance != this) { 

 // if it does, destroy the new instance 

 Destroy(gameObject); 

 } 

  

 // make sure to preserve the manager when a new scene is loaded 

 DontDestroyOnLoad(gameObject); 

} 

 

Step 9: 

Create a function to toggle the UI display on or off based on a boolean parameter passed to 
the function  

 public void ToggleUIDisplay(bool shouldDisplay) 

 { 

 canvas.SetActive(shouldDisplay); 

 }  

 

Step 10: 

Create a function to toggle the Inventory slots on and off based off of its current state  

 public void ToggleInventorySlots() 

 { 

 inventorySlots.SetActive(!inventorySlots.activeSelf); 

 } 

 

This line of code will set the active state of the game object to the exact opposite of its current 
state.  

Step 11: 

We now need to create a function that will control the scene fader. In order to do that, we 
need to make this a coroutine function. If ever you aren’t sure whether you should make a 
function a coroutine or not ask yourself if it has timing to it. In other words, if you need 
something to progressively perform a task as in fade something in or out or if you need 
something to wait before continuing then you probably need it to be a coroutine. Let’s first 
create the underlying logic of a scene fade. 

public IEnumerator SceneFade(float targetAlpha) 

{ 

 while (!Mathf.Approximately(fader.alpha, targetAlpha)) 

      { 

fader.alpha = Mathf.MoveTowards(fader.alpha, targetAlpha, 

Time.deltaTime); 

  

 yield return null; 

      } 

} 

 

Here, we create a while loop that will constantly iterate until the condition is no longer met. In 
this case, we are checking if the fader’s alpha value is approximately equal to the 
targetAlpha we have set as a parameter. The targetAlpha should normally be either 1 or 
0, 0 being a fade in and 1 being a fade out. 
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Inside the loop, we are moving the fader’s alpha value towards the target alpha at a 
rate of Time.deltaTime. Time.deltaTime is used to get the time between frames. 
Since our game runs at around 60fps, we don’t want the alpha to take only 3 frames 
to reach the target. This allows the alpha value to move towards the target alpha at a 
speed relative to the frame rate. 

Lastly, we pause the coroutine after the alpha value has been modified. In this case, we only 
pause it for one frame. Using yield return null causes the function to pause for the 
remainder of this frame but resume on the next frame. 

The logic behind this function is that as long as the fader’s alpha has not reached the target 
value, it will continue to move towards it gradually every frame. 

 

Testing the UIHandler 
Step 1: 

Now that we have a basic UIHandler, we need some way to test it. Let’s create a new 
UITester C# script for that. 

Step 2: 

Let’s test our scene fader first. We need to call the SceneFade coroutine on Start so it fades 
in as soon as the game starts. 

 void Start() 

 { 

 StartCoroutine(UIHandler.instance.SceneFade(0)); 

 } 

 

Let’s test it out but first, we need to attach our 2 new scripts to objects in the scene. First, we 
need to create a new empty gameObject and attach the UIHandler to it. This will be our 
UIHandler object. Next let’s just throw the UITester on the UIHandler as well for simplicity’s 
sake. Populate the UIHandler. 

Step 3: 

We now need to create a way to see if our UI toggle works. In the update, let’s look for player 
input and set it so U toggles the UI off and I toggles it on. 

 void Update() 

 { 

 if (Input.GetKeyDown(KeyCode.U)) 

 { 

  UIHandler.instance.ToggleUIDisplay(false); 

 } 

  

 if (Input.GetKeyDown(KeyCode.I)) 

 { 

  UIHandler.instance.ToggleUIDisplay(true); 

 } 

 } 
Step 4: 

Now, we need to test the inventory slots toggle, but we don’t need to create anymore code for 
it. Select the Inventory Button object and add a function in the OnClick event. Drop the 
UIHandler in the slot and select the toggleInventorySlots function. 
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Cinematics 1 / Instructor: Ray Caplin 

Intro to After Effects 
Learn the fundamentals to an essential multipurpose composting tool. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 9:15AM — 1HR 30M 
 
Instructor Prerequisites 
Instructor should have experience working with After Effects and understand its capabilities 
and workflow. 
 
Participant Prerequisites 
Students must have Adobe After Effects CC. 
 
Equipment/Software Materials 
A screen to show the PowerPoint Presentation 
Computers for students with Plastic SCM and After Effects installed. 
 
Objectives 
Introduction to the interface, capabilities, and general workflow of After Effects, including 
navigation, effects, layers, and rendering. Understand the purpose and creation of cutscenes. 
  
Vocabulary 
Composition, Layers, Timeline, Preview, Effects, Workspace, Cutscene 
  
References 
What is After Effects? 

- https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html   
- https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html  

 
Cut scenes 

- https://www.youtube.com/watch?v=sGXIR2dlktc  
- https://www.youtube.com/watch?v=r9ExIKYZd6o  

 
Customizing your workspace 

- https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html  
 
Composition basics: 

- https://helpx.adobe.com/after-effects/using/composition-basics.html  
 
Timeline: 

- https://helpx.adobe.com/after-effects/atv/cs6-tutorials/the-timeline.html  
 
Layers: 

- https://helpx.adobe.com/after-effects/using/selecting-arranging-layers.html  
 
 
 
Software Tutorials: 
Simple Animation tools 

- https://youtu.be/XLPchE7DPQE 
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What is After Effects and what will we use it for? 
 

Adobe After Effects is a digital visual effects, motion graphics, and compositing 
application developed by Adobe Systems and used in the post-production process 
of filmmaking and television production. Among other things, After Effects can be used for 
keying, tracking, compositing and animation. It also functions as a very basic non-linear 
editor, audio editor and media transcoder. -Wikipedia 
 
“CC” stands for Creative Cloud, the Adobe platform that gives users access to a collection 
of Adobe software.  
https://en.wikipedia.org/wiki/Adobe_After_Effects  

 
For this workshop, we will use After Effects as a tool to build Cutscenes for the game we are 
working on. With After Effects, we will be able to bring renders made in Unity and images 
from the web, our cameras, and Photoshop work to make videos to play inside of the game.  
 
Quick video showcasing After Effects: 
https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html (2min08) 
 

 

About Cutscenes 
Cutscenes are starting to have quite a reputation in the game industry. There are many 
opinions and research recorded about what is a good or bad cutscene, what effect it has on 
gameplay and why you’d want to take control away from the audience, etc. Because this has 
already been talked about in the Game Design lessons, we won’t get into it too much, but 
here are a few things you might want to consider: 
 

- Use the cutscenes for things that we wouldn’t be able to see in-game 
- Use the cutscenes to contextualize what is happening 
- For this workshop, as much as possible, limit the cutscenes to intro and end 

sequences 
 
 
Some interesting videos on the topic of cutscenes: 
Extra Credits: Cutscenes - A Powerful (and Misused) Narrative Design Tool (2012)  
https://www.youtube.com/watch?v=sGXIR2dlktc  (8min27) 
 
Extra Credits: A Case for Cutscenes - Everything Old is New Again (2017) 
https://www.youtube.com/watch?v=r9ExIKYZd6o  (7min) 

 
 

 
Interface and Workspaces 
Once you first open up After Effects CC 2017, you will see a welcome window. You can use 
this to open a an existing project, or start a new one. For now, let’s just close that page to get 
a blank project.  
 
You should now be able to see the Essentials interface. A bit like with Blender or Photoshop, 
this interface can be customized to your needs as you are working - an easy way to do so is 
with the default Workspaces. They can be accessed at the top right of the interface. If you 
wanted to customize your workspace and save it for later, you can also do so here.  
 
The default workspace is Essentials, which really is as much as we’ll need for the moment.  
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A bit like the Blender and Photoshop interface which can be customized at will, After 
Effects’ interface is made out of different panels that can be moved around, combined, 
and separated. For now, let’s keep it as is.  
 
Note: When a project is opened, the application remembers the arrangement of the interface 
from the last time it was used and saved.  
 

 
 

 

 
Project Panel  

On this interface, on the Left, you’ll see the Project panel. It serves as a library to hold the 
many compositions included in a project, its imported files (even if they are not actively used 
in the project) and any other item, such as solid colours or text. You can create folders within it 
to hold different types of items, and organize it any way you like.  
 
Add items to this list by right-clicking, choosing Import > File..., and selecting the file you 
want to add.  
You can create Folders by clicking the little folder icon at the bottom of the panel.  
You can also create new Compositions by clicking the icon to the right of the folder icon, 
which looks like a film strip with shapes on it.  
 
The items that are imported in this panel are only links to the files in the computer - this 
means that if the file is deleted or moved to another folder, you will have to relink it by 
right-clicking and finding the file in your Navigator. 
 
You can preview files that are in the project panel by double-clicking them.  
 
 

About imported files and footage items  
https://helpx.adobe.com/after-effects/using/importing-interpreting-footage-items.html  
 
Importing 3D images from Photoshop and Illustrator  
https://helpx.adobe.com/after-effects/using/preparing-importing-3d-image-files.html  
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Video Preview / Composition 
The box in the middle is your Composition, which is the preview of your video as you 
are working on it. It also serves as a workspace; most of the items within it can be 
selected and modified directly through this panel, let’s say to move them around.  
 
Compositions, like files, are found in the Project panel.   
 
Once a file is open in the preview window, you can Zoom in with the Mouse Wheel, and use 
Spacebar + Left Click to pan around the space.  
 

What is a composition?  
To work on files in After Effects you need to place them in a composition, often referred to 
simply as a “comp”. A composition is a container that stores layers of video, audio, text, etc. 
Compositions are essentially independent timelines, so you can think of each composition 
as being a separate movie project.  
 
You can have multiple compositions in the same project. Compositions are listed with other 
assets in the project panel.  
You can also create nested compositions, i.e. one comp inside another. 
 
http://www.mediacollege.com/adobe/after-effects/workflow/composition/  

 
 

 
Layers / Timeline 

At the bottom is the Layers or Timeline panel, which is where you can find the items that 
appear in the active composition itself. It’s similar to the layers on Photoshop, except it holds 
images, effects, 3D cameras, lights, titles, audio files… or any other item that could show up in 
the final film.  
This is where you edit the length of video clips, images, or anything else that affects them.  
 
The Timeline panel can have multiple tabs, for different compositions you’d be working on at 
the same time. For example, you could have one composition inside another (nested), and 
have the two of them open as different tabs on the Timeline to be able to go back-and-forth 
from one to the other.  
 
To add items to the Timeline, and therefore to the current composition, simply drag-and-drop 
some files from the Project panel to the Timeline. This will add the item as a new layer in the 
composition, represented by coloured rectangles of fixed durations, colour-coded according to 
the kind of file you added.  
 
 
You can Rename a layer by Right-Clicking it and choosing Rename.  
Like with Photoshop layers, the order of items in the timeline matter:  the layers that are 
placed on top will appear on top in the Video Preview. Click-and-drag the layer to move it 
on top of or under another layer.  
 
You can preview files that are in the layers / timeline panel by double-clicking them.  
You can Play and Stop a video by pressing the Spacebar.  
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Effects and Presets 
On the right, there is a panel called Effects & Presets that is open by default, 
surrounded by other panels such as Audio, Libraries, Character and Paragraph. This 
panel is a quick access menu to all sorts of options to add to your composition.  
 
To Add Effects to a layer, drag-and-drop it onto it.   
 
 

For example... 
- Putting things in Black and White (Color Correction > Black & White effect) 
- Making Rain Effects (Simulation > CC Rainfall effect) 
- Making Objects Glow/Sparkle (Stylize > Glow effect) 
- Adding Shadows (Perspective> Drop Shadow, Radial Shadow) 

 
 

 
Adding new panels 
If you closed one of the panels and want to add it back, or if you want to add one that is not 
part of your current workspace, you can do so  in the Window menu at the top of the page. 
You can then dock it wherever you like in the interface.  
 
On customizing the workspace and panels: 
https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html  
 

 

 
Composition Settings 
When creating a new Composition, many settings will be asked of you to be filled out.  
 
The normal preset should be fine for now: “HDTV 1080 29.97” 
 
HDTV 1080 refers to the High Definition Television standard with the 1920x1080 pixels size, 
a format which has an aspect ratio of 16:9 (the ratio of the width to the height of an image or 
screen.)  
29.97 refers to the frames per second, currently set to the standard for television and film 
recording.  
 
You can change all of these individual aspects if you like, for example if you’d like the 
composition to be at 24 frames per second to match your Blender animation.  
 
Underneath all this, you will see the Duration as 0;00;30;00. 
That is, Hours;Minutes;Seconds;Frames.  
This means that the current composition is of 30 seconds.  
 
You can change most of those composition settings afterwards, if there was an error. You can 
also copy data from one composition to another if need be.  
 
You can preview your composition by double-clicking it in the Project panel.  
 

About Drop-Frame vs Non-Drop Frame timecodes 
“There are two types of 30 fps timecode for use with NTSC video: non-drop frame and drop 
frame. Non-drop frame timecode is simple: for every frame of video, there is a 
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corresponding timecode number. The timecode increments without any 
compensation. In almost all cases, timecode is non-drop frame. In fact, drop frame 
timecode only matters in the case of NTSC video. 
 
Drop frame timecode compensates for the fact that the NTSC format has a frame rate of 
29.97 fps, which is .03 fps slower than the nearest whole number frame rate of 30 fps. 
Timecode can only be represented by whole numbers, so timecode numbers are 
periodically skipped in drop frame timecode. This way, the timecode number always 
matches the seconds and minutes of video that have played. NTSC can use either drop 
frame or non-drop frame timecode.” 
 
https://documentation.apple.com/en/finalcutpro/usermanual/index.html#chapter=D%26section=6%26tasks=true  
 
What is NTSC and Pal? 
NTSC is the video system or standard used in North America and most of South America. In 
NTSC, 30 frames are transmitted each second. Each frame is made up of 525 individual 
scan lines. 
 
PAL is the predominant video system or standard mostly used overseas. In PAL, 25 frames 
are transmitted each second. Each frame is made up of 625 individual scan lines. 
 
http://ihffilm.com/videostandard.html  

 
 
About composition basics 
https://helpx.adobe.com/after-effects/using/composition-basics.html  
About precomposing, nesting and pre-rendering 
https://helpx.adobe.com/after-effects/using/precomposing-nesting-pre-rendering.html  
 

 

 
 
Navigating After Effects 
You can Play and Stop a video by pressing the Spacebar.  
After Effects often has to pre-render video in order to show it properly; until then, playback 
will not be entirely smooth. You can tell which sections of the timeline have been pre-rendered 
thanks to a green bar that appears at its top.  
 
Use the Blue Playhead in the Timeline window to scrub through the composition you are 
working on, and stop at a specific frame.  
Zoom in and out of the composition with Alt + Mouse Wheel.  
 
Click and Drag a clip to the place you’d like it to be on the Timeline.  
Shorten or Lengthen a clip by Clicking and Dragging it from its left and right edges; image 
files can be stretched and shortened to the length that you want, but video clips are limited by 
their original duration.  
 
Directly from the Video Preview panel, select clips and objects if you want to transform them. 
With the tools at the top panel, you can scale or rotate the clips, for example.  
Each layer in the Timeline has a little arrow to its left that lets you look at its tools, effects and 
settings. You can also manipulate their size and rotation there, amongst other things. This is 
also where you will find the waveform of audio files, and the keyframes for any animated 
properties on a layer.  
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You can also find some icons there to: 
- Hide/Show layers; 
- Mute Audio layers 
- Show a layer in solo 
- Lock a layer so it can’t be modified  

 

 

 

 
 
About the Timeline 
https://helpx.adobe.com/after-effects/atv/cs6-tutorials/the-timeline.html  
Selecting and arranging layers  
https://helpx.adobe.com/after-effects/using/selecting-arranging-layers.html  

 

 
Effects 
If you wanted to add an effect to a layer, simply drag-and-drop it from the Effects menu on 
the right onto your layer. In the layer’s settings, which can be accessed with the little arrow on 
the left of the layer, you’ll be able to change all of the parameters of the effect as they are 
appearing on your layer.  
 
You can activate and deactivate an effect with the fx icon to the left of the layer.  
To delete an effect, select the effect itself under the layer and hit Delete on the keyboard.  
 
As a separate tab in the Project panel, you should find Effects Controls, which helps 
fine-tuning the effects.  
 
 

Ask the students what kind of effects they would like to explore for their cutscenes in order 
to find and prepare them for lesson 3. By this point, they should have a good idea of what 
kind of cutscenes they’d like to include in the game, and these lessons can be adapted 
towards that.  
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Beginner tutorial for AE CC 2017:  
https://www.youtube.com/watch?v=F1ezwdhbYnc  
 
 
Credits for Intro Test File 
AE Intro Template by Official Designs 
https://www.youtube.com/watch?v=OnWJrkUU76k  
http://bit.ly/OffTMDesigns  
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Cinematics 2 / Instructor: Ray Caplin 

After Effects Animation Tools 
Learn motion graphics, keyframing, and Puppet animation tools. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 11:00AM — 1HR 30M 
 
Instructor Prerequisites 
The instructor should have some experience working with the animation tools in Blender as 
well as a general understanding of animation techniques. 
 
Participant Prerequisites 
Students should have basic knowledge with After Effects and an introduction to animation 
principles. 
 
Equipment/Software Materials 
Screen to show presentation slides 
Computers for students with Plastic SCM and After Effects installed 
 
Objectives 
Introduce methods and techniques for animating characters in After Effects. 
Discussing some of the basic animation tools in After effects, such as Transforming objects, 
and The puppet tool. 
  
Vocabulary 
Keyframe, puppet tool, pin, walk cycle 
  
References 
Simple 2D animation: 

- https://www.youtube.com/watch?v=X3i3MtdmoEI  
- https://www.youtube.com/watch?v=RnAPxkS64HE  

 
Animate a logo 

- https://helpx.adobe.com/premiere-pro/how-to/logo-animation.html?playlist=/ccx/v1/co
llection/product/after-effects/segment/designer/explevel/beginner/applaunch/orientati
on/collection.ccx.js  

 
Animate a logo - assets 

- https://assets.adobe.com/link/5d423e12-f5d1-4ebc-64d2-94b90c488d48?section=ac
tivity_public  

 
Basics of animation 

- https://helpx.adobe.com/after-effects/how-to/aftereffects-understanding-animation-c
c.html?playlist=/ccx/v1/collection/product/after-effects/segment/designer/explevel/beg
inner/applaunch/orientation/collection.ccx.js  

 
Puppet Tool / Bones 

- https://helpx.adobe.com/after-effects/using/animating-puppet-tools.html  
- https://helpx.adobe.com/adobe-character-animator/using/puppet.html  
- https://helpx.adobe.com/adobe-character-animator/using/editing-puppet-structure.ht

ml  
- https://helpx.adobe.com/animate/using/bone-tool-animation.html 
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Walk Cycle in AE 
- https://www.schoolofmotion.com/training/walk-cycle-after-effects   

 
 
Cut out in Photoshop - Advanced tutorial 

- https://www.schoolofmotion.com/training/viewer/how-to-cut-out-images-in-photosh
op  

 
 

 
On the transform or effect options underneath a layer, you will see a stop-watch icon. This 
icon serves to indicate that you will animate that property; additionally, it will automatically 
place keyframes as you change the properties of the different parameters.  
Note that if you disable the stopwatch, it will disable all of the animation on this property, and 
delete all of the keyframes that were placed on it.  
 

Manually adding keyframes 
In addition, you can add extra keyframes by hand by pressing the little diamond button on the 
left-hand side. The arrows to the left and right of it serve to move the cursor (blue playhead) 
to the position of the previous and next keyframes, respectively. This helps to change the 
values of existing keyframes.  
 

Deleting keyframes 
There are two ways of deleting keyframes. If they are currently selected, with the cursor (blue 
playhead) placed directly over them, the cursor button on the left will be blue. Click on it to 
delete the keyframe.  
Alternatively, you can click on a keyframe directly in the timeline and hit Delete on the 
keyboard.  
 

 
 

 

 
The Puppet Tool 

The puppet tool works similarly to paper-cut out puppets; it lets you animate character by 
putting pins at its joints and moving around its parts. In order to learn how to use it, we will 
do an exercise together.  
 
For the sake of this exercise, I have made a character to animate. As you can see, similarly to 
a cardboard pinned puppet, the character is made of parts placed on different layers for the 
limbs, and the separate areas of the body that should move independently from one another.  
 
IMPORT CHARACTER.psd  
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https://www.pinterest.com/pin/559009372470893800/  
 

 
 
Upon importing our character, which is a Photoshop .psd file, it is important to change the 
import kind to Composition - Retain Layer Sizes and Editable Layer Styles. This will let us 
manipulate the different parts of the puppet easily.  
 

 
 
 

Placing Pins with the Puppet Pin Tool 
Our new character will now be opened in a new composition of its own. Now, selecting each 
layer at a time, we will add pins with the Puppet Pin Tool in the top toolbar.  
 
Place pins at the very top and bottom of the head, at the shoulders, elbows and wrists, at the 
knees and at the ankles, at waist level and at the bottom of the skirt, for starters. To do so, 
you will have to choose layer after layer and place the pins on the appropriate parts.  
 
The Puppet tool will appear as an effect under the layers on which it is applied.  
From here on out, when you select the Puppet effect under a layer, its pins will appear. If you 
select a pin, you can hold it and move it around to move your character.  
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Pins on a Puppet 
As you may have noticed, in this example I use pins in two different ways. As 
illustrated by this example, both methods can be used together, depending on your needs. 
 
The first method is to place one pin which will remain immobile, and one pin which will 
move. An example of this is the head; the bottom of the head stays immobile against the 
neck, but the top pin can be moved to rotate the head forward or backwards. This method 
is closer to that of real puppets made out of cardboard.  
 
The second method is closer to bones in Blender. See the arms. The first pin is placed at the 
shoulder, the second is at the elbow, the third at the wrist, and the fourth at the fingers. 
This allows for the shoulder to stay in place as per the first method, but also for the rest of 
the arm to be able to rotate however it needs to.  

 
 

 

 
 
This is all thanks to the fact that After Effects created a mesh out of the separate layers, to let 
them be deformed at will. In order to see the mesh, check the Mesh: Show box at the top of 
the page, and hover your mouse over the layer.  
 
Expansion refers to the area the mesh takes over the layer; we want it to be snug enough to 
frame the model accurately, but loose enough that we don’t cut out pieces of the image.  
 
Triangles refers to the number of triangles created within the mesh, similarly to subdivisions 
inside Blender. The more triangles there are, the nicer the image will deform as it is animated, 
but the slower the animation will render.  
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Solidifying our character with the Puppet Starch Tool 
In order to keep some parts of the character rigid, such as the forearm between the wrist and 
the elbow, we will need to use the Puppet Starch Tool. To access it, click and hold on the 
Puppet Pin Tool to find the menu.  
 
Similarly to the Pin tool, the Starch tool works by pinning down areas that should stay more 
or less solid.  
 
Amount refers to the amount of starch that should be applied, or essentially how static that 
selection should be.  
Extend refers to how far that starch pin reaches, and how big of an area it’s affecting.  
 

Defining which parts should be in the front with the Puppet Overlap Tool 
We might want to ensure that our front hand stays at the front of the body no matter what. 
The layers already kind of cover that, but let’s do it so that if her hand was to go and touch 
the elbow of the same arm, it would stay on top of it.  To access this tool, click and hold on the 
Puppet Pin Tool to find the menu where it’s located.  
 
Pin an Overlap pin onto a part of the body.  
In Front defines if the selected part of the mesh will be in the front (positive values) or in the 
back (negative values) as compared to the values set on nearby objects.  
Extend refers to how far that overlap pin reaches, and how big of an area it’s affecting.  
 
With all of this knowledge, you are now ready to animate! 
 
Do you want to know how to animate quickly (albeit messily)?  
Hold Ctrl and start moving some Pins. After Effects will record the movement you give it in 
real time.  
 
To help with movement, I have Parented some parts of the body to the torso. The only parts I 
did not parent are the legs, seen as I wanted the rest of the body and the skirt to bob on top 
of them. Now, when I move the torso, the rest of the body will move with it.  
 
A selected pin will be fully yellow, while an unselected pin will be empty in the middle. If you 
want to deselect pins, click outside of the preview window.  
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--- 
 

About Walk Cycles and Animation References 
 
Animation principles transfer from traditional drawn animation, to 3D animation, to after 
effects. It’s not about software, it’s about movement. Any kind of animation tips you might 
have picked up are good to know here, including the 12 Principles of Animation, but also 
understanding the main positions behind a walk cycle.  
 
You can find many animation references online, and in book form.  
A true animation bible to have at hand is the Animator’s Survival Kit by Richard Williams, 
which covers all of the basics of animation. Once you know how those basics work, you can 
personalise your animation to make it your own.  
 

 
https://filmsandfriends.files.wordpress.com/2013/06/db.jpg  
https://en.wikipedia.org/wiki/The_Animator%27s_Survival_Kit  

 
 

Making your Own Puppet in Photoshop 
 
Follow along with the example file.  
 
The steps are simple.  

1. On a single layer, draw a draft, outlined version of the asset you will want to create.  
2. Decide which parts should be kept separate to ease animation (For example: the 

limbs, a piece of clothing, the head) 
3. Draw each of these parts as flat colours on separate, transparent layers. 
4. Make sure that the lower layers cover enough space so that the other parts don’t 

accidentally detach (for example, the whole torso should be drawn, even if the arm is 
“glued” on top of it, so the arm’s rotations don’t leave a large transparent hole in the 
middle of the asset).  

5. Finish each of the different parts with outlines, details, and other decorations. 
6. Name each layer appropriately, to be able to find it easily in After Effects.  
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Replacement Animation for Lipsync 
The way that will be explained here is not exactly the way it was made on the 
example file. See below for the explanation relating to our AE project.  
 
What you’ll need to export from Photoshop: 

1. A blank, mouthless face drawing. 
2. Multiple mouths drawings on other layers, detailing the different phonemes needed 

to animate.  
 
Bring this file into After Effects, with each independent layer being editable.  
Bring all of the mouth layers (not the face) into a single composition.  
Reduce the length of each layer to 1 frame.  
Select all of them.  
Animation > Keyframe Assistant > Sequence Layers.  
Reduce the composition’s length to be the same as your sequence of layers.  
From now on, each mouth phoneme is associated to a frame in this composition.  
 
Go back to your original composition, and bring your new Mouth composition into your 
timeline as a layer on top of the Face layer.  
Select the Mouth composition layer. 
Layer > Time > Enable Time Remapping.  
You can now keyframe which mouth should appear at what time. 
Parent the Mouth composition layer to the Head layer.  
 
With this setup, you would not be able to pin the head to move it with the puppet tool 
setup. Instead, you’d have to move its pivot to its base and rotate it from there. 
 
How to move a pivot? 
Using the Pan Behind/Anchor Point tool (Y), you can click and drag the pivot point (the 
little cross at the center of the asset) and place it wherever you like.  
 
Rigging replacement animation in After Effects | lynda.com 
https://www.youtube.com/watch?v=gfj7AOz7hUM  
 

--- 
 
In our example, the setup briefly AFTER making the walk cycle (a less than ideal, but still 
functional setup). A new composition with just the mouths and the head was used to 
replace the Head layer of our original composition.  
Since it was added to the original walk cycle animation, in which the head was already 
pinned and animated, we had to replace the head layer with the new head composition 
layer.  
 
How to replace a layer with another layer or composition?  
Click on the layer that you want to replace. 
Alt-Click the new asset in your project files, and drag that new asset on top of the original 
layer in your After Effects sequence/timeline. 
 
The advantage of having the full head as a composition is that it acts as a single layer; 
therefore, we can use the pins on the head.  
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Rendering 
Once you are done with your composition and are ready to export the result as a 
movie file, you will have to bring the composition into the Render Queue. We will be 
exporting in mp4, so instead of using the standard Render Queue, we will use the 
Adobe Media Encoder (AME) Queue.  
 
Select the composition you wish to render. 
File > Export > Add to Adobe Media Encoder Queue.  
This will open Adobe Media Encoder CC 2017.  
 
Set the Format as H.264 
Set the Preset as HD 1080p 29.97, unless your composition had a different aspect ratio or 
framerate.  
Set the Output as wherever you would like the resulting file to appear in your folders.  
Press the green arrow at the top right of the page, or press Enter. This will start the queue.  
 
Go and watch the file in your navigator to make sure it exported properly.  
 

 
 
https://helpx.adobe.com/after-effects/using/basics-rendering-exporting.html   
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Cinematics 3 / Instructor: Ray Caplin 

After Effects Camera Tools 
Understanding the virtual camera and multiplane compositing. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 1:30PM — 1HR 30M 
 
Instructor Prerequisites 
The instructor should be comfortable using After Effects CC 2017, Familiar with its Keystroke 
layout and able to spot wrong keystrokes made my studios, should be Familiar The Camera 
Layer and all of its Functions. basic understanding of filmmaking shot terminology, to 
distinguish shot types. 
 
Participant Prerequisites 
Students must have access to Plastic Gluon to access the provided work Examples. 
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
After Effects CC 2017 
 
Objectives 
Understand the Camera Layer and its many functions and attributes. To link a similarity 
between The Camera Layer in After effects and real world film cameras. 
  
Vocabulary 
3D layer, Active Camera, Depth of field, Focal Distance 

  
References 
Software website: 

- Adobe After Effects 
Software Tutorials: 

- How to use the Camera Tool 
- 3D Camera Techniques 

Additional Tutorials 
- Introduction to shot types and camera movement 

  
 

 

Preparation: 
Provide Example file to students and have a copy for yourself for dementrations. 
 

3D layers  

Before we dive into using the Camera, we must set up our Scene, or objects to respond to the 
Camera Layer. Initially, After Effects Compositions are 2D, with all Assets imported also being 
2D. However After Effects allows for each Layer to be easily converted into a 3D layer, by 
checking enable 3D layer on desired layer. This gives 2D Assets placed within the 
composition, that already have a Y and X axis, a Z axis to allow for 3D Transformation or 
scaling. Objects can be transformed to appear closer or further away to give the illusion of 
depth.  
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With the ability to transform 2D assets in 3D space, this can allow for 2D assets to be 
arranged to form background environments. or create sets pieces for characters to act out 
within. They can also be arranged to form long rolling scenes intended for a Panning Parallax 
effect. or layed out spanning to form a distant mountain range or other environment settings. 

 

 

 

The view port can be changed to view from Front, Right, Left, or Top, or even Custom views, 
to effectively arrange your assets or to get a better idea of where the Assets are situated 
within 3D space. the Active Camera view port is what the final image will appear a

 

 
Camera Layer  
 

The Camera Layer  is a tool that resemble an actual film Camera, It allows you to reframe the 
composition, or move freely within a 3D virtual space created in after effects. The Camera 
Layer has many features such as, Depth of field, Focal Distance, Zoom, and Film size, Again, 
all of which resembles a real film Camera. if you have any knowledge in filmmaking, there are 
more advanced options modeled from film Cameras, such as Aperture, F-stop and Blur level. 
these are intended to mimic the respected traditional attributes they are modeled after.  for 
this lesson will cover most of the basic features.  
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Presets 

Each preset has different variables, all which are modeled after real world camera. for 
example. the 15MM preset has a very wide field of view, while the 80MM has a very Narrow 
field of view. regardless of which preset you choose you can customize each variable as you 
go. The standard preset commonly chosen is the 35MM, as it's also a common standard in 
real world film making.  

 

One-Node and Two-Node Camera 

The only difference between One-node Camera and a two node camera is how it 
Orientates, One Node Camera, Orientates around itself, while a Two-node Camera 
Orientates around a Point of Interest.  

 

Zoom  

Zoom allows you focus in on any desired point of interested from a fixed location, and 
without having to re-orientate the camera closer.  

 

Angle of view  

Allows the field of view to be adjusted, which expands or contracts the frame we view 
through, ether allowing us to see more and less of the scene.  

 

Depth of Field  

You’ll need to have Enable Depth of Field check on. to activate some of the Camera’s 
advance properties, such as Depth of Field, which is the distance between the nearest and 
the furthest objects that give an image judged to be in focus in a camera. further objects 
appear blurry. closer objects will also appear blurry,  
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When enabled this will allow you to Adjust the Focus Distance, and Aperture, The Focus 
Distance determines the distance of where objects are in or out of Focus, Objects out of focus 
will appear slightly blurry, objects too near will also appear blurry. Objects within the Focus 
Distance will appear Clear. Aperture controls how blurry Objects out of focus appear. closer 
objects will appear More fuzzy while distant objects will more soft. objects in the point of 
interest are not effected.   

 

The quickest way to set the Point of Interest of the Camera, and avoid spending time 
manually adjust the Focus Distance and Aperture, would be to ether set the Camera to Set 
Focus Distance to Layer or Link Focus Distance to Point of Interest.  

To apply a sort of auto focus to a moving asset within the environment, you can Link Focus 
Distance to Layer, Anything within the linked Layer moving will remain in focus to the 
camera, while everything else will be out of focus. 

 

 

 

 

Camera Layer Tools 

At this point, we should be familiar with how keyframe animation works in After Effects, and 
how to apply it to Assets imported into After Effects,  The Camera Layer Utilizes Keyframe 
animation to move within the vitrial 3D space. Moving the Camera Layer will reframe the 
composition, and if an environment or scene is laid out, it will pan or fly through the 
environment, creating a paper cut out feeling which is usually associate as 2.5D animation 
style.  
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There are tools exclusively for the Camera Layer. all are related to reorienting the Camera in 
various ways. 

Unified Camera Tool allows for Free flowing rotation around the Point of Interest. it has a 
samilure control scheme found in most 3D software, and can controlled entirely with you 
mouse. 

 

 

Orbit Camera Tool, allows for similar orientation such as the Unified camera tool, but its 
purpose is to serve as a substitute if your using a mouse without a middle mouse button.  
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Track XY Camera Tool, will track the Camera along the X and Y axes, can be useful 
for horizontal Camera Pans. or Trucking shots. 

 

 

 

Track Z Camera Tool. allow the Camera to move along the Z axes, which is useful for moving 
the camera forward or back within the space, which can create a Dolly shot. 
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 3D Animation 1 / Instructor: John Mervin 

Principles of Animation (2.5D & 3D) 
Overview of the 12 principles of animation in various media. 

 

 
Teaching Days, Time, & Length 
Monday July 16th, 3:15PM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 

- https://docs.google.com/presentation/d/14X4YCvjU-Wb2TS0yeEWkAoiqrvnUnnEbt0
mEde0jet8/edit 

 
Instructor Prerequisites 
Knowledge of the 12 principles of animation. 

 
Participant Prerequisites 
none 
 
Equipment/Software Materials 
PowerPoint presentation for future referral. 

 
Objectives 
Learn about the principles of animation to aid in drawing and animation skills. 

  
Vocabulary 
Squash and stretch, anticipation, staging, straight ahead and pose to pose, follow through 
and overlapping, slow in and slow out, arcs, secondary action, timing, exaggeration, solid 
drawing and appeal. 

  
References 
Principles of Animation: 

-       http://minyos.its.rmit.edu.au/aim/a_notes/anim_principles.html 

-       https://ohmy.disney.com/movies/2016/07/20/twelve-principles-animation-disney/ 

-       http://the12principles.tumblr.com/ 

-        Illustion of Life Disney Animation by Frank Thomas: 
https://www.amazon.ca/Illusion-Life-Disney-Animation/dp/0786860707 

 

Overview 

The main purpose of the principles of animation were to produce an illusion of characters 
adhering to the basic laws of physics, but the principles also dealt with more abstract issues, 
such as emotional timing and character appeal. 

  

Illusion of Life Disney Animation Book 

This book was written by two of the animation masters at Disney during the Golden Age of 
animation and is known as the best animation books of all time. The book gives a history of 
Disney animation and explains the processes involved in clear, non-technical terms. It has 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

excellent technical drawings and fun examples of the principles of animation at work 
in some of the most famous films. 

  

Squash and Stretch 

This action gives the illusion of weight and volume to a character as it moves. Squash and 
stretch is useful in animating dialogue and doing facial expressions . How extreme the use of 
squash and stretch is, depends on what is required in animating the scene and  is done by 
expanding and compressing the character’s body. It is used in all forms of character 
animation from a bouncing ball to the body weight of a person walking. This is the most 
important element you will be required to master and will be used often. 

  

Anticipation 

This movement prepares the audience for a major action the character is about to perform, 
such as, starting to run, jump or change expression. A dancer does not just leap off the floor, a 
backwards motion occurs before the forward action is executed: the backward motion is the 
anticipation. A comic effect can be done by not using anticipation after a series of gags that 
used anticipation. Almost all real action has major or minor anticipation such as a pitcher's 
wind-up or a golfers' back swing. 

  

Staging 

A pose or action should clearly communicate to the audience the attitude, mood, reaction or 
idea of the character as it relates to the story and continuity of the story line. The effective use 
of long, medium, or close up shots, as well as camera angles also helps in telling the story. 
There is a limited amount of time in a film, so each sequence, scene and frame of film must 
relate to the overall story. 

  

Straight Ahead and Pose to Pose 

Straight ahead animation starts at the first drawing and works drawing all drawings to the 
end of the scene. You can lose size, volume, and proportions with this method, but it does 
have spontaneity and freshness. Fast, wild action scenes are done this way. 

Pose to Pose is more planned out and charted with key drawings done at intervals 
throughout the scene. Size, volumes, and proportions are controlled better this way, as is the 
action. 

  

Follow Through 

When the main body of the character stops all other parts continue to catch up to the main 
mass of the character, such as arms, long hair, clothing, coat tails or a dress, floppy ears or a 
long tail (these follow the path of action). Nothing stops all at once. This is follow through. 
Overlapping action is when the character changes direction while his clothes or hair 
continues forward. The character is going in a new direction, to be followed, a number of 
frames later, by his clothes in the new direction. Timing becomes critical to the effectiveness 
of drag and the overlapping action. 

  

Slow In and Slow Out 

As action starts, we have more drawings near the starting pose, one or two in the middle, and 
more drawings near the next pose. Fewer drawings make the action faster and more 
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drawings make the action slower. Slow-ins and slow-outs soften the action, making it 
more life-like. This will be covered in the bouncing ball exercises in the animation 
courses. As a ball falls down, it moves faster and as the ball bounces upwards it gets 
slower as it reaches the peak. 

  

Arcs 

All actions, with few exceptions, follow an arc or slightly circular path. This is especially true 
of the human figure and the action of animals. Arcs give animation a more natural action and 
better flow. Think of natural movements in the terms of a pendulum swinging. All arm 
movement, head turns and even eye movements are executed on an arcs. 

  

Secondary Action 

This action adds to and enriches the main action and adds more dimension to the character 
animation, supplementing and/or reinforcing the main action. Example: A character is angrily 
walking toward another character. The walk is forceful, aggressive, and forward leaning. The 
leg action is just short of a stomping walk. The secondary action is a few strong gestures of 
the arms working with the walk. All of these actions should work together in support of one 
another. Think of the walk as the primary action and arm swings, head bounce and all other 
actions of the body as secondary or supporting action. 

  

Timing 

Expertise in timing comes best with experience and personal experimentation, using the trial 
and error method in refining technique. A variety of slow and fast timing within a scene adds 
texture and interest to the movement. Timing in the acting of a character to establish mood, 
emotion, and reaction to another character or to a situation. Examples of timing are that 
walking is slower than running. A ball bounding upward should be slower than the ball 
coming down. 

  

Solid Drawing 

The basic principles of drawing form, weight, volume solidity and the illusion of three 
dimension apply to animation as it does to academic drawing. This principle encourages 
animators to be mindful of the fact that while forms may be presented in 2D, they should 
strive to look 3D 

  

Exaggeration 

Exaggeration is not extreme distortion of a drawing or extremely broad, violent action all the 
time. It's like a caricature of facial features, expressions, poses, attitudes and actions. 
Exaggeration in a walk or an eye movement or even a head turn will give your film more 
appeal. Exaggeration is all about overstating certain movements in a way that helps evoke a 
point, yet doesn’t ruin the believability of the scene. 

  

Appeal 

A live performer has charisma. An animated character has appeal. Appealing animation does 
not mean just being cute and cuddly. All characters have to have appeal whether they are 
heroic, villainous, comic or cute and the model and animation should reflect that personality. 
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3D Animation 2 / Instructor: Kahentawaks Tiewishaw 

Blender Rig Tools 
An in depth look at rigging a 3D character for animation -  
Placing bones, targets, and skinning.  

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 9:15AM — 1HR 30M 
 
Supporting Materials 
Presentation Slides 

- https://docs.google.com/presentation/d/1n4LRLyr8RNaqnb6Mrw13vzT0k71_MpG3M
pIYY1GsH5E/edit?usp=sharing 

 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.78/2.79), enough to 
foresee wrong keystrokes that the participants might make. The instructor should also be 
familiar with the basics of blender skeleton tools and Rigify. 
 
Participant Prerequisites 
Participants must have access to Plastic Gluon to access the provided work model.  
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender Version 2.79. 
Plastic Gluon 
 
Objectives 
Understand the concept and process of armature rigging, skinning, and weight painting. 
  
Vocabulary 
Armature, bones, extruding, joints, parenting, weight painting, rigging, skinning, constraints, 
inverse kinematics, targets.  
  
References 
Blender website: 

- http://www.blender.org/ 
 
Character Rigging Tutorial: 

- https://youtu.be/f5HoJcOetK0 
 
Rigging Tutorials: 

- https://cgi.tutsplus.com/tutorials/building-a-basic-low-poly-character-rig-in-blender--
cg-16955  

- https://www.youtube.com/watch?v=cGvalWG8HBU  
 

 

 
Rigging 
This kind of rigging is useful because it is most likely what you will be using to rig 
non-humanoid characters. When brought into Unity the animation type will be “Generic.” 

Rigging is the process of creating a skeleton for a 3D model so it can move. Characters are 
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rigged before they are animated because if a modelled character doesn't have a rig, 
they cannot be deformed and moved around. They are stuck in whichever pose the 
modeler decided to put them in. In most cases, characters are modelled in the T-Pose. 

 

Parts of the Rig 
The main parts of a character rig are the following: 
 

- Bones: Bones in the body that make up the skeleton. 
- Joints: Points where bones meet and form a bend. 
- Skeleton: Body structure of the bones. 
- Controllers: Parts used to move and pose the character. 

 
Modes 
There are 4 main modes in rigging a character and each have their own use and purpose. 
 

- Object Mode: Is used to move the entire skeleton at once. 
- Edit Mode: Is used to move individual bones into place. In this mode you will always 

see your skeleton in rest mode. 
- Pose Mode: Is the mode in which you can add constraints to bones and pose and/or 

animate  the character. In this mode you will always see the current pose of the 
skeleton. 

- Weight Paint Mode: Is used to paint the influence from the skeleton onto the mesh. 
 

 

 

Adding Bones 
How do we add a bone to the scene? 
 

- Press Shift + A > Armature > Single Bone 
 

Bones have have 3 elements or parts to them: 

- The start joint named root 
- the body itself 
- and the end joint named tip 

 

Selecting Bones 
You can select each individual part of the bone by: 
 

- LMB + CLICKING on a bone’s individual parts. 
- Using SHIFT + LMB, you can add/remove from the selection. 

 
When you select the body of the bone, you will implicitly select its root and tip. 
 
Adding Another Bone 
If you want to add another bone to the scene: 

- Select the TIP of the previous bone and press E to extrude another bone from the 
previous one.  

- Press X, Y, or Z to lock the extrusion to that axis.  
- Drag to scale it up or down, LMB to apply. 
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Tips and Tricks 
Because we’re going to be rigging for Unity, there is a specific bone structure we must 
follow. Everything must be extruded out of a single root bone: The base of the 
spine/hips. A good bone structure to follow is: 
 

1. Hips > spine > chest > shoulders > arm > forearm > hand.  
2. Hips > spine > chest > neck > head 
3. Hips > thigh > shin > foot > toe 

 
You can turn on X-Ray to see bones through objects. This makes manipulating and 
positioning bones easier. 
 

- Navigate to the Armature tab of the Properties panel 
- Under the Display tab, check the X-Ray box. 

 
Change the display of the bones to better see the mesh behind it 
 

- Navigate to the Armature tab of the Properties panel 
- Under the Display tab, check one of five options: octahedral, stick, B-Bone, Envelope, 

Wire. 
 
Naming your Bones 
Name your bones by: 

- Click on a bone in the skeleton 
- Navigate the Properties Panel and select the Bone icon 
- Use the dialogue box at the top of the tab to rename it 

 
Naming Conventions 
Firstly, you should give your bones meaningful base-names like: head, torso, forearm, 
shoulder. If you have a bone that has a copy on the other side (a pair), like an arm, use a suffix 
to differentiate them  (arm.L & shoulder.R).  Use camelCase for names with multiple words: 
UpperArm.L 
 
To display the names next to the bones: 
 

- Navigate to the Armature tab of the Properties panel 
- Under the Display tab, check the Names box. 

 
When naming bones remember that when you are looking at the front of a model: 
 

- Your LEFT is the model’s RIGHT 
- Your RIGHT is the model’s LEFT 

 
Bones that are in the center of the rig (spine, chest, neck, and head) do not need a directional 
suffix.  
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Bone Parenting 

Parenting is the hierarchy of bones. You can move the child bone freely without 
affecting the other bones in the chain but if you move the parent bone, it moves all of 
the children bones with it.When you extrude a bone Bone.002 from Bone.001: 
 

- Bone.002 becomes a child of Bone.001 
- Bone.001 is the parent of Bone.002. 

 
Un-Parenting 
To Break a parenting relationship: 
 

-  Select 2  bones you wish to separate 
-  Hit ALT+P > Clear Parent 

 
Re-Parenting Connected Bones 
The order in which you select the bones matters when parenting. The first bone selected will 
be the child, the second bone selected will be the parent.  
 

- LMB to select the bone you want to be the CHILD 
- SHIFT + LMB to select the bone you want to be the PARENT 
- CTRL + P  > Connected. 

 
Re-Parenting Offset Bones 
Keep offset will keep the bone in its position and will only move with the whole skeleton in 
Object Mode or in Pose Mode. As always the order in which you select the bones matters 
when parenting.  
 

- LMB to select the bone you want to be the CHILD 
- SHIFT + LMB to select the bone you want to be the PARENT 
- CTRL + P  > Keep Offset 

 
 

 

NOTE: For this lesson participants should open the provided work file from Plastic Gluon 
(Course Assets > Course Material > 3D Animation > BlenderRigTools.blend) and follow 
along with the slides. 

This lesson will cover: 
 

- Making a generic skeleton 
- Inverse Kinematics 

 
Make a Skeleton for Gerta! 

- In Object Mode place the first bone at the groin of your character. (SHIFT + A > 
Armature > Single Bone.) 

- In Edit Mode,  select the tip of that bone and Extrude(E) up to create the spine. (There 
should be at least three bones in the spine. (Spine, Spine.001, Chest) 

- Extrude(E) two more bones up to create the neck and the head bones.  
- Pick either the right or left side to create the limbs on. We will mirror them later so 

they will be exactly the same. 
- Extrude(E) the arms out of the bottom of the neck bone. There should be at least 4 

bones in the arms (shoulder, arm, forearm, hand.) 
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- Extrude(E) the legs out of the base of the spine bone. There should be at least 
4 bones in the legs ( thigh, shin, foot, toe. BUT you can add hips and heels  if 
you want.) 

- Select the arm and leg bones (all of them). SHIFT +D, then ENTER to duplicate 
them. 

- SHIFT + C to center the 3D cursor, change the Pivot Point to 3D cursor. 
- Click Armature > Mirror > X Local.  
- Name your bones! 

 
Constraints 
Constraints apply to bones in the skeleton. Constraining bones can be used to control their 
degree of freedom in their movements. The main one we will be covering is Inverse 
Kinematics. Inverse kinematics helps joints to be controlled and bend easier as a chain 
following one another. These are mainly used on arms and legs as they have many bones in 
the chain that follow each other in specific ways. 
 
Inverse Kinematics (IK) 
Inverse kinematics specifically helps bones to move as a chain, following one another. It’s 
mainly used on arms and legs. To apply the IK constraints to the left forearm: 
 

- In Pose Mode select the left forearm.  
- Select the Bone Constraints tab from the properties panel  
- Select Inverse Kinematics 

 
We see a new menu here. What do these items mean? 
 

- Target: Separate object that handles the IK movement. 
- Pole Target: Separate object that handles the IK orientation. 
- Chain Length: How many bones are connected in the chain. 

 
When you create your IK, you will need to adjust the chain length. This is how many bones 
are influenced by the IK handle. For this arm, we want it to bend up to upper arm, so its chain 
length is 2.  
 

- In the IK dialogue box there is a slider that says “Chain Length” 
- Its default its 0, change it to 2.  

 
Now you need to create a Target. The target will be what acts as a controller for the whole 
arm.  
 

- In Edit Mode, Add a separate bone to be used as a Target.  
- Move it close to the Tip of the IK bone (in this case it's the wrist.) 
- Name it ForearmIKTarget.L 
-  In Pose Mode, set the target to ForearmIKTarget.L 

 
Now you can move the IK chain with the target object in Pose Mode. 
 
 

Now that we’ve done it together once, try it out on the right arm. 
 
Reminder of the steps: 
 

- Pose Mode: Select right forearm bone 
- Apply Inverse Kinematic from the Bone Constraints panel 
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- Adjust the Chain Length to 2 
- Add new bone for Target (Edit Mode) in front of the IK bone 
- Name it ForearmIKTarget.R 
- Set the Target (Pose Mode) to ForearmIKTarget.R 

 

 

Now we need to add a Pole Target. This is what will make sure the elbow behaves properly.  
 

- In Edit Mode, Add a separate bone to be used as the Pole Target. 
- Move it behind the elbow and name it ArmPoleTarget.L 
- In Pose Mode set the Pole Target to ArmPoleTarget.L 

 
You might see that the arm looks badly twisted, this can be fixed by setting the Pole Angle. 
The Pole Angle helps to keep the IK chain’s orientation.  
 

- In the IK Constraints dialogue box, use the Pole Angle Slider to fix the twisted arm.  
 
Now the elbow should behave properly. NOTE: If the elbow moves in unexpected ways even 
after the Pole Angle has been set, it might be because it is not obvious to Blender which way 
the it is suppose to bend. Try going in Edit Mode and moving the joint itself a bit closer to the 
Pole Target so that there is a slight bend in the arm. 
 
 

Now that we’ve done it together once, try it out on the right arm. 
 
Reminder of the steps: 
 

- Add new bone for Pole Target (Edit Mode) place it behind the elbow. 
- Name it ArmPoleTarget.R 
- Set the Pole Target (Pose Mode) ArmPoleTarget.R 
- Adjust the Pole Angle to untwist the arm 

 

 

Use the techniques we’ve just learned to set the IK constraints for the legs. Think about how 
you want it to behave when its finished.  
 
Reminder of the steps for Targets: 

- Select Bone (Pose Mode) 
- Apply Inverse Kinematic Constraint 
- Adjust the Chain Length 
- Add New Bone for Target (Edit Mode) 
- Name it appropriately 
- Set the Target (Pose Mode) 
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Reminder of the steps for Pole Targets: 
- Add New Bone for Pole Target (Edit Mode) 
- Name it appropriately 
- Set the Pole Target (Pose Mode) 
- Adjust the Pole Angle 

 
 
Skinning 
Up to now, we have been just moving the skeleton but never moving the actual mesh. 
Skinning is the process of applying the mesh to the skeleton so that the joints move the mesh. 
To apply the rig to the mesh: 
 

- In Object Mode make sure the Skeleton and Mesh are aligned. 
- Select the Mesh first because it’s going to be the Child. 
- SHIFT + LMB to select the Rig which will be the Parent.  
- CTRL + P > With Automatic Weights 

 
The mesh now moves with the skeleton. It’s really that simple. 

 
 
Weight Painting  
Weight painting is the amount of influence the bones and joints have on the mesh. The 
weight information is literally painted on top of the mesh demonstrated using a cold to hot 
color system The areas of low influence are drawn in blue (cold) and areas of high influence 
are drawn in red (hot). All in-between influences are drawn in rainbow colors, depending on 
their value: blue, green, yellow, orange, red. To try it out: 
 

- Switch the models viewport shading to Solid to make things easier to see.  
- In Pose Mode select the bone whose influence you want to edit. 
- Select the Mesh (which should be in Object Mode) and press CTRL + TAB 
- You can now select different bones with LMB and see their influence on the mesh. 
- Select a brush that either adds or subtracts influence from the Weight Paint Tools 

menu. 
- Double click +  drag to paint the desired influence on the mesh. 
- Switch back into pose mode to see how it worked. 
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3D Animation 3 / Instructors: Kahentawaks Tiewishaw & John Mervin 

Blender to Unity Rigging 
Creating and using the blender rigify skeleton and controllers. 

 

 
Teaching Days, Time, & Length 
Thursday July 19th, 11:00AM — 1HR 30M 
 
Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1a_dsiD9WEU2idVRVYHFPPNYht7KEX79-4iz
B0u79_QA/edit?usp=sharing 

Rigify into Unity Mecanim, required plugin: 
- https://github.com/trynyty/Rigify_DeformBones 

 
Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.78/2.79), enough to 
foresee wrong keystrokes that the participants might make. The instructor should also be 
familiar with the basics of blender skeleton tools and Rigify. 
 
Participant Prerequisites 
Participants must have access to Plastic Gluon to access the provided work model.  
 
Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender Version 2.79. 
Plastic Gluon 
Rigify. 
Rigify into Unity Mecanim plugin.  
 
Objectives 
Understand the concepts of armature rigging, skinning, and using rigify to create controllers 
to pose and animate a character. 
  
Vocabulary 
Rigify, armature, bones, x-ray,  meta-rig, rig, joints, generate, pose, animate.  
  
References 
Blender website: 

- http://www.blender.org/ 
 
Rigging Tutorials: 

- https://www.youtube.com/watch?v=f5HoJcOetK0&feature=youtu.be 
- https://www.youtube.com/watch?v=dYiAd_08-0k&feature=youtu.be  
- https://www.blenderguru.com/tutorials/introduction-to-rigging  

 
 

 
Rigify 
 

This kind of rigging is useful because it is most likely what you will be using to rig humanoid 
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characters. Rigs made with this method can use both custom animations AND 
premade animations from Mixamo.com. Mixamo is a website with a library of FREE 
premade humanoid animations. When brought into Unity the Animation Type will be 
“Humanoid.” 
 

Rigify is a built in Blender add-on that allows for easy and quick character rigging. It makes 
posing and animating characters easier by allowing limbs to move fluidly via the use of 
controllers. This is different from creating a humanoid skeleton out of a single bone, which 
would require moving individual bones one at a time in order to pose/animate.  

 

 

NOTE: For this lesson participants should open the provided work file from Plastic Gluon 
(Course Assets > Course Material > 3D Animation > BlenderRigify.blend) and follow 
along with the slides. 

 

This lesson will cover: 

- Enabling the proper add-ons and settings 
- Creating and editing a meta-rig. 
- Using the meta-rig to generate character controllers 
- Adjusting the influence of those controllers. 
- Converting the rig to work with unity 

 

Enabling the proper add-ons and settings. 
 

While making the Skins 6.0 test game, we encountered some issues with using rigify on 
characters you plan to export to Unity. As a result, we had to install a plugin that converts 
rigify rigs into something Unity can understand.  The following is how to enable all of the 
proper add-ons, plugins, and settings to make sure the lesson runs smoothly. 

- Once participants have BlenderRigify.blend open, go into File > User Preferences. 
- In the Add-ons tab, use the search bar located in the upper left corner to search for 

“rig.” This will call up all the installed add-ons and plugins related to that word. 

- Two add-ons called Rigging: Rigify, and Rigging: Rigify to Unity should appear. 
Make sure that both of their checkboxes are checked.  

- Click the arrow next to Rigging: Rigify to expand it. Make sure Rigify Legacy Mode is 
checked.  

- Under the File tab, check the Auto Run Python Scripts box. Once that is done, hit the 
Save User Settings button on the bottom left. Close the window.  

 

Making the Meta-Rig 
 

The first step of rigging with rigify is creating and editing the meta-rig. It is almost exactly like 
building a skeleton from scratch in that you are editing bones to fit inside your character. 
However, these meta-bones will eventually be deleted. Think of them as being a blueprint for 
your rig, rather than being the rig themselves.  

The first thing to do is position your character appropriately in the scene. The meta-rig’s origin 
is centered between its feet, and will generate wherever your 3D cursor is.  So to make things 
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easier, we want our character to be sitting exactly where the meta-rig is going to 
appear.  

- In Object Mode, grab(G) your character and move them so that their feet are 
resting on the X axis. Eyeball it as best you can, it doesn't have to be exact. 

- Additionally, the character should be centered on both the X and Y axes.  To do this 
select the character and open their properties panel (N).  

-  Under the Transform tab make sure the location values for the X and Y axes are set 
to 0.  

Now that your character is in the proper location we can generate, and edit the meta-rig.  

- To do this press SHIFT + A  to open the add menu.  From here you select Armature > 
Human Meta-Rig.   

- In the Armature tab of the properties window, check the X-Ray box to be able to see 
the meta-rig through your mesh.  

- Use scale(S) to match the size of the meta-rig to the size of your character.   
- With the meta-rig selected, switch into Edit Mode(TAB).  
- In the Tools panel (T), under the options tab, check the box for X-Axis Mirror. This 

will make editing the meta-rig much easier. Changes made to one side of the skeleton 
with automatically happen on the other.   

- Place the individual bones in alignment with the mesh.  

NOTE: Just like building a traditional rig, the bones of the meta rig should mostly be 
centered inside your mesh from both front and side view.  

 

Now that your bones match up with your mesh, it's time to make sure your joints are going to 
behave properly. Whatever way the joints curve/bend, they should all be facing the same 
axis. In this case, they all need to bend towards the Z-AXIS. 

Some more explanation:  
● The elbow bends forward, so the Z-Axis needs be in front of the elbow.. 
● The knee bends backwards, so the Z-Axis needs to be behind the knee. 
● The ankle bends backwards, so the Z-Axis needs to be behind the ankle.  

 
To verify the orientation of your bones/joints… 
 

- With the meta-rig selected, navigate to the Armature tab, under display check the 
Axes box to make them visible.  

- Make sure the elbows (forward Z), knees (backwards Z), and ankles (backwards Z) 
are all pointing in the right direction.  

 
Since the Z axis will determine which way the joint bends most comfortably, we must adjust 
the angle of the wrists joint. The wrists has the most range of motion going up and down, not 
side to side. So the Z axis should point down towards the body of your character.  

To edit the orientation of your bones/joints… 
 

- select the joint in Edit Mode, and open the properties panel (N). 
- Under the transform tab, use Roll to adjust the orientation of that joint.  

 
 

Generate the Rig from the Meta-Rig 
 

Now that you’re done making the blueprint for your rig, we are ready to actually generate it. 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures  
Skins 6.0 | indigenousfutures.net 



 

You are more than halfway done, with just a few more steps to go! 
 

- With the meta-rig selected in Object Mode, press CTRL + A to apply all the 
location, rotation, and scale transformations you performed while in Edit 
Mode.  

- With the meta-rig still selected, navigate to the Armature tab, scroll down to the very 
bottom, and hit the Generate button.   

- Scroll back up the Armature tab, and hit the X-Ray button to see the rig through the 
mesh.  

- Select the meta-rig, and delete it.  
 
This is the part where we make use of the plugin to convert the rig for Unity.  
 

- Select the rig in Object Mode. 
- Navigate to the Armature tab. There should now be another button under Generate 

that says Convert to Unity Rig.  
- Press that button. 

 

Parent the Mesh to the Rig and Edit the Controllers 
 
Now we have our rig, but you might notice that if you try to move the controllers, nothing 
happens. This is because they are not yet linked. What we need to do is make the mesh the 
child of the rig. This is what makes the mesh move along with the rig.  
 

- In Object Mode select the mesh FIRST and the rig SECOND.  The order you select 
them in determines which object is the child and which is the parent.  

- Press CTRL + P > With Automatic Weights to set the parent.  
 
The only thing left to do is determine the amount of influence the controllers have on the limbs 
of your character. What we want is if we move the foot, the entire leg will follow along 
accordingly.  
 

- With the rig selected, go into Pose Mode.  
- Select the controller for the foot, and push (N) to bring up its properties panel.  
- Scroll down to the Rig Main Properties tab, here you will notice the sliders for both 

FK/IK and  Auto-Stretch IK.  
- Set the FK/IK slider to 1, and the Auto-Stretch IK to 0. 
- Repeat this process for both hands and feet controllers.  

 

 

Done!   
 

Try to use the controllers to pose your character! 
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3D Animation 4 / Instructor: Kahentawaks Tiewishaw 

Animation References & Tools 
Learn about Blenders interface & tools for 3D animation. 

Teaching Days, Time, & Length 
Thursday July 19th, 1:30PM — 1HR 30M 

Supporting Materials 
Presentation slides: 

- https://docs.google.com/presentation/d/1Np4aa1aDmLg938wBQveciLkOJaDDAaj91b
JHE-qycZg/edit?usp=sharing

Instructor Prerequisites 
The instructor should be comfortable using Blender (using version 2.79), enough to foresee 
wrong keystrokes that the participants might make. The instructor should also be familiar 
with the basics of blender animation 

Participant Prerequisites 
Participants must have a basic awareness of animation. Participants must have access to 
Plastic Gluon to access the provided work model that has been rigged with rigify. 

Equipment/Software Materials 
A presentation screen on which to show PowerPoint. 
Blender Version 2.79 
Plastic Gluon 

Objectives 
Understand the concept of computer animation. Understand the animation interface, basic 
keyframing and action editor.Learn the basics of animation references and film your own 
animation references for later use. 

Vocabulary 
Timeline, keyframe, pose mode, dope sheet, graph editor, tweening, animation, rigging, 
principles of animation, walk cycle, run cycle. 

References 
Blender website: 

- http://www.blender.org/

Animation Tutorial 1: 
- Animation Tutorial 1

Animation Tutorial 1: 
- Animation References

Walk Cycle Tutorial 
- Walk Cycle Tutorial
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Animation Basics 
When moving an object from point A to point B, the 3D animation software creates 
the in between motions (tweening) through the mathematical process of 
interpolation. The timeline shows you what keyframes are inserted and where.Here 
we inserted a keyframe at 0 (START) and one at keyframe 30 (END). The software 
interpolates the in between motions to go from Point A to Point B. 

Animation Interface 
To navigate to the animation interface, click on the Screen Layout button on the top and click 
on animation. You can also do a custom setup by dragging the screens and selecting the 
current editor type for that area. 

- Dope Sheet: The dope sheet shows when and how long a movement occurs
- Graph Editor: The graph editor allows you to modify the animation curves meaning

the interpolation between points
- Timeline: The timeline shows the overview of the animation part of the scene

Timeline: In detail 
Here you have an overview of the animation part of your scene. What is the current time 
frame, where are the keyframes of the active object, the start and end frames of your 
animation, markers, etc… 

1. Timeline Icon: Change the view to the timeline.
2. Timeline Length: Length of the animation.
3. Keyframe: Yellow line shows where a keyframe is inserted.
4. Cursor Position: Green line shows where the cursor is positioned on the timeline.
5. Start Frame Number: The first frame of the animation.
6. End Frame Number: The last frame of the animation.
7. Cursor Frame Position: This is the number at which your cursor (the green line) is

placed.
8. Playback Controls: Controls for playing the animation. This can also be done with the

hot key ALT + A.

Dope Sheet: In detail 
Here you have an overview of the keyframes. Each one being shown as an horizontal colored 
strip. On these channel strips lay the keyframes, visualized as light-gray (unselected) or 
yellow (selected). 

1. Dope Sheet Icon: Change the view to the dope sheet.
2. Object Name: Name of the selected object or the object that is being keyframed.
3. X, Y, Z Locations: Indication of the axis that is being keyframed.
4. Keyframe Locations: These dots show at that time on the timeline that there is a

keyframe. If the diamond is grey, it is not selected. If it is orange it is selected.
5. Change Over Time:  If there is no change on that keyframe over a certain amount of

time, a orange line will appear.
6. Cursor Point: Green line shows where the cursor is positioned on the timeline.

Graph Editor: In detail 
When something is animated, it changes over time. This curve is shown as something called 
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an F-Curve. Basically what an F-Curve does is an interpolation between two 
animated points. 

1. Graph Editor Icon: Change the view to the graph editor.
2. Object Name: Name of the selected object or the object that is being keyframed.
3. X, Y, Z Locations: Indication of the axis that is being keyframed.
4. Keyframe Location: These points show at that time on the timeline that there is a

keyframe.
5. Cursor Point: Green line shows where the cursor is positioned on the timeline.

Keyframe 
A key frame is a location on a timeline which marks the beginning or end of a transition. It 
holds information that defines where a transition should start or stop on a certain axes. The in 
between frames are interpolated over time between those definitions to create the illusion of 
motion. 

To insert a keyframe on an object. Select that object and press “I”. This brings up the Insert 
Keyframe Menu. Keyframes can be inserted on different axes. I can be inserted on one at a 
time or a few at once. 

● If you want to animate on the shapes location, choose location.
● If you want to rotate the object when moving, choose rotation.
● If you want to grow or shrink the object, choose scale.

If you do not keyframe a certain movement, that motion will be lost and will revert back to the 
earliest keyframe before or to its default.  

If you want to delete a keyframe you inserted, you must select that keyframe either in the 
dope sheet or in the graph editor (by either box selecting (B) or by selecting with the LMB) 
and then press ALT + I to delete keyframe. The object will return to the previous keyframe 
state. 

To Remember 
You must place your cursor on the timeline at the time frame you want to keyframe before 
you move or keyframe the object. If you move the object and then move the cursor on the 
timeline, it will revert back to the previous location. Don't try to do everything in sequence. 
Start with the beginning, middle and end poses, then keyframe in between to smooth things 
out. 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures 
Skins 6.0 | indigenousfutures.net 



Exercises: Bouncing ball & Girl Character 

Ball 
For the bouncing ball exercise, have participants open up blender and create a small sphere 
to animate. Start with the ball up in the air, then touching the floor, then back in the air. 
Then go back and fix the squashing, stretching, curves etc. 

Girl Character 
For the girl exercise the participants should  open up the provided work file from Plastic 
Gluon (Course Assets > Course Material > 3D Animation > 
BlenderAnimationTools&References.blend) 

For characters, it is easiest to keyframe on the controllers rather than the bones 
themselves.  
The main ones being: Chest, Body, Hands, Elbow Pole Target, Legs, Knee Pole Target. Have 
them animate something very simple. Head leaning and foot tapping. 

Creating and Using Animation References 

The Animator’s Survival Kit 

Written by Richard Williams who was the creative mind behind the animation of the Who  
Framed Roger Rabbit. Excellent animation drawing references! Includes techniques, advice,  
tips, tricks, and general information on the history of animation. Excellent step by step  
drawing and explanations of animations and poses. 

The Walk Cycle: 

Walk cycles encapsulate all of the principles of animation. It deals with complex issues of  
weight and timing, in order to be convincing. All walks are different so we will be filming our  
own references.  

Characteristics of a walk cycle: Short strides, small arm swings, little bounce. 

The Run Cycle: 

Run cycles encapsulate all of the principles of animation. It deals with complex issues of  
weight and timing, in order to be convincing. All walks are different so we will be filming our  
own references.  
Characteristics of a run cycle: Long strides, big arm swings, bigger bounce. 

Act It Out: 

Now we are going to film ourselves acting out the animation for reference when we are going  
to animate them in blender. 

Act out your animations and film them as reference. Look at your own body bending 
and moving as you create these animations. Make exaggerated gestures. 

Workshop on Aboriginal Storytelling and Video Game Design produced by the Initiative for Indigenous Futures 
Skins 6.0 | indigenousfutures.net 

329



Write Draw Play

Story Development

Art Direction

Gameplay Design

Graphics Engine

3D Animation 2.5D Cinematics Audio & 
Atmosphere Programming

3D Modelling

Texturing

Rigging

Animation

2D Graphics

2.5D Cinematics

UI Elements

Recording 
Dialogue

Sound Effects

Music

Level Building

Interaction

Mechanics

Integration

B
rainstorm

ing
D

ay 01–05
Learning
D

ay 08–10
Production
D

ay 11–15
Prototyping &

 
Pre-production
D

ay 06–07

G
am

e D
evelopm

ent W
orkflow





Skins 6.0
skins.abtec.org/skins6.0

Initiative for Indigenous Futures
indigenousfutures.net

Kanaeokana
kanaeokana.net


